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LOI NOI PAU

Trén thé gidi, hé thong théng tin dia Iy GIS ra doi vao dau théap ky 70 va ngay
cang phdt trién manh mé trén nén tang cua tién bé cong nghé mdy tinh, dé hoa
mdy tinh, phén tich dir liéu khéng gian va qudn ly div lisu. Hé GIS déu tién duge
ung dung trong cong tdc quan ly tai nguyén ¢ Canada vdi tén goi la "Canada
Geographic Information System” bao gom cdc thong tin vé néng nghiép, lam
nghiép, su dung ddt va déng vat hoang dd. T nhitng ndm 80 tro lai ddy, cong
nghé GIS da c6 sw phdt trién nhdy vot vé chdt, trd thank mét cong cu hitu hiéu
trong cong tde quan Iy va trg giip quyét dinh. Phan mém GIS dang hudng tdi dua
cong nghé GIS thanh hé tu déng thanh lap bdn dé va xit Iy dir liéu phuong tién cao
cap, hé chuyén gia, hé tri tué nhén tao va hudng doi tuong.

0 Viét Nam, trong xu thé hji nhdp khu vue va quéc té, hé thong thong tin dia ly
cing duge nghién citu, iing dung va phdt trién nhw mét tat yéu khdch quan. T
ché ing dung va phdt trién mang tinh ti phdt, nhitng ndm gdy ddy, céng nghé
GIS da duoc nghién et va tng dung rong rdai ddc biét & cdc thanh phd lon. PE
ddp @ng nhu cdu hoc tdp, nghién citu va ung dung GIS ngay cang tding, ching
toi xin ra mat ban doc b6 sdch "Hudng dén sz dung phén mém cong nghé GIS”
gom 2 cuén. Cudn th nhdt "Té chic hé thong thong tin dia ly GIS va phdn
mém GIS-MAPINFO 4.0", cuén thi hai "Hudng ddn sz dung phén mém céng
nghé GIS- ARC/INFO".

Trong qud trinh bién soan bé sdch nay, tuy dd rat cé géing nhung vol kha nang,
kinh nghiém con han ché, b sdch nay chac sé con khiém khuyét, chiing toi mong
cde dong nghiép, ban doc gan xa cho ¥ kién déng gép.

Thiz gop ¥ xin gui vé :

- Nha xufit ban Xay dung - Bé Xay dung - 37 Lé Pai Hanh Ha Néi.

- B6 mé6n Tric dia - Trudng Pai hoc Xay dung Ha Néi.

Chiing t6i xin chén thanh cam on.

Cac tac gia



Phan |
T0 CHUC HE THONG THONG TIN BIA LY GIS

Chuong mo dau

KHAI NIEM VE CONG NGHE GIS

I. DINH NGHIA CONG NGHE GIS

Trong cdc tai li¢u da cong bo hién nay c6 khd nhiéu cdc dinh nghia khic nhau vé
cong ngh¢ GIS. Nhung néu xét vé mit ban chat van dé thi cic dinh nghia dé khong
khdc nhau lam va tém lai c6 thé hiéu GIS 12 mét tap hgp ¢6 t8 chitc ciia phdn ciing mAy
tinh, phan mém, dif ligu dia ly va céc thd tyc cla ngudi st dung nhim tro gitp viéc thu
nhan, luu trlf, quan 1y, xir ly, phan tich va hién thi céc thong tin khong gian tir the giGi
thyc d¢ gidi quyét cdc van dé tdng hop théng tin cho céc muc dich cha con ngudi dat ra.

GIS khdc v6i cdc hé do hoa may tinh don thuan. Céc hé dé hoa may tinh khéng quan
tam nhicu dén nhiing thong tin thuéc tinh phi d6 hoa gin lién vai cdc doi tugng quan ly,
cac thong tin ma mot thire the dia 1y chiing ta quan sét duge ¢6 thé nhan thay rd nd hoic
khong nhin thay dugc. Trong khi d6 cdc thudc tinh nay lai rat hivu ich trong vi¢c phan
tich dir liu. Mot h¢ théng d6 hoa t6t 13 mot phan co ban clia phan mém GIS nhung
chura di, né méi chi 1a mot trong céce co s¢ nén tang cho viéc phdt trién cong nghé GIS.

GIS khong giong vdi cic hé thong tro gitp thiét k€ bing may tinh CAD (Computer
Aided Design) dung dé v& cdc ban v&, d6i twong ky thuat. Su khdc nhau chil yéu cia
CAD va GIS la céc thong tin clia CAD khong bét budc phai gin véi (th€ gidi thuc va su
tu nhién hoa trong phong céch phan tich dif liéu clia hé thong. Cic hée AM/FM va LIS
(Land Information System) chi 12 céc trudng hop riéng ciia GIS chuyén dung cho mot
muc dich nhit dinh.

Hé thong thong tin dia Iy 1a mot loai hé théng tin kiéu méi (New Information
System) va la mot cong ngh¢ mdy tinh tng hop. Tir cdc thong tin ban dé vi thong tin
thuoc tinh luu trif ta ¢6 thé dé dang tao ra cdc loai ban d6 va cic bdo cdo dé cung cdp
mot sy nhin nhan c6 hé théng va tong thé, nhim thu nhan vi quan 1y théng tin vi trf ¢6
hi¢u qua, cho phép cic nha lanh dao thuc hién tt hon cong viéc lap k€ hoach va tro
giip quy¢t dinh. He thong thong tin dia 1y quan 1y vi tri dia 1y gan lién véi cic s6 liéu
riéng ré khic lién quan dén no.



Hé théng thong tin dja 1y ¢6 thé 1a mot hé théng thong tin 16n chay trén mdy tinh
MINI hay MAINFRAME hoac 1a mét hé théng nho chay trén mdy vi tinh hay tram
lam vi¢c (Workstation), hoat dong trong méi trudng pham vi cha moét co quan hay
nhicu co quan. NG ¢6 thé chita dung cdc chitc ning AM/FM (AM/FM- Automated
Mapping/Facilites Mapping: Tu dong héa ban d6 / Phuong tién dé dang thanh lap ban
d6) va CADD (CADD - Computer Aided Drafting and Design: Thi€l k€ v v& k§ thuat
trén may tinh) khéc nhau phu thudc vao yéu cdu cong viéc va tai chinh cua co quan tng
dung cong ngh¢. Khi quyét dinh tmg dung hé théng thong tin dia Iy vao cic hoat dong
quan 1y va chuyén moén clia co quan minh, ching ta cin xem xét cic ting dung theo ba
nguyén tic sau:

+ He thong thong tin dia 1y 1a cong cu dé 1am 16t hon viéc 1ap k€ hoach, tro gidp ra
quyét dinh. H¢ théng thong tin dia 1y 14 mot loai cong nghé thong tin ma cdc théng tin
chudn cua né duge ding phuc vu cho cong tac chi dao viée quy hoach téng thé (master
planning) trong cdc hoat dong kinh t€ - xa hoi.

+ Hé thong thong tin dia 1y 1a cong ngh¢ lién két cc cd s& dir liéu don déc, nang cao
viéc su dung thong tin nhu mot ngudn tai nguyén chién luge xuyén sudt.

+ He¢ thong thong tin dia 1y phai dugc phat trién theo cdc yéu ciu va nhiém vu cla co
quan dé khong ngimg tro gidp lanh dao, cic nhi quan 1y vi ngudi sit dung.

II. CAC KHA NANG CUA CONG NGHE GIS

Céc thong tin quan 1y trong GIS ¢6 dic tinh rigng ma cdc hé théng théng tin khic
khong nhat thi€t bat buge 1 ching phai gan két v6i vi tri dia 1y thue ctia céc d6i tuong
thudc ving lanh thé chita dung ching. Kha nang ctia GIS khé phong phd va thy thudce
vio céc Ung dung cu thé cha noé trong thuc t& nhung bat cit mot hé GIS nao cling phai
16i thiéu giai quyét duge 5 van dé chinh sau day:

+ Vi tri (Location) - quan |y va cung cdp vi tr{ ciia cdc d6i tong theo yéu cdu bing
cdc cdch khdc nhau nhu tén dja danh, ma vi trf hoic toa do.

+ Diéu kién (Condition) - thong qua phan tich cdc di lieu khong gian cung cap cic
su kign ton tai hodc xay ra & mot dia diém nhat dinh hodc xdc dinh cdc déi tugng thoa

min cdc didu kién dit ra.

+ Chi¢u huéng (Trend) - cung cap hudng thay déi cia dai tuong thong qua phan tich
cdc dit ligu trong mot viing lanh thé nghién ciu theo thai gian.

+ Ki€u mau (Pattern) - cung cdp mitc do sai lénh cia cac d6i tuong so v6i kidu mau
va noi sip dit ching di ¢6 tir cdc nguén khdc.

+ M0 hinh héa (Modeling) - cung cdp va xdc dinh nhitg gi xdy ra néu c6 su thay déi diy
liéu hay ndi cach khac xdc dinh xu thé phit trién clia cic d6i tugng. Ngoai thong tin dia 1y,
hé théng can phai ¢6 thém thong tin vé cdc quy luat hoac ngudn thong tin théng ke.
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Thoéng tin dugc 16 chitc quan 1y trong mét hé théng thong tin dia 1Y cdn duge diing
chil yéu dé phan tich nhimg van dé bién dong khdc nhau nhu sur lan truyén bénh sét rét,
h¢ théng an toan khi dong dat va quan Iy nhan sy, t0i pham .v.v...

Ung dung hé théng thong tin dia 1y chiing ta s& dat duge cac tién bd sau trong cic
hoat dong tdc nghiép cia minh: _

- Lam giam hoac loai bé cic hoat dong thira, tiét kiém thoi gian, tién clia va cong sifc;

- K&t qua s6 ligu tot hon véi gid thanh thdp hon va tro gidp quyét dinh, 1ap ké hoach;

- Nhanh choéng thu nhap duge nhiéu thong tin va phan tich chiing, lap bdo cédo cho
moi nhu cdu cua coéng tdc quan 1y,

- Céc linh vire hoat déng méi clia co quan ¢ thé tv dong héa dudi mot cai 6
(Umbrella) day du s6 liéu chia hé thdng thong tin dia ly;

- Cau néi gitta cdc cong cu va cong nghé nhirm cai tién san xudt;

- Tang kha nang liru trit va xir 1§ s6 liéu, cai tién truyén thong thong tin;

- Tao ra mot loai dich vy mdi 1a cung cdp thong tin;

- Tra 1&i cdc van dé quan tam nhanh, chinh x4c va tin cay cao;

- Luén ¢6 san cdc san pham phuc vu cdc muc dich méi (nhu ban dé, bao céo, thong
tin, s6 liéu .v.v... phuc vu 24 gi¥ trong ngay).

IIL. MOI QUAN HE CUA CONG NGHE GIS VOI CAC NGANH KHOA HOC KHAC

Cing giéng nhr cic nganh khoa hoc tng dung khéc, trong qué trinh phat trién cla
minh, cong nghe GIS luén lién quan mat thiét véi cdc nganh nén ting cha minh, & day
chiing toi chi giéi thi¢u so luge moi quan hé clia cong nghé GIS véi mét s& nganh chinh
nhu sau:

- Nganh cong nghé mdy tinh: Mdy tinh la mot trong cdc thanh phan ctia cong nghg
GIS, dya trén co sd nén tang cia cde bo xir 1y (CPU) va hé diéu hanh cdc phan mém GIS
khong ngimg phat trién va hoan thién. C6 thé néi sy phat trién chia cong nghé mdy tinh
s& quy€t dinh sy phat trién va pham vi iing dung clia cong nghé GIS.

- Nganh khoa hoc qudn tri dit li¢u: Cac dit 1iéu trong GIS dugce té chirc va quan ty
dua trén nén tang nguyén tic ciia cdc phadn mém quan tri dit liéu. Co s& dif licu ciing 13
mot thanh phén co bin cua he GIS. Su phit trién va hoan thién cta cic hé théng quan tri
dit liéu s gidp cho GIS hoan thién chifc ning quan 1y co s& dit liéu cta minh t6i wu hon.

- Nganh bdn dé hoc: Ban dé 1a mot thanh phan thé hién céc d6i tiong dia 1y trén bé
mat Trai dat ciia ching ta trong hé¢ GIS. Dit liéu ban d6 1a mot thianh phéan chinh trong
co s dif ligu cha GIS. Sy phét trién chia nginh Ban d6 s& gitip cho GIS hoan thién cdc
chitc nang xir ly dit li¢u khéng gian, phong cdch thé hién cdc dit liéu ban d6 trong hé
thong va cdc san pham d4u ra.

- Nganh trdc dia va vién tham: Céc dit liéu trong GIS luon gén chat véi the gisi thue.
D€ dam bao co s& todn hoc cho sy lién két d6 1a mang lu6i toa do théng nhat (Hé toa do
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quée gia). Nganh tric dia cung cép cde s6 licu toa do Nha nude chinh xdc va thong
nhat. Céc thong tin quan 1y trong GIS phan 16n 13 théng tin finh, titc 14 ching 14 nhimg
théng tin vé nhitng sur vat va hién tuong da x4y ra & tai mot thai diém hoic mot khoing
th&i gian nhat dinh nae dé. DE ¢6 thé ddi mdi va cap nhat thong tin trong GIS cho phi
hop véi nhiing bign d6i di xay ra ¢ thdi diém hién tai can phai ¢6 cdc s6 liéu, w liéu
mdi vé chling va mot ngudn thong tin méi dé ¢6 thé thu nhan nhanh chong thong qua
cdc anh hang khéng hoac anh vién tham.

- Nganh todn hoc: Céc chiic nang xir 1y cua GIS luon gan lién véi cac thuat todn cu
thé trong todn hoc. Sut hoan thién trong viéc giat quyét cdc thuat todn Ung dung da gidp
cho cdc nha lgp trinh phan mém GIS c6 thém kha nang md rong va hoin thién cdc chiie
nang trong GIS nhat la chitc nang xur 1y dia [¥. Todn hoc 12 mot trong cdc nén tang cd sO
dé phit trién va hoan thién cdc chiic nang bén trong ciia cic phian mém GIS.

- Nganh truyén théng thong tin: Cac thong tin trong cédc hé GIS chi ¢6 thé trao déi
véi nhau thong qua cdc phuong tién truyén thong. Su phét trién clla nginh ndy s& cung
cap cho GIS nang luc lién két mang mdy tinh, tao ra cdc h¢ GIS da nganh. Néu truée
day phédn 1én GIS dugc sir dung doc 1ap véi nhau thi ngay nay hau hét da duge két noi
thanh mang mdy tinh sit dung chung cho cic co quan khic nhau da lam cho cic nha
quén Iy thdy rd thém hiéu qua ddu tur vi {ch loi ciia cong nghé GIS.

IV. KHAI QUAT QUA TRINH PHAT TRIEN CUA CONG NGHE GIS

H¢ GIS diu tién ra doi vio nhimg nam dau cha thap ky 70 vh ngay cang phat trién
manh me (rén nén tdng cla cdc tién bo cong nghiép mdy tinh, d6 hoa mdy tinh, phan
tich dit ligu khong gian va quan tri di lieu. He GIS dau tién duge dua vio ung dung
trong ¢ong tac quan ly tii nguyén & Canada véi cdi tén goi ta “Canada Geographic
Information System” bao gém céc thong tin vé néng nghiép, lam nghiép, sur dung dat va
déng vat hoang da. Tix nhitng nam 80 trd lat day, cong nghé GIS di c¢6 mét sir phdt trién
nhay vot vé chat. TrG thanh mot céng cu hitu hiéu trong céng tdc quan ly va tro gidp
quyet dinh. Phan mém GIS dang huéng t6i dua cong nghe GIS thanh Hé ur dong thanh
Yap ban dé va xir 1y dit licu Hypermedia (phuo‘ng tién cao cép) hé¢ chuyén gia, hé tri tué
nhan tao va huéng d6i tugng. Phan cing clia GIS phat trién manh theo gidi phap mdy
tinh d€ ban (Desktop), nhat 13 trong nhitng nam gan day dd ra doi cde bo vi xir Iy cue
manh, thi€l bi luu trit dir liéu, hién thi va in 4n thong tin tién tién da Jam cho cong nghc
GIS thay déi vé chat. Ngay nay cong nghé GIS dang phat trién manh theo huéng 8 ho’p
(Emerprlse) va lién két mang. C6 thé néi trong sudt qud trinh hinh thinh vi phat trién
cua minh, cong nghé GIS da luén tu hoan thién t thdp dén cao, tir don gian dén phitc
tap dé phil hgp véi cdc tién bo mai nhét ciia khoa hoc va k¥ thuat,

Nhu trén di néi, cong nghé GIS ludn di tix thdp dén cao va tir don gidn dén phiic tap,
tr chuyén dung dén da dung. Giao dién v6i ngudi sit dung clia cdc phin mém GIS trude
day hau het Ia cdc cau Iénh va doi héi ngudi st dung phéi 13 nhimg nguvi ¢6 chuyén
moén cao ciing nhu phai cé hiéu bi€t nhat dinh vé may tinh méi cé thé siv dung GIS
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dugc. Ngay nay phan 16n cdc phan mém GIS giao dién véi nguoi sir dung thong qua
giao dién d6 hoa (GUI) kém theo céc chi din cu thé trén man hinh cho nén khong cin
ngudi st dung phai ¢ chuyén mon sau va hiéu biét nhiéu vé mdy tinh. Thém nita, phin
cing mdy tinh ngdy mot ré di rit nhiéu nhung lai tang thém kha nang xir Iy dir liéu,
chinh diéu nay da lam cho céng nghé GIS duoc ing dung rong rai hon.

V. CAC THANH PHAN CO BAN CUA CONG NGHE GIS

Theo dinh nghia da néu & trén, cong nghé GIS dugc hiéu 1a mot hé théng va dugc
kién tric tir cde thanh phdn co ban 1a: phén cing, phdn mém, co so dit liéu va nguoi st
dung. Cac thanh phan cau thanh dé c6 lién quan mat thiét véi nhau v méi quan hé giita
cdc thanh phan dé c6 thé dugc mo ta theo so dé sau:

Hay duoc minh hoa theo so dé sau:

Thu nhén s5 fig,,

Thé gidi thuc

6 X
&
) - ]




Trong céc so d6 trén vé thanh phdn co ban cua cong nghé GIS ching ta thiy cé mot
thanh phin quan trong d6 1a Ngudi sir dung, nhan t8 thuc hién céc thao tic diéu hanh sy
hoat dong cha hé thong GIS. Giai thich m6i quan hé gilra cac thanh phan trong cdc so
dé trén ¢é thé sa luoc nhu sau: Cac thong tin vé cac su vat va hién tuong tir thé gidi thire
duge dua vao GIS quan 1y, tao ra cdc co sd dir liéu s6 va duge xu 1Y theo muc dich cua
ngudi s dung r6i trén k&t qua phan tich dir liéu théng qua cong cu phan mém GIS,
ngudi sir dung lai tdc dong lai the gidi thuc nham dat duge muc tiéu da dé ra va thé la
la1 phét sinh ra cic thong tin méi va cdn dua vao quan 1y va xir ly trong GIS, ¢ nhu thé
nd 1a mot vong tudn hoan khép kin giira cdc thong tin thu nhan nr thé gidi thue, moi
trudng cong nghé GIS va ngudi sur dung.

Can luu y rang GIS khong phai 1a mot hé théng vat 1y bao gém: mdy tinh va phéan
mém don gian dé lam ban d6, tuy nhién né cé kha nang tac ra cac ban do & cic ty 1@
khdc nhau trong cdc luéi chi€u khéc nhau va thé hién cdc ban d6 chuyén dé theo cac chi
tiéu, mau sic khdc nhau. C6 thé coi GIS 12 mot cong cu phan tich, cai tao thé gidi thuc.
Mot wru diém néi bat cia GIS 1a né cho phép ta xdc dinh cdc méi quan hé khéng gian
gifta cac hinh anh va d6i tugng ban d6 quan 1y trong hé thong. GIS khong luu trix cic
bén d6 theo cac kich ban cé truyén va ciing khéng luu trit cdc hinh 4nh cu thé theo mot
tdm nhin (View) cho mot viing lanh thé dia Iy quan tam. Thay vao dé né lwu trit cic dit
ligu ma tir cdc dir liéu dé ching ta ¢4 thé tao ra cac tdm nhin theo nhu cdu dit ra, phat
sinh va v& cdc hinh anh ciing nhu ban dé phuc vu cho cic muc dich cu thé dit ra.

Nhu di néu & trén, trong GIS khong quén 1y cac trang ban dé hoac hinh anh cu thé
ma né quan 1y mot co s& dif liéu, théng thudng co sé dit lidu ciia hé Desktop GIS 13 co
sG dif liéu quan hé tap trung duoc tao lap bdi cac dit liéu khong gian trong thé gidi thue
di k&m theo thong tin thudc tinh cia ching va do ciing 1a su khéc biét chinh giita céc hé
GIS d6i vd6i cidc h¢ CAD. Mudn tao ra mot hinh anh cho c4c d6i tong dia 1Y quan tam
trong mo1 truong GIS ching ta can phai xdc dinh duge 3 thanh phan cha thong tin vé
hinh anh d6 luu trit trong hé thang la:

- Hinh anh dé 1a gi (What);

- Hinh anh d6 & dau (Where);

- N6 lién quan dén cdc hinh anh khdc ra sao (Relation).

Théng qua céau lénh va thao tic cua ngudi sir dung cdc di liéu hién cé trong co s& dit
liu GIS s€ cung cap céc gia tri cho cdc thanh phin dé va tr xay dumg nén cdc hinh anh
can thiét. Dac biét, GIS cho phép ta kha nang téng hop théng tin trén ban dé tir cic co
s¢ dit ligu da xay dyng va tao ra cdc m&i quan hé khong gian méi giita cde théng tin
nhdm x4c dinh hudng phét trién t6i wu clia cdc d6i twong va dénh gid xu the bign dong
clta chiing thong qua chuéi dit liéu theo thoi gian.

Nhu ching 161 dé trinh bay & trén, cong nghé GIS c6 thé coi 1a mot cong cu tng dung
da nganh. N6 cling c6 thé coi 12 mot hé théng lap ban dé may tinh thong minh. Tuy
theo nhu cdu va dic diém cha timg nganh ma viéc tng dung GIS c6 thé & timg mitc do
khac nhau.
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Chuong 1
PHAN MEM CONG NGHE GIS

Phan mém va phan cimg 1a hai diéu kién cén dé c6 thé ung dung cong nghé GIS vio
thye t€. Phan nay s€ gi6i thiéu gitip chiing ta hiéu rd hon nhitng dic diém cta hai y&u t6
trén trong hé théng GIS.

Phin mém cla hé théng thong tin dja ly 13 mét tap hop cla cic cau lénh, chi thi
nhdm diéu khién phan cing clla mdy tinh thuc hién mot nhiém vu xéc dinh. Phdn mém
duge luu gilt trong mdy tinh nhu 1a cdc chuong trinh trong bo nhé clia hé thong nham
cung cdp cdc thu muc hoat dong trong hé thong co s cha mdy tinh va thu nhan. Phan
mém ¢6 thé chia lam hai 16p:

- Lép phdan mém miuc thap: Hé diéu hanh co sd ;

- L6p phan mém miic cao: Céc chuong trinh img dung, ding thuc hién vige thanh lap
ban d6 va cac thao téc phén tich khong gian dia 1y.

Vai trd va dédc tinh phan mém dugc gén lién véi kien tric cha phin ciing sir dung
trong may tinh va su tién bo clta cong nghé tin hoc. Ngdy nay phén 16n cdc phin mém
GIS 1a giao dién than thién v6i ngudi sir dung.

I. CAC LOP CUA PHAN MEM
Trong cic h¢ théng may tinh hién dai, phin mém cai dit cé thé khai quat tir cdc 16p sau:
- Hé diéu hanh;
- Céc chuong trinh tién ich dac biét (He tién ich);
- Cac chuong trinh ting dung (Hé tng dung).

Su lién heé gilta cdc 16p phan mém va cic bién phdp thuc hién su tuong tc giita
ching dugc xéc dinh trong h¢ théng ciia mdy tinh béi cac chuong trinh hé théng.

- He dicu hanh la nhitng chuong trinh diéu khién hoat dong clia hé théng va kiém
sodt truyén thong thong tin véi céc thiét bi phan cimg néi véi may tinh.

- He ti¢n ich déc biét cung cdp cic chuong trinh thuc hién cic chitc nang thudmg
diing nhat cua nguoi sit dung. N6 bao gom ca ngén ngit bién dich, cong cu quan 1y File
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dac bigt trong luu trilt, céc thiét bj diéu khién (Driver) dic biét cho truyén thong thong
tin v&i cdc thi€l bi ngoai vi nhur may vé, bang tir .v.v... va cdc chuong trinh khdc tro gidp
ngudi st dung va thao tdc vién hé thong thuc hién nhiém vu hang ngay.

- Phan mém tmg dung hay con goi la Hé ing dung bao gdm cic chuong trinh truy
cap truc tiép, gidp ngudi s dung tao ra mot san pham cu thé. Phan mém ting dung
thong thudng giong nhu mot san pham "dong géi" (package) cé nghia Ia né 1h mot té
hop licn ket cdc chuong trinh véi nhau nham thuc hién mét timg dung nhat dinh.

a) Hé diéu hanh:

Cung cap giao di¢n phuc vu gitta ngudi sit dung, cdc chuong trinh tng dung va phin
cing cua mdy tinh. Mac diy, khai niém vé h¢ diéu hanh lién tuc thay déi trong nén cong
nghi¢p may tinh vi khéng cé mot tap hop chic ning nao téng thé, toan ning cho moi
loai may tinh nhung cdc chitc nang chinh cla hé diéu hanh cho tat ¢4 cdc loai mdy tinh
tr mdy PC dén may MINI va MAINFRAME c6 thé xem nhut sau:

- Quan ly bé nhé (Memory Management);

- Truy nhép hé théng va tinh toin (System Access and Accounting );

- Kiém so0dt truyén théng (Communication Control);

- Xt ly céu 1énh (Command Processing);

- Quan Iy File va dir liéu (File and data Management).

Mot h¢ diéu hanh ¢6 (hé coi la chuéin (standard) hién nay 14 Dos va Windows, diing
cho mdy vi tinh 16 hoac 32 bit. Hé diéu hanh nay ducc phét trién boi hang IBM va
Microsoft, 14 mot hé diéu hanh phé dung nhat trong nén cong nghiép mdy vi tinh. Mot
h¢ diéu hanh khdc kha thong dung [ hé diéu hanh Unix ma ngudi khot tao la cdc nha
khoa hoc tai trudng téng hop California.

b) Hé tién ich ddic biét:

Nhimng chuong trinh tién ich chinh thudng dung trong hé théng thong tin dia 1y ¢6
thé nhu sau:

- Ngon ngir bien dich (Language Compilers). Phén 16n cdc phidn mém quéan ly dif liéu
dia ly dugc viet trong ngon ngit lap trinh Assembler, Fortran, Cobol, Basic hoac C.
Nhing ngon ngit d6 la tap hop cdc cau lénh co s viét trong Anh ngit nhim diéu khién
mady tinh trong mot cau tric ngit phap (Syntax) dé thuc hién mot nhiém vu xdc dinh.
Céc chuong trinh & dang ma nguén phai duge dich ra dang co s& ngon ngir may
(Binary).

- Diéu khién thi¢t bi (Device driver). La nhimg chuong trinh dic biét duoc thigt k€& dé
cung cap cdc giao dién giita hé diéu hanh va phan mém tng dung véi céc thiét bi ngoai

12



vi. Ching dich céc Iénh trong phan mém itng dung sang thanh cac chi thi ma thiét bi c6
thé hiéu duoc dé thue hign.

- Tién fch luu trit dia (Disk Backup Utilities). La nhitng chrong trinh dac biét duoc
thi€t k& dé cung c4p nhilmg dich vu sao chép, cit gitt dit lidu.

- Thu vién con (Subrountine Libraries). LA nhitng Modules chuong trinh dugc viét
trong cdc ngodn ngir lap trinh néi trén, chiing c6 thé cho phép ngudi sitr dung phat trién
mem déo cdc ding dung va truy nhap vao céc chitc ning clia hé théng.

- Phin mém truyén thong dic biét (Special Communication Software). L nhitng
chuong trinh trg gitip digu khién cdc thiét bi nhu thi€t bi luu trit, ngoai vi, modem,
mang may tinh v.v.., ’

¢) Phdn mém itng dung:

Phdn mém tng dung dugc cung cdp ¢ dang bo chuong trinh bao gém nhiéu chuong
trinh lién k€t chat ch& véi nhau nhdm tao ra mot kha nang cu thé cho viéc lap ban dé,
quan 1y va phén tich s§ liéu dia ly. Phan I16n c4c phan mém GIS duoc tao nén tir hai
phén co ban:

- Phin trong tam co ban la cdc chuong trinh hodic chiic nang vé& lap ban dé co ban,
quan ly dit liéu dia 1y va phan tich goi la "Core” .

- Phan thit hai 1a cic chuong trinh tng dung. Céc chuong trinh nay moc néi véi
"Core™ dé phuc vy cho ting dung cu thé chia ngudi st dung nhu phan tich dia hinh, lap
ban d6 chuyén dé dic biét, mo hinh héa v.v.

Phén mém hé théng thong tin dia 1y 13 mot tap hop cac san phim da thiét k& nhim
thyc hién dia xir ly va cung c4p nguén luc cho cic tng dung cita h¢ théng thong tin dia
ly. Chung la nhiing ham s6 khéng gian hoac cong cu, phin mém quan 1y co s6 dit liéu
va ngoén ngir he théng hoac doi khi I nhimg chuwong trinh ting dung. M6t vai co quan
ddi hoi mic do cao hon vé cau hinh phan mém so véi nhiing h¢ théng da c¢6 va thuong
mai hod. Cé mot quan diém chung 12 céc chirc néng cua hé thong thong tin dia 1y phai
dugc xem xét trong qua trinh trinh dién (Demonstration) cdc chic ning cd ban cé trong
h¢ thdng. Nhung cén luu y ring phdn 16n cdc trinh dién chi moé ta tiém ning cta hé
théng chit khong phai & mic do thay déi cau hinh. DE hién thuc nhat, viéc phét trién
phin mém phai dva vao nhimg yéu cdu cha ngudi s dung cudi cling va tu van cia ho.
Cho dén nay vin chua ¢6 mo hinh chudn nao vé hé thong thong tin dia 1y cdp co quan
dad dugc chap thuan dé xay dung cdc phdn mém g dung chung cho moi ting dung. .

Muc tiéu clia he théng théng tin dia Iy 13 quan 1y va phén tich nhitng thong tin khong
gian. D¢ dat duoc muc tiéu dé nén tang cla hé thong thong tin dia 1y phai thoa man céc
chifc nang thue hién cdc cau lénh nr don gian dén céc ing dung phiic tap. Nhimng nguoi
sit dung phan mém GIS quan tam dén cdc chifc ning xiur ly cia né trén hét va thong
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thuong [a viéc su dung cdc thuat ngit. Céc biéu thitc nhu céc cong cu, cdc Macro, céc
ham s8 va cdc ng dung da trd nén rat thong dung. Mdi mot muc nhu vay cén phii duoe
xdc dinh dgc lap vé gid tri ctia né d6i voi ngudi st dung. Nhitng quang cdo thi tradng vé
cong cu "Tools" mém déo, giao dién vdi ngudi sir dung than thién, @ng dung cho moi
hoan canh khdc nhaun.v.v... khéng thé dugc nim lai trong su xem xét cdc chic ning ciia
hé théng thong tin dia ly. Khéng c6 su thoa hiép nao vé viec xem xét cdc chifc nang cla
hé thoéng. Mat vai hé thong con cung cdp cdc chite ning, cdc Macro, khi nang xiy dung
thuc don va ngon ngit 1ap trinh phdt trién cic Gng dung. Tuy nhién, ngudi sit dung cugi
cung phai lam mot s6 viéc nhat dinh v€ thiét k& hé théng cho co s& dit liéu vi cdc ing
dung. Qua trinh thuc hién doi hoi cén thiét phai ¢é mot su phan tich hé thong, thist k&
s0 b, thi€t k& so do co sa dir lidu, thigt k€ chi tiét cdc ing dung , md héa phin mém va
kiém tra, bdo tri lién tuc hé théng khi nén tang co s& duge nang cip. Thong thudng cdc
ting dung va thuc don clia hé thong khong thé phat trién xong trong thai k¥ xay dung hé
théng ngén ngti. Céc nha sit dung phu thudc vao sy hiéu biét cic lénh h¢ théng vA ngon
nglt 1ap trinh, né phai duge thuc hién cho cdc nhiém vu lau dai hon dé trao déi tiY co
quan 1ap trinh dén cdc co quan ngudi sir dung.

Mot di€u quan trong cdn luu ¥ 13 su thay ddi nang cao lién tuc cta cic hé thong
théng tin dia ly da dua dén mot s6 van dé vé phan mém. Ap luc thi trudng tai céc tho
diém da dan dén sy voi vang trong viéc phat hinh cdc phadn mém. Doi khi nhitng thé h¢
cii hon di bi qud 16i thoi, ngudi sit dung bi khé khin trong viée nam bit hét cac chitc
nang theo muic d¢ cua phan mém cung cép, gdy ra su mao hiém cho cdc hoat dong hang
ngay cua to chifc (ng dung hé théng.

II. KHA NANG XU LY DU LIEU KHONG GIAN CUA PHAN MEM

Kha néng xir 1y dit liéu khéng gian bao ham céc chic nang cho phép ngudi sir dung
nhép hoac bién tap hinh 4nh ban d6 va tao ra céc ghi chi, ky hiéu nhim tao ra cdc ban
d6 trén man hinh hodc gii ra cdc thiét bi in. Kha nang nhap s6 liéu khong gian cho phép
ngudi sir dung nhap hinh anh bén d6 va luu giir ching theo toa do (x,y) hoac d6i khi
ca do cao (z) theo mot h¢ toa do x4c dinh. Cdc chu din van ban va hinh anh ciing c6
thé duge nhap vao tao ra mot hinh anh ban d6 thong nhat véi cdc thude tinh hen gitr
trong co so dir liéu. Nhitng kha nang chinh xir Iy s6 liéu khong gian trong phan mém
GIS nhu sau:

- 86 héa thi cong (Interactive Digitizing). S6 héa 1a qua trinh thuc hién chuyén déi
thong tin tir ban dé di in sin sang dang s8. Cho phép ngudi sit dung nhap toa do (x.y)
clia hinh &nh bin d6 tir ban s6 héa (Digitizer). Dung con chuot (Mouse) hoic bit dién
tir (Stylus) dé di theo cdc dudng bién cia hinh anh ban d6 cin s6 héa dé chuyén ching
thanh dang s6 cua phan mém quan Iy. Trong viéc nhap s6 liéu c6 thé diing mot s6
chuong trinh dic biét, cho phép ngudi sit dung tao ra céc hinh toian hoc nhu hinh chi
nhat, cung tron tir ba diém, dudng cong Spline.v.v....
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- Nhap ghi chi (Annotation Entry). Ghi chi 1a nhiing van ban chit thé hién gidng nhu
nhan cua cdc hinh anh ban dé, cdc chi giai, tieu dé va chi din cua ban dé. Thong
thudng cdc phan mém GIS tao ra cic ghi chii bang hai céch:

+ Nhap trye ti€p ta ban phim cling véi qu4 trinh nhap cic thong tin khoéng gian;

+ Nhap vao co so dif liéu thuge tinh va gén cho chiing cdc d6i trong ban dé.

- Kha nang bién tap khong gian. Bién tip dir lieu khong gian la mot (rong nhimg
chirc nang co ban cua mot phin mém h¢ théng thong tin dia 1y, N6 bao g6m cdc cong
viéc chinh sau:

+ Xoda d6i tugng:

Cho phép ngudi sir dung chi dinh cdc d6i tuong cdn xo4 khoi ban vé bang chuot hoac
con tré. Trong hé théng thong tin dia 1y khi céc dif liéu thudc tinh phi khong gian da
duge lién két véi cic d6i tugng dia 1 thi chie nang xod ciing s& tu dong xod thudc tinh
cua né trong co s¢ dit licu.

+ Chinh sira déi tuong:

Cho phép ta lam thay ddi hinh dang, dinh huéng hoic vi tri clia céc d6i tong di c6.
Chirc nang nay cé thé thue hién trén mot hay nhiéu d6i tuong. Thong thuong ta hay
dung cdc chitc nang chinh sira cit xén, kéo dai, xoay va dich chuyén.

+ Céc lénh bien tap dac biet:

Mot s6 phian mém c6 céc chuong trinh bién tap dac biét, cho phép ta tr dong phan
tich va x4c dinh nhimg d6i trong ban dé da nhap vao khong hop 1y nhu cdc hinh dang
todn hoc chuan chua duoc khép kin, dudng thang bi dit gay thanh cic doan v.v..... theo
mot gidi han chi tiew cho phép cha ngudi sir dung (12 sai s6 cho phép giita thong tin
khong gian nhap vio v6i sy thé hién trén ban dé ciia cdc d6i tuong). Phin mém tu dong
hoan chinh hoic thong bao véi cac d6i tuong di xdc dinh d6.

+ Lam tron va khéi quat héa dudng thang;

Lam tron 14 chitc nang chuyén dudng gap khiic thanh dudng cong, khai quit héa 1a
chuyén dudng cong thanh dudng gap khiic.

Hiéu thj dir liu khong gian va kha nang vé&. Mot trong cdc thanh phédn cua hé thong
thong tin dia ly I cdc chuong trinh hién thi va v& ban d6 trén man hinh hoidc mdy vé.
H¢ thong thong tin dia 1y cho phép ngudi sir dung kiém sodt cdc tham s6 xdc dinh
khuon dang hién th va giti ra may v& sau:

+ Kiéu dudng hiéu thj;

+ Kicu ky hiéu;

+ Mau thé hién;

+ Kiéu va kich thude chit;

+ Vi tri ctia bang ghi chi, tién dé va c4c yéu 16 dic biét trén ban dé;

+ Kich thudc hoac ti 1é cha ban vé.
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Thong qua cdc tham s diéu khién trén hé théng thong tin dia 1y s& tao ra mot tap tin
céc 1énh phi hop vdi céc thiét bi ddu ra cu thé ma ngudi st dung da chon thé hién goi 1 -
Map-File cua co so dit liéu hé théng mudn hién thi hoic in an.

IIL. KHA NANG QUAN LY CO SO DU LIEU

Phin mém hé thong thong tin dia 1y thudng 6 khd nang luu gift va tra citu cic so
liéu thudce tinh phi khéng gian cung véi cac thong tin ban d6. Vi du vé mot thira ddt, ta
quan ly duong bién bang toa do (khéng gian) nhung dugc gan vdi tén chi s& hitu, gid tri
dat, tén thita v.v... 1 cac thudc tinh cta thira dat d6. Cic bude chinh xdc dinh va quén 1y
co 56 dit liéu nhu sau:

- Xdc dinh mé hinh qudn 1y dit liéu liea chon la tdp trung hay phan tdn.

Thong thuong trong cac hé GIS clia mot co quan va cdc hé Dekstop, mo hinh quan 1y
dir li¢u 12 m6 hinh tap trung. M6 hinh dit li¢u phan tdn c6 thé ing dung trong cic GIS
tap doan. Kién triic ctia co s& dit liéu phan tan biéu hién ring cic phin cla dit licu duge
luu gitf vat Iy & clc vi tri khac nhau nhung ngudi sit dung vin c6 thé truy nhap va quan
1y thong tin trong mot sy di€u phdi quan tri chung cho co sd dit licu.

- Dinh nghia cdu tric cia dit liéu (Data Definition Language - DDL).

Cho phép ngudi sit dung mé ta so hoa vé céc tap tin sé luu giit cc s6 liéu thudc tinh
phi khong gian. So hoa (Schema) chita nhitng thong tin nhu tén ciia dit liéu thanh phén,
kich thuGe cla cic truong dit lieu trong don vi bytes hay c6ét, kiéu loai dit liéu (chit, s
nguyén, nhi phan, so thic v.v...) va cdc thong tin yéu cdu khdc cin thiét cho phin mém
XU 1y s6 liéu thudc tinh.

- Thii tuc nhdp dit liéu (Data Entry Procedures).

Cling nhu cdc h¢ quan ly dir liéu khdc, hé thong thong tin dia 1y ¢6 kha nang nhap dix
ligu va tao ra File s6 liéu theo ngon ngit dinh nghia s6 liéu DDL va cho phép ta g nhap
thong tin theo DDL da x4c nhan theo ddu mai hé théng.

Hi¢n nay c¢6 mét s6 phan mém GIS tién ti€n c6 thé cho phép ta thiét k€ mot man hinh
dac biét d€ nhap thong tin thudc tinh hiéu qua hon va nhanh chéng hon. Nhitng chuong
trinh d6 cho phép ta ngoai viéc nhap thong tin con ¢é kha nang kiém tra 16i trong qua
trinh nhép s6 ligu theo l6gic va khuon dang ta di xdc nhan bing DDL.

- Ngon ngit xar Iy 56 liéu (Data Manipulation Language - DML).

Mot trong céc ich lgi thuc t& ciia h¢ thong thong tin dia 1y 1a kha nang tra citu s6 ligu
theo mot chi tiéu ma ngudi sir dung dinh nghia tir co s& dit ligu quan 1y. Viéc tim ki€m
thong tin d6 thong qua ngon ngilt hoi dép (Query Language) mot ngdn ngit bac cao, dé
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hiéu va sir dung don gian v6i cdc cau lénh. Thong thudng céc cau lénh dé duge t6 hop
thanh mot chudi phitc tap vdi cdc 1énh AND va OR. Trong tim kiém thuong diing cac
lénh =, >, < d¢ gdn cdc diéu kién tim ki€ém. Ngay nay hau hét cac phan mém GIS xir 1y
56 liéu thude tinh thong qua SQL (Structure Query Language).”

- Khd ndang lién két s& liéu thude tinh véi s6 liéu bdn dé.

S¢ liéu thudce tinh va théng tin ban dd khong don gian 12 hai co so dir liéu doc lap
trong hé théng thong tin dia Iy ma ching lién két rat chat ch& véi nhau. Ta c6 thé tim
ki€m va phan tich dong thoi ca hai loai dit licu d6. D6 1a kha nang duy nhét chi ¢é h¢
thong thong tin dia 1y méi dam bao cung cap ddy di duoc.

IV. CONG CU PHAN TICH PIA LY VA BAN PO CUA PHAN MEM GIS

Céc phian mém GIS phai ddm bao dugce 16i thi€u cdc chie nang phan tich dia 1y va
ban d6 sau day:

- Chuyén ddi hé toa do va nim chinh hinh hoc

+ Chuyén dich hé toa do ban dé (x0, y0) sang hé toa do (x,y);

+ Chuyén ddi luéi chiéu ban dé (x, y) sang (B, L) hay (x, y');

+ Nam chinh hinh hoc. Thyc hién viéc chinh hinh anh ban dé theo diéu kién hinh hoc
d€ chuyén vé dé hinh thuc clia né (thuc chét 13 loai bo cic sai s6 bign dang hinh hoc).

- Thao tac xtr 1y théng tin ban dé:

+ Tiép bien va n&i ghép ban do. Ding toa dé clia cdc diém khéng ché chung dé ghép
noi cac ban d6 véi nhau hoac timng phan clia ban d6 thanh mot & ban dé chung.

+ Tach mot ctra s6 cac déi tugng ban d6. Chon mét cira s6 bao céc déi tugng va tach
chiing ra khoi ban d6 hién thdi dé xir 1Y hoac diing cho mét muc dich khac.

- Cong cu lap ban dé dac biét:

+ Chéng 1dp khong gian (Graphic Overlay);

+ Lap ban do chuyén dé (Thematic Mapping);

+ Lap ban d6 va tim ki€m theo dia chi (Adress Matching and Mapping). Kha nang

phén tich va lap ban d6 theo cdc s6 liéu gan lién véi mot dia chi xdc dinh (nhu dudng
phd, dia diém tru s& .v.v...).

- Phan tich va chéng phu cdc viing (Polygon). Polygon 1a mét déi tugng dia 1y c6
dién tich va déi khi ngudi ta con goi la d6i tugng viing (Region) né thé hién trén ban dé
1a mét hinh khép kin.

+ QOverlay cac Polygon: Thuc hién viéc cong lai hoac tiach ra gilta cdc Polygon
(Union and Split).

+ Overlay diém vio Polygon: Thuc hién chong phil d6i tuong diém trong viing.
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+ Overlay duong vao polygon: Thuc hién Overlay d6i tuong dudng trong ving.

- Cong cu phdn tich ban dé

+ Tinh khoang cach, chu vi, va dién tich;

+ Tim ki€m thco ban kinh (Radius Search);

+ Tao ra cac Buffer (Buffer Generation).

- Cac chuong trinh céng cu khac:

+ Chuyén déi dit liéu vécio va Raster (Raster/Vector Conversion);

+ Chuyén déi khuon dang dit liéu (Format Translation).

- Cac chuong trinh tng dung va céng cu: Theo timg linh vuce ung dung hé théng
thong tin dia Iy cdc cong cu dé c6 thé bao gdm:

+ Phan tich mang Iuéi (Network Analysis);

+ Toa do vit hinh hoc (Coordinates and Geometry);

+ Phan tich dia hinh (Terrain Analysis);

+ M6 hinh héa bé mat (Surface Modelling);

+ Thiét ké& k¥ thuat (Engineering Design).

Céc giao dién chl yéu cla cdc phan mém GIS thuong mai hién nay v6i ngudi st
dung c¢6 thé nhut sau:

- Giao dién theo ciu 1énh (Command Interfaces);

- Giao dién theo thuc don (Menu Driven Command Interfaces);

- Giao dién theo lap trinh Macro (Macro Programming).

Hién nay, ¢ nudc ta da va dang ng dung mot s6 phan mém GIS nhap ngoai nhu
ARC/INFO, MAPINFO, GIS-OFFICE, PAMAP, ILWIS, .v.v... vd mét s6 phdn mém ¢6
cac chire nang cua cong nghé GIS do cdc co quan trong nudc viét tr nhing nam
1990 1r¢ lai day. Trong khuon khé cuén sdch nay, ching t6i khéng dé cap hay phan
tich, danh gid cdc diém manh hodc diém yé&u ciia timg phin mém néi trén ma chi
g101 thiéu véi ban doc 1am quen cdch sir dung mot s6 phan mém hién dang phd bién
ang dung nhat.

V. THIET LAP CAC CHUONG TRINH UNG DUNG TRONG MOI TRUGNG GIS

Céc phan mém GIS thong thudng duge viét trén cdc ngon ngit lap trinh bac cao nhu
Fortran, Cobol, C hoic Basic va thanh lap theo cdc modun doc [ap. Tuy phian mém GIS
la mot san phdm tron géi nhung van cho phép ngudi stt dung can thiép va thiét lap cac
tng dung riéng cho minh - dé6 ta tinh m& cha hé thong.

1. Cdc phuong phdp thiét lip ting dung

- Thiét lap theo c4u tric Macro;
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- Thiét lap theo cdu tric thu vién;
- Thiét lap theo cau triic chuong trinh tmg dung déc lap.

Vi du nhu:- ARC/INFO ¢6 AML, MAPINFO ¢6 MapBasic, .v.v... phuc vu cho viéc
lap trinh Uimg dung trong hé thdng.

2. Cdu tric cla cdc trinh g dung

Chuong trinh {ng dung 1a mot tip hop cdc ciu i¢nh duge sidp x&p theo mot trat tu
nhat dinh (Syntax) nhidm diéu khién hé théng thuc hién mot nhiém vu dat ra. Cau tric
cdc chuong trinh (ing dung bao gém: tén chuong trinh, cdc thong bdo bién va loai bién,
cdc ham va céc cau 1énh cling véi cde tham s6 cia chiing.

3. Cdc budc xdy dung trinh iing dung

- Phan tich yéu cdu;

- Thuat todn va so dé khoi ing dung;

- Lap trinh va chay kiém tra;

- Hu6ng déan sit dung.

Nhur dd néu trén, su cén thi€t ban ddu vé phan tich va thiét k& co s¢ dit lidu cia hé
théng thong tin dia 1y la nhitng nhu cdu nén tang dé phat trién cdc img dung sau ndy.
Qua trinh phét trién cdc ing dung 1a mot két qua logic chia cdc hoat dong truée do vé
thiét k& co s& dit liéu va phan tich nhu cdu. Su vang thiéu clia cdc chudn trong linh vuc
nay da tao ra cdc kho khan cho su tich hop cdc phdn mém ng dung cta céc hé thong
khédc nhau va han ché€ thi trudng cho su thuong mai héa cdc bo ttng dung co ban ciia hé
théng thong tin dia 1y. Do vay, viéc phat trién cdc dng dung heé théng théng tin dia ly
cua khdch hang s& vin con cé y nghia chinh cho sy da dang cdc tmg dung thuc t&.

Phit trién cde img dung clia hé thng théng tin dia 1y phai luu -

- Banh gia nhu cau;

- Phén tich gid thanh va loi ich;

- Sur uu tién va ngén sédch;

- Phan tich dir }iéu, lap trinh, kiém tra;

- Kiém sodt chat luong phan mém;

- Tai liéu va dao tao;

- Thuc hién trong moi trudng nhiéu ngudi sir dung;

- Cung cép cho ngudi sit dung cuéi cing.

Toan bo céc giai doan phit trién img dung va chu trinh thyc hién phai cé mot muc
tiéu chinh: Bdo dam tu dong xir 1y nhiém vu trong phuong thiic bido tén su tueng thich
cua phian mém, hiéu qua thu duge 6n dinh, mém déo va dé img dung trong co quan.

Nhu céu phit trién phan mém tng dung duge dat ra tir cic co quan sir dung, cdc co
quan cung cap h¢ thong thong tin dia 1Y riéng r&, hoiic cac hé thong théng tin trong cdc
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cd quan co s&. Nhiém vu phét trién phdn mém tng dung duge quan ly va giao phé cho
mot ngudi ¢b trach nhiém trong co quan phu trdch thong qua cde hgp dong. Nén ¢6 céc
chuyén gia kiém soat toan bo cac giai doan phat trién phian mém d¢ tao ra mot phuong
phap hé théng chung cho san pham phdn mém. Hé théng thong tin dia ly rdt nhay cam
v6i su thay déi nhanh trong céng nghé. Diéu quan trong l& sy nhéan thiic vé tiém nang
nhu cdu can thiét, doi khi nhitng chinh sira chinh trong nién khoa nhiém vu. Nén xem
xét sy phat trién clia cdc phan mém dinh k¥ thay déi dé khi cdn thay doi t6 chiic.

Negudi quan 1y cdn danh gid can than nhitng tién bd va gia thanh clia cdc giai phdp
cong nghé. Phai xem xét gid tri sitc lao dong da doi hoi cho chuyén doi dit lieu va d tu
vin thuong mai ciing nhu cic giai phdp trong co quan. Cac van dé phai khao sat ta mife
d6 phdp quyén, chat lwong cdce tu liéu hién ¢6, wu tién cic ing dung. Thong thudng cac
nhd quin 1y $& doi hdi mat mitc do kha cao vé kha nang hoat dong cla cic hé théng, ke
ca cdc md hinh co sa dir liéu cho cdc ing dung rong rii. Cic co quan cling s€ ¢cé loi tu
viéc tiéu chudn hda cong nghiép trong toan bd cac mat clia mot hé thdng thong tin dia
Iy, tir sy trao d6i dit licu ban d6 véi mé hinh co sd dit licu da nhiém va cdc img dung.

Céc hé thong tot cho phép nguai st dung khong can quan tam dén cdc thi€t bi hwu i
s6 liéu va van dé mo hinh hod. Hé thong théng tin dia 1y phai dat dugce: Thiét k€ heé
théng bén trong t&t va don gian, dé sir dung hé théng bén ngoai. Thong qua thiét 1ap céc
phan mém (ing dung ching ta s& dé dang dat dugc muc tiéu néi trén.
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Chuong 11
QUAN LY THONG TIN TRONG CONG NGHE GIS

I. HE TOA PO DUNG CHO CAC LOP THONG TIN GIS

Céc 16p thong tin nhur dat, thay hé, giao thong, v.v... tdp hgp lai thinh mét co sé dir
ligu va té chitc nhw 12 mot manh ban dé thuc t€. Cc 16p théng tin trén con goi 12 céc
l6p thong tin chuyén dé, trén mot ving lanh tho ching duge thé hién nhu 1 cic 16p phil
theo phuong thang dimg. Do vay, cdn thiét phai ¢6 mot hé khung (hé toa do) dé c6 thé
chong x€p céc Igp thong tin d6 lén nhau, phi viing lanh thé ching thé hién. Viéc 18
chitc céc 18p chuyén dé dé nham:

- Trg gitp viéc quan ly dé dang;

- Chi ¢6 céc d6i tugng lién quan dén chuyén dé;

- Han ché s6 lugng thong tin thuge tinh cin gén cho d6i tgng ban dé quan ly;

- Tang kha nang cdp nhat théng tin va bao tri chiing vi thong thudng mdi mot 16p
thong tin cé cdc nguédn tu li¢u thu thap khic nhau;

- Hién thi ban d6 nhanh, dé& truy cip.

Thong thuong cdc Idp thong tin duge tao ra tir cdc méanh ban dé khac nhau, nhung
khi quan 1y trong co s¢ dir liéu chiing duge ghép néi lai thainh mot manh ban dé 16n bao
pht ca khu vire quan ly. Viéc phan chia cdc manh ban d6 nhu vay con goi 12 phan méanh
ban dé theo toa do khung.

Cac he toa do thuc thong dung trong cdc phan mém GIS ¢é thé nhu sau:

- Hé toa do dia ly: Do qua dat tu xoay quanh truc ciia né va do nhiéu nguyén nhén
khdc ma hai cuc Bac va cuc Nam ciia qua dit hoi bet. Do det nay gan bang 1/300 ban
kinh cua né. Trudc hét ching t6i mudn gidi thiéu nhitng yéu 16 lién quan dén hé toa do
dia ly nhu sau:

+ Tam qua dat: diém chinh giita qua dat;

+ Truc qua dat: dudng thang tudng wong chay xuyén tir cuc Nam dén cuc Bic qua
tam qué dat. Qua dat ty xoay quanh truc ndy;

+ Nam cuc: diém cu6i phia Nam cia truc qua dat;

+ Bic cuc: diém cubi phia Bic ciia truc qua dat;
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+ Mat phang xich dao vi dudng xich dao: mit phing cit ngang qua tam qua dat v
vuong géc vai truc qua dat goi 1a mét phing xich dao. Né chia qua dat thanh hai phin
bang nhau ma chiing ta thudng goi ta Nam ban cdu vd Bac b4n cdu. Pudng giao nhau
giita mat phang xich dao véi mat trai dat goi 13 dudng xich dao.

+ V1 tuyén: nhitng duong tron trén mat qua dat song song vdi xich dao goi 1a
dudng vi tuyén. Cac vi tuyén to nho khic nhau, cang gén hai cuc dudng vi tuyén
cang nho din,

+ Kinh tuyén: cdc mat phang cit doc qua dat, di qua truc qua dit goi 14 mat phiang
kinh tuyén. Budng giao nhau gitta mdt phing kinh tuy&n véi mat qua dat goi 1a dudng
kinh tuyén. Cac kinh tuyén déu dai nhu nhau.

+ Kinh tuyén goc: dudng kinh tuyén gdoc 1a dudng ¢6 gia tri 0. Hoi nghi quéc t& vé
trac dia héi thé€ ky 17 da théng nhat 1ay kinh tuyén di qua dai thién van Go-rin-uych
(tht d6 nude Anh) la dudng kinh tuyén géc quoc té.

Thong qua hé théng kinh tuyén va vi tuyén, chiing ta dé dang xdc dinh toa dé dia 1y
cha moi diém trén mit dat bing gid tri kinh d6 va vi do.

- Céc ludi chiéu ban d6: Chuyén céc vi tri d6i tuong khong gian trén mat dat sang
mat phang. Cdc ludi chi€u ban dé cé cdc dac diém sau day:

+ Luon ¢6 bién dang vé hinh dang, dién tich do dai hoac phuong vi

+ C4c ludi chi€u khic nhau s&€ ¢6 cdc bién dang khdc nhau

+ Céc tinh chat ctia céc ludi chiéu mang tinh cuc bg, nghia 14 né phit hop vdéi cac iing
dung cu thé

Céc phuong phip chi€u d6 co ban nhat 1a: chiéu dé trén mit phing, chiéu dé trén
mat hinh nén va chi€u dé trén mat hinh ong.

Heé toa d6 ban d6 la hé toa do mat phing. Heé toa do nay 13 hé toa do Dé cic va vi tri
cdc diém duge x4c dinh bang cap gid tri (x,y). P& thuc hién phép chiéu ban dé ngudi ta
chia qua dat ra thanh cdc mui chiéu khdc nhau dua trén cdc dudng kinh tuyén (théng
dung nhat 1a mdi 6 d6 va muii 3 do).

Trén ban do truc toa do Y 12 anh clia xich dao va truc toa d6 X 1a anh cla kinh tuyén
trung wong qua phép chicu ban dé. D€ lam viéc v6i gia tri duong cha toa do Y ngudi ta
101 g6¢ toa do sang Tay 500 km. Cdc ludi chi€u hay diung nhdt 1a Gauss, UTM,
Mercator, Lambert. Khi mgt ban d6 duge s6 héa, céc toa do x, y duge quén 1y & toa do
ban s6 hda. Chiing dugc chuyen d6i sang hé toa dg thyc théng qua cic diém khéng ché.

I1. MO HINH QUAN LY THONG TIN TRONG GIS

Thong thudng hé théng thong tin dia 1y phai ¢6 k¥ thuat 61 vu dé quan 1y thong tin
da dang cua h¢ théng. Phan 16n cdc phan mém GIS ding cdu tric quan 1y khong gian
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cho toa do dia 1¥, cau triic 1dgic cho méi quan hé va hé quan tri dir liéu ¢6 truyén cho
thudc tinh.

Trong cong ngh¢ GIS thong thudng c6 cac mo hinh quén 1§ dit léu co ban sau:

- M6 hinh cép bac (Hierarchical): cde bdn ghi quan 1y theo ciu tric cha con (hinh
cdy), mot lién hé dén nhiéu (One-To-many).

- M6 hinh mang 1w6i (Network): cdc ban ghi ciing loai s& duoc phan nhém vieo mot
File quan niém hoic duge nhém vao céc tap hgp gilta cdc File.

- Mo hinh quan h¢ (Relational): cac ban ghi quan 1§ theo cau triic ma tran hang cot.

- Mo hinh tuan tr (Sequential): cdc ban ghi duge quan 1y theo tudn or lién tuc.

MOT SO SO PO MO HINH QUAN LY DU LIEU

i R

Sa d6 cap bac So d6 mang uéi

So d6 quan hé So d6 tudn ur

Sau day la mt vai nhan xét vé mot s6 loai mo hinh 16 chirc co sé dit lieu thong dung
trong cac phan mém GIS hién nay:

+ He thong cip béac (Hierarchical). Cau tric co s& dit liéu theo hé théng cdp bac
giong nhw dang cay, véi cu tric ndy cho phép truy cap s6 liéu rat nhanh va don gian.
N6 xir ly rat hiéu qua nhiing 56 liéu 16n. Tuy nhién, cdu tric c&p bac lam viéc khong tot
& moi trudng dong (Dynamic), & dé thudng xuyén thay d6i méi quan hé tuong quan.

+ Hé¢ théng mang ludi (Network). Céu tric co sd dir liéu theo hé thong mang ludi
cung cap nhi€u cdp bac dir liéu, ¢ thé xac dinh nhidu dudng dan truy cap vio co sd dif
ligu. Cau trdc nay lam tang thém sy mém déo vé truy cap vao dir liéu nhung né ciing tao
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ra khé khan trong viéc d6i mdi co s& dit liéu. Ciing nhu co s dir ligu theo hé théng cap
bac, sy truy cap cia ngudi sit dung cudi cling thudng bi han ché. Cad triic mang ludi 13
thé hé cao hon cila cdu tric cap bac.

+ Hé théng quan hé (Relational). Cau triic co s¢ dit lieu quan hé thé hién mot vu the
trong quan 1y co s¢ dir licu. Cac hé¢ thong quan hé 16 chic dit licu vio trong céc File
khéi ni¢ém ma ching duoc tao thanh bdi cdc 6 dir lidu (dong va cot). Khi nang coa hé
thong co s& dit liéu ndi gan dit lieu v cac File nhanh chéng [ miu chét sy linh hoat cila
no va [a mét cong cu rit hitu hidu cho ngudi st dung. He théng quan he niim trén céc
ngdn ngit xir Iy chuan di biét nhu Standard Query Language tao ra cho ngudi sir dung
dé thao tdc va cdc tiém nang khac cua hé théng. Tuy vay, van c6 thuc t& han ché viéc
truy cap vao s6 liéu quan h¢, thai gian tra 101 yéu cdu vé céc loai s6 liéu phic tap.

C6 mot loat cdc mitc d¢ giao dién gilra cdc hé thong trong cong nghé GIS. Trong
mic dé don gidn, s6 ligu c6 thé chuyén tir mot hé théng nay sang cic hé khac bing
cdch sao chép qua bang tir. Mitc do (i€p theo 1a két ndi dién tir va chuyén s6 lieu déng
that (mang mdy tinh). Trong céch nay mot h¢ thong s& trds thanh thiét bi truy nhap tir xa
cua h¢ théng khdc. Mitc giao dién nay cé thé dugc dimg cho viee ddi méi cic s6 lidgu
déc bi¢t clia mot he théng bang cach thu nhan tir cic hé thong khéc. Phin [6n cic mic
trén la giao dién tryc tiép on-line, trao d6i théi gian thue, tai dé cdc s6 lieu nhap vao tir
mot hé théng ¢é thé tra citu tryc i€p bing cic hé thong khac.

Cée mifc trao d6i thong tin tuong tmg s& thay déi tuy theo cdch cai dat v céc ung
dung cu thé clia cong nghé GIS. Nhimg khé khan trong viéc trao ddi théng tin trong cdc
truong hop dé ciing khdc nhau. Trong trudng hop don gian nhat 13 ca hai hé GIS va hé
diéu hanh lién quan hoat dong trén cling mot bo xir 1y hodc cdc bo xir ly tuvong thich cla
mot nha cung cap h¢ thong va dung cling mét hé quan 1y dit ligu. S& rét khé khan trong
trudng hop hai bo xur 1y riéng ré do hai nha hé théng cung cip va trén hai h¢ diéu hanh
khac nhau, vi du nhu giita moi trudng Dos va Unix ching han né doi hdi phai ¢é mot S
chuyén déi khuén dang va cdu tric dit liéu theo céc phan mém. Ky thuat ndy 1a kj thuat
twong d6i mdi, dac biét d6i véi cac nha san xuat phan mém GIS, nhung cdc wu diém tao
ra tlr cdc k§ thuat mang mdy tinh hi¢n nay di va dang gia tang su két néi mang may
tinh, ing dung trong moi trudng céng nghé GIS tao ra cdc hé GIS mé (Open GIS) va
GIS tap doan (Enterprise GIS). Trong nhimg trudng hop nay mé hinh quan ly thong tin
ctia GIS ciing doi héi phai lya chon sao cho phit hap.

III. CHAT LUONG SO LIEU TRONG GIS

Dai lvong xdc dinh chat lugng clia céc hinh anh ban dé thong dung nhét 14 do chinh
x4c vé vi tri clia né. D6 chinh xéc 1a sy tring khép clia cdc dai lwong do, tinh toan hoic
udc tinh so vdi gid tri thuc. D6 chinh xdc vi trf 12 mot s6 do clia sy chuyén léch vi i
hinh anh ban d6 so v6i vi tri thuc chia né. Do chinh x4c vi tri bao gém hai loai: do chinh
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X4c tuyét doi va d6 chinh xdc tuong d6i. Do chinh xdc tuong déi 4 s6 do sai s8 cila cac
hinh anh riéng r€ trén ban dé so v6i cdc hinh anh khéc trén cling t& ban dé d6. Do chinh
xdc tuyét doi 1a s& do sai $6 vi tri cdc hinh anh trén ban dé so v6i vi tri thuc clia nd trén
bén mit Trai dat.

Cac tiéu chuan vé do chinh xdc néi chung 1a nhilmg sai s6 ¢6 thé chap nhan duge ma
cac dai lugng do phai dat duge. Ty I¢ ban dd ciing 1a mét yéu t6 quan trong trong viéc
ddnh gid do chinh xdc ban d6. Vi du, tiéu chudn d¢ chinh x4dc ban dé quéc gia ctia hau
hét cdc nude déu quy dinh do chinh xdc mat bang cha céc doi tugng ban dé & cac ty 1¢
phai khong 1én hon 1/3M, trong d6 M la ty 1¢ ban d6 thé hign d6i twong. Nhing han sai
cho phép nay dugc dp dung che viée ddnh gid, xdc dinh cdc diém di chon lua trén ban
dé khi sir dung,

D6 chinh xdc vi trf ¢6 thé kiém tra & b6n mitc: theo ude tinh suy dién, theo ngiu
nhién ndi by, so sanh cdc ngudn khdc nhau, so sdnh véi mét nguén doc lap ¢6 d6 chinh
X4c cao.

D¢ chinh xdc cua cdc théng tin trong co s dit liéu cia GIS bao gém:
- B¢ chinh xdc cha thong tin thuéce tinh
- D6 chinh xéc cia théng tin ban dé

Dai lugng xdc dinh chat luong quan trong nhét ciia dit liéu ban dé 12 d6 chinh xdc vé
vi tri cia né. Ty 1€ ban d6 12 yéu t6 quan trong anh huéng dén chat luong dif liéu ban d6
56 cua GIS. Céc sai s6 chia dir liéu ban dé phai nam trong gisi han cho phép. Cac dir ligu
thuge tinh phai dém bao tinh xédc thyc va 6n dinh. C4c dit liéu trong GIS khong thé tu
lam bién d6i chat lugng chia né duoc, vi vay chiing phai 12 thong tin ¢é do tin cay cao
nhit ¢o duge.

IV. THIET KE MO HINH CO $G DU LIEU

Ngudi quan 1y he théng thong tin dia ly phai nhan thife duge ring khong ¢ mot
cbng nghé hay h¢ théng nio lai ¢6 thé ty dong chuyén sang cdc chic nang thuc dung,
hod nhip ot vao cic hoat dong quén 1y, san xudt ciia mot don vi tng dung né. 6 la
mot quan ni¢m sai vé h¢ thong thong tin dia 1y 1a c6 thé cung cap ngay modt mo hinh co
sG dit ligu tro gidp phdt trién ung dung. Tuy nhién, rat it he théng thong tin dija 1y cung
cap ngay mot mo hinh co s dir lidu 16i thiéu co ban cho vice tng dung ngay cic chic
nang cia ngudi sir dung cudi cling. Thiét k& co s dit liéu theo sur dé dat cia ngudi sir
dung va thyc hién tir cdc chuyén gia trong Iinh vuc co s& dir liéu. Céc dia phuong c6 thé
lra chon tir cdc mo hinh co s& dif liéu hé théng thong tin dia 1y chuan hoic tw thiél k&
o s0 dif liéu noi nio cdn thiét va phai dam béo tinh kha thi.

Mot mé hinh co so dit liéu 13 mot nén tang céc ting dung chuan cla dia phuong.
Nhimg mé hinh nay c6 thé cung cap so d6, dudng s4, cht sir dung dat va céc diu tr clia
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co so ha tdng. Su lua chon phai chii ¥ dén nhu cau cuc bo, tham khao, moi trudng quan
1y théng tin v cac ing dung uu tién.

Thiét k& co s& dit liéu hién tai ¢é mot anh hudng 16n dén su da dang cac ting dung.
Néu mo hinh chudn khong hop 1y thi nd t6t nhat nén méi twe vin trong thiét k& co sd dit
liéu. Mot vai co quan da dung céic hé théng thong tin dia 1y don gian gid thip nhung cic
chitic nang han ché. Phan 1én s6 lugng cac co so dir liéu hé théng thong tin dia 1y hién
nay di duoc phit trién déng thoi trén mot bo phin mém, diéu dé gidm gid thanh ciia
viéc phit trién cic dng dung not nghiép va duy tri hoat déng ctia hé thang. Khi thigt ké
md hinh co s& dit liéu can phai xdc dinh cu thé cic loai d&i twong trong timg 16p thong
tin va céac thude tinh di kém véi nd.

V. NHUNG VAN BE QUAN LY CO SO DU LIEU

Mot van dé quan trong trong cong nghé¢ hé¢ théng thong tin dia 1y 13 thuc hién xay
ding co 50 dir liéu cua hé thdng. Phidn nay cung cdp mot su khii qudt chinh vé co sd dit
liéu thuong tinh dén trong viéc danh gid hé théng thong tin dia 1y vé su lura chon v thuc
hi¢n. Nhimng tiéu dé saun day s€ duge tham khéo. Céc thanh phan cua dif liéu trong hé
théng théng tin dia ly va luu giit, mé hinh héa co s dif liéu clia hé théng théng tin dia ly,
t6 chic co s& dif liéu clia he thong thong tin dia 1Y, kha nang lién két co s& dit liéu clia he
théng théng tin dia 1¥ véi co so dit liéu bén ngoai, su théng nhat clia hé théng thong tin,
s& hiru dit liéu v tich hop no.

- Nhiing thanh phén ctia 83 liéu trong hé thong thong tin dia ly. C4c thong tin khong
gian, thuéc tinh va lién quan dén cdc s6 1iéu tham khdo dia 1y 12 toan bo cdc thanh phén
cha dit liéu trong hé thdng thong tin dia 1y. S6 liéu khang gian ¢6 thé luu trir theo céc
16p hoac cdc mitc d6 don gian chéng x&p cha hé thong (Overlay System). Nhimng 16p
nay c6 thé luu trlt nhu nhitng khéng gian hoic cing véi thong tin v& mdéi lién hé
Topology. Ching ¢6 thé luu trit thanh cdc d6i tuong, hodc hinh anh ma tir d6 dé dang
truy cép tir bat k¥ céc lép lo6gic nao. Ca hai phuong phap huu trit déu 13y co sé la cau
tric bén trong cta ban d6. Cic ban dé ¢6 thé luu trit theo céc doan tuong duong véi cc
manh ban d6 tr dong hodc 12 mot ban dé mdy tinh lién tuc. Cc ban dé 1ién tuc cé mot
vu thé hon ban do theo timg doan 12 loai bd dudng bién nhén tao cita ban dé va viéc bao
tri don gian hon. $6 liéu thudc tinh (ma hodc khéa duge dinh nghia bdi ngudi sit dung)
va cédc s6 lien tham khdo dia ly cung ¢dp nhiing théng tin moé ta hoac xdc dinh vé& mot
yeu td dia 1y. Mot vai hé thong luu giit thuoc tinh phi dé hoa vao cac tap tin riéng ré
béng cach diing nhitng chi s8 chung lién quan dén ca hai loai théng tin. Trong céc hé
thong & the hé trude nhing tap tin riéng r& da dugc quan ly bing cdc phin mém co s&
di¥ liéu, di tao ra nhitng khé khan trong viéc truy cap dit liéu. Nhitng hé théng thong tin
dia 1y phat trién gdn day phén I6n 12 khéng han ché ngudi sit dung truy cap dit ligu. Vi
du, mot toa nha ¢6 thé thé hién trong hé théng théng tin dia 1y 13 mot yéu t6 khong gian
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va dia chi cia tod nha ay 1a thudc tinh (ma hoic khéa) va thong tin vé gia tri thuc cia
toa nha, thi€t bi phong chdy, céc ching chi quyén sir dung cia toa nhi v.v... 1a nhimg
thong tin tham khdo dia ly.

- M0 hinh héa co s¢ dir liéu ciia hé théng thong tin dia 1. CAc van dé chinh cin sur
luu tam khi thyc hién xay dung mot hé théng thong tin dia ly 12 viéc mé hinh héa céc
doi tuong dia 1y va 8 chitc cdc s6 lidu lién quan. Thong tin vé cdc ban ghi dat dai
(ménh, 6 thira.v.v...), cdc cong trinh xay dung va dia chi clia ching 12 su séng cdn cla
ca mang luéi dudng phé cia dia phuong.

D€ minh hoa so d6 co s& dit li¢u, chiing ta hiiy xem xét mot loat hé théng thong tin dia
Ly tiéu biu ma ngudi sir dung mong mudn vé hién thi tron géi dit liéu giai tich va lwa chon:

+ Chon mot ph6 hay mot doan phé. Hién thi toan bg c4c toa nha va cic ban ghi lién
quan dén toa nha, cdc dia chi lién quan dén cdc phd cla ching, céc ban ghi ngudi & cho
cdc dia chi d6. Hiy tiy chon bén trai hay bén phai clia dudng phd.

+ Chon thu€ mét thia hodc mot manh dat. Hién thi todn bo cic cong trinh va céc ban
ghi lién quan dén cong trinh cling v6i thira dat d6, bd qua s6 liéu céc cong trinh, dia chi
va phia cila né trén pho.

+ Chon mot tod nhi. Tra citu todn bo cdc cdu tric va thong tin lién quan cau tric, boi
vi nhitng cdu trdc nay lién quan dén cdc doan phé sd xung quanh tod nha, chon toan bo
thong tin ching véi cdc cong trinh xay dung va méi mot doan phe.

+ Chon mét viing dan cu, khu trudng hoc hoac dién tich cdng an bdo cdo. Tra ciu
toan bd céc tod nha, 6 thira dat, cong trinh xay dung va céc dja chi trong ving dé.

+ Chon trung tam nudc va nude thai. Tra citu toan bo céc cong trinh xay dung va dia
chi clia chiing n6i két véi trung tam.

Khoang hdi dép nay dép tng nhur thé nao? C6 mot thue & khé khan 13 dé cé di nhan
thie phan tich toan bo hé théng c6 thé dugc dung mo hinh co s& div liéu da thiet ké va
dir dodn mo rong trong twong lai s& bi kéo dai qud trinh xir ly thong tin trude mat, Cong
vige Xt 1y théng tin trong co s& dif liéu c6 thé nay sinh ddi hoi su thay déi thist k& cila
céc ting dung déu tién trong h¢ théng. Su nguy hiém nay can phai 1am séng 16, ngudi sir
dung mong mdi qud trinh thuc hién xay dung hé théng thong tin dia 1y rdt ngan va
nhanh chéng dua co s dit liu thiét k& vao img dung thue (€.

Diéu nay tao ra cdc khé khan cho viée thyc hién cic ing dung khéc va tao ra cdc gi6i
han cho cdc cong cu phan tich dja Iy clia hé théng. Nhiing muc dich ciia viéc mo hinh
hoa ca s¢ dir ligu clia h¢ théng thong tin dia 1y cling véi hé théng mém déo va Ién manh
Ja gi? Su mém déo va 16n manh clia hé théng phi 1 thue t& cap bacli nang cao cung véi
viéc tiéu chuan héa mé hinh co sé dit liéu ctia he thong thong tin dja 1y thuong mai héa.
Cdc mo hinh co s& dir liéu ctia hé thdng thong tin dia 1y vimg chéc phai hoa nhap véi thi
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trudng va tién t6i gidm gia thanh ciing nhu s mao hiém clia cdc Gng dung phdt trién,
cung cap nang lugng cho chu trinh séng (Life Cycle) clia hé théng.

Cédc md hinh co s& dir liéu ciia hé thong thong tin dia 1y ¢ thé gidi quyét su khong
dong nhdt dir liéu trong hé théng thong tin dia ly? Khong hoan toan. Tuy nhién, hé
théng thong tin dia 1y ¢6 thé tuan thit cdc chudn dé dang, néu 16 chic ton trong cic
chudn ciia né. Chidc nang cua hé théng thong tin dia Iy khong thé sit dung cho moét loai
cdc co quan néu thong tin tich hop khéng duge t6 chiic cde bd nhan biét (Identifier).
Mot co quan hoac don vi phai duge dam bao viée quan 1y diéu phdi, tuan thu theo cac
tieu chuén thong tin co ban va chuyén déi hop 1y céc File s6 liéu truéc day sang cac ticu
chuén méi. Toan bo cdc thanh vién tham gia hé théng (hé GIS da nganh) cdn duogc gitp
d& trong viéc xdc dinh cdc linh vyc dit liéu quan 1y cdn thiét va phai tiéu chuédn héa. Can
¢6 céc van ban vé€ chuin quan tri co s& dit liéu va ching c6 thé nhu sau: chuyén déi tén,
truy cdp va bao mat, quan 1y thu vién, chinh sdch truyén dit liéu, luu cdp bén sao, phat
trién img dung kiém tra mai trudng va thi tuc quan 19...

- Té chitc quan 1y co s& dit liéu. Cin xem xét cdc ki€u 16 chiic chinh nhdm tro gitip
ngudi quan 1y hiéu duge nhitng van dé thudng x4y ra nhat vdi céc co so dit liéu. Nhimg
vdn dé nay phai duge lam sdng t6 timg vin dé sy cdn thiét t6 chitc quan 1y co sg dix liéu
trén mitc do t6ng thé. Nhimg nha chuyén giac hé théng thong tin dia Iy phdi nhan thic
duge sy dam béo an toan cho co so dir liéu vé lau dai nha 13 mét phan cai tién hé théng
ngay sau khi hé théng thong tin dia 1y hoat dong. T chitc xay dung h¢ théng thong tin
hién tai bing céc phan mém quén tri dit liéu phai duge khao sat vé su tuong thich clia hé
thong thong tin dia ly vdi cdc hé théng cha co quan hién cé. Tuy nhién, té chifc ddnh
gia hién trang v& su chuyén d8i dén mai trudng co sé& dir lieu dé két hop toan bo nhu
ciu ngay cang tang cua hé thong thong tin va nhu cdu hé théng thong tin dia ly trude
- khi quyét dinh sir dung phan mém quén 1y co s& dit liéu. Su lua chon va thuc hién mot
h¢ théng quan 1y co sd dit liu phai duge tuan theo c¢o ciu hién trang t6 chic va trong
tuong lai cdc nhu cdu vé h¢ thong thong tin. Gi4 tri toa do, diém, dudmg va viing khong
ty né la nhitng dit liéu quan hé nhung dia chi, dudng phd, 6 thita v.v... thé hién trong hé
thong thong tin dia 1y va trong thé€ gi6i thuc 1a nhilmg dit liéu quan hé. Nhitng biéu thi
hinh hoc ctia ching dua ra chi 1a mot cdch ngudi sit dung ¢6 thé dé dang nhan biét, truy
cap va xir ly thong tin vé ching.

Cong nghé co sé dir liéu quan hé khong ding & cde co sd dit liéu 16n. Mot s& co quan
da cai dat cong nghé quan hé nhung mot s6 vén tiép tuc phdt trién cdc ing dung trong
cach thic ¢d truyén. Sy thong nhat dit lidu vin chua duge quan tam diing mifc trong céc
dia phuong vé xit 1y thong tin. (O phén 16n céc co quan tmg dung cong nghé GIS hién
nay, cong ngh¢ h¢ thong thong tin dia 1y dd duge [am quen va bét ddu sit dung cong
nghé co s& dit liéu quan heé.
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Chuong II1
XAY DUNG CO SO DU LIEU CUA GIS

1. KHAI NIEM MO HINH CO SO DU LIEU GIS

Buée ddu tién trong vice thue thi cdc dir 4n GIS 1a x4y dung mot co s& dif liéu ban dé
50. GIS ¢6 mot mo hinh dir liéu rieng dé thé hién cac dit liéu ban dé trén may tinh. Viéc
x4y dung mot co s dir liéu ctia hé thdng thong tin dia 1y 14 mot van dé quan trong nhét
va tiéu t6n thoi gian nhiéu nhat trong viéc trién khai thuc hién cong nghé hé théng
thong tin dia 1y. C6 cdc y ki€n khéc nhau vé€ nghia cla thuat ngit "Co s dit liéu” trong
h¢ thong théng tin dia 1y. Ta c6 thé hiéu co sd dit liéu 14 mot tap hgp 16n céc s6 lidu
trong may tinh, dugc t6 chitc sao cho c6 thé mé rong, sita déi va tra ctiu nhanh chéng
d6i vdi céc ing dung khac nhau. S6 liéu ¢6 thé duge t6 chic thainh mot tap tin (hay
con goi la File) hoac nhiéu File hodc thanh cdc tap hap trén mdy tinh. Ching ta c6 thé
thong nhdt quan niém vé ban chalt clia co sd dit Iiéu GIS 1a mét nhém xdic dinh céc dit
ligu, duoc t6 chic trong mot cau tric cha mot phan mém quan 1y co s& dir lidu. D6
chinh la mot tap hop cua cdc dir lieu khong gian va phi khong gian duge quén 1y béi
phan mém GIS.

SO PO MO HINH CO SO DULIEU CUA GIS

S6 ligu khong gian

Co s dit liéu

Thita 101 A JOIN S6 liéu thudc tinh
pipe 12¢ 1969

Phéan {6n cdc théng tin trong co s& dif li¢u cha he théng théng tin dia 1y la nhing s6
lieu ludn bi thay déi theo thdi gian va c6 méi quan hé phic hé. Chiing bao gém nhiing
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mo ta s6 cua cdc hinh anh ban d6, méi quan hé logic gitra cdac hinh anh d6, nhitng s6
liéu thé hién cédc dac tinh cua hinh anh va cdc thong tin vé cac hién tugng xay ra tai cc
vi tri dia Iy xdc dinh. Noi dung thong tin cua co s6 dir liéu GIS luon duge xac dinh boi
cac ung dung khdc nhau cta hé thong thong tin dia 1y trong mét hoan canh, diéu kién
cu thé do con ngudi quy dinh. C4c théng tin trong co s¢ dit lieu GIS duge t6 chic quan
ly theo mét phong cach riéng, dac trung cho cong nghé GIS ma cac hé quan ly thong tin
khac khong c6. Céc thong tin vé su vat va hién tugng da, dang va sé ton tai trong moi
trudng song thuc t€ dugc con ngudi nhan thitc va thé hién ching thong qua cong cu ban
do6 déu 1a nhiing d6i tugng quan ly va nghién ciru cua GIS.

Sau day 1a mot mo hinh 4nh xa dé thu nhan cdc thong tin tir thuc t€ khach quan vao
céc 16p thong tin trong co sa dir liéu GIS.

Thiy van

Bia hinh

Str dung dat

Céc thiét bi

Phan hang dat
Budong pho

Ranh gidi hanh chinh
Céc thira dat

gl in
"“l Parks Riv;{(
Discharge
Sand and Solid Waste Point
Gravel 4
Water Table

Phicong phdp thé hién thé’ gisi thic bang cdc 16p thong tin ¢6 quan hé véi nhau

C6 nhitng quan di€m cho ring co s& dit lieu GIS chi don thuan 1a mot tap hop s6 liéu
trong may tinh giéng nhu phép cong vat ly céc chiic nang dé hoa ctia phan mém dé hoa
may tinh vi du nhu Autocad v6i phdn mém quan tri dit liéu vi du nhu Foxpro. Quan
diém nay thuc ra méi nhin nhan bé ngoai cia cong nghé GIS, chua di sau vao ban chat
bén trong cta hé théng céu tric va phuong thic quan ly dit liéu trong moi truong GIS.
Tuy nhién héu hét céc phin mém GIS t6 chiic quéan 1y céc thong tin khong gian va phi
Khong gian doc lap v6i nhau nhung chiing luén luén duoc lién két chat ché véi nhau.
Moi lién két nay s& duoc trinh bay k¥ hon & phan sau.
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I1. SO LIEU KHONG GIAN VA PHI KHONG GIAN

Mot co s6 dit ligu cha h¢ thong thong tin dia 1y ¢6 thé chia ra lam hai loai s6 liéu ¢
ban: s6 ligu khong gian va phi khong gian. Mdi mét loai ¢6 nhimg dic diém riéng va
chiing khdc nhau vé yéu ciu It giit s6 liéu, hiéu qua, xir 1y vi hién thi.

S6 li¢u khong gian 1a nhitng mo ta s6 cla hinh anh ban d6, chiing bao gém toa do,
quy luat va cdc ky hiéu ding d€ x4c dinh mot hinh anh ban d6 cu thé trén t3 ban dé. He
théng thong tin dia 1§ diing céc s6 ligu khong gian d€ tao ra mot ban dé hay hinh anh
ban d6 trén man hinh hoac trén gidy théng qua thiét bi ngoai vi v.v...

S6 li¢u phi khong gian 1a nhig dién t& dac tinh, s6 luong, méi quan hé ctia céc hinh
anh ban do v6i vi tri dia 1y cha ching. Céc s6 liéu phi khong gian duoc goi 1a dir liéu
thugc tinh, ching lién quan dén vi tri dia ly hoac cc d6i tuong khang gian va lién két
chat ché vdi chiing trong hé théng thong tin dja 1y théng qua mot co ché théng nhat
chung. Mai lién h¢ cla hai loai dir litu d6 dioc mo ta theo so dé sau:

MOI LIEN QUAN CUA SO LIEU KHONG GIAN VOI PHI KHONG GIAN

biém Thuoc tinh
Pudng Tham khao dia 1y
Viing Chi s§ dia ly
Ghi chu Cic quan hé khong gian
h 4
Toa do Chir
Ky hiéu S8
Quy luat Ky tu
Chim diém S6-chir
56 lién khong gian S6 liéu phi khong gian

a) S6 liéu khong gian

S6 liéu khong gian hay con goi 1a dit liéu ban dé dugc dang dién ta hinh anh cia
thong tin ban d6 trong mot khuon dang hiéu duge ciia mdy tinh. Céc dir lieu nay 1a
nhitng thong tin mé td vé déc tinh hinh hoc cha cdc déi tuong dia Iy nhu hinh dang, kich
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thude, vi tri .v.v... 18n tai trong thé€ gidi thuc cla chiing. Vi tinh da dang va phic tap vé
dic tinh hinh hoc cua cac d6i tugng dia ly trén thuc t& cho nén ngudi ta phai thuc hién
triru tuong héa cdc ddi tuong d6 va quy ching vé cic loai d6i trong hinh hoc co ban dé
luu trit va thé hién trén ban dé ciing nhu trong co s6 dit liéu.

Cic loai thong tin khong gian co s& thudng duge diing dé thé hién hinh anh ban dé va
ghi chii cua nd trong cac hé thong thong tin dia ly nhu sau:

- Béi tugng di€m: Thé hién cdc vi tri rdi rac nham x4c dinh cdc déi tuong ban dé ma
hinh dang cua chiing qui nho dé€ c6 thé thé hién thanh dudng hozc mién. Thong thudng
dung c4c ky hiéu dac biét hoac c4c nhin (Label) dé thé hién loai d6i tugng nay trén ban dé.

- DPai tuong dudng: Vé ban chat loai d6i tugng ndy 14 mot tap hop toa do diém ndi
véi nhau, thé hién hinh 4nh ban d6 cé hinh dang tuyén tinh.

- D6i tugng viing: Vé ban chit loai d6i tugng ndy thé hién céc hinh anh ban dé khép
kin vi du nhu ho, x&, huyén .v.v... N6 1a mot tap hop cac doi tugng dudng, két néi véi
nhau tao ra mién déng kin.

- P6i tugng chit: Thé hién cdc mo ta vin ban hay ghi chii ban dé, vi du nhu tén song,
tén dia danh .v.v...

M@&i quan hé khong gian cla cdc d6i tugng ban d6 ciling duge thé hién trén 1 ban d6
nhung phu thudc vao d6i tugng va muc dich sir dung ban doé. Vi du khoang cach giita
hai thanh phg, cic tuyén xe tic xi .v.v...

b) So'liéu khong gian c6 thé luu trit & dang vécto hay dang raster

S6 liéu vécto 12 nhimg toa d6 clia cac diém (x, y) hodc cdc quy luét tinh todn toa do
va n6i chiing thanh cdc déi tugng trong mot hé toa do xac dinh. Hé toa do cé hai loai co
ban: Hé toa d6 vuéng gdéc Pé-céc (x, y) vi Hé toa do tric dia cdu (B, L - vi do, kinh do).
Toa do ban d6 1a gid tri s6 cha biéu thitc chuyén déi vi trf trén mit dat thuc sang mat
phéng 1udi chi€u clia ban d8. Tuy nhién ta c6 thé ding cic hé toa do khic, nhumg trong
hé théng thong tin dia 1y théng thudng ngudi ta sir dung mét hé toa d6 théng nhét, gan
v6i trdi dat thue d€ tién cho viéc quan 1y, chuyén déi va dé dang dat do chinh x4c cao
hay cdn goi 1a Hé toa d6 qudc gia. He toa do quoc gia thong thudong bao gom: Hé toa do
mit phing va Heé toa do do cao.

Trong GIS vé nguyén tic céc dir liu c6 thé duge luu trit va quan 1y dia 1§ hoac phi
dia Iy nhung t6t nhat ching ta khong nén quan ly cac dif liéu khong gian trong cdc hé
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toa do phi thuc t& (tuong tu nhur cac hé CAD) hay con goi 12 hé toa d6 Non-Earth boi vi
s¢ rat khé khan cho viéc chuyén déi cdc h¢ toa do sau nay khi ¢6 nhu céu.

Raster 1a so li¢u duge tao thanh bdi cac 6 ludi (chdm diém) véi do phan giai xdc
dinh. D6 12 mot ma tran cédc 6 ludi va do 16n cha cdc 6 ludi phu thude do phan gidi cho
trude. Do vay, néu kich thude 6 ludi 16n s& tam giam do chinh xdc cua thong tin va néu
n6 qud nho thi co sd dit liéu lai qué 16n.

THE HIEN SO LIEU VECTO VA RASTER

x1,yl x2,y2

"x3,y3 x4,y4

Dang vécto Dang raster

c) Dol tuwong va lop déi trong

Dai da s6 cédc phin mém GIS thuong mai hién nay cé mot khuyén nghi lua chon 8
chire cac dif liéu khong gian trong d6 cdc hinh anh doc 1ap hoic mot nhém céc hinh anh
dugc dinh nghia thanh cdc d6i tuong (Object). D61 tugng 12 mot hinh anh doc lap hay
mét nhém gitta chiing ding d& mo ta mot hinh dnh ban d6. Trong trudng hop niy mai
lien h¢ gitta cac hinh dnh phai duoc xdc dinh trong co s& dif liéu cu thé vi cdc thao tic
phan mém vé d6i tugng s& duge thuc hién nhu 1 céc thue thé dia ly.

Thong thudng thanh phéan s6 ligu khéng gian cha hé théng thong tin dia Iy hay con
goi 1a co g dir liéu ban d6 duoc quan Iy 6 dang cdc 16p doi tuong, mdi mot 16p chita céc
hinh dnh ban d6 lién quan dén mét chifc nang, tng dung cu thé. Viéc phan tich cdc 1ép
[a dua trén co s¢ cua mai lién quan l6gic va mo ta dé hoa ciia tap hop cac hinh anh ban
dd. Vi du: Lép thong tin khong gian vé loai dt, 16p thong tin vé giao thong, lGp thong
tin v¢ dia hinh, 16p thong tin vé ludi toa d9, 1dp thong tin vé quy hoach v.v... Vay ching
ta ¢6 thé hiéu ring 16p doi tuyng (Layer) la mot tap hop cdc hinh anh ban dé thudn nhit
(Homonogenuos) lién quan dén mot chic nang va phuc vu cho mét iing dung cu thé cha
ngudi sur dung trong méi truong GIS.
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SO PO QUAN LY THEO LGP THONG TIN TRONG GIS
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d) Cdch thé hién cdc doi tuong bdn do trong mdy tinh

Céc doi tugng dia 1y trén mat ddt thong thudng duge quan 1y niam trong hé toa do
khong gian, khi thé hién trén ban dé ching dugc chuyén vé mit phing. Trong m4y tinh
cdc doi tuong nay dugc luu o dang s6 bao gém cdc cip toa do (x,y). Mdi mot diém s&
luu trir mot cap gid tri (x,y). Cac d6i tugng dudng dugc luu trit thanh mét chudi c6 sap
X€p (x.y) va cdc doi tugng ving la tap hop cdc chubi déi tuong duong ma chiing tao ra
mién déng kin. V6i toa do (x,y) mdy tinh thé hién cic d6i tuong diém, dudng vi viing
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gidng nhu 1a mot danh séch toa d¢ thay cho cdc hinh anh hoic khéng gian. Mdy tinh tu
dong thanh Igp céc ban d6 tir tap hop cdc diém toa do luu trit vd méi tuong quan giita chiing.

Topology Ia mot thi tuc (Procedure) todn hoc nhim x4c dinh méi lien hé khéng gian
gitta cdc doi tugng ban d6. Trong qua trinh thanh lap ban dé, Topology gitip ta xac dinh
sy ghép ndi va lién hé giita cdc hinh 4nh ban dé. Ngoai ra Topology con gidp ta xdc
dinh hudng cta cic d6i tugng. Phan mém GIS ding tap hop toa do cic diém va quan he
Topology cta céc d6i tugng quan ly trong co sd dit liéu dé thé hién cdc dai tuong 46
trén man hinh may tinh theo cdc s6 liéu di quan 1y trong hé théng.

e) So'liéu phi khong gian

S6 liéu phi khong gian hay con goi 1a thudc tinh 12 nhitng mo ta vé dic tinh, dac
diém va cdc hi¢n tuong xdy ra tai cdc vi trf dia ly xdc dinh. Thong thudng hé théng
thong tin dia ly c6 4 loai s6 liéu thuoc tinh:

- Déc tinh cua d6i tugng: lién két chat ch& véi cde thong tin khong gian ¢6 thé thuc
hién SQL (Structure Query Language) va phan tich.

- S6 li¢u hién tugng, tham khao dia 1y: miéu (4 nhimg théng tin, céc hoat dong thude
vi tri xdc dinh.

- Chi s6 dia 1y: tén, dia chi, khéi, phuong huéng dinh vi v.v... lién quan dén cic d6i
twrong dia ly.

- Quan h¢ gilta cdc déi tugng trong khong gian, c6 thé don gian hodc phitc tap (su
lien keét, khoang twong thich, méi quan hé dé hinh gitra cic d6i tong).

S6 licu thudc tinh phi khong gian mé ta c4c thong tin vé dic tinh ctia cac hinh anh
ban do. Ching dugc lien két véi cdc hinh anh khong gian thong qua céc chi sé x4c dinh
chung, thong thudng goi la ma dia ly (Geocode) duge luu trir trong cé hai béan ghi dit
liéu khong gian va dir ligu phi khong gian. Trong méi trudng GIS cdc thong tin thudc
tinh nhu trén da néu 1a nhimg mo t4 vé dac tinh, dac diém cta cac doi trong va cac hién
(wong xdy ra tai vi tri dia 1y xdc dinh. Mot trong cdc chitc nang dac biét ciia cong nghé
GIS la kha nang cta né trong viéc lien ket va xir ly déng thoi gitta dit liéu ban d6 véi dir
li¢u thuoc tinh. C6 ba dac diém can luu y trong khi thuc hién lién ket dit lieu nhu sau:

+ Quan hé mot - mot: mdi mot hinh anh ban dé duoc gin véi mot ban ghi thudc tinh
cha doi tugng.

+ Su lién ket giita cdc hinh anh ban d6 va cdc ban ghi thuéc tinh cla déi tuong duoc
thuc hién thong qua bo x4c dinh (Identifter) chung, gén cho cé hai loai dit li¢u.

+ B0 xdc dinh chung duge luu trit vat 1y & ca hai noi (trong File dit liéu ban d6 va
File dir liéu thuéc tinh). '

Sau day chiing t6i gidi thich k§ thém vé bn chat mot s6 thong tin dit liéu thude tinh
nhu sau:

S0 liéu tham khdo dia Iy mé ta céc sy kién hoic hién twong xay ra tai mot vi tri xéc
dinh. Khong gidng cdc thong tin thudc tinh khéc, ching khéng mo ta vé ban than cic
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hinh anh ban dé. Thay vao dé chiing mé ta cdc danh muc hoac cac hoat doéng nhu cho
phép xay dung, bdo cdo tai nan, nghién ciu y t€ v.v... lién quan dén cac vi tri dia 1y xdc
dinh. C4c théng tin tham khao dia ly dac trung duoge luu tri va quan 1y trong céc file
doc lap va hé théng khong thé truc tigp tdng hop chiing véi cdc hinh anh ban dé trong
cd s9 dif li¢u ctia hé théng. Tuy nhién, cdc ban ghi nay chita cdc yéu 16 xdc dinh vi trf
cua sy kién hay hién tugng.

Chi 56 dia Iy duge luu trong hé théng thong tin dia 1y d€ chon, lién két va tra cifu s
lieu trén co 6 vi trf dia 1§ ma ching d3 duge mo ta bang cédc chi s6 dia 1y xac dinh.
Mot chi s6 ¢6 thé bao gém nhiéu bo x4c dinh cho céc thuc thé dia 1y st dung tir cdc co
quan khac nhau nhu la lap danh sdch cdc ma dia ly ma ching xdc dinh m&i quan hé
khong gian gifta cdc vi tri hogc giita cac hinh &nh hay thuc thé dia 1§. Vi du, chi s¢ dia
Iy vé duomg phd 1a tén phé va dia chi dia 1y lién quan dén phé d6.

Moi quan hé khong gian cia cac thuc thé tai cdc vi trf dia 1y cu thé rat quan trong
cho cac chitc nang xir 1y cua hé thong thong tin dia ly. Cdic méi quan hé khong gian
c6 thé 1a méi quan hé¢ don gidn hay logic, vi du ti€p theo s6 nha 101 phai I s6 nha
103 néu 1a s6 nha bén lé hoic néu 12 bén chin thi ca hai déu phai 12 cic s chin ké
nhau. Quan h¢ Topology ciing 12 mét quan hé khéng gian. Céc quan hé khong gian ¢é

thé duge ma héa nhu cic thong tin thude tinh hodc iing dung théng qua gi4 tri toa do
cta cdc thyc thé.

Moi quan hé giiia dit licu khong gian va phi khong gian thé hién phuong phap
chung d€ lién két hai loai dit liéu d6 thong qua bo xéc dinh, luu trir déng thoi trong céc
thanh phan khong gian va phi khong gian. Cic bé xdc dinh ¢6 thé don gian la mot s6
duy nhat lién tuc, ngdu nhién hoic céc chi bdo dia 1y hay s6 liéu xdc dinh vi trf luu triv
ching. Bo xdc dinh cho mot thuc thé 6 thé chita toa d6 phan bo cla né, s& hiéu manh
ban d6, mé ta khu vurc hoac con trd dén vi trf Iwu trit cla 56 liéu lién quan. B6 xédc dinh
duge luu trlt cling véi cdc ban ghi toa do hoiic m6 ta s6 khac ciia cdc hinh 4nh khéng
gian va cling véi céc ban ghi s6 lién thugce tinh lién quan.

Su lién ket gitta hai loai thong tin co ban trong co s& dir lieu GIS c6 thé thé hién theo
so do sau:

iD Tinh |Tinh |Tinh
(ma) |[chat | chat 2 chat 3
] 2
l X X X
2 X X X
3 X X X
AN W T
4 3 ID
Thong tin ban do Thong tin thudc tinh
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Thong thudng céc I6p lién ket véi nhau thong qua ludi toa d6 va cic hinh co ban, gin
lién véi bé mat clia qua dat thyc. Viée t8 chiic quan 1y thong tin theo 16p s& gnip ching
ta dé dang xay dung cdc ban dé tdng hop tir céc 16p di ¢6 tuy, theo nhu cdu dat ra.

III. CAC BUGC XAY DUNG CU SO DU LIEU

Céc budce chinh d€ x4y dung mot co s¢ dit liéu cho GIS ¢6 thé khai quat nhu sau:
+ Thu thdp nguon théng tin:
- Cac loai ban d6 cén thiét ;
- Kiém tra d6 tin cay, do chinh x4c;
- Thong tin théng ké va diéu tra co ban.
+ Nhdp thong tin:
- Digitizer (ban s6 hda): t6n kém va kha chinh x4c, d& 1am:
- Photogrametry (dnh hang tric): thong tin méi, c¢6 ca do cao;
- Scanner (mdy quét anh): nhanh, nhung sé6 liéu I Rater ;
- EDM (do dac ngoai nghiép): dé chinh x4c cao, ton kém, thong tin mdi;
- Keyboard (ban phim): s6 liéu thuoc tinh;
- Convertion (chuyén déi): chuyén déi File s4 licu da ¢6.
Sau day ching ta s& xem xét mét s6 phuong phap théng dung nhat hién nay diing dé
$0 héa ban do.
1. 86 hoa thi cong
Trong phuong phap nay, thao téc vién sir dung ban s6 héa (Digitizer) va Workstation
dé chuyén ddi ban dé hoac ban vé sang dang s6 héa. Phuong phap nay digc dung chi
yéu ¢ cdc co quan vi dé thao tdc nhung do chinh x4c théip, phu thude 16n vao thao téc
vién. Ngoai ra con c6 hai sai s6 anh hudng dén phuong phap nay 1a ti ¢ ban dé géc va
d6 phan giai cua thiét bi s6 héa. Ki€m tra chat lugng s6 liéu 1a viec quan trong trong
phuong phédp nay.
Nguoi quan 1§ h¢ théng thong tin dia 1y phai quyét dinh viéc s6 héa s& thuc hién
frong co quan hay thong qua cic hgp déng ky két. Phai tuan theo céc chi tiéu sau:
+ Chat lugng clia ban dé phai chuyén déi;
+ 56 luemg cha ban d6 phai chuyén déi;
+ Phan mém, phdn cimg va nhan su hién c6;
+ Chuyén gia kiém tra cht lugng hién c6;
+ Sy mém déo trong qud trinh chuyén déi ;
+ Su hoa nhap (Fit) v6i hé théng thong tin dia 1.
Céc d6i tugng ban do trén céc to ban do gidy hién 6 thong qua qué trinh s6 hoa s&
dugc chuyén thanh tap hop cac diém toa do (x,y). S6 héa tha cong doi hoi thao tac vien
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phai dua con tré ciia ban s can lai cde d6i tugng trén ban d6. Cac ky thuat s6 hoa ban
dé thi cong:

- S6 hoa theo cdc cung nho lién ti€p nhau (serial smaller acrs);

- Tao ra cdc thuc don (Mcnu) trén ban s& dé sit dung cau lénh clia hé théng déng thoi
v§i qud trinh s6 hoa;

Céc budc thu nhan théng tin bing s6 hoa:

- Sir dung cdc ban d6 nén 16t ;

- Xdc dinh thu tuc nhan théng tin;

- Cong tac chuan bi ban dé vi ban s6 héa;

- K&t n6i ban sd héa véi mdy tinh;

- S6 héa thong tin .

Céc loai doi tugng chinh s€ tao ra khi s6 hoa cdc théng tin ban d6 nhu sau:

béi tuong diém :

+1  Di€mss Toadd x,y
2 +3 n R
2 2.7
+4 3 6,7
4 45

baéi twong dudng:

Puongss [ Toadox,y
i 1.53.6 6.56.7

//\QJ
//{ N 2 1,1 335282

Péi tuong viing :

<<:> Vingss ' Teadoxy

1 36 5,7 76 44 36
2 73 8593 1,8 73

Thiét bi s6 hoa (Digitizer) phé bién nhat dugc sit dung cho viée s6 héa ban d6é bao
g6m mot mang ludi day dién tinh vi va duge nhiing vao trong bé mat ciia mot bang hop
kim. D& thuc hién viéc s6 hda, ban dé phai duge gin vio bé mait trén clia ban s6 hoa,
cdc diém va céc dudng trén ban d6 duge do can lai bing con trd cia ban 3§ héa

38



- (Digitizer Cursor) hay 1a Keypad. Thuat ngit Keypad duge sir dung trong cuén sach nay
dé tranh nhdm l&n v6i con trd clia man hinh, ghi lai vi tri tai d6 ¢ diém giao
(Crosshair). Vling cam tng dién tit thong thudng khong mao rong dén cdc canh ciia ban
s6 hda. Vi vay, dé xdc dinh cdc gid tri toa d6 khi thuc hién s6 héa ching ta phai dam
bao chac chan ring ban dé gidy clia chiing ta phati dat trong viing hoat déng cia ban s6
hoa (chua dén cdc canh bén cta ban s¢ héa). Khi chiing ta 4n nut trén Keypad ma né lai
ndm ngoai viing hoat dong ciia ban s héa thi s& khong cé gid tri nao duoc tra lai. Céc
nut trén Keypad duoc lap trinh dé tién hanh mot s6 chiic nang khi s6 héa ching han nhu
ghi lai mot diém hodc bat dau mot dudng. Khi Keypad duge an, may tinh s& ghi lai céc
toa do X,y cta vi trf hién thoi , gid tri (x,y) duoc tinh theo don vi ciia ban s6 héa (thudng
Ia centimeter hodc inche). Day chinh la cic toa do cia mét d6i tuong diém hoac vi tri
cua cdc dinh hop thanh d6i tugng duding hay ving. Hai hay nhiéu dudng giao nhau tai
mdt diém thi di€m dé duge goi 1a giao diém. Khi s6 héa, chiing ta ¢ thé chon céc giao
diém nhu ia cdc nit, hoiic ¢6 thé bod qua céc giao diém. Ca hai phuong phap nay déu cé
thé chap nhan duge. S6 héa theo phuong phdp Spaghetti s& bd qua cic giao diém giita
cdc do6i twong khi céc cung duge s6 héa. Phuong phdp nay thudng duge sir dung dé xéc
dinh céc dudng Spaghetti, chang han nhir cdc duding bién, céc ludi va dir liéu hién trang
str dung dat. DGi véi cdc d6i tugng chinh x4c hoic céc déi tuong cong va xoan lai véi
nhau, chiing ta nén s6 hoa riéng r& (Discrete). Xdc dinh cdc giao diém s& nang cao do
chinh xdc cla déi tuong theo toa do. S& héa theo phuong phép Discrete s& thuc hién s6
héa ca cdc giao di€m gilta cdc doi tuong trong qué trinh s§ héa ban dé. Vi du trong
phan mém ARC/INFO c6 cau lénh Clean ding dé 1am sach dif liéu va tao ra Topology
cho I6p théng tin.

2. Nhdp thong tin théng qua Scanner

D6 Ia mot cong nghe mdi, cdc bén ghi clla Scanner chita toan bo céc hinh anh trén to
ban d6 bao gém céc dudng nét, ky hiéu va vin ban chit trong qu4 trinh chuyén déi. wu
the ciia né 1a t6¢ do. Tuy nhién, s6 liéu Scanner khong thé ding ngay dugc cho céc hé
théng thong tin dia ly. Mot cong tde bién tap thém phdi lam dé x4y dung cic dir lién
"thong minh" ddi hoi cho cdc hé théng thong tin dia 1y 13 chuyén déi cac dit liéu Raster
sang dang Vécto. Gia thanh x4y dung co sé dit liéu tir Scanner khé cao. Dung céng nghé
Scanner trong mét hé théng thong tin dia Iy dé chuyén déi dif lieu ban d6 khong bi han
ché€. Quét dnh va lu trit anh 1a nhitng céng nghé thuc hién cudc cdch mang trong viéc
xur ly thong tin va thay déi cdch nghi viéc tra ctu théng tin. Su tién bo va nang cao kha
nang luu trir coa cdc dia tir da 1am thay déi lén trong cong nghé nay trong thuc t& va
hi¢u qua kinh 1€ cho cdc ting dung. Nhimg vidn dé cdn luu ¥ khi ing dung cong nghé
nay la:

- Quét anh, d6 phan giai dam bao 1dy hét thong tin trén & ban dé;

- Xir Iy anh so bo va xuong héa hoic 13y dudng bién ;

- Vécto hda cdc doi twong (tu dong va ban tu dong);

- Nam chuyén vé hé toa do ban dé;

- Ghép ndi cac manh ban dé (tuy chon).
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+ Bién tdp thong tin:
- Loai bd d61 twong khong cén thiét ;
- Phat sinh thém cdc d6i tugng méi ;
- Bi¢n t4p cdc dinh doi tugng.
+ Tao cdc doi twong qudn 1y
- Hinh thanh cic 16p quan 1y ;
- Thé hién cdc d6i tugng chia 16p.
+ Lién két thong tin thudc tinh véi doi niong qudn 1y:
- K&t gén thudc tinh truc tiép
- Két gén thudc tinh thong qua File dix liéu di ¢6

IV. BAO TRi CO SO DU LIEU

Co 50 dit li¢u ctia GIS giéng nhu 12 ngudn nang lugng duy nhit cho su hoat dong cua
cong nghe GIS, do vay n6 phai duge bao quan, bao tri chu ddo trong sudt chu trinh séng
(Life Cycle) ctia GIS. Théng qua viée bdo tri co s¢ dit liéu cua GIS chiing ta s& d6i méi
thong tin va khong d€ cho cdc théng tin trong GIS 14 théng tin chét, dim bao cho céc
thong tin luén phu hgp vdi thuc t€ ton tai clia chiing. Trong qua trinh béo tri ta ¢dn luu y
cac diém sau day:

- Viée xay dung lai co s dir liéu 1a rdt ton kém.

- Théng tin trong co s& dir liéu luon phai d6i méi.

- Théong tin trong co s& dit li¢u phai dé tin cay cao.

- Théng tin cia GIS phai dugc bao quéan an toan. .

- Théng tin cua GIS dam bao phuc vy ding déi tugng.

- Co's6 dit liéu ciia GIS 1a mot i san vo cling qui gid.

- Vi céc thyc thé dia Iy quan 1y trong GIS luén phit trién va thay déi cho nén phai déi

ma6i, ¢ap nhat thdng tin theo dinh ky cho phi hop va ddp ng véi moi yéu cdu. Tao ra
ngudn thong tin méi.

- La nguén thong tin duy nhat ctia hé théng thong tin dia 1y gidng nhu nguén nang
lugng cua cic thiét bi khdc cho nén phai bdo vé né trong suét thai gian t6n tai cha hé
théng thong tin dia ly.

- Khi thyc hién d6i mdi thong tin trong GIS cén phai xdc dinh 16 cac van dé lien quan
sau day:
« Nguon thong tin cho st déi méi
e Tic gia
» Vi tri xdc 1ap méi
« Kiém tra ddu vét thong tin
« Ddm bao chéng lai su ci k¥, lac hau cta théng tin
+ Thuc hién téng hop, khdi quét thong tin
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Chuong IV
THUC HIEN DU AN UNG DUNG CONG NGHE GIS

I. NGUYEN TAC THIET KE HE THONG THONG TIN DIA LY

Du 4n hé thong thong tin dia 1§ chi c6 thé thuc hién thanh cong trén co s& da chudn
bi ddy di cdc diéu kién trg gitip cin thiét cla cdc co so tng dung hé¢ théng. Nguyeén tic
chung dé€ thiét k& he thong thong tin dia ly 1a: “Céc {ing dung cua hé théng théng tin dia
1y quyét dinh cdc thanh phdn va chic ning ciia he thong thiét k&". Tai day thuat ngir
"H¢ théng” dugc hicu bao gom ca phan ciing va phin mém ciing nhu noi dung co sd dit
ligu, cau tric ciia nd, nhan sy va hé théng t6 chiic, tai chinh,

SO PO NGUYEN TAC THIET KE HE THONG THONG TIN DIALY

Yéu ciu va
phuong sich
Y
Ung dung
v v
Chifc nang Néi dung I\’Ihi{a\m v to
hé théng co s& dit lieu chiic va co quan

Phan mém Thiét ké CSDL,

Phéan cimng

Qua trinh thi€l k€ h¢ thong thong tin dia 1y 12 mot qua trinh lap lai, chuyén tir y
tudng dén khai niém, ¢lr thiét k& so bo dén thiét k€ chi tiet vA sau dé 1a cu thé héa. Co 56
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dif li¢u la nén tang dé thuc hién cdc ung dung khac. Do vay, xay dung co s& dif liéu ciia
hé thong thong tin dia 1y 1a mét cong viec lau dai nhdt va t6n kém nhat. Phai x4c dinh
ndi dung va do chinh xdc clia né trong sudt qua trinh hoat déng, phit hop véi tinh chat cla
cdc img dung ctia h¢ théng théng tin dia 1y 13 mot trong céc budc quan trong clia thigt k&
h¢ thong. Sau d6 dén thi€t k& chi tiét co so dit licu ty thudc vao phin mém cha hé théng
thong tin dia 1y dung trong viéc xir 1y v thuc hién cdc chitc nang luu trit s6 liéu.

Céc chire nang clia hé thdng ¢6 thé xdc dinh khéng phu thuéc vao cic phin mém vi
phin ciing cu thé¢ nao nhu: xit 1y, thao téc co s& dif liéu d6 hoa vi phi dé hoa, mo hinh
héa, kha nang phan tich va téng hop. Gifia néi dung clia cdc ting dung da chon va thiét
ké chitc ning hé¢ thong phai x4c dinh cdc mdi twong quan sau:

- He thong ¢6 t6i wu hay khong cho viéc ti€p nhan cdc ban v& va ban dé;

- C6 ddm bao xu ly thong tir khong gian duge khong trong céc t hop clia nhiéu yé&u
t6 the hign bing cdc polygon hoac chuyén d6i va thay déi kiéu lien két ciing nhu kich
thude clia chiing;

- C4c nét hinh anh miéu ta ding hinh dang thuc t&€ thé hién;

- C4c nét hinh anh dugce sir dung trong thé hién kiéu déng dia vat;

- C6 nhiéu ngudi s& sir dung co s& dit liu;

- H¢ tap trung hay phan tdn s& phii hop 0t nhat dé giao dién véi nguoi sit dung;

- H¢ théng c6 cung cap cdc chitc nang xir 1y khac phi hinh hoc.

Nhitng céu tra 16i cho cidc van dé trén s& hinh thanh mot kh4i niém cau hinh he
théng, phén cing, hé diéu hanh (Dos, Windows hay Unix) mét hay nhiéu phan mém, su
hén két gilra cdc may tinh.

11. CAC BUGC TRIEN KHAI THUC HIEN UNG DUNG CONG NGHE GIS

Thirc thi mot du 4n hé théng thong tin dia Iy 14 mét qué trinh téng hop phitc tap. Gia
thanh c6 thé Ja hang tram ngan dén hang tridu d6 la. Thong thudng dé thuc thi thanh
cong mot hé théng thong tin dia 1y ta phai thuc hién cdc budc sau va chia thanh nam
giai doan:

1. Khdi niém (Concept)

1) Phan tich yéu cdu, nhiém vu (Requyrements Analysis).

2} X4c dinh tinh kha thi clia dir 4n (Feasibility Evaluation).

2. Thiét ké (Design)

3) Ké& hoach thuc hién (Implementation Plan).

4) Thiét k€ h¢ thong (System Design).

5) Thiét k& co so dit liéu (Database Design).
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3. Phat trién (Development)

6) Xay dimg hé théng (System Accquysition).

7) Xay dung va thu nhéan co s& dir liéu (Database Accquysition).

8) T4 chitc nhan su va dio tao (Organization Staffing and Training).

9) Chuan bi cho hé théng hoat dong (Operating Procedure Preparation).
10) Chuén bi van phong noi lam viéc (Site Preparation).

4. Thao tdic (Operation)

11) Cai dat hé théng (System Installation).

12) Dy 4n thir nghiém (Pilot Project).

13) Chuyén déi s6 liéu (Data Convertion).

14) Phét trién tng dung (Applications Development).

15) Chuyén déi sang hoat dong dong (Convertion to Automated Operation).
5. Kiém nghiém (Audit)

16) Xem xét lai hé théng (System Review).

17) Mo rong hé thong (System Expansion).

SO BO QUAN HE CUA CAC GIAI POAN THUC HIEN DU AN

KHAI NIEM THIET KE

PHAT TRIEN

THAO TAC

—~H| KIEM NGHIEM
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Buge 1: Phan tich yéu cau

Phan tich yéu cdu 1& mét budc bao ddm cho viéc thuc thi hé théng thong tin dia 1y
thanh cong. Viéc phan tich bao gém x4c dinh nhiing hoat déng, tic dong phai dua vao
ban d6 va thong tin dia 1§ trong céng viéc chia co quan ciing véi su luu ¥ t6i ¢d hai loai
théng tin khong gian va thong tin thudc tinh cha cdc d6i tugng dia 1y. Trong nhiéu
truong hop, thong tin thude tinh gén lién véi thong tin dia 1y 13 méi quan tdm chinh coa
nhitng hoat déng quan 1y chuyén nganh va diéu hinh hanh chinh. Viéc thu thap s6 liéu,
quan ly, luu giir va xtr Iy thong tin trong co quan, cdc yéu cdu clta cd quan vé hé thong
thong tin dia 1y phai dugc nghién ciru k§ ludng va xdc lap tir nhimg phan tich cau tric
hoat déng ciia hé théng thong tin dia ly va du kién trong diéu kién phdt trién trong
trong lai.

Ddnh gid cic nhu cau can thiét phai duge thue hién nghiém tic va khoa hoc. T6i
thiéu phai phan tich 7 loai yéu cdu sau day ctia hé théng thong tin dia ly:

- Céc chife nang xu 1y ;

- Noi dung s6 liéu ;

- Chudn héa s& lidu va dic diém;

- Céc chitc nang x\r ty;

- Céc ting dung va san phdm cla hé théng;;

- Khd nang va nhiém vy cua phin mém ;

- Thiét bi phan ciing va kha nang cha né ;

- C4c phuong tién truyén thong.

Phan tich yéu cdu c6 thé diing cdc loai cdc k¥ thuat khac nhau bao gém ca phong
van, hoi thdo, tric nghiém vd mé hinh héa. Muc dich ctia viéc phan tich 1a x4c dinh cdc
yéu cdu hién tai va trong tuong lai clia hé théng thong tin dia 1y. Trén co s& nhan thitc
va thong tin duge cung cap bdi doi ngii nhan sy hién tai. Tuy nhién béi vi nhimg ngudi
nay c6 thé chua thdu hiéu vé cong nghe he théng thong tin dia 1y cho nén cén phai cung
cdp cho ho mdt kién thitc co ban chung thong qua dao tao, héi thio, &n phim vé hé
théng thong tin dia ly va cdc phuong tién gido duc khédc nhau. Qué trinh x4c dinh yéu
ciu doi héi phai dua trén co s6 lgi ich chia hé théng thong tin dia 1y trong t8 chwic va
phén dinh chiing thanh cac mie d¢ va linh vye chice nang ing dung.

- Phong van 13 phuong phép chinh d€ thu nhap nhimg théng tin yéu cdu. Céc théng
tin d6 ¢6 thé duge ciu tnic hda theo cdc ddi héi nhat dinh hay khong cdu tric héa tiy
theo diéu kién cu thé cta t6 chic ma ngudi phéng van huéng din thao luan theo chn dé
di néu ra. Mot hoac nhiéu nha phan tich cé hi€u biét vé cong nghé hé théng thong tin
dia 1y s€ tién hanh cdc cudc phéng van, ddng thoi nha phan tich ciing phar ¢6 hiéu bigt
vé té chite va céc chifc nang hoat dong cfia né. V& timg chitc nang clia co quan phai
duoc thao luan va lam 16 muc dich, Iinh vuc quan 1y va céc khia canh k¥ thuat. Véi su
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hudng dan cla cdc cd nhan hay mét nhém ngudi, cac cude phéng van dugc s& mo ta lai
toan bd nhi¢m vu clia t6 chirc, hoat dong hién tai va cdc van dé gap phai. Trong qua
trinh phong vin cdc loai ban dd va cdc tu lidu trg gitp phai duge tap hop va xem xét,
xac dinh méi truong hoat dong va nang luc clia t8 chic.

Phong véan 1a cong viéc kha4 tiéu t6n thoi gian va sitc lao déng. S& mat khé nhiéu thoi
gian d6i véi nhiing t6 chiic giir vai trd chinh trong viéc phat trién hé thong thong tin dia
ly, d6i véi cdc 16 chire khdc nén han ché 6i thiéu cic cudc hoi thio, phdng van.

D¢ thu thap thong tin vé ban dg, s6 liéu va cdc nhu ciu tng dung cé thé sir dung céc
cugc trac nghi¢m. Cac hinh dnh ban dé, cdc mo ta bing ban dé hien tai, ty 1&, khéi
luong 6 li¢u va cdc thong tin khdc dé dang ghi nhan tir nhiing nguoi tham gia cac cude
trac nghiém dé€ thi€t k& theo muc dich. Tuong tu céc théng tin vé gid thinh va tiém nang
cita t6 chiic thong thudng thu nhan tir cic phicu tric nghiem.

Mo hinh hodc bang bi¢u ki€m tra cha cdc chic ning chuidn va cdc yéu cdu cé thé
kiém chiing va phan tich céc thong tin da thu thap. Cic md hinh durge diing dé phan tich
56 ligu va cdc thong tin ban d6, ddi hdi mai lien quan cla s6 liéu, xir 1y va céc chite
nang hién thi cling véi thiét bi phan cing.

Céc thong tin yéu cdu dugc tao thanh van ban dé diing trong céc budc sau. bay 1a
buée dau tién cung cap toan bo thong tin cho cdc bude khéc nhu thist ké, phat trién ing
dung va thuc hién.Vin ban dién ta thanh phdn tham gia, muc tiéu cla he théng, s6 liéu
dau vao, xir 1y, tra cttu, hién thj yéu cau, s6 liéu khong gian va phi khong gian, yéu cau
chirc nang va kha nang phdn cing. Sau khi céc bén lién quan tham gia xem xét, khang
dinh va sita 461 theo céc kién nghi s& hinh thanh ban bdo cdo cudi cling.

Nhén su trong hé théng théng tin dia ty va cdc chuyén gia bén ngoai can phéi hgp
v6i nhau d€ thuc hién cdc phan tich yéu cdu nhim tao ra cau ndi gita cong nghé hé
thong thong tin dja 1y va ngudi sit dung chua c6 hiéu biét nhidu vé he théng thong tin
dia Iy. Cic nha phan tich phai chi ra cdc thong tin cdn thiét phu thuoe vio mitc do cua
16 chifc, s6 Tugng td chifc tham gia vao suf tdng hop clia h¢ thong thong tin dia ly.

Phén tich yéu cau duge thire hién tir mot ban am hiéu va giau kinh nghiém ciling s&
dong mgt vai trd gido duc quan trong trong linh wirc phé bién cong nghé hé théng thong
tin dia 1§ cho nhimg ngudi sir dyng va cac thanh phan tham gia. Binh thuong thdi gian
phén tich yéu cdu 12 4 - 6 thang.

Buroe 2: X4c dinh tinh kha thi

Hau hét cdc co quan phai tinh todn tinh kha thi ctia du 4n hé¢ théng thong tin dia Iy
trude khi tién hanh ddu wr chinh thic. Xdc dinh tinh kha thi 13 din ching tong thé
chung cic chi tiéu, quy mé ma hé théng thong tin dia 1y tng dung thuc t€, ddnh gi4 gid
thanh va tinh hiéu qua ciia né. Pham vi nghién cdu tinh kha thi phu thudc vao kich
thude, su phite (ap ciia co quan va tinh da dang cia tiém nang Uing dung hé thdng thong
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tin dia 1y. Mot co quan lén hoic da nganh hé théng thong tin dia 1y thong thudng doi
hoi mét sy phan tich rong 16n bao quat, trong khi d6 mot co quan don 1é diing hé méy vi
tinh (PC - hé théng thong tin dia 1y) cé thé chi cdn vai gier ddng ho khao st d€ chudn bi
mot bdo cdo v¢ gid thanh cilia né.

Nghién ciu kha thi duge dua trén co s& clia théng tin phan tich yéu cdu. Thang tin vé
cdc hoat dong hién tai duge dung d€ thiét k&€ mot dudng day co s& diéu kién, (i€p nhan
va dam bao cdc phuong phip quan 1y hién thoi s& dugc tiép tuc coéng viée. Cic yéu cau
duoc diing dé chon cdc cdu hinh ciia hé thong thong tin dia ty va co s& dit lieu cho co
quan, nhifng khai niém thi€t k&€ nay dua dén mét co s& cho viéc danh gia hieu qua va
gid thanh, phai xdc dinh lua chon hé théng thong tin dia 1§ theo cau hinh phan tin hay
tap trung vé viéc Xir Iy co so dit lieu, pham vi hodc cdu hinh t8i thiéu cia hé théng
thong tin dia ly.

Gia thanh cia phan ciimg va phan mém, xay dung ca s& dit liéu, bao tri vi hoat dong
cua hé théng thong tin dia ly trong moét giai doan xdc dinh phai duge tinh todn cho timg
lya chon. Tinh todn gid thanh phéi dua ra mot khoang xéc dinh trén co s& tinh todn tir
mot s6 cdc hing kinh doanh h¢ théng va co sé dif lieu ma ching théa man yéu cdu cua
co quan, gid thanh hoat dong bao gom mot doi ngii nhan sy ¢6t cén quan 1y vi cung cép
trg gitip hé thong, co s& dit liéu cha né va phét trién, bao tri cic truong trinh Gng dung
clia h¢ thong théng tin dia ly. Viéc danh gid gid thanh cta hé GIS phai bao gém viéc
x4c dinh ca hai budc thanh phan:

- Chi phi lao dong thue t€ (Actual Labor);

- Hiéu qué dau tu (Saving Resulting).

Gid thanh va hiéu qua cla lya chon céu hinh hé théng thong tin dia Iy duoc tinh va
sau d6 so sanh véi gid thanh cha hoat dong hién tai. Sy so sénh s& md rong theo thoi
gian cho dén thyc hién ddy du cac thanh phan cia hé théng thong tin dia Iy ciing véi co
s& dif ligu cha né va dua vao hoat dong hoan thanh. Thong thudng théi gian thue hién
mot dur 4n he théng thong tin dia 1y ddi hoi tir 2 -5 nam. Phan tich kha thi do vay ¢6 thé
phat bao ham tir 7 -10 nam chu ky s6ng cla hé théng thong tin dia 1y (Life - Cycle -
Period). Tinh khdch quan va tin ¢4y 1a cac chi tiéu ciia phan tich tinh kha thi. Trong mot
s¢ trudmg hop nghién citu kha thi duge thuc hién boi nhitng ngudi hoac té chitc mudn
diéu chinh viéc thu nhan cta hé théng chuit it. Trong cic truong hop khéc duge dinh
huéng d¢ thu nhan c4 khoi cha hé thong.

Viéc hinh thanh khéi ni¢ém gan diing cia hé théng thong tin dia 1y thiét k& va dénh
gid loi ich, gid thanh ddi héi mot tinh d¢ chuyén gia cao. Can phéi tham nhap vio
théng tin clia h¢ théng va gi4 thanh cdc s6 lieu khong c6 trong co quan.

Thaoi gian nghién ctru kha thi thudng tir 6 - 9 thdng hoac nhiéu hon tily thude vio tinh
hinh yéu cau ciia timg hé thdng théng tin dia 1y thiét k&
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Keét qua nghién cttu kha thi déng vat trd thuyét phuc cdc nhi quén ly, lanh dao va
dan bi€u trong viéc tng dung cong ngh¢ hé thong thong tin dia ly.

Buge 3: K& hoach trién khai

Trién khai cong nghé hé thong thong tin dia ly théng thudng phai thuce hién hang loat
nhiém vu cla cdc nganh, bao gém ca hé théng nha dat va hop déng. Lap k€ hoach ti mi
va diéu phsi 1 mot viéc hét stic quan trong. K& hoach trién khai cung cép cho toan bo
céc thanh vién tham gia hiéu rd vai tro, nhiém vu caa ho va sy lién quan giita cdc nhiém
vy, xdc dinh va ki€ém tra ton bo céc bude trong qua trinh thuc hién nhur sau:

- Xédc dinh va mo ta nhiém vu riéng ré;

- Xac dinh trdch nhiém cho méi nhiém vuy;

- Chi ra nguén tdi nguyén cam két:

- Xdc dinh moi lien quan giita cdc nhiém vu;

- Xdc dinh san pham va chat luong;

- Thanh Iap bang, biéu dé thuc thi.

K& hoach phai 1ap cu thé cho timg yé&u 16 quan 1y, cho phép dé dang cap nhat va kiém
tra, bdo cdo tinh hinh (i¢n trién trong qu4 trinh thuc hién. Ngoai ra con phai ¢6 so dé
lwe6i the hién su lién quan gitta cdc nhiém vy, thoi gian va tién do thuc hién va céc ghi
chii can thi€t. Pam bao 12 mot cong cu co s& trg gitip quan 1y va kiém tra toan bé cong
vigc v cdc ngudn 1ai nguyén phuc vu cho he thong thong tin dia 1y. K& hoach thyc thi
duge xay dung trén co s& céc thong tin tir nghién cttu tién kha thi v& cau hinh he théng,
noi dung co s¢ dir ligu, du todn gid thinh vi chc nganh tham gia trong hé théng théng
tin dia 1y. K& hoach trién khai cta cong nghe GIS chi ¢é y nghia thuc thi khi va chi khi
no co thong tin cy thé sau day:

- Timg cong viéc va mo ta chi tiét ciia né;

- Tén va s6 luong cong viéc, trach nhiém ca céc 6 chiic bén ngoai tuong mg cu thé,

- V6n va nhan lyc cho timg giai doan;

- Sén phdm cha ting cong viéc va timg giai doan;

- Sy lién quan gifta cong viée, su diéu phoi va thong nhat giita cdc thanh phan tham
gia va quyét dinh ciia cdc nha lanh dao.

K¢ hoach dwgc thanh lap tir nhimg nha chuyén moén ¢6 su am hiéu va kinh nghiém vé
xay dyng h¢ thong thong tin dia Iy truée d6, hiéu rd toan bo cong viéc va sanh soi
trong cong vi¢c xdc dinh nhimg tai nguyén cdn thist dé thuc hién cho timg cong viec.
D6 1a cong viéc téng hop phic tap va 6 thé mat hang thing thoi gian méi cé thé hoan
thanh tir nhitng nha l1ap k& hoach giau kinh nghiém.

Trong qud trinh thyc hi¢n ¢6 thé ndy sinh cdc van dé pht sinh, do vay cén phai phoi
hop dicu chinh gitta cac nganh tham gia hé thong thong tin dia ly.
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Buroc 4: Thiét k& hé thong

Hé théng thong tin dia ly dugc thic hién bang vi¢c dua vao img dung mot hé thong
phin ciing va phin mém hién ¢6, c¢6 nhiéu h¢ thong thong tin dia 1§ dang c6 trén thi
trudmg, mbi hé déu c6 diem manh va didm yéu rieng biét doi véi yéu cau cu thé cua
timg co quan. Viéc chon mot he théng ¢6 thé 1a mot qué trinh chinh thitc. Bdi vi c6
nhiéu hé théng dua ra do viy tai giai doan nay phai xdc dinh rd cic thiét bi cu thé, chon
medcl va phan mém ndo? mé ta cu thé phan cing, phan mém s& diing cung véi kha
nang va chiic nang cia nd. Tap hop cdc thong tin chi tiét vé cdc loai ban dé, s6 liéu va
c4c yéu cau xir 1y thong tin. Mo ta céc loai thong tin dau vao va dau ra, s0 luong thiét bi
phin ciing hé théng va ngoai Vi, cach méc ndi gifta cdc méy tinh, c6 thanh lap mang
hay khong?

D& dam bao thu duge két qua tot nhat trong cong Viec thiét k& chi tiét, hé thong
doi hoi phai ¢6 cac chuyén vién am hiéu phan cing, phan mém. Mang mdy tinh va
truyén thong tham gia thue hién, thai gian thuc hién viéc thiét k& vé hé théng phu
thude vao khéi lugng va sy phic tap clia hé théng ma ngudi sit dung da dit ra, co the
13 tx 6 - 9 thang.

Buoe 5 Thigt k& co so dif liéu

Thiét k& chi tiét co s& diF liéu cla hé thong thong tin dia 1y dugc tién hanh song song
véi viee thigt k€ he thong. Thi€t ke chi 116t co s& dit lidu 1a xéc dinh 16 rang dac diém k¥
thuat khi tao ra va bio tri co s dit licu. Hudng dan chi tiét viéc thu thap s6 liéu va ma
héa ching cén thiét cho hé théng thong tin dia 1y. Viéc thi¢t k€ ca so dir licu phai xac
dinh cu thé noi dung, dac diém k¥ thuat, mdi lién quan va ngudn tu liu s& hop nhét
trong co s& dit liéu cua hé thong thong tin dia ly. Mo ta chi tiét vé timg chuyén dé s6
licu s& duge dua vao co s& di lieu nhur 56 liéu quy hoach, do dac, tai nguyeén, dia g16i
hanh chinh, kha nang tién ich v.v... Thiét k€ chi ti¢t 1a mot su tinh loc va gia tang cua ¥
tudmg thiét ké trong nghién citu khad thi. Mdi nguén tu ligu phai xdc dinh 16 phing
thong tin yéu cdu dd c6 san va do tin cay cita né ciing nhu kha nang mi héa chung.

Trong vin ban thiét k& phai xdc dinh 15 nhimg thong tin ban dé va phi ban do6 ciing
véi céc dac tinh chung clia né. Sy lién quan gilta céc thong tin it quan trong va dac bit
1a su déng dang va su lién két giong nhu méi quan hé ngoai thyc t&. Phai xdc dinh do
chinh x4c cdn thiét cia cdc thong tin va sy théng phat cha céc d6i tuong trong cac 1Gp
d6i twrong khi thu thap ching. X4c dinh, tim ki€m cdc ngudn tu lidu va cdc phuong phap
thu thap cho timg loai thong tin ban d6 va thong tin thudc tinh theo yéu cdu da thi€t k&,
Né&u khong tim thdy dugc nguon tu ligu yéu cdu phai lya chon quyét dinh hoac huy bo
thong tin d6 hay 16p thong tin dé trong ¢o s& dif lieu thiét k& hoac thu nhan ching tir fu
liéu hang tric (chup anh hang khong) hay tir do dac thuc dia mdi. Sav chép toan bo tu
lieu da c6 va chuyén lai cho nguoi quan ly dy 4n ding dé tham khdo trong sudt qua
trinh thuc thi xay dung hé thong thong tin dia 1y.
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Tai liéu thi€t k& 1a su nhin nhan, xem xét tiém ning cung c4p va \ing dung nhimg s6
liu chia hé thong thong tin dia 1y tir ngudi sir dung dé chinh sira va thay déi cdc ngudn
tu liéu, trén thye € viéc thi€t k& dugc thuc hién tr mot ngudi hay mot nhém tir 2 -3
nguoi da c6 kinh nghiém va am hiéu vé phuong phdp cg s& dif liéu cta hé théng thong
tin dia ly, ban d6 va xir 1y thong tin d6 hoa. Thoi gian d¢ thigt k€ so s& dif lieu ctia he
thong thong tin dia Iy phic tap c¢6 thé mat 4 -6 thang.

Viéc thu thip va xédc dinh cdc nguon tu liéu s& thudng xdy ra van dé 1a trong hau hét
cdc cd quan, cdc loai ban db hién c¢6 va cde ngudn tu liéu déu nim rai ric, phan tén tai
nhiéu don vi va khong théng nhat tron ven véi nhau hoic khong théng nhét khuén dang
chuan nao ¢4, tham chi ¢6 trudng hop mau thuin va hoan toan khong khép nhau khi
ghép ndi. Thuc t& s& xdy ra khi thu thap céc 56 liéu thuoc tinh ta phai giai quyét sao cho
khuon dang (Format) ctia s6 liéu phai phit hop hoac chuyén déi dé phit hop véi mot cdu
tric dir liéu cy thé cha phdn mém quan ly nhung vin giit duge méi quan hé logic véi
cac do1 trong dia ly.

Ngudi lanh dao co quan sir dung hé théng thong tin dia 1y nén quyét dinh vé miic do
cua do chinh xdc, su cén thiét va mic d6 anh hudng d6 phai dua trén co s& clia céc yéu
cdu k¥ thuat trong cdc ting dung s& thuc hién cung véi gid thanh cho phép, cang ting do
chinh x4c thi gid thanh cang cao. Russell White da dua ra cong thitc sau day:

Gid thanh = dién tich x mat d¢ x hinh anh x phuong phip

Dung cdc phuong phap khdc nhau s& thu duge cdc midc do khac nhau vé dé chinh
xdc, tir d6 s& thu duoc cic loi ich gid thanh phil hop véi yéu cdu dat ra. Tém lai, gid
thanh xay dung co sd dit li¢u cho GIS phu thu6e vao bén yé&u t6 co ban: pham vi, do
chinh xdc, mitc do chi tict va phuong phéap xay dung.

Buoce 6: Tiép nhan hé théng

Thu nhan phén cing, phin mém cha hé théng thong tin dia 1y thudng 12 tieu diém
chinh cia mét du 4n hé théng thong tin dia 1y; muc dich cla budce nay 1a thu nhan phan
cing ctia hé théng thong tin dia 1y hiéu qua nhat, phdm mém va céc tro gilp tién tién
nhat trén thi trudng v6i gid ca hop ly. He théng c6 thé duoc thu nhan theo cac cdch khac
nhau. Thong thudng cdc co quan da chgn mét hé théng thong tin dia ly tir khi lap du 4n
cung véi sy tuong thich cia h¢ théng xédc dinh. Qua trinh thu nhan hé thong s& sir dung
nhing chi dan tai thi€t k& chi ti€t & budc 4 dé chin bi cho cdc yéu cdu di dé ra.

Bdi vi ¢6 nhiéu hé théng trén thi tredng nén viec lya chon phai can cif vao cic dé
nghi clra thuc tién. Trude tién 14 chudn bi phin ciing theo kiéu loai cha thiét bj nhu tram
lam vige (Workstation), bo xir 1y (CPU), mdy v&, thiét bi truyén tin v.v... vd kha ning
clia ching nhu do phan gii, t6c d6, dung luong va céc thong tin khac ciing vdi s6 lugng
cén thiét. X4c dinh phin mém theo cac chitc ning yéu ciu di théng nhat vd moéi trudng
tam viéc clia né nhur h¢ diéu hanh, hé xir Iy khong gian, hé quan tri s6 liéu va ing dung
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cua phdn mém. Xéc dinh cdc thiét bi vd phdn mém dé lién két tao mang gifta cdc mdy
tinh. Toan b& nhimg x4c dinh trén dugc tao thanh ban bdo cdo theo mot kidu miu c¢é
san va sé thong qua tai co quan quan 1y. Qua do thanh 1ap mot danh sach yéu cau theo
fimg danh muc nhu dao tao, bao Iri, ngay cai dat, k& hoach thanh toan va cac hop
déng vdi ngudi cung cdp hiét bi dé xin duyét chinh thitc. Sau d6 ngudi cung cép hé
thong thong tin dia ly & ducge mdi dén va cho y ki€n vé nhitng dé nghi chao hang vé
phan ciing va vé phan mém trong hodc vugt ra ngoai nhitng quy dinh yéu cdu di dinh
trude, theo thoa thuadn trén s€ ky hgp dong va thdi han cung cdp cac yéu cau giita
nguol ban va ngudi mua.

Thanh 1ap mot doj tir 5-6 ngudi am hiéu vé phan cing, phian mém, truyén thong, ing
dung ban d6 va quan ly dit liéu d€ tién hanh (3o tao theo chuong trinh cén thidt va tiép
nhan, kiém tra toan bo cdc thanh phan, chifc nang clia hé théng thong tin dia Iy da thiét
ké&. Thoi gian ti€p nhan hé thong thudng 12 midt thang déi vai hé théng théng tin dia 1y
don gian va khoang vai thang déi véi h¢ thor-g thong tin dia 1y phiic tap.

Bioe 7: Thu nhan co so dir liéu

Phat trién mot co sd dir liéu cia hé théng thong tin dia 1y - chuyén ddi thong tin
kKhéng gian dang twong tu (analog) va thong tin phi khéng gian sang dang thong tin s6
idigital) va thay doi khuon dang clia nhitng 6 liéu da cé vao co s¢ dir liéu ciia hé théng
thong tin dia ly doi hoi phai ¢6 sir ddu tr 16n vé sitc ngud?, thoi gian va thi chinh, co s¢
dit liéu cua hé thong thong tin dia 1§ thong thudng bao gbm bon loai s6 liéu sau day:

- Suru tap tir anh hang trac va s6 héa may do v& giai tich ;

- Ty dong chuyén d6i cac h¢ thong tin ban d6 di 6 bing ban s& héa (Digitizer) hay
m.iy quét anh (Scanner);

- Nhap tir ban phim ;

- Chuyén d6i cdc sd liéw di cé tir trude dé sir dung.

[hu nhan va xay dung co & dir liéu chia hé thong thong tin dia 1y doi hoi phai ky kst
cac hgp dong v6i mot hay nhidu co quan (hang) dé thu thap nhimg théng tin di cd va s6
hda cdc thong tin ban d6, trude khi ky cdc hop déng thu nhap v s6 lieu phai xdc dirh
cu 1€ toan bo cdc thong tin ban dé va thong tin thude tinh s& dva vio trong co s& dit
liéu cling véi cdc chudn va de chinh x4c ctia chiing. M6 ta céc nguén tai liéu, san phém
va F huon dang ciia n6 cing v$i cac dac diém thich hop, phu trach viéc thu nhan co s
dit I éu phai 12 ngudi cé kinh nghiém trong [inh vuc phat trién co s6 dir ligu. Thanh 13-
mot doi gidm sat va kicm tra ra cdc ngudn wr liéa, chat lugng san pham va tién do thue
hién céc hop dong da ky két vii cdc 16 chitc cd nhan vé thu thap va s6 hda théng tin cho
he thong thong tin dia 1. Thoi gian thu thap va xay dung co sd dif lieu cho hé théng
thong tin dia iy ¢6 thé kéo dai hang nam thy theo do chi tiét va do 16n clia co s& dif licu
thiét ké.
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Buée 8: Té chite nhan su va dio tao

TS chitc va nhan su 12 yéu 16 chi chét va quyét dinh su thanh cong ciia du 4n hé
théng thong tin dia Iy. Mot khi cong tdc quan Iy du 4n h¢ théng thong tin dia 1y hiéu
qua va doi ngll nhan s ding va hop 1y thi kha nang thing loi cang cao. Mét van dé
quan trong trong cong tdc nhan su 1a k§ ning cva cdc thao tic vién chit khong phai la
s0 lugng, thi€u nang luc. Yéu 6 quyét dinh ctia du dn hé thang théng tin dia 1y 13 chinh
sdch va cdu tric cla du dn hé thong thong tin dia ly. Hé thong thong tin dia 1y s& thuc
thi tai mot co quan hay da nganh? néu da nganh thi doi hdi mot su lién két cau tric giita
cac hoat dong khdc nhau nham tao ra mot t6 chic hoat dong chung cho toan bd cic
nganh va doi hoi mot ngudi quan Iy thudng true dé diéu phéi cdc hoat dong cla cic
thanh vién tham gia hé théng thong tin dia ly.

Co cau t chiic ¢6 thé la co ché tap trung véi mot he théng thong tin dia 1y chinh &
cung cdp cac dich vu cho cdc nganh khdc hodc ¢ thé 13 phan tdn véi titng nginh he
thong théng tin dia 1y hoat dong doc 1ap véi nhau. Néu céc nganh trao déi, sir dung s6
li¢u va tai nguyén véi nhau thi ban 8 chitc hé théng théng tin dia 1y phdi thiét [ap mot
tiéu chuan xéc dinh sif tuong thich ctia phin citng vi cac thanh phan ciia phan mém cla
hé théng.

Céu triic hé théng cua hé théng théng tin dia 1y xdc dinh quyén luc, trach nhiem,
nhom cau Iénh, mifc dé nhan su va cdc dac diém quén 1y, lap k€ hoach va trién khai cdu
triic t& chitc thong thudng can phai luu ¥ dén miic do quan 1y cia cde nganh tham gia,
trong cd ciu phan tdn cua hé thong thong tin dia ly thanh phan phai tuan theo mot cau
truc chung cho toan cuc.

Nhan sy & nhimg ngudi thyc hién cdc cong viec chic nang bao gém ngudi quan ly
thuc hién dy dn, quan Iy hé thong va quan 1y co s dif lieu cla hé thong théng tin dia 1y,
nha phén tich hé théng, 1ap trinh vién vi thao tic vién.

Ngudi quan 1y thuc hién du dn ¢6 trich nhiém vé toan bo cong viée cdc mit coa cong
viéc thuc hién dy dn, quan 1y vé viéc ti€p nhan hé thong phit trién va xay dung co sd dit
li¢u, ti€p nhan va (6 chiic dao tao can bo, phat trién cac chuong trinh tng dung va chuin
bi dua hé théng vao skt dung thue t€.

Nguti phu trach hé théng chiu trach nhiém hang ngay quan 1y toan bo hé théng va
hoat dong ctia né doi hoi phai ¢6 kinh nghiém va hiéu biét vé toan bo cdc van dé cla
cong nghé hé thong thong tin dja 1y va hoat déng ctia nd.

Nhiém vu cla ngudi quén Iy hé théng va quéan 1y thuc hién du 4n c6 thé phan
cong cong viec cho mot hoac hai ngudi, phu thudc vio cong viéc clia du dn va cong
viée thuc té.

Quan tri ca s& dif li¢u ¢6 trdch nhi¢m quan 1y cdc ngudn we liéu, chat Ivong, bio quan
va sir dung co s¢ dit lidu cua h¢ thong thong tin dia ly. Nguoi niy xac dinh co s& dit licu
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v cdc yéu t6 thanh phan, phuong phép tao ra co o dit lieu, xdc dinh cac tiéu chuan
chat lugng, ban quyén va cdc quy dinh truy nhap vao co so dit lieu va cac thu tuc cap
nhat thong tin.

Thao téc ciia cdc hé thong va lap trinh vién c6 trach nhiém phat trién, bao tri cdc
chuong trinh ting dung, c¢dc trg gidp h¢ thong va cdch giai quyét cdc van dé phat
sinh. Nhitng ngudi am hiéu vé hé théng thong tin dia 1y, thanh thao lap trinh & cdc
ngdn ngit bac cao duge cung cap tir hé thong théng tin dia 1y va céc thao tac, thu tuc
vdi co so dir ligu.

Thao tac vién ctia hé théng 12 nhitng ngudi can v&, Ky sur va nhimg ngudi khic da
dugc dao tao dé sir dung khai thdc he théng phuc vu cho cong viéc clia ho. Trach nhiém
ciia ho 13 s6 héa thong tin, bién tap va in &n cdc loai ban dé theo chuyén dé, truy nhép
56 lieu va thue hién cdc phan tich can thiét cho ngudi sir dung.

Dao tao cong nghé hé thong thong tin dia 1y gilt mot vai trd dic biét quan trong va o
mic d6 chuyén sau khdc nhau trong mot dir 4n he¢ thong thong tin dia ly. Quan ty hé
thong thong tin dia Iy vA cdc nhan sy chu chdt cha dy dn s dao tao chuyén saun vé cong
nghe, con céc ngudi khdc thi dao tao vé& cdc thao tac khai thdc hé thdng, viéc dao tao
bao gém cdc van dé vé quan Iy hé théng, 1ap trinh phdn mém hé thong va cdc chiic nang
ctia hé théng thong tin dia 1y. Viéc dao tao vé cdc tng dung va chiic nang clia he thong
thong tin dia ly dugc tién hanh tir cdc hang cung cip hé th6ng. Ngoai ra cic nhan sir con
¢6 thé dao tao thong qua cdc nhém lam viée (Workshops) clia hé théng thong tin dia 1y,
hoi thao, hoi nghi va cdc su kién chuyén dé vé h¢ thong thong tin dia 1y 6 chtic tai cdc
vién, trudng dai hoc va cdc 16 chirc quoc te.

Buge 9: Cong tac chudn bi cdc thil tuc hoat dong ctia hé thong

Sau khi da xay dung mét cdu tric chung cho toan bo hoat dong ctia hé thong, tién
hanh chuén bi cho hoat dong clia céc thi tuc vé hoat dong va quan ly clia he thong, vé
bao tri va cap nhat co s& dir liéu va cic (ng dung trong cdc nganh tham gia vio hé thong
thong tin dia 1y, vé cdc san phdm dau ra chudn ciing nhwr san pham dac biét clia hé¢
théng. Cau triic ctia hé thong phai dam bao su tuong thich trong céc thu tuc clia cic don
vi doc lap va giam 16i da cdc thao téc thira. N6 la co s& hudng din thu thap théng tin
cho hé théng thong tin dia 1y lac ban dau thyc hi¢n. Trén co sG clia cdu tric tong thé do,
céc nganh tham gia vio hé théng s& thi¢t k& nhimng thi tuc riéng, twong tmg vé thu thap
56 lidu, truy nhap va thao tac v6i he thong thong tin dia ly, hién thi va thanh lap céc loai
han d6, bdo cdo, cic san phim cho ngudi st dung cudi cling, st dung cdc san pham
trong méi trudng xdc dinh.

Trude khi cai dat va di viio hoat dong hé thong phai xdc lap cac thit tuc quan ly bao
trlim 1én toan bod cic hoat dong sau:

- Hoat dong hang ngay va cédc thanh phan hé thong;
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- Bdo tri thiét bi phan ciing va phdn mém;

- Kiém tra dich vu hé thong;

- Giai quyét cdc vn dé phdt sinh;

- Lun giff co s dir 1i¢u v phan mém;

- Cap phat ban quyén sit dung thiét bi hé théng va truy cap hé thong;

- Quan 1y phan ciing va cdc hgp dong bao tri phdn mém; -

- Tro gidp ngudi su dung hé thong;

- Ban quyén clia viéc phat trién tng dung hé théng va cai dat;

- D6i méi phin cing va phin mém.

Thanh 12p mot bdo cdo vé cic thanh phdn clia hé théng va céc thil tuc vé bao tr
chiing trong khi cai dat va trude khi lan ddu tien he thong hoat dong, mo ta dic tinh va
cdc van dé xay ra cling nhu cdc hogt dong bao tri cc thiét bi trong qud trinh ton tai cna
hé théng.

Bige 10): Chudn bi van phong

Lua chon dia diém t6i uu cho viéc cai dit cdc thiét bi, b6 tri khong gian tuong dng
cho todn b cdc thanh phén hé théng, chudn bi chi tiét cho vi¢c thiét k€ va xay dung van
phong cén thiét, dam bao ddy di nguén cung cip dién 4p va cdc thiét bi kiém tra, ciing
nhur dudng day théng tin lién lac. Phan kén cde thanh phéan cau hinh clia hé thong thong
tin dia 1§ 1am viéc trong diéu hoa nhiét do, do 4m nhat dinh .v.v... do vay yéu céau phai
tuan thu céc diéu kién trong 1y lich cha thiét bi nham tao ra diéu kién Iam viéc t6t nhat
cho h¢ thong thong tin dia ly. Thanh 1ap bin thiét k€ rén co s& cua thiét k& cu hinh chi
ti€t cua h¢ théng thong tin dia 1y va cdc dac diém vat 1y cta thiét bi d€ ba tri va sap xép
hé théng.

Vigc chuan bi van phong ¢6 thé ky hop déng véi cic co s& riéng 1€ cho timg danh
muc cong viéc nhu xay dung, tu sira , thong hoi, diéu hoa .v.v... nhim chudn bi day du
co & vat chit dé dua hé théng vao hoat dong nhanh nht.

Bioe 11: Cai dat he théng

Vigc cai dat h¢ théng duge thuc hién sau khi nhan ddy db céc (hiét bi phan cimg va
phan mém theo thiét k&, dudi su chi dao clia ngudi quan 1§ t6 chirc he thong. Tham gia
cai dat ¢6 ngudi quan 1y dur 4n, nhéan su va ngudi sir dung hé thong théng tin dia 1y, cin
b6 k¥ thuat va truyén thong hé théng lap k& hoach chi tiét cho viéc cai dit va thuc hién
theo hudng dan ciia hing cung cap hé théng. Khi toan bo thanh phan di dugce cai dat s&
thue hién thao tdc kiém tra thi, trude tién kiém tra thir tai ché viec cai dat cé diing theo
chi dan va hop 1& khong, sau dé kiém tra hoat dong ciia toan bo phan citng va phéan
mém. Néu bude kiém tra xong vi thiy céc thanh phén h¢ théng hoat déng binh thuong
ta c6 thé tin tuong vao hoat dong va dao tao nhan st thao tic.
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Buoe 12: Thu nghiém

Thong thudng trude khi dua hé théng thong tin dia 1y vao chinh thidc sir dung can
thue hién mot du dn thir nghiém véi muc dich nhu sau:

- Tham tra hoat dong va loi ich clia cong nghé hé thong thong tin dia 1y;

- Tham tra gid thanh va hiéu qua di x4c dinh tai nghién citu kha thi;

- Tao ra mot co s& dit liéu cho hé théng lua chon kiém tra chudn;

- Xay dung mau co so dit liéu cho nganh trong mot khuén dang va ciu tric xac dinh
cho phan mém hé théng thong tin dia 1y da chon,

- Tham ira thil tuc phét trién va xay dung co s& dit liéu;

- Cung cép viéc dao tao truyén tay cho nhan sy cla co quan vé cong nghé hé théng
thong tin dia 1y xéc 1ap mot k& hoach thir nghiém véi muc dich noi dung cu thé. Trong
d6 quy dinh pham vi thir nghiém, noi dung cia co s& dit liéu va cdc thao tac kiém tra
cung véi nhitng chi tiéu tinh todn thit nghiém phai dat dugc. Trong du dn thir nghiém
mot loat thao tac kiém tra phai duge thuc hién nhu s6 héa va nhap s6 liéu vao hé théng
da cai dit, tao cac ban d6 chuyén dé, thuc hién cdc bai todn ing dung, tim kiém va phan
tich s6 liéu .v.v...

Nhim thdm dinh cdc kha ning clia hé thong thong tin dia Iy cho phép ngudi st dung
kiém dinh vi quan sét hé théng trong qud trinh van hanh.

Thyc hién kiém nghiém ddi héi mot déi ngii cdn bd c6 nang luc va hiéu biét vé hé
thong théng tin dia ly dé phat trién tng dung, thao tic trén hé théng va cic thao tic
kiém tra.

Thai gian thyc hién ki€m tra phu thudc vio mite do clia hé théng thong tin dia 1y va
n6i dung du dinh kiém tra, c6 thé 12 tir 3 - 6 thang.

Buoe 13: Chuyén déi sé liéu

Xay dung nd1 dung co s dif liéu ciia hé thong thong tin dia 1y 1& cong viéc t6n nhiéu
thoi gian va tién clia nhat cta dur 4n hé théng thong tin dia 1y, co s6 di liéu chia hé théng
thong tin dia ly thudng duge phat trién tir cong sie chia doi ngii ¢dn bo cla co quan va
céc hop déng kinh t& vdi cdc nganh khéc lién quan.

Toan bo 56 liéu clia co so dit liéu duge chuyén vao phian mém quan 1y cia hé thong,
do vay chiing ta phai duge ma héa va chuyén tai vao hé thong théng tin dia 1y, truéc khi
chuyén tai théng tin vao hé théng thong tin dia ly phai ti€n hanh xdc dinh uéi dung, tinh
toan ven, do chinh xdc, tinh lién tuc va logic, xdc dinh tinh chit theo 16p va loai dai
trong, cdc diac diém chat lugng s6 lieu. Sau khi thdm dinh chit lwong s6 lieu ching ta s&
tai nhap vao co s& dit liéu vinh ciru. Dam bao chéc chédn toan bo s6 licu dugce tai nhap
vao hé théng hop ly va ¢é co ché diéu khién, cap nhat théng tin da tai vio. Sau khi hoan
tat cong viéc xay dung co s¢ dif lieu, ching duge dua vao st dung va thuc hién cac thit
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tuc bao tri hé théng budc ddu dé cap nhat nhitng théng tin ban dé vi nhimng thong tin
thuge tinh khu vuc ¢6 thay d6i. Cdc s6 lieu & khudn dang va cdu tric khic nhau dugce
chuyén déi theo cdu tric cha phan mém hé thong thong tin dia 1.

Bude 14: Phat trién cdc tng dung

Céc ung dung cung cdp chudn ctia hé théng 12 cdc chitc nang thudng diing clia hé
thong thong tin dia 1y, ching lién quan dén mot loat cdc bai toan nhu tim kiém va té
chifc s6 liéu, thuc hién tinh todn s6 hoc va kiém tra logic, bién tap thong tin ddu ra, dau
vao cua h¢ théng .v.v... Céc chuong trinh dé dugc viét bing cdc phdn mém va céng cu
ngon ngif cia hé thong thong tin dia 1y vdi ngon ngil ap trinh Fortran hoic C. Céc
chwong trinh dugce phdt trién dé rg gidp vA nang c4p cdc thao tdc tinh todn nhur thue
hién tim ki€m s& liéu, tham tra chit lugng, hién thi, tao ban v&, tao bdo cdo .v.v...

Nguoi quan ly hé théng xac dinh cdc tha tuc cho viéc phit trién, bao tri vi kiém dinh
cac chuong trinh ting dung. Dam bao céc chuong trinh tng dung dé khong ¢6 hai gi dén
hoat dong cta hé théng va co s dit li¢u. Do tao thao tic vién sit dung chiing, céc
chuong trinh tmg dung dugc cai dat sao cho ching cling vé6i cdc chite ning khéc ¢6 thé
thao téc ngay tir lan hoat dong ddu tién clia hé théng.

Buoe 15: Chuyén déi sang thao tac tu dong héa

Théng thudng giai doan thuc hi¢n x4y dung hé thdng thong tin dia 1y twong déi kéo
dai va thi cong do vay doi hoi phai chuyén déi céc thao tic bang tay hién tai sang céc
thao tac ty dong mdi cia h¢ théng. Trong qud trinh xay dung co s& dit liéu, thong
thudng viéc bao quan sé liéu duge thuc hién bing thi cong va hang ngay lién tuc. Khi
cdc thanh phan cila co s6 dit liéu dd hoan thanh ta thue hién chuyén nhap va thim tra s6
liéu réi sau dé ti€n hanh chuyén ddi va bao tri thao tic tu dong. Tuy nhién céc thao tic
thu cong va tr déng c6 thé con ti€p tuc ton tai song song mot thdi gian vi ngudn tur licu
cho hé thong ludn d6i méi va doi hoi phai cap nhat s6 liéu thi cong.

Buoe 16: Xem xét lai hé thong

Tuy heé thong théng tin dia ly da dugc thiét ké rdt cong phu nhung van cdon mot s6
khodng cdch khong hop 1y trong ing dung cong nghé méi vé con ngudi va tinh tu viet.
Xem xét lai h¢ thong gift vai trd theo dbi hé thong vA nham dua hé théng phit hop hon
v@i thiét k& ting dung (con ngudi, phén citng, phan mém va céc chuong trinh tng dung).
Thong qua vigc xem xét lai ta cé thé quan sdt 1dng thé vé hé théng trong moi truong
lam vi¢c, nhin nhan thuc trang clia hé thong so véi thigt k& trude d6, ban chat cha he
théng, t6 chifc va trang thiét bi k¥ thuat clia he thong théng tin dia 1y hién tai.

Buoc 17: Mo rong hé théng
Véi sy phét trién khong ngimg cta khoa hoc k¥ thuat, phdn mém clia hé thong théng

tin dia 1y ludn doi mdi bang cdc phién ban wu viét hon véi cac chite nang va tng dung
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cang ngay cang hoan thi¢n hon. Mat khac gid thanh cta céc thiét bi phéan ciing khong
ngimg ré di nhung khd nang lai m& rong hon. Ta cin phai xem xét cén than médun méi
cua phin mém va cdc thiét bi méi cha phén cing trén th trudng quang cdo dé quyét
dinh lva chon cdc chiic nang méi dé md rong hé thong da cai dit thuc tai theo nhiém vu
mdi dat ra.

1L MOT SO VAN BE KY THUAT THUC HIEN UNG DUNG CONG NGHE GIS

Nhitng wu th&¢ méi nhat cia cong nghé xit ly dia Iy hay con goi la dia xir ly
(Geoprocessing Technology) va viéc gidm gid thanh ddng ké da md ra nhimg tien dé
cho vi¢e giam dan hoac loai bo nhitng cong viée xir 1y thi cong trong cong tac quan ly
thong tin ¢ cdc nganh va cic dja phuong. Nhitng vin dé cong nghé nao s€ dat ra khi ing
dung cong ngh¢ h¢ théng theng tin dia 1y trong cong téc quan ly va sir dung théng tin?
Phan nay chiing ta s& fim hiéu vé cdc van dé dé.

1. Bia xut Iy va qudn Iy thong tin

He thong thong tin dia 1§ 12 mot cong cu cho phép ta gén 1ién dir lieu vi wf dia Iy
V61 ndi dung ciia né va thé hién két quéa d6 thanh céc ban dé chinh x4dc. Do vy, cac
chitc néing quéan ly ctia chinh quyén dia phuong ¢6 thé dwoc ty dong héa. Nhiing chirc
nang ¢d thé tr dong hoéa thong qua cong ngh¢ h¢ théng thong tin dia 1y bao gom:
Thiet k€, k¥ thuat, 1ap ban d6 va cong cu tro giip, nang luc quan 1y va thong tin lién
quan dén dat dai, an toan xa hoi, quy hoach do thi, quan 1y hanh chinh va cdc nguén
tai nguyén thién nhién.

Nhung cuéc cdch mang cong nghé nay dua lai didu gi cho viéc quan 1y cha dia
phuong? N6 phit hop va hoa nhap nhu the ndo véi moi trrdng 16 chife cla céc cong
nghe hién c67 Mbi cong ddng phéi hifu 16 cdc kha ning vé 3 chiic quan by, tich hop lai
va cau triic lat théng tin quan 1y ciia cong nghe v.v... Trude khi quyét dinh tng dung
moét cong nghé mdi,

He thong thong tin dia 1y 1a mot tap hop cdc thi thuét hinh hoc may tinh, trén co sé
dia Iy xir Iy (Geoprocessing) nhiam xdc dinh cdc sir lién két khong gian gifta cdc deéi
tugng trong hé thong. Cac déi tuong phai chifa dung 1a mot cong cu lap ban d6, nhung
hau hét cdc phan mém CADD khong c6 kha nang tao ra cdc manh ban d6 cling lic vdi
nhau, lwu trif s6 liéw thude tinh mém déo, tém tét s6 lieu, va truy nhép s6 liéu tir cic
ngudn tur liéu khac.

Tir vién cinh quan 1y thong tin, he théng thong tin dia 1y da tao ra mot loaj téc dong
chién luge: Thong qua co 5§ dit lieu cla né, hé théng thong tin dia 1y cung cip kha
nang quan 1y s liéu dia ly va lién két né vdi cac he théng t6 chic da c6. Bing viéc tieu
chuan héa né cho phép phat trién vii giao dién véi cdc phan mém "Third-Party”. Cic
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phin mém cua hé théng thong tin dia 1y cung cap kha ning quan Iy (inh vi cic chic
nang dia xur ly trong cdc moi trudng tinh todn khdc nhau. Thong qua ban dé co s& né
cung c¢dp kha nang tao ra ban d6 dién tir co s méi hoic chuyén déi sang nhimg ban dé
da co khi can. Céc tng dung thuc tién da ching 16 nhiing wu thé cia hé théng thong tin
dia ly. Viéc danh gid tinh hiéu qua va gid thanh cia hé théng théng tin dia Iy khong nén
chi quan tam dén mot ng dung clia né, tuy nhién trén thuc t€ do ap luc chinh tri vé
thuc thi nhanh va trinh dién céc lgi ich clia né d anh hudng dén quyét dinh chién lugc
vé he thong thong tin dia y. Phét trién h¢ th6ng thong tin dia 1y phai dim bio ca muc
dich lau dai va muc dich truée mat, nén chi y:

- Khong nén tach biét nhitng van dé quan 1y co s& dir lieu clia hé théng thong tin dia
ly v6i cdc vin d¢ quan ly co s& dit liéu c6 nham ddy nhanh vigc thuc hién cdc ung dung
cua hé thong.

- Khong nén gop ngay céc loai chic nang dia xir 1y boi vi ching khéng can thiét cho
cdc img dung dau tién.

- Khéng nén dau tr 16n vao vige phit trién cdc tng dung tam thoi. Phai dam bao sy
on dinh clia phan mém cao, va sut mao hiém 1én khi nén tang co s& clia hé théng thong
tin dia 1y thay déi.

- Khong nén dau wr vao nhiig cong nghé phén cimg vi phin mém tinh xao dé giam
gid thanh va thoi gian. Chiing ta nén bat d4u tir nhitng h¢ théng nhéd dén 16n.

- Khong nén coi nhe van dé quy dinh tiéu chuén héa co s& dit lisu. Nhitmg nha quan
Iy thudng xem xét viée dua vao ting dung cong nghé mdi thco quan diém gidm gi4
thanh va céc kha nang né s& anh hudng dén céc hoat déng trén viing lanh thd quan ly.
Nguot quan ly thong tin phai hién duoc nhu cau t6i wu héa trong viéc sir dung cong
nghé trong té chic ciia minh.

Nhimg kha nang ciia linh vyc quan ly théng tin va dia xu 1y khong phai 12 méi mé,
chiing twong tu nhu vige qudn 1y cdc tram wr dong. Nhimng yéu to dam bio su thanh
cong hay that bai clia du 4n rdt rd rang. Mat khic, thuc hién cong nghé hé thong thong
tin dia 1y dang gap nhimg khé khan lién quan dén viec diing thuat ngit, nén tdng co s& ddy
di cia khoa hoc va tiéu chudn héa, qua trinh thyc hién lau dai va doi héi cao. Khi hé
théng thong tin dia Iy da duge ting dung vio céc co quan trong dia ban ctia dja phuong s&
doi hoi su lién két giira cdc co s& dir fieu dinh huéng déi tuong, cic hé théng vé ngudn
thong tin cung cip va suf trao ddi cdc thong dia ly s& duoc dit ra nghiém tic hon.

H¢ thong thong tin dia 1y khong thé thay ddi chat hrong va hién trang cua cdc dir liéu
da c6, tgo ra cdc chudn cho khuén dang dit lidu va noi dung hodc giai quyé&t cdc van dé
khong twong thich chia dir lieu da dinh nghia trong co quan ing dung hé théng. Ciing
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nhu vay, hé thong thong tin dia 1y khong thé dé dang va ré d6i v6i viéc chuyén déi s6
liéu bin dé sang khuon dang s6 héa. D6 1a nhitng vén dé dat ra cho cdc nha quan Iy hé
théng thong tin dia 1y va nhan vién van hanh phai nhan thic va lvu tam khi lap k&
hoach, x&p xép t6 chitc quan 1y thong tin vé nhitng co hoi va kha nang khi tng dung hé
thong théng tin dia 1y.

2. Danh gid lua chon cong nghé hé thong thong tin dia ly

Theo nhan thitc truyén thong vé dénh gid mot cong nghé thudng phan biét phin
ciing, phan mém va truyén thong nhung ddi véi céng nghé hé théng thong tin dia ¥
khong thé ap dung theo céch d6 duge va do vay khong thé dinh gid né theo cach hiéu
don gian la so sdnh cic thanh phdn cha nd doc lap véi nhau. Cong nghé hé thong thong
tin dia Iy 12 mot hé thong dong géi cdc san phdm clia phdn mém co sd, hé théng thong
tin dia ly duoc thao tdc trén nén tang da lua chon vé phan ciing va co s& dit lieu.

+ Phdan mém hé thong thong tin dia 1y

Phin mém hé théng thong tin dia 1y 12 mot tap hop cdc san phiam da thiét ké nham -
thue hién dia xit 1y va cung cdp ngudn luc cho cac ving dung clia hé thong théng tin dia
ty. Ching 1a nhitng ham s8 khong gian hoac cong cu, phdn mém quan 1y co s& dir liéu
va ngdn ngit h¢ théng hodac doi khi 1a nhimg chuong trinh ung dung. Mot vai dia
phuong doi hoi mue d¢ cao hon vé cau hinh phdn mém so véi nhitng hé théng da c6 va
thuong mai héa. C6 mét quan diém chung 1a céc chic nang clia hé théng théng tin dia
Iy phai dugc xem xét trong qud trinh trinh dién (Demonstration) céc chifc nang co ban
¢ trong he¢ théng. Nhung cén lwu ¥ rdng phan 16n céc trinh dién chi mé ta tiém ning
ctia h¢ thong chit khong phai & mitc do thay déi cau hinh. Dé hién thuc nhat, viéc phat
trién phdn mém phai dua vio nhitmg yéu cdu ciia ngudi sir dung cudi cling va tu vén ciia
ho. Cho dén nay van chira ¢6 mé hinh chuin nao vé hé théng théng tin dia 1y cip dia
phuong da duge chdp thuan dé xay dung céc phan mém ng dung chung cho né.

+ Phdn citng va hé qudn i co 5o dit liéu

Nén ting co s& bao gém céc bo xUr Iy, hnu giit s6 liéu, mang luéi truyén thong, thong
tin, cac tram lam viéc, quan tri co s& dit liéu va cdc phdn cing cén thiét cho viéc cai dat
mdi mot nén tang ¢o s6¢ méi hodc chay phdn mém hé théng thong tin dia Iy trén nén
tang di c6, thay d6i hodc nang cap nén tang co s&. Nén tang co s& s& 4nh hué‘ng‘dé'n
viéc diéu hanh va tién trinh thuc hién céc giai phdp cho hé théng thong tin dia }y. Do
vay, su nghién ctiu chl yéu trong viée ddnh gid sy lién két clia hé thong thong tin dia 1y
v&i moi trudng di cé va cdc co sG cong nghé khic nhau dang tén tai.

Phan 16n cic dia phuong dd ¢6 su ddu tu nhdt dinh trong céng nghé GIS 1y ddi hoi
phan tich va danh gid nén tdng (Platform) quan 1y théng tin hién tai v cdc muc dich
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chién lugc thyc hién s& tic dong dén viéc st dung nén tang hién thai tham chi néu mot
cong ngh¢ h¢ thong thong tin dia ly méi duoc cai dat trén cic co s& khic nhau. Vin dé
truy nhdp cdc nén tang co s¢ khdc nhau, phdt trién mang va nhu ciu clia co s& dir lidu
phai la mét phan cha gidi phdp hé théng thong tin dia Iy vé& hiéu qua gia thanh va su
thich &ng ciia né.

Ngoai phan cimg co ban, cin phai xem xét cdc mat sau day:
- K& hoach quan 1y thong tin tdng thé hi¢n cé va cic hudng chién luge hoac lau dai.
- Hé thong quan trj co s6 dt liéu hién cé.

- Ngén ngir 14p trinh mdy tinh hién ¢4, thu vién cdc chuong trinh, cdc bo bién soan
vin ban, h¢ théng cac chuong trinh tién ich.

- Céc hé théng lap k€ hoach tu dong hién ¢ va céc tap tin (File) v6i nhu cdu vé tiém
nang dia xur ly.

- Céc kha nang hién c6 trén toan bo hé théng va céc File.

- Cac dac tinh vat 1y cha hé théng mdy tinh hién cé.

- Nguon nhén hyc hién cé khac. _

+ Cac chitc ndng va khd ndng ciia hé thong thong tin dia 13,

Muc tiéu cia h¢ théng théng tin dia 1§ 1a quan 1 va phan tich nhitng thong tin khong
gian. D¢ dat duge muc tiéu dé nén tang ctia hé thong théng tin dia 1y phai théa man céde
chitc nang thue hién céc cau lénh tir don gian dén céc ttng dung phitc tap. Phdn sau sé
xem x€t cdc chitc nang da lya chon phai thuc hién trong khao sdt cdc phin mém di cé
cho vigc sir dung ngay duoc, s 6n dinh, tiém nang phat trién, dé sir dung va hiéu qua
gia thanh cta céc ing dung phat trién tro gidp lau dai. Nhung trude tién, mot s6 van dé
can luu § phai duge 1am sang t6.

Nhitmg ngudi sir dung hé thong théng tin dia 1y quan tam dén céc chiic ning xir 1y
chia né trén hét va thong thuong la viee skt dung cdc thuat ngir. Cic bidu thitc nhy céc
cong cu, cac Macro, cac ham s6 va cdc tng dung da trdr nén rat théng dung. Mbi mot
muc nhu vay cin phai dwgc xdc dinh doc lap vé gid tri cha né d6i véi ngudi sit dung.
Nhitng quéang céo thi trudng vé cong cu “Tools” mém déo, giao dién véi ngudi sir dung
thin thién, tng dung cho moi hoan canh khic nhau v.v... khéng thé¢ dugce nam lai trong
SU xem xét cic chife nang clia h¢ théng thong tin dia 1y. Khong ¢6 su théa hiép nio vé
viéc xem xét cac chiic ning cua hé théng. Mot vai hé théng con cung cdp cic chic
nang, cac Macro, kha nang xay dung thyc don va ngén ngit 1ap trinh phat trién cdc tng
dung. Tuy nhién, ngudi sir dung cuéi cling phai 1am mot s viéc nhat dinh vé thi¢t k& hé
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théng cho co s& dit ligu va cac ing dung. Qud trinh thyc hién doi hoi can thiét phai cé
mot sy phan tich hé théng, thiét k€ so b, thiét k& so db co s& dit liéu, thiét k& chi tist
cac ing dung, ma héa phdn mém va kiém tra, bdo tri lién tuc hé théng khi nén tang co
$4 duoc nang cap. Thong thudng cdc ing dung va thire don ciia hé¢ théng khong thé phdt
trién xong trong thoi ky xay dung h¢ théng ngin ngui. Cdc nha sir dung phu thude vao
su hi€u biét cac lénh hé théng vi ngon ngit lap trinh, nd phai duoc thuc hién cho cic
nhi¢m vu lau dai hon dé trao déi tir co quan chl dén cic co quan ngudi sir dung.

Mbat diéu quan trong cén lwu y Ia sy thay ddi nang cao lién tuc clia céc hé thong
théng tin dia 1y dd dua dén mot s6 van dé phan mém. Ap luc thi trudng tai cac thai diém
dd dan dén sy voi vang trong viéc phat hanh cic phdn mém. Doi khi nhitg thé hé ci
hon di bi qua 161 thoi, ngudi sit dung bi khé khin trong viéc nim bét hét cac chitc nang
theo mirc d6 ciia phidn mem cung cip, gay ra sy mao hiém cho céc hoat dong hang ngay
clia t6 chie ing dung hé théng.

Sau day la nhitng ¥ kién trao d6i vé 6 linh virc chite nang chinh trong cdc nganh va
cdc dia phuong ting dung GIS:

a} Lieu tri¥ va bdo nri cde 56 liéu bdn dp

He thong thong tin dia 1y trg gitp viée tao ra va bao tri cdc ban dé véi mét do chinh
xdc cao. Ngudi sit dung c6 thé xdc dinh va yeu cdu vé do chinh x4c, hién thi ban do, dé
fa nhitng y€u t6 chinh trong viéc xédc dinh mirc d6 chia céc chifc nang xir 1y khong gian
da néi trén. Chirc ning luu trir va bao tri dit lieu ban d8 [2 nhiing chitc nang di duge
thuc hién t6t nhit trong thuc don cla hé théng, né dam bio cho su sit dung hé thong tot
hon, thuan tién cho viéc dao tao va tang nang suat ctia thao tac vién. Sy 6n dinh cia s&
ligu ban dé dd nhap ciing 1a mot yéu cdu cho thi€t bi luu trit co s& dit liéu. Trong qua
trinh x1r 1y tao ra cdc déi tuong ban dé nhu i cdc dudng phé, 6 thira dat, cau tric hoac
dudng trung tam, hé théng c6 thé gitip d& su bao toan théng nhit trong cdc img dung.
Vi thé, vi du dudng truc cta phd duge luu trit khong gidng nhu nhimg dudng 8ng nudc,
cac ing dung bao tri 8 lieu ban d6é cling v6i mé hinh co s& dit licu, tinh chat va quy
luat vé& sy huru trit ddm bao duy tri timg phén cta théng tin ban dé.

b} Phan ménm phan tich

Khd nang phan tich tdng hop thong tin cita phan mém h¢ théng théng tin dia 1y da
lam cho cong ngh¢ nay duge cdc chinh quyén dia phuong luu tam rét 16n. Tuy nhién
khi nang cia h¢ théng thay déi tir mic do nay dén miic do khdc, phan 1én cdc phdn
mém he¢ théng thong tin dia ly ¢é thé phan tich s6 liéu trén co 56 céc Polygon (ving) va
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mang ludi. Dién hinh cho chitc niang niy 13 phan tich Buffer, mang luéi twong déng,
tinh duong din ngin nhat, xdc dinh nhimg can tré trén dudng di v.v...

Céc chie nang ctia hé thong thong tin dia Iy doi hoi phai thuc hién tinh toan théng ké
hoac tap ban dé chuyén dé da gén chat véi cdc kha ning phan tich cha phdn mém. Su
hién thi céc san phdm phan tich va sy mém déo trong viéc phdi hop cdc loai ban dé nhu
thé 1a nhitng dic diém quan trong trong hé théng.

Can phai luu ¥ rang viéc huu trr s6 liéu ban d6 thong thudng tao ra gidi han vé viéc
st dung s liéu. Nhu di néu 6 trén, m6 hinh co s& dit liéu va su 8n dinh dit liéu s& déng
mot vai trd chinh trong toan bé hé théng hitu ich cho cédc chire ndang phan tich.

) Ngieot sit dung cudi cing md giao dién hdi dap

Giao di¢n mo v8i ngudi sir dung vé hoi ddp cung cdp d& dang va tin cay cho dao
hang vé dia 1y va cdc File s6 ligu g6c va mot hé thong ngudi chi (Ownership). Kha
nang nay la quan trong d6i v6i ngudi sit dung khéng can than (cau tha). Cic nhan vién
lam cong dn lwong tai dia phuong thong thudng thudc & cdc nganh khac nhau, nhu cau
ngudi cdn ban dé va s6 ligu tir cdc hé théng khéc nhau, céc File va ngudi siv dung cé thé
truy nthap vao hé théng thong tin dia 1y thong qua thuc don diéu khién va céc giao dién
dau moi chudn. Chidc nang nay cé thé duge mua ciing vdi hé théng hoac khich hiang
phat trién.

d) Moi trudng phdt trién phdn mém g dung

Nén tang hé thong thong tin dia 1y cung cip mét moi trudng cho viéc phat trién cac
phdn mém ng dung. Mot s6 hé thong la ngudi ban than thién ctia ngudi su dung. He¢
théng bao gém thuc don dé trg gidp viéc phét trién phan mém ngoén ngi 14p trinh, dich
vu v¢ File va thu muc va nhimg nhi¢m vu khéc vé xay dung phan mém (mg dung. Mot
vai h¢ thong su dung ngdn ngit thit tu, tiéu chuan héa cong nghiép dé trg gitp viéc phét
irién (ng dung. N rat quan (rong dé dénh gid moi trudng chia hé théng cho phét trién
ing dung, dic biét khi né 1a sir hy vong cho viéc ma héa phan mém s& duge thue hién
ngudi su dung,

e) Moi truong ho tro co so dit liéu

D6 la méi trudng duge cung cap do hé thong nhim trg gidp viéc quan 1y dit liéu theo
cdc chiic nang chuan cla céc phdn mém quan tri co s& dir Héu. Sau day la nthimg vi du
vé su ho trg co so dit liéu chia hé théng thong tin dia 1y:

- Sur khai théc dit liéu, cdp nhat va su théng nhat cla co sé dit lieu. S6 lieu duoc xdc
dinh cho chinh slra dugc dénh diu tir h¢ théng dé ddm bao rang ngudi st dung ¢ thé
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kiém tra lai cdc hinh anh ban d6 dé chinh sira. Khi d chinh stra xong, hé théng kiém tra
vé sir théng nhdt cita toan bo s6 liéu lien quan.

- He thong s€ luu gift nhiéu thé h¢ ban doé (lich sir, hién trang, su thay déi clia cac 16p
théng tin v.v...)

- Quan 1y dir liéu khong gian va cung cdp su téng hop céc File dit licu ban d6é va su
twong quan cua ching véi cic s6 liéu thudc tinh, cong cu thiét k& hé théng cho viéc
phan b6 cdc dir liéu khong gian, luéi chiéu ban d6 va mdé rong dif liéu quan trong.

- Mé hinh dugc xay dung trén co s& cidc mdi twong quan cla cac déi twong nhu
dudmg s4, 6 thira d4t dai, c4u tric va dia chi cha chiing nhim cung cip mot cich mém
déo sy da dang clia thuc t€ khdch quan.

- Phan 16n cde h¢ thdng quan 1y co so dit liéu thuong mai cung cap s& liéu nhy mot tir
dién tra ctu vé6i cdc kha nang khdc nhau. Thém nita, mét s6 bod phan phian mém hé
thong thong tin dia 1y cung cdp mét cich nang cao than thién véi ngudi su dung dé doc
toan bé ndi dung da dinh nghia trong File hé théng vi nhap nhitng mé ti cho méi muc
thong tin Iuu trit trong File. Phai luu tam rang céc tir dién thuong mai thudng véng thiéu
kha nang tao van bén tir nhimg ddi tuong khong gian ctia mot hé théng thong tin dia 1y, Ca
hai dac tinh khéng gian va thuéc tinh phéi duge thé hién ddy di trong mét tir dién dit licu.

- Lién két vdi céc co so dir liéu bén ngoai 14 mot trong nhitng chiic ning quan trong
nhat cua h¢ théng thong tin dia 1y. Toan bo hinh anh khéng gian cé thé lien ket chiing
vao cdc dir lieu huu gilr trong cdc bang hoic File khic v6i ciing mot bo xé4c dinh chi s
(Index).

- Kiém sodt quyén téc gia cha ngudi skt dung. Nhiéu ngudi sit dung truy nhap doi héi
cdc cong cu clia he théng dat cdc mic do bin quyén va kiém soét truy nhap vao cac 16p
ban d6 va cdc tap tin. Phdn 16n nhitmg mao hiém phan biét 1a gifva kha néing chinh sira va
kha nang thim van va chay cdc chitc nang phan tich...

- Phan 16n céc he thong thong tin dia 1y cung cdp su bio mat dit licu hodc lien quan
dén hodc khong phu thude vao kiém sost ban quyén. Mot hé théng thong tin dia ly da
nganh hodc da co quan ddi héi su kiém soat chat ché nhim cho phép su thaim vin mém
déo trong dit lieu ciia hé thong thong tin dia 1y khi bao ve su truy nhap khong cho phép
vao dif liéu va ban dé hru giir.

f) Cde tng dung

Céc tng dung cha h¢ théng thong tin dia ly con duge mé réng 16n hon tir ngudi s
dung doc lap phat trién. Ho phdt trién cdc tng dung tir cdc nhan vién trong co quan hay
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duoc tur vin. Mac d, cic tng dung chuin dang duogc ngay cang tang thém va xay dung
trén cdc he théng théng tin dia 1y khidc nhau. C4c ting dung thudmg dung nhéat vdi cong
nghé GIS ¢é thé nhu sau:

- Thanh lap ban d6 va bao tri tng dung. Tw dong thanh lap ban do va cdc thong tin
lién quan 14 ving dung d4u tién ciia cdc hé thong thong tin dia ly. Cac thao téc tr dong
héa ban d6 va chuyén déi ching sang khuon dang s6 héa khong chi ¢6 trong loi ich
phong phii ma con tao ra nhifng co s chién luge cho céc ung dung ctia h¢ théng thong
tin dia Iy trong twong lai.

- Lap ban d6 ha ting co s&, hé théng quan 1y vé sinh va cde hoat dong lién quan.
Trong h¢ thong thong tin dja Iy cdc tmg dung quan ly bao gébm hé thong giao théng, hé
théng vé sinh, mang lu6i cdp thoat mude v.v... déu lién quan dén viéc 1ap ban dé quan
ly, ciing véi né la cdc chitc nang phan tich mang luGi da dugc cung cap theo phin mém
h¢ théng thong tin dia 1y hoic c6 thé duge khich hang phél trién.

- Uhg dung an toan xa hoi. Hé théng an toan xa hoi nhu la mét nhiém vu mdy tinh
cdn phéi giai quyét ngay va di dugc nang cao 911 ¢6 thé luu trit bing ban do6 trong hé
thong thong tin dja 1y. Sy ghép néi thudmg duge phat trién giira hai he thong.

- K& hoach héa, sit dung dat va cdc tng dung phan tich phat trién kinh t€. Quy hoach
va iing dung phan tich sir dung dat, tinh chat, dia chi va thong tin dich vu lign quan da
dugc phat trién trong cac hé théng thong tin dia 1Y ngay tir trude. Mot vai ing dung nhu
kiéu nay dugc xay dimg tir cac nganh sir dung cugi ciing hé théng.

3. Phan citng va phan mém hé thong GIS

Phan ciing clia h¢ thong thong tin dia Iy tiéu biéu bao gém nhu sau:

- Don vi xir Iy mdy tinh: Kiém sodt su truy nhap cua ngudi str dung, quan 1y File, co
sO diF li¢u va thao tdc d6 hoa, toan bo moi trudng tinh todn. Nén tang hé thong théng tin
dia [y sir dung mo hinh phan tan hay tap trung hoic t6 hgp ca hai bo xr 1y.

- Dia tit luu trif: So v6i hé théng s6 lieu phi khéng gian, hé thdng s6 lieu d6 thi doi
hoi s6 luong bo nhé trong dai 16n dé luu trir. Viec i trit s6 liéu phu thudc vao cic
kiéu loai tmg dung s& phat trién.

- Bing tir: ding d€ trao déi s6 ligu véi cac hé thong khic, thuc hién chic niang luu
ban sao dir liéu (Back-up data).

- Mdy vé: dung dé v& cdc File d6 hoa véi lue nét va cac mau khéc nhau. Ngay nay cé
cdc toai may v& bt kim, lazer va dién tir.

- Tram lam viéc va Terminal. Cung c4p cong cu cho ngudi sir dung nhap so lidu d6
hoa, hién thi va xir 1y ban d6 may, phan tich dia ly va hoi dédp co ban. Phan I6n cac hé

63



théng thong tin dia 1Y ciing ding nhiing Workstation va Terminal gid ré dé giam gia
thanh viéc truy cap vao cac ban do va s6 liéu lién quan.

- Mdy in va man hinh. Ding in &n cdc vén ban, bang biéu hoac ddu ra d6 hoa cho cac
phan tich va thé hién can thiét.

- Ban s6 héa va may quét anh. Sir dung dé chuyén d6i cdc hinh 4nh ban dé sang dang
s6 hoéa. Cic mdy quét anh dién quang nhan dodn cdc cham diém den trang trén anh
Raster va chuyén d6i mo hinh nay sang File s6 héa. Tuy nhién, cic mdy quét anh néi
chung khong tao ra co sd dir liéu ban dé trong mot logic xdc dinh vi cdu tric dif ligu,
nhung cdc s6 liéu Raster d6 c6 thé duge vée to héa cho cac muc dich yéu cdu ciia hé
thong thong tin dia ly.

Trude khi cai dit mot hé théng thong tin dia 1y, mot loai cdc thé loai phdn mém
hé théng duge yéu cdu: h¢ di€u hanh, xir ly d6 hoa, trg gitp hé théng v ngén ngit
~ lap trinh.

4. Mang ludi truyén thong va truy cdp s6 liéu

Mang lu6i truyén thong la mot khdo sat quan trong trong cdu hinh cta hé thong
thong tin dia 1y. Ty dong héa ban d6 tao ra mot s¢ lugng 16n s6 liéu trong cong tic
chuyén déi thong tin tai thdi diém quan ly 12 mot mao hiém dén cdc hoat déng thanh
cong cua hé thong truyén théng s6 liéu dé hoa ¢6 thé ngén nhidu thai gian trén he
théng. Truyén thong da ngudi sir dung hién cé trong kiéu tir mdy chii dén céc thiét bi
ngoai vi truyén thong - truyén thong cé truyén giita bd xit 1y trung tam vi céc Terminal
hodc tram lam viéc hoac thong qua mang ludi phan tén.

Mang lu6i phan tén cha cdc bo xtr 1y hita hen dich vu 6t hon cla cdc Workstation.
Kha niang ctia mang ludi da duge khdo sit nhiéu trong nhimg nam gin day. Tuy nhién,
phdn mém vé céc thuin tién mang ludi phan tan (moéi trudng may chu, phuong tién co
so dit liéu va phuong tién truyén théng) vin con dang phdt trién. Cac hudng chién luoc
chinh trong linh vuc nay dang duge cdc hing (cong ty) hang ddu vé cong nghé thong tin
quan tam phdt tién. Céc dia phuong cdn phai ¢6 quyét dinh ding dén vé kha nang cia
minh khi bat ddu trié€n khai cong nghé hé thong théng tin dia ly.

Co s dit liéu clia hé théng thong tin dia 1y c¢6 thé lwu trit tap trung hodc timg phén
trong cac co s¢ dir 1iéu khdc phan b6 & nhiéu noi theo mat dé quy hoach va chinh sach
da quyét dinh. M6t s6 co so dir liéu phan tdn khong tich hop thong tin tuong tic bdi vi
cach cai dat co sO dif liéu va quan 1y né. Mot vi du cho su tich hgp theo chu k¥ thong tin
vao cd s¢ dif liéu 12 giira chinh quyén dia phuong va céc cong ty dich vy, trg gitip. Co s&
dit liéu phan tan c6 thé khong phai tuan theo mot kiéu cich quan 1y cé dinh cho toan bo
cg s& dit ligu. Moi sur thay d6i trong co s& dit liéu thuong duge quan 1y thong qua céc
giao dién 1ap trinh va s liéu thong thudng phai dugc diéu chinh.
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Kién tric cla co s& dir ligu phéan tdn biéu hién ring cic phin cha dit liéu duoc luu giir
vat Iy 6 cdc vi tri khac nhau nhung ngudi sit dung vin c6 thé truy nhap va quan 1y théng
tin trong mot sy diéu phéi quén tri chung cho co sd dir lieu. Nhu cdu vé co sd dit liéu
phan tdn di dugc tang thém boi cong nghé Workstation vi nhu cdu ciia ngudi sit dung
vé truy cap thong tin nhanh chéng hon. Trién vong cua viéc sir dung nhiing tram {am
viec manh va gid thanh thap cho céng vi¢c trong hé théng thong tin dia 1y 1a két qua clia
dp lyc thi trudng vé cic gidi phap cho co s& dif liéu phan tdn. Theo cich nhin nhan cia
nguol si dung thi cic Workstation c6 co hoi nang cip phit trién mém déo hon cdc thiét
bi khdc va giam ddu ne tai chinh. Vige ting dung co so dir liu phan tin da loai bd moi
su mao hi€m chwra? Kha nang dé md rong mot co s& dir lieu Mainframe dé so véi s6
lugng 16n cdc tram lam viéc n6i v6i nhau thong qua mot mang cuc boé (LAN) 1a van dé
trong tuong lai. V& 1y thuyét, loi ich chia nhan thite ting dung nay so véi hé théng quan
[y co s& dif ligu tap trung kém hiéu qua 1a: Hiéu qua gid thanh khi m& rong he thong,
thoi gian tra 101 yeu cdu t6t hon, va gid thanh ban dau thdp hon. Trén thuc t€, phai khéo
sét cdc yéu t6 sau day:

- Cong ngh¢ co s& dit liéu phan tén 13 dang & trong thdi ky hinh thanh va phat trién.

- Van chura ¢6 mét co s6 dit lieu phan tén nao o6 ddy di cdc ning luc d6i méi, cap
nhat thong tin nhanh chéng.

- Chura ki€m sodt va ngan can dugc mot c4 nhan & tai mél Workstation c¢6 thé 1am
thay déi co sd dit lieu. Céc chi ddn di c6 va da cung cap tao cho ngudi st dung cé
kha nang d& dang truy cap vio co s& dit liéu, bd qua céc su gidm sat va su toan ven
cla dit liéu,

- Sur thudn tién nam bit s6 liéu cha ngudi sit dung cudi cing bing nhiing ngoén ngit
bac cao va cdc dicu khién sit dung trén s6 liéu, déng thai ciing 13 mot ngudn cung cap
st 14m ldn thong thudng xdy ra v6i cong nghé co s dit lieu phan tan.

Mot vén dé lién quan cin ban la kha ning ctia cdc hé théng quén Iy théng tin nham
cung cdp cho ngudi sl dung cu6i cling nhiig dich va va cong cu nham khuyén khich
ngudi sir dung cudi cung hoat dong sdng tao khéng quan tam dén céc kiéu loai truy cip
s6 Jigu cha co s& dif liéu.

Sur ket hop co s dit ligu GIS voi cdc hé théng bén ngoai 1a mot phan quan trong cua
giai doan thiét k€ co s dit liéu, 12 phuong phdp s dung ngudn thong tin hién c¢6 trong
céc h¢ thdng hoat dgng hién tai. Céc hé théng va céc File nay thon g thuong gén lién véi
cdc h¢ théng bén ngoai ma ching dugc tao ra tir nhiing 1ng dung hién cd, nhu cdc ban
ghi dat dai, theo déi sir dung dat, mang lu6i nude thai, mang ludi théng gié, cic cong
trinh xay dung v.v...
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Tir goc d6 chia ngudi sir dung, mong mudn loai bd sy khic biét giita méi trudng hé
théng thong tin dia 1y va phi h¢ théng thong tin dia Iy va toan bo kha nang cha céc he
th6ng nén duge sir dung trong moét phuong thiic théng nhat. Trong thuc t€, sur hop nhat
thudng duge thyc hién theo timg giai doan cn thiét. C6 hai phuong phap cho sut két hop
dir liéu: Sao chép File va lién két truc tiép t¢i hé théng hoat dong (mang méy tinh). Sao
chép File la mc}E phuong phép chung don gian nhat dé lién két véi s6 liu bén ngoai, né
cung ¢dp mot giai phap truy cap sé liéu khong doi hoi su thay déi nao trong hé théng
san xudt. Tuy nhién, phuong phdp niy khong tr dong héa dé tuan tha sy két hop dit
ligu, mot tap hop céu tric cao cac tha tuc phdl dugc phat trién tir ngudi sit dung dé bao
dam sy 6n dinh dit liéu.

Sur két hop truc ti€p lien ket t6i cic hé thong hoat dong van con hiém c6, nhig khé
khin nam trong sy khéc nhau giita moi trudng tinh toan ciia hé thong théng tin dia 1y va
caa cdc h¢ théng hién c6. Hé théng thong tin dia 1y s& dugc c4u hinh tai khi cai dat dé
nhan biét tén File vi khéa truy cap cho méi File bén ngoai. Ngudi sir dung sé& c6 thé
truy cap thong tin méi nhét trong cdc File nay théng qua hé théng thong tin dia 1y.
Tham chi, néu sy k&t hop truc tiép trd nén binh thudng mot sé van dé chinh vin con
phai luu tam:

- Théong thudng ngudi sir dung cdn céc File "Frozen" (tuoi) tai thdi diém tra ctu
thong tin.

- Viéc thye hién cdc thao téc truy nhap hé théng phai dugc xdc minh tir viec thém
van diéu tra thdm quyén cla ngudt truy cap.

- Su két hop m6i hodc su thay déi cic ing dung quan trong trong hé théng phai dam
bio ring co sd dir liéu va ban dé déi méi dugce phéi hop véi nhau.

- Sy théng nhat hé théng thong tin, ban quyén dir iéu va tich hgp. Su théng nhat hé
thong 12 phai bao t6n khi ti€p tuc chuong trinh quan 1y he thdng thong tin. N6 khong
thé tr nén mot van dé ngoai, dac biét 13 khéng phai diéu khoan gid thanh nhat dinh cta
h¢ théng théng tin dia ly. Cdc t6 chiic lien tuc cai ti€n chat luong dit liéu va hién trang
dir liéu, gia thanh 1a ngudi kiém sot sy k&t hop moi thay ddi véi so d6 bio tri hoéc thay
th€ cia.cic hé théng hién co6.

Céc heé théng théng tin c6 mot s6 ngudi st dung va nhu 13 mot quy luat, cdc co quan
khdc nhau ¢6 trich nhiém vé cdc théng tin khdc nhau lwu giir trong mot hé théng chung.
Ngudi sit dung chinh ciia mot co s& dif liéu 6 trdch nhiém vé d6i méi s liéu. Nhimg
ngudi sir dung khdc cin phai ¢6 quyén ty do truy cap dén cac dif lidu ndy va kha nang
ket hop thong tin tr mot loat cdc ngudn tai nguyén cho céc muc tiéu gidi tich, khong
quan tdm dén nguén thong tin géc.
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Mot huéng quan trong trong quy hoach quan ly thong tin I viéc quyét dinh théng tin
nao duge tich hgp. Tir d6 phai bao tri trong mot phuong cach phdi hop va thong tin nao
1a cta tap thé va clia c4 nhan?

Céc thil tuc nén dugc xdc dinh cho viéc bao tri thong tin 1éng hop dé bao dam su
twrong tng dinh nghia t6t nhat céc dit liéu di thu thap hoac chu trinh ddi méi.

Moi trudmg tinh todn lién két khong ¢6 nghia 12 mot méi trudng may tinh tap trung.
N6 1a mot qué trinh xir Iy gidi quy&t quyén s& hitu s§ lidu va cdc van dé truy cap theo
cach thic hiéu qua nhat, chi dinh ngudi st dung, x4c dinh va theo dbi viéc bdo tr dir
lieu & mic lien hop véi nhau. Khi su két hop khéng duoc xéc lap, cong nghé hé thong
thong tin dja Iy van con bi mao hiém vé sy ¢6 l4p tir cdc muc dich tdng thé quan 1y céc
nguén tai nguyén thong tin.

Tao ra va chuyén déi co s& dif liéu ban dé. Viéc xt ly s& liéu ban d6 nhap vao tir mot
tap hop cdc tu liéu goc thong thudng duge 1a chuyén déi s6 lieu hoic xay dung mot co
30 dif liéu ban d6, cdc ban d6 thit cong duge chuyén sang ban d6 s6. Chat luong kiém
tra thoa man mot loat cdc phuong phap khédc nhau vé chuyén ddi dir liéu khong thé dua
ra mot sn pham chat lugng cao hon tr ligu gdc va céc tu lidu g6c chat luong kém phai
duge "chai chudt” trudc khi chuyén déi. Do vay, cdc ban d6 s6 xay dung va lién quan
dén nghien ciru chat lugng clia cdc ban d6 di ¢ thudng duoc chi dao xir 1y kha t6n kém
va kéo dai nham cai tién chat lugng cta tu ligu nhap vao. Déi khi, vai noi phai ti€én hanh
do dac va do dac lai trudc khi chuyén déi dit ligu . Nhitng noi doi héi dién tich l6n thi
nén diing xir 1y s6 héa 1ap thé (Stereo digitizer) dé chuyén déi 4 liéu do dac thing sang
khuén dang sd.

Nhom cdc thong tin dia 1y cdn thu thap phai thong nhat trén cde mitc yéu cdu vé do
chinh xdc trude khi lya chon phuong phdp tao ra mét co s& dit liéu s6. Vin dé dé chinh
xdc lam diéu ding (4t ca nhitng ngudi cin phii thda man né trong cong vide. Cic ing
dung khédc nhau yéu cdu céc tiéu chudn d6 chinh x4c khéc nhau. Vi du cédc k¥ su phdt
trién mo hinh du bdo mua bio ddi hdi mic dé cao hon vé do chinh xac clia ban d6 co s&
hon 13 cong viéc quy hoach diéu phéi sy phat trién kinh t€. Mitc do do6 chinh xdc va ti 1&
ban do khéng déng nhat khéng chi véi dia phuong ma con gilra ba mirc: nha nudc,
nganh va dia phuong. Cdc tiéu chudn nha nuéc duoc ban hanh trong cdc quy pham vé
cdc tiéu chudn dé chinh x4c ban d6 qudc gia. Tuy nhién mbi nganh déu cé thé ¢6 cac hé
théng tieu chuén vé do chinh xdc do dac riéng clia minh trong khuén khé tiéu chudn
quoc gia.

C6 ba nhém chudn quéc gia vé s6 liéu ban dé s5. Tuy nhién, cac dia phuong quan
tam dén viéc thu duge mitc do can thigt vé do chinh céc phai duoc thic ddy khong chi
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v6i cdc tiéu chudn ctia nganh hay nha nudc ma con phai xdc 14p mot co sd thong tin xéc
thue va chat lugng cao, tir d6 dé€ trg gitip quyét dinh.

5. Mang may tinh va cong nghé GIS

Mang cuc bd (Local Area Network - LAN) duge diing nhiéu nhit véi cong nghé hé
thong thong tin dia ly. Mot mang LAN 1a mot nhém cdc mdy tinh clia nhiéu ngudi st
dung, cédc tram lam viéc va cdc LAN nodes (Terminal) duoc lién k&t véi nhau bang mot
thié€t bi tin hoc truyén tai s6 lidu nhanh (High Speed) trong moét tod nha hay mot lanh
thd xdc dinh. Cong nghé LAN rat phi hgp v6i cdc khé nang lién két mang clla cic may
vi tinh. Trong lién két mang mdy tinh cuc bo hién nay ngudi ta chl y&u sit dung cac do
hinh sau day:

- D6 hinh sao hoic cay (Star);
- D6 hinh vong (Ring);
- D6 hinh tuyén tinh (Linear).

Mang LAN ¢6 kha nang cho phép mot mdy tinh ¢6 thé gin néi cdc mdy khic qua
mot giao dién xdc dinh. LAN cho phép mot méi trudng tinh todn, 1am viéc khéng déng
nhdt (heterogeneous) théng qua cdc chudn, boi vi thong thudng hé théng thong tin dia
1y duge xay dung tir nhiéu nha san xudt, tir cic phdn cimg va phdn mém khac nhau. Cac
chudn tinh todn cho phép cdc nha sn xut tao ra céc san phdm canh tranh nhimg tuong
tich v&i nhau. Céc chudn cho phép chuyén mén héa nén san xuat va cung cdp mot giao
dién thong minh giita cdc thanh phan cia mang.

Mang mdy vi tinh dugc xay dung trong mét 16p Kién triic phdn mém diéu khién, né
12 mot cdch thiét k& phan mém trao déi dit liéu chudn héa. Lép phan mém didu khién
mang 1a mét chitc nang truyén thong théng tin doc 14p véi céc chiic nang khic. Chudn
chinh thiic trong mang 1& m6 hinh ISO/OSI (International Standards Organization/ Open
System Interconect). Kién triic khach chi (Client - Server) thudng diing trong cdc mang
v6i co sd dif liéu phan tdn. Mot trong nhitmg van dé quan tam nhat hién nay trong viéc
ng dung he théng théng tin dia Iy vao méi trudng 16 hop (Enterprise Environment). He
théng mdy tinh t6 hop duge dac trung bdi su luu giit tap trung tap hop thong tin rit 1on.
Nhimg théng tin niy ludén duoc sit dung trong t6 hop, do vay phdi ¢é phuong phap 6
chitc thong tin t6i wu. Thong thudng viéc tinh todn xit Iy trong t6 hop duge thuc hién
trén mot bd x(r 1y trung tam 16n hodc mdy tinh Main Frame vi duoc dat tap trung mot
ché goi 13 trung tam dit lieu, cic trung tam dir liéu d6 cung cép cho céc co quan sir dung
thong tin kha nang xir Iy déng thoi véi t6c do truy cip cao dén moi co s dit licu 16n da
tich hop. Trong kié€n tric ciia mdy tinh trung tam dir liéu, ngudi sir dung truy cap dir liu
bang cdch chay cac chuong trinh thuc hién tréen CPU clia mdy Main Frame. Ngudi su
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dung dung céc Terminal dé chuyén ddi va thu nhan dit liéu tir hé théng trung tam. D6 1a
mo6 hinh xu 1y dift li¢u tap trung. Mac di, cdc dit liéu duoc luu giir tap trung nhung ngudi
s dung van ¢6 the truy cap thong tin & nhitng diém céch xa trung tam théng qua cic
thi¢t bi ngoai vi. M6 hinh tap trung nay cho phép lam tang khi nang xur 1§ s6 lidu bang
cdch tang kha nang clia mdy tinh trung tam.

Ngay nay cong nghiép mdy vi tinh, tram 1am viéc dé ban (Desktop-Workstation),
cong nghé mang, cdc mdy tinh Server v.v... d& dua ra mét huéng khéc trong viéc thuc
hién x\t ly dir lieu t3 hop. Nhimng hé thong mé nay (Open System) cho phép ta xay dung
nhitng m6 hinh xr 1y phan t4n, nhiéu méy tinh c6 thé lam viéc ciing mot liic, ting hiéu
qua kinh t€ va gid thanh thiét bj giam di dang ké.

Thé nao la mot hé théng mdy tinh phan tdn? Mot hé may tinh phéan tan 1a mdt tap
hop cdc mdy tinh rai réc va duge n6i v6i nhau bing mét mang truyén tin. Céc dia tir,
may in, mdy vé& va céc thiét bi ngoai vi duge tich hop lai théng qua mang. Ngudi sir
dung (User) truy nhap vao mang bing mot cong nghé theo nhu cau cia ho, toan bd cic
may vi tinh, tram lam viéc, Host va Terminal déu c6 thé ding chung dugc. Mang cho
phép cdc mdy tinh kha nang tao ra mot 6 hop dit liéu trén may chir. Trong méi trudng
mdy tinh phén tdn, méi mét mdy tinh clia mang dugc phan chia phuc vu cho cic nhiém
vu xdc dinh. Tram lam viéc tro gitp nang luc xir Iy cha mdy tinh 16n va véi céc g130
dién do hoa stt dung tam cho viéc sit dung méy tinh dé dang hon. May chu tro gidp truy
cap vao cdc nguodn tai nguyeén tich hop nhu dia ciing, thiét bi d6 hoa in ra, cdc mdy chi
Server ¢6 bg da xit ly (Multiprocessor) s& cho phép tdc do trao déi cao va dé dang nang
cap khi cén thiét.

Hé phan tén 1a mét mang mdy tinh dugc céu thanh tir cdc thiét bi phan cimg va phén
mém vé mang, cdc mdy tinh nGi ghép vdo mang va cdc thiét bi ngoai vi dugc néi véi
hodc médy PC hoac truc ti€p vao mang. Néu cac mdy tinh duge ghép ndi & trong mot toi
nha hodic mét dia di€m duge goi 1a LAN. Néu hai hay nhiéu mang LAN dugc néi véi
nhau bang cong ngh¢ truyén thong théng tin trén khoang céch 16n théng qua cong nghé
song ngan, vé tinh, dién thoai .v.v... ta goi la WAN (Wide Area Network).

Cdc thanh phan quan trong ctia phdn mém diéu khién mang trong moi trudng GIS
phan tdn ¢6 thé nhu sau:

- He théng phén tén tap tin (File) cho phép céc mdy tinh sir dung dif lidu trén céc dia
tir clia cdc mdy khdc trong mang.

- Chuong trinh diéu khién, lién lac, lién két giita cdc may tinh.

- He thong phan mém quén tri diing kiém so4t cdc hoat dong ctia mang.
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- Hé thong dich vu cho phép ph6i hop mang truy cap t6i cic thiét bi dau ra da tich
hop trong mang.

- Hé théng dich vu chi dao su giao luu dir lidu trong mang dén céc thiét bi theo nhu
ciu can thiét.

- He théng dich vu diéu phéi su truy vao mang doc 1ap ciia nguoi str dung.

- Céc chuong trinh tng dung khéch/chu cho phép phan bé cac bai todn cla ho trong
cac may tinh trong mang.

vi DU SO PO MANG MAY TINH TRONG GIS
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Phan It
SU DUNG PHAN MEM MAPINFO

Chuong I
CAI PAT MAPINFO

I. NHONG YEU CAU CUA HE THONG

D€ dam bao cho phin mém Desktop GIS Maplnfo Ver 4.0 c6 thé chay én dinh trén
mdy vi tinh, trudc khi cai dit phan mém chiing ta phéi chdc chin dim béo duge céc yeu
cau sau day:

- B nhé mdy tinh: T6i thi€u c6 4 Mb RAM (khuyén cdo nén c6 8 Mb);

- Dung luong dia cing: Phdn mém Maplnfo Ver 4.0, san xudt niam 1995 chi€m khoang
25 Mb dung lugng dia ciing cho céc chuong trinh ttng dung va cho phén céc dit liéu vi du
chi€m khoang 7.5 Mb. Vi vay, tru6e khi cai dat phin mém phai d4m bao chic chén ring
trong dia cing cd t6i thi€u it nhat 33 Mb dung lugng khéng gian dia con trong.

- Man hinh: Can c6 man hinh VGA hoic cdc man hinh c¢é do phan gi4i cao hon.

- Moi truong he théng: Doi hdi moi trudng hé théng 1a Windows 3.1 hodc cao hon.

II. CAI PAT MAPINFO VER 4.0

1. Ndng cdp phan mém Maplnfo dd cai dit trudc thanh Maplnfo Ver 4.0

Néu trong mdy tinh di cai dat phn mém Maplnfo Ver 3.0 thi chiing ta c6 thé nang
cap ching thanh Maplnfo Ver 4.0 theo hai cch sau day:

- Cai ddt phan mém Maplnfo Ver 4.0 vio mot thi myc khée véi thu muc chita phan
mém Maplnfo Ver 3.0 d4 cai dit tir true. Nhur vay, trén mdy chita hai the hé ciia phan
mém Maplnfo, chiing ta ¢6 thé chay ching doc lap véi nhau hoic néu khong can thi
x6a thu muc chita thé hé Maplnfo Ver 3.0 td di.

- Cai dat phan mém Maplnfo Ver 4.0 vio cling thu myc chita thé hé¢ Maplnfo 3.0 di
cai dat tir trudce, khi d6 cdc chuong trinh tng dung ctia Maplnfo Ver 4.0 s& ghi dé lén
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Maplnfo Ver 3.0, trong trudng hop nay khi cai dat s& thady mot loat cdc thong bdo trén
man hinh vé "OverWrite" céc tap tin va khi dé ching ta s& chon OK dé€ tiép tuc thue
hién viéc cai dat.

2. Cai dat Maplnfo Ver 4.0 tir dia mém

Céc chuong trinh clia phdn mém Maplnfo Ver 4.0 duge chita trong 11 dia mém 1.44
Mb, d6 1a cdc File duge cit tich ra tir File chuong trinh géc trén dia CD - ROM va cdc
budc cai dat duge thue hién nhur sau:

- Sao chép toan bo 11 dia chuong trinh vao mot thy muc va ding trinh néi File dé
ghép cic File di cat tdch ra MI400.* thanh mét File (c6 thé ding NC 5.0) véi tén la
MI400.001 (vi du thu muc C:\Map)

- Chay chuong trinh Windows;

- Chon Run trong thue don File cia Windows, sau d6 bam niit Browser va chon thu
muc chita chwong trinh néi trén;

- G6 c\map\setup vao héi thoai Command Line va dn phim Enter;

- Nhap hod#c khing dinh tén clia thu muc chita chuong trinh Maplnfo Ver 4.0. Thu
muc ngam dinh 1a C:\Mapinfo. Néu chiing ta muén thay déi thu muc ngam dinh thi hay
g6 tir ban phim tén cla thu myc mdi réi sau d6 &n Enter. Trén man hinh s& 14n luot hién
ra thong bdo v€ tén ngudi sit dung, co quan sit dung va s6 hiéu phin mém, ching ta chi
can nhap tén ngudi sir dung va sau dé an Enter dé tiép tuc.

- Khi cai dat xong Maplnfo Ver 4.0 s& c6 thong bdo trén man hinh vé dang ky ban
quyén, chon Exit va sau d6 s& ¢6 thong bdo cho biét da hoan thanh viéc cai dat chuong
trinh, chon OK d¢ khang dinh két qua cai dat da thanh cong. Hé thdng sé& tu dong tao ra
bi€u twong clia chwong trinh Mapinfo 4.0 trong cita s8 cfia trinh diéu khién File,

Céc s0 lieu vi du miu dugc cung cdp boi ban hing s& tr dong cai dat vao he théng
trong thu muc con\ Data trong thu muc chita chuong trinh.

Trong qud trinh cai dit n€u cé van d€ gi vé ky thuat vi khé gidi quyét ching ta ¢6
thé lién hé vdi ban hing theo s6 Phone 800 - 552 - 2511 hoiic yéu ciu sy gitip d& cua
cac chuyén gia vé Mapinfo.

3. Cai dit Maplnfo Ver 4.0 tir dia CD-ROM

Cac thu tuc cai dit Maplnfo tir dia CD-ROM ciing twong tu nhu viéc cai dat né tir dia
cung trén va c6 phin don gian hon. Céc budc tién hanh nhu sau:

- Chay chuong trinh Windows;

- Chon Run trong thurc don File cia Windows:

- Cho dia CD-ROM chifa chuong trinh MaplInfo Ver 4.0 vio 6 dia CD (vi du é D:);
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- Gb D:Setup vao Héi thoai Command Line va 4n phim Enter.

- Nhap hodc khang dinh tén ctia thu muc chita chuong trinh Mapinfo Ver 4.0. Thu
muc ngam dinh 14 C:\Mapinfo. Néu chiing ta muén thay déi thu muc ngdm dinh thi hay
g0 tir ban phim tén cha thu muc mdi réi sau d6 dn Enter. Trén man hinh s& 14n luot hién
ra thong bdo vé tén ngudi sit dung, co quan st dung va s6 hiéu phan mém, ching ta chi
cin nhap tén ngudi sir dung va sau d6 4n Enter dé tiép tuc.

- Khi cai dat xong Maplnfo Ver 4.0 s& c6 thong bdo trén man hinh vé dang ky ban
quyén, khi d6 chon Exit va sau dé s& ¢6 théng bdo da hoan thanh viéc cai dat chuong
trinh, chon OK dé€ khang dinh k&t qué cii dit di thanh cong. Hé¢ thong sé tu dong tao ra
biéu tuong clita chuong trinh Mapinfo 4.0 trong cira s6 clia trinh diéu khién File.

Sau khi hoan thanh viéc cai dat chuong trinh, c6 thé chay phdn mém Mapinfo 4.0
tryc ti€p tir biéu twong chwong trinh di tao ra hodc tir chic nang Run trong trinh diéu
khién chuong trinh ctia Windows (Windows Program Manager).

Ghi chii: Sau khi cai dat xong phdn mém Mapinfo trong File WIN.INI trong thu mue
Windows s& duoc tr dong thém mot phan cdc tham s6 diéu khién cho chuong trinh

Mapinfo. O day chi giai thich mot s6 tham s& quan trong chia chuong trinh va ¢6 thé
bién tap duge khi cdn:

- DDeTimeout = number. Gi4 tri number = 10000 14 ngdm dinh, day 1a tham s6 diéu
khién thdi gian trao déi ctia Maplnfo v6i DDE cua Windows.

- OffscreenBitmap = number. Gi4 tri number = 0 hodic number = I, ngim dinh 14 1,
day la tham s6 diéu khién xir Iy man hinh khi hién thi cta Maplnfo. Gid tri bang 0 chi
thi cho Maplnfo khong xit ¥ man hinh va gi4 tri bang 1 chi thi cho Maplnfo xit 1¥ man
hinh déng thoi véi viée hién thi thong tin khi vé ching trén man hinh.

- MaxFiles = number. Gi4 tri number nim trong khoang tir 10 - 100, tham s6 nay chi
ra 56 tap tin t6i da ma Maplnfo c6 thé lam viéc ddng thoi. Ngdm dinh number = 29.

Vé nguyén tic phan mém Maplnfo khong doi héi phai c6 bo déng xir ly toan hoc
(Math Coprocessor) nhung @€ 1am tang t6¢ do tinh toan cling nhu viéc thé hién théng
tin ta nén ¢6 con chip d6 trong may tinh va c6 thé dung card tang t6¢ man hinh (Video

Accelerator card) ciing nhu card truy cap dia ciing nhanh dé nang cao t¢ do hién thi
théng tin ctia Mapinfo.
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Chuong 11
TO CHUC THONG TIN VA THUC PON TRONG MAPINFO

L TO CHUC THONG TIN BAN PO TRONG MAPINFO

1. Té chirc théong tin theo cdc tdp tin

Mapinfo 1a mét phidn mém hé théng tin dia 1y GIS cho giai phdp mdy tinh d€ ban
(Desktop Solution). Cac thong tin trong Mapinfo dugc 16 chitc theo timg bang (Table),
méi mot Table 12 mot tap hop cdc File v& thong tin do hoa hoac phi dé hoa chita céc
ban ghi dit liéu ma hé théng tao ra. Ching ta chi c6 thé truy nhap vao cdc chirc nang cua
phdn mém Mapinfo khi di md it nhat mot Table. Sau day chung t0i € gidi thiéu vé cg
c4u 18 chifc. thong tin cha cic Table, toan bo cic Mapinfo Table ma trong dé ¢6 chita
céc d6i wong dia 1y duge td chiic theo cac tap tin (vi du: tt 12 tén cia Table bat ky):

+ tt.tab - Chifa cdc thong tin mo ta c4u tric di liéu, d6 1a File & dang van ban mo ta
khuon dang cua File luu trit thong tin. '

+ tt.dat - Chifa cac thong tin nguyén thiy, phan m& rong cla tap tin nay ¢ thé 1a
* wks, dbf, xIs néu chiing ta 1am viéc véi cdc thong tin nguyén thily 12 cdc sO liéu tir
Lotus 1-2-3, dBase/FoxBase va Excel.

+ tt.map - Bao g6ém cdc thong tin mo ta cic d0i tugng dia ly.

+ tt.id - Bao gbm céc thong tin vé su lién két giita cdc d6i tuong voi nhau.

+ tt.ind - Chia céc thong tin vé chi s6 d6i tugng. Tap tin nay chi cé khi trong céu
tric ctia Table di cé it nhat mot truong (Field) dif liéu da duge chon lam chi s6 héa
(Index). Théng qua cdc thong tin cua File nay chiing ta ¢6 thé thuc hién tim ki€m thong
tin théng qua mét chi tiéu cho trude bang chitc ning Find cia Mapinfo.

Khi chiing ta muén t6 chitc quan Iy va uu trlt téng hop cdc Table hoac céc cita s6
thong tin khéc nhau clia Maplnfo vio chung mot tap tin va cic mdi tuong quan giita cac
d6i twong d6 phai duge bao tén nhu khi tao lap, tap tin quan 1y chung d6 duoc goi 1a
trang lam viéc (Workspace) va n6 ¢6 phin md rong ngam dinh la *.wor.

2. T4 chitc thong tin theo cdc 16p doi tuong

Céc thong tin ban d6 trong cdc phdn mém GIS thudng duge t6 chifc quan 1y theo
timg 16p d6i tugng. Hay hinh dung ring trong mdy tinh clia chiing ta m¢t manh ban do
mady tinh 13 su chéng xép clia c4c 16p thong tin 1én nhau. M6i mot 16p thong tin chi thé
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bién mot khia canh cha ménh ban dé téng thé. Ldp théng tin 1a mét tap hop céc d6i
tugng ban dé thudn nhat, thé hién va quan 1y cc d6i tong dia 1y trong khong gian theo
m¢t chii d€ cu thé, phuc vu mét muc dich nhat dinh trong hé thong. Trong Mapinfo
chiing ta c6 thé coi méi mét Table 1a mot I6p d6i trong (Layer). V6i cach t6 chiic thong
tin theo timg 16p d6i tugng nhur vay da gidp cho phdn mém Maplnfo xay dung thanh céc
khéi thong tin doc 1ap cho cdc méanh ban d6 mdy tinh. Didu d6 s& gip chiing ta thanh
1ap céc ban d6 mdy tinh linh hoat hon theo céc cach tap hop lép thong tin khac nhau
trong hé thong. Dé dang thém vao manh ban dé di c6 cic 16p thong tin méi hoac xda di
cac 16p doi tuong khi khéng cén thiét,

Cac doi tugng ban d6 chinh ma trén co s& d6 Maplnfo s& quéan 1y, triru tugng hda cdc
doi tuong dia 1y trong thé gidi thuc va thé hién ching thanh cic loat ban d6 mdy tinh
khac nhau la:

+ Doi turong ving (Region) - thé hién c4c ddi trgng khép kin hinh hoc va bao phil
mot viing dién tich nhat dinh. Chiing c6 thé 1a c4c Polygons, hinh ellipse va hinh chit
nhat. Vi du: lanh thé dia giéi mot x3, hé nude, thira dat, khu rimg .v.v...

+ D6i tuong di€m (Point) - thé hién vi tri cu thé clia céc d6i tugng dia 1y, vi du nhu
cot ¢&, di€m ban xang, .v.v...

+ Doi tugng dudng (Line) - thé hién cdc d6i tuong khong khép kin hinh hoc va chay
dai theo mét khodng cdch nhat dinh. Chiing ¢6 thé 1a c4c dudng thing, cdc dudng gip
khiic va cdc cung. Vi du: dudng phé, séng susi, v.v...

+ D61 tuong chir (Text) - thé hién cdc d6i tugng khong phai 1 dia ly cia ban d6 nhu
nhdn, tiéu dé, ghi chd .v.v...

3. Su lién két thong tin thugc tinh vé6i cdc d6i tuong bdn do

Mot dac di€m khac biét clia cdc thong tin trong GIS so v6i cdc théng tin trong cédc hé
d6 hoa may tinh khéc 1a su lien k&t chat ché, khong thé téch rdi gita cdc thong tin thuoe
tinh véi cdc d6i twong ban d6. Trong co cdu t§ chic v quan ly clia co s& dit lieu
Maplnfo s&€ dugc chia 1am hai thanh phdn co ban: co s& dif liéu thuoc tinh va co s& dir
liéu bdn d6. Cac ban ghi trong cic co s dir licu nay duge quan 1y doc lap véi nhau
nhung duge lign két v6i nhau théng qua mét chi s6 ID, duge lwu trir va quan 1y chung
cho ¢4 hai loai ban ghi néi trén, Cic théng tin thude tinh thé hién néi dung bén trong
chia cdc d6i tuong ban dé va ching ta c6 thé truy cap, tim ki€ém thong tin cin thiét thong
qua ca hai loai dit liéu. '

IL THUC PON VA CAC CHUC NANG CO BAN CUA MAPINFO 4.0

1. Lam quen v6i phdan mém Mapinfo 4.0

Chiing ta c6 thé khéi dong goi phan mém Maplnfo truc tiép tir bidu tuong thuc don
cta chuong trinh hodc gidn tiép tir dong lénh Run trong cira s cia man hinh quan 1y
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chuong trinh Windows (Program Manager). Sau vai gidy, trén man hinh s& hién thi ra
biéu twong ctia phan mém va sau d6 1a mot cira s6 hop hoi thoai nhanh (Quick Start
Dialog) nhu sau:

Quick s'n 5

. C ' ;ﬂpen Laxt Used Workspace :

;.BAHD D\fN WDFI

G 0 pen a "w'olkspace

C! Dpen a Tahle

Hop hoi thoai nay c¢6 céc chitc nang sau:

- Restore Previous Session (khoi phuc lai tinh trang lam viéc truéc day). Néu chon
chiic ning nay va sau dé6 bdm chon OK thi trén man hinh s& hién thi toan bd nguyén
trang thong tin ma trudc d6 ching ta da thuc hién trude khi thodt khéi chuong trinh
Maplnfo.

- Open Last Used Workspace (mo trang lam viéc st dung 1an cudi cung). Néu chon
chiic nang nay va sau dé bam chon OK chiing ta s€ thuc hién mo lai trang lam viéc da
st dung 1an cudi cung trudc khi thoat ra khoi Maplnfo.

- Open a Workspace (mo mot trang lam viéc da c6). Néu chon chiic nang nay va sau
dé bam chon OK man hinh s& hién ra hop héi thoai mé File cia moéi truong Windows
khi d6 chiing ta s& thuc hién chon tén clia trang lam viéc va chon nit Open dé md trang
lam viéc da chon.

- Open a Table (m& mot bang thong tin da c6). Néu chon chic nang nay va sau dé
bdm chon OK man hinh s& hién ra hop hoi thoai mo File cia moéi trudbng Windows khi
d6 chiing ta s& thuc hién chon tén ctia Table va chon niit Open dé m& Table da chon.

Néu khong muén truy nhap vao cic chitc nang trén cua hop hoi thoai nhanh thi
chiing ta c6 thé bam chon nit Cancel dé tré vé man hinh thuc don cla chuong trinh
Maplnfo.
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Maplnfo Professional - [BANDO4 Map]
Query Table Options Map Window Help

File Edit

Objects

Trong man hinh nay chiing ta thay:

- Thanh tiéu d¢ clia chuong trinh & vj trf trén ciing;

- Ti€p theo la thanh thuc don chinh clia chuong trinh;

- Ti€p theo la bi€u tugng thuc don chinh cha chuong trinh;

- Phia du6i man hinh 12 thanh trang thi;

- Hai hop cong cu thuc don trong cira s6 man hinh (Main va Drawing).
2. Lam quen v6i thuc don ciia hé thong

+ Thuc don File:

- New Table. Tao ra mot 16p thong tin mdi.

- Open Table. M& mot 16p thong tin di c6.

- Open ODBC Table. M6 mot 16p thong tin trong dang ODBC di c6.
- Open Workspace. M& mot trang lam viéc da cé.

- Close Table. Déng mot 16p thong tin dang mo.

- Open All. Péng moi 16p théng tin dang mo.
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Save Table. Ghi mot 16p thong tin dang md vao dia tir.

Save Copy As. Ghi mdt 16p thong tin dang mo vao dia tir véi tén Khéc.

Save Workspace. Ghi mot trang lam viéc dang md vao dia tir.

Save Window As. Ghi hinh 4nh ctia mét ctra sé thong tin dang md& vao dia tir dudi
dang File anh.

- Revert Table. Bao toan nguyén trang mot 16p thong tin dang mo.

- Run MapBasic Program. Thuc hién mét trinh ng dung viét trong ngon ngir MapBasic.
- Page Setup. Cai dat trang gidy cua thiét bi in.

- Print. Thuc hién in cdc thong tin ra thi€t bi in.

- Danh séach cac 16p thong tin da mo tir trudce.

- Exit. Thoét ra khoi chuong trinh.

Maplnfo Professional - [BANDO4 Map]
Query Table Options Map Window Help

Edit

Objects

" New Table... Cul+N
Open Table... Ctrl+O
Open Workspace... Ctrl+A _ e
Close Table...
Close All

Save Copy As...
Save Workspace...
Save Window As...

Run MapBasic Program... Ctrl+U

Page Setup...
Print... Ctrl+P

. CAMAPINFO\BANDOA.TAB

. CAMAPINFO4/\WORKSPCS\DCSEAM.WOR
. CANITHUANXA.TAB

. CAMAPINFOAATOOLS\GRIDMAKR.MBX

Exit Alt+F4

=
”
Y

ok

(I [ X

Create a new table.

+ Thuece don Edit

- Undo. Loai bo tac dung ctia cau Iénh trudc do.

- Cut. Cét bo céc d6i tuong di chon.

- Copy. Sao chép céc déi tugng da chon.

- Paste. Dan cédc d6i tugng dang luu trong bo dém clia mdy tinh.
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- Clear. Xo4 céc d6i tugng da chon.

- Clear Map Objects Only. Chi x6a cédc d6i tuong ban dé da chon.
- Reshape. Bt cic dinh ctia d6i tuong di chon.

- New Row. Thém mot ban ghi méi vao 16p thong tin bién tap.

- Get Info. Hién thi hop thong tin dia 1y vé d6i twong da chon.

= r:::\-@ apinfo Profe ONa SANDO4 Map :¢-Z
=| File G Objects Query Table Options Map Window Help 3
mE T ]

Cut Ctrl+X K

Copy Ctrl+C

Clear Del

Clear Map Objects Only

Reshape Ctrl+R

Get Info... F7
Unda the last edit

+ Thucc don Objects

- Set Target. Dat d6i tugng da chon thanh d6i trong muc tiéu.

- Clear Target. Loai bo viéc chon d6i tuong thanh d6i tuong muc tiéu.
- Combine. Téng hop céc doi tugng da chon thanh mot déi tuong méi.
- Split. Phan tach d6i tugng di chon thanh cic d6i tuong mdi.

- Erase. Thuc hién x6a mot phan ctia d6i twong da chon.
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- Erase Outside. Thuc hién x6a mét phan cua déi tugng da chon bén ngoai doi tugng khéc.
- Overlay Nodes. Tao ra diém tai vi tri clia cdc d6i tugng giao nhau.
- Buffer. Tao ra d6i tugng vanh dai clia cdc déi tuong cho trude.
- Smooth. Lam tron déi tugng da chon.

- UnSmooth. Loai bo sur 1am tron clia d6i tugng da bi tidc dung clia chiic nang Smooth.
- Convert to Regions. Chuyén d6i tugng dudng thanh d6i tugng ving.
- Convert to Polylines. Chuyén d6i tuong viing thanh déi tuong dudng.

Mapinfo Professional - [BANDO4 Map]
[(SlJ[3=EW Query Table Options Map Window Help
Set Target Ctri+T F=SIHF o

= .Eilc Edit

Buffer...
Smooth
Unsmooth

Convert to Regions
Convert to Polylines

Specily the selected object(s) as the target for editing.

+ Thuc don Query:
- Select. Cho phép chon cac d6i tugng thong qua céc chi tiéu cho trudc.

- SQL Select. Cho phép chon cic d6i tuong thong qua cic chi tiéu cho trudc va thuc
hién déng thoi viéc téng hop cdc dir liéu thuoce tinh cho céc dit liéu duoc chon.

- Select All from ... Cho phép chon cic d6i tuong trong mot 16p d6i tugng cho trude
dang mo.

- Unselect All. Loai bo su chon toan bo cic d6i tugng dang dugc chon.
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- Find. Tim ki€m cédc d6i tugng theo mét chi tiéu cho trudc.

- Find Selection. Hién thi cdc d6i tuong dang chon vao cira s6 ban d6 hién thoi trén
man hinh.

- Calculate Statistics. Hién thi ctra s6 thong tin tinh todn thong ké.
Man hinh thuc don ctia chitc nang nay nhu sau:

Maplinfo Professional - [BANDO4 Map]
Objects Me[TLLYM Table Options Map Window Help

oo

SQL Sélect...
Select All from BANDOA
Unselect All =

Find... Ctri+F ®is
Find Selection :

Calculate Statistics...

i Creal&é;ﬁiledion by querying tables.

+ Thuc don Table:

- Update Column. Thay déi gid tri clia cdc trudng dit liéu trong Table. Thuc hién lién
ket céc d6i tuong trong céc Table theo trudng dit liéu thudc tinh chung va theo phan bg
dia 1y.

- Append Rows to Table. Ghép n6i cdc ban ghi cua hai Table cé cing céu tric di
liéu thanh mot Table méi.

- Geocode. Thuc hién dia ma héa cc d6i tuong trong Table .

- Create Points. Tao ra d6i tugng diém trén co s& toa do ctia chiing.

- Combine Objects using Column. Téng hgp céc déi tuong dia 1y theo gi4 tri clia cdc
truong dir liéu.

- Import. Nhap céc dir liéu dia 1y trong cdc khuon dang (Format) trao déi dé hoa vao
hé thong.
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- Export. Xudt c4c dit liéu dia Iy trong mét 16p ra cdc khuoén dang (Format) trao doi
d6 hoa véi cdc hé théng khac.

- Maintenance. Thuc don quan 1y va thuc hién céc thao tdc vé Table trong hé théng.
Day la thuc don con né bao gébm cdc chitc nang x4c dinh céu tric dit liéu cho 16p thong
tin - Table Structure, x6a Table, d6i tén Table, déng géi dir liéu - Pack Table va cac
chitic khac vé ODBC Table.

- Raster. Thuc don quan 1y va thuc hién céc thao tic vé cac Table hinh anh trong hé
théng. Thuc don nay cho phép ta thay ddi tinh chat clia File anh g6c va diang ky hinh
anh vao trong ctra s6 ban dé hién thoi.

Maplinfo Professional - [BANDO4 Map]
Objects Query BELIM Options Map Window Help

Update Column...

Append Rows to Table...

4r [ 4>

Geocode...
Create Points...
Combine Objects using Column...

Import...
Export...

Maintenance )
Raster >

Create temporary columns of modify existing columns.

+ Thuc don Options:
- Line Style. Thay d6i thuoc tinh thé hién ctia céc déi tugng dudng .
- Region Style. Thay déi thudc tinh thé hién clia cdc d6i tugng ving.
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- Symbol Style. Thay d6i thuoc tinh thé hién ctia cdc d6i tuong diém.
- Text Style. Thay déi thudc tinh thé hién cla céc d6i tuong chit.

- Toolbars. Diéu khién su hién thi clia cdc hop cong cu thue don.

- Show Legend Window. Hién thi cira sé ghi chu.

- Show Statistics Window. Hién thi ctra s6 thong tin théng ké.

- Show MapBasic Window. Hién thi cira s6 cau lénh clia MapBasic.

- Hide Status Bar. Tat/hién thanh trang thdi clia hé théng.

- Custom Colors. Dinh nghia thém mau mdi va chon mau cho hé théng.

- Preferences. Xéc dinh céc tham s6 chung cho hé théng.

Maplnfo Professional - [BANDOA Map) v
Map Window Help
Line Style... Shift+F8

o

Region Style... Ctrl+F8
Symbol Style... Alt+F8
. Text Style... F8
£ Toolbars...
» ¥4 ShowLegend Window
Show Statistics Window
Show MapBasic Window
Hide Status Bar
Custom Colors... SAMA
Preferences...
bl
Fl=

2

Specify ne color, pattem and width.
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+ Thuc don Window:

- New Browser Window. M& ctra s6 thong tin xét duyét (Browser).

- New Map Window. M& cira s6 théng tin ban dé (Mapper).

- New Graph Window. M4 cira s6 thong tin biéu d6 (Graph).

- New Layout Window. Md ctra s6 tao trang trinh bay (Layout).

- New Redistrict Window. M& cira s6 thong tin phan nhém (Redistrict).
- Redraw Window. V€ lai man hinh.

- Tile Windows. Sap x&p céc cira s6 thong tin dang mo theo cot.

- Cascade Windows. Sap x&p cdc cira s6 thong tin dang mo theo 16p.

- Arrange Icons. Sap x€p céc biéu tuong ciia hé théng vao man hinh hién tai.
- Danh sach cac cura s6 thong tin dang mo.

Maplinfo Professional - [BANDO4 Map]

ery

New Browser Window...

New Map Window...
New Graph Window... Fa

- New Layout Window... F5
New Redistrict Window...

. Redraw Window Ctrl+D

C Tile Windows Shift+F4

Cascade Windows Shift+F5
Arrange Icons
1. BANDOA4 Map

D:splay and manipulate data in tabular format.

+ Thuc don Help:
- MapInfo Help Topics. Goi thong tin trg gitp cua hé théng theo cic chu dé tra citu.

- Maplnfo on the World Wide Web. Goi thong tin trg gitip cua hé théng trén cic
trang Web trong mang Internet.

- About Maplnfo. Hién thi cdc thong tin vé ban hang.
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= T g ap D D oNna BA DO 4 ap -
File Edit Objects Query Table Options Map Window elp

About Mapinfo

oo

Displays Help topics for Maplnfo,

Khi ching ta thuc hién m& cdc cira s6 thong tin trong thuc don Window thi trén
thanh thuc don s& tw dong hién ra cic thuc don vé ching tuong ting nhu:

+ Thuc don Map:

- Layer Control. Goi hop hoi thoai xdc dinh céc tham s6 diéu khién céc 16p trong
hé théng.

- Create Thematic Map. Tao ra cdc ban dé chuyén dé.

- Modify Thematic Map. Bién tap lai céc ban d6 chuyén dé da cé.

- Change View. Thay d6i tim nhin cta cira s thong tin.

- Clone View. Tao ra mét tdim nhin doc 1ap cho mot cira s6 thong tin.

- Previous View. Trd lai tim nhin truéc dé6.

- View Entire Layer. Hién thi toan by n6i dung ctia 16p thong tin trong mot cira sé
xac dinh.

- Clear Custom Labels. Loai bo cdc nhan d6i tuong do chiing ta phét sinh.

- Save Cosmetic Objects. Ghi lai céc thong tin ndm trong 16p trung gian.

- Clear Cosmetic Objects. Loai bé cic thong tin nam trong 16p trung gian ctia hé théng.

- Set Clip Region. Hién thi cilta s6 thong tin ctia d6i twong da phan téch.

- Clip Region On. Phan tich d6i tugng da chon thanh mot cira sé thong tin.

- Digitizer Setup. Cai dat ban s6 hoa.

- Options. Xdc dinh cdc tham s6 diéu khién clia cira s6 ban dé.
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o ap D Profe D

BANDOA4

File Edit Objects Query Table Options

CEREEEER

d

Window Help

Create Thematic Map...

Change View...
Clone View
Previous View
View Entire Layer...

4
4@ 0

Set Clip Region

Options...

Manage map layering and display.

+ Thuc don Browser:
- Pick Fields. Chon céc truong di liéu.

- Options. X4c dinh cdc tham s6 diéu khién cua cira s6 xét duyét.

Mapinfo Professional
Options

File Edit Objects Query Table

I EIETE [ s ) ]

Browse
E Pick Fields...

Window Help

= BANDO4 Map T 2Pons...
- A Bis 3 ro - | &
DIENTICH |DANSO MDDANSO |STT +*
| 0 0 0 0
.| 0 0 0 ol
(I 0 0 0 0
i1 0 0 0 0
3 0 0 0 0
a 0 0 0 0
- 0 0 0 0
L] 0 0 0 o
1 0 0 0 0 Q.
<1 |¢;H

Choose fields that display in the active Browser.

86




+ Thue don Graph:
- Graph Type. Lua chon cic loai biéu dé c6 trong hé théng

- Label Axis. Xac dinh nhan cho céc truc cta biéu dé

- Value Axis. Xéc dinh céc gi4 tri cho cic truc cia biéu dé
- Series.

Mapinfo Professional
[l Window Help

Graph Type... |

Label Axis...

Query1 Graph |4 Value Axis...
Series...

Graph of: Query1

17063

Choose a graph type and specify its associated options.

+ Thuc don Redistrict: .

- Assign Selected Objects. Gan cac d6i tugng di chon cho nhém.

- Set Target District from Map. Xé4c dinh nhém muc tiéu tir cira sé thong tin ban dé.
- Add District. Thém mo6t nhém.

- Delete Target District. Loai bo nhém muc tiéu.

- Options. Xac dinh céc tham s6 diéu khién cta ctra sé phan nhém .
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Maplniu Pmlessinnal

Set Target District from Map |—
=2 v A @ 1k
e Add District -
o D Browse v Delete Target District W
DIENTICH | Count|Line _|# Opiions.. fd

[ 158 =
({17069 |—F
D 7500  § e B
(] 14468 e
OJ| 5800 1|—
() 8445 1
OJ| ate7 1
| 6494 1
O] 183t 1 3
& »

+ Thuc don Layout:

- Change Zoom. Thay déi tim nhin ctia trang trinh bay.

- View Actual Size. Hién thi trang trinh bay theo kich thuéc thuc.

- View Entire Layout. Hién thi toan bo noi dung clia trang trinh bay vao mot cira s6
trinh bay.

- Previous View. Tr¢ lai tAm nhin trude cla trang trinh bay.

- Bring to Front. Chuyén déi tugng ctia trang trinh bay vé phia truéc.

- Send to Back. Chuyén déi tugng clia trang trinh bay vé phia sau.

- Align Objects. Can céc d6i tugng cla trang trinh bay.

- Create Drop Shadows. Tao béng cho céc d6i tugng trong trang trinh bay da chon,

- Options. Xéc dinh céc tham s diéu khién cla cira s6 trang trinh bay.
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b A L Maplnfo Professional

File Edit 0b|ects Query Tahle Oglluns [ESINE Window Help
. : = Change Zoom...

{ View Actual Size

View Entire Layout

=

Options...

Trong céc chuo‘ng trinh \ing dung cung cap trong hé théng Maplnfo 4.0 ¢6 3 chuong
trinh rédt hitu ich cho cong viéc clia ching ta, do vay & day s& gidi thiéu céch sir dung
cta 3 chuong trinh d6. C4c chuong trinh vé nguyén tic, cch sir dung cta ching ciing
twong tu nhau, ching ta ¢6 thé ty tim hiéu chiing.

Ching ta vao thuc don File va chon chiic nang Run MapBasic Program, khi dé man
hinh hién ra hop hoi thoai tuong tu nhu khi chon 1énh mé File va chiing ta chon céc File
(GridMaker.mbx, ScaleBar.mbx, CogoLine.mbx) sau khi thuc hién xong céc chuong
trinh trén thi tai thanh thuc don s& ¢6 thém thuc don Tools. Thuc don nay s& dugc luu
lai nhu 1a mot thuc don chinh cta h¢ théng néu chon ché d6 Auto-Load cta it nhat mot
chuong trinh ing dung.

+ Thuc don Tools:

- Run MapBasic Program. Thuc hién chuong trinh tng dung MapBasic.
- Show MapBasic Window. Hién thi cira sé cau lénh clia MapBasic.
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- GridMaker. Tao 6 luéi toa do cho ban dé.
- ScaleBar. Tao ra thang ti 1& cho ban dé.
- Cogoline. V& d6i tugng dudng tir mot di€m véi mot gée va do dai cho trude.

:-g_fbtat' apInfo Professional - [XA Map bt K2

=| File Edit Objects Query Table Options Map RLUIEW Window Help v
it vin. et - el A apBasic Progra

& |E E* : @ Show MapBasic Window 1

GridMaker »

ScaleBar 4

COGOLine »

3. Cdc hop cong cu cua Maplnfo

Trong Maplnfo ¢6 hai hop cong cu chli yéu va chiing hién thi déng thdi véi man hinh
thuc don khi ching ta goi khoi dong phdn mém.

a) Hop céng cu chinh (Main tools box):
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Trong hop cong cu chinh nay y nghia cua cdc biéu tugng theo thit tur tir trén xuéng
dudi va tir trdi qua phai nhu sau:

- Bi€u tugng cong cu chon d6i tuong.

- Biéu tugng cong cu chon cic d6i tuong theo mot cira s6.

- Biéu tugng cong cu chon céc déi tugng theo mot vong tron.

- Bi€u tugng cong cu chon céc d6i tugng theo mot da tuyén khép kin.

- Biéu tugng phéng to cira s6 man hinh.

- Biéu tugng cong cu thu nho clra sé man hinh .

- Biéu tugng cong cu thay déi tim nhin ciia cira s6 ban d6.

- Biéu tuong cong cu dich chuyén man hinh.

- Bi€u tugng cong cu hién thi clra s6 thong tin doi twong.

- Bi€u tuong cong cu hién thi tu dong nhin d6i tuong.

- Bi€u tuong cong cu nhan ban cira sé thong tin ban dé.

- Biéu tuong cong cu diéu khién cic 16p thong tin.

- Biéu tugng cong cu do khoang cich trén man hinh.

- Bi€u tuong cong cu diéu khién hién thi cira s ghi chi (Legend).

- Biéu tugng cong cu diéu khién hién thi cira s thong tin thong ke.

- Biéu tuong cong cu dat nhém d6i tuong dd chon thanh nhém dai tuong muc tiéu
District (bi€u tugng nay chi bat Ién khi chiing ta di mé it nhat mot cira sé District).

- Bi€u tuong cong cu gén d6i tuong District da chon.

- Biéu tugng cong cu hién thi d6i tugng di phan tach thanh cira s8 doc 1ap.

- Biéu tugng cong cu phan téch déi twong chon thanh d6i twong doc lap.

b) Hop cong cu vé (Drawing tools box):

Trong hop cong cu chinh nay y nghia cta cc biéu tugng theo thit fur tir trén xudng
du6i va tir trdi qua phai nhu sau:

- Bi€u tuong cong cu tao d6i tuong diém.

- Biéu tuong cong cu tao d6i twong dudng thing.

- Biéu tugng cong cu tao ddi tuong da tuyén (Polyline).

- Biéu tugng cong cu tao cung tron.
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- Biéu twong cong cu tao d6i tugng viing.

- Bi€u tugng cong cu tao vong tron.

- Biéu tugng cong cu tao hinh chif nhat.

- Biéu tugng cong cu tao hinh chit nhat vat géc.

- Biéu tuong cong cu tao d6i twong chit (Text).

- Bi€u tugng cong cu tao céc khung cira s6 (Frame) trén trang trinh bay.

- Biéu tugng cong cu diéu khién bat/tit cac diém niit ctia d6i tuong.

- Biéu tugng cong cu tao thém diém niit cho d6i twong.

- Biéu tugng cong cu xéc dinh tham s6 thuoc tinh thé hién ctia d6i tuong diém.

- Biéu tuong cong cu x4c dinh tham s6 thudc tinh thé hién cta d6i twong dudng.

- Biéu tugng cong cu xdc dinh tham s& thudc tinh thé hién ciia d6i tuong viing.

- Biéu tugng cong cu x4c dinh tham s6 thudc tinh thé hién ctia d6i tugng chit.

c) Diéu khién tat/bat cdc hop cong cu:

Thong thudng khi khai dong goi phdn mém Maplnfo thi cdc hop cong cu trén da
hién ra trén man hinh mdy tinh (d6 1a lya chon ngém dinh ctia h¢ théng). Néu chiing ta
muén tit ching di khoi man hinh thi c6 thé nhay dip chuot vao mit diéu khién cia cira
s6 hop cong cu hodc bdm chuot vao niit diéu khién r6i sau dé chon Close (twong tu nhu
céc cira s6 trong moi trudng Windows). Chiing ta ciing ¢6 thé chon diéu khién tir thuc

don cua hé thong, vao thuc don Options réi chon ToolBar khi d6 man hinh hién ra hop
héi thoai sau:

Toolbar Options

Drawing
Main
Standard

Chon tén cia hop cong cu cin bat hoic téit rdi sau d6 ddnh ddu hoac loai bé d4nh dau

céc lua chon vao hop kiém tra (Check box) 6 Show hoic 6 Floating néu chiin g ta mudn
di chuyén hop céng cu dé.
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Chung ta cling c6 thé dat ¢6 dinh c4c lua chon diéu khién cac hép coéng cu thanh cic
gia tri ngdm dinh clia hé théng bing cich d4nh diu 6 Save as Default.

Chon 6 Color Button d€ dat mau cho céc mit biéu trang cong cu.
Chon 6 Large Button d€ dat do I6n cho c4c niit biéu tuong cong cu.
Chon 6 Show ToolTips dé hién thi chi giai noi dung cho cdc niit biéu tuong cong cu.

Chon 6 Save as Default dé ghi lai cdc lya chon trén cho céc bidu tvong céng cu thanh
cdc gia tri ngdm dinh.

Sau khi chon xong céc lua chon diéu khién nhép chon OK dé€ thyc hién. Nhap Cancel
dé€ loai b6 va nhdp niit Help dé goi trg gidp.

C6 thé chon cdc hop cong cu trén man hinh va di chuyén né dén vi tri ma chiing ta
muén hogc tit né bang cach nhdp dip vao biéu tugng déng cira 6.
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Chuong 111
CAC THAO TAC CO BAN VOI BANG TRONG MAPINFO

I. LAM VIEC VOI BANG

1. Mo mét Table

Nhu trén ching ta da rd khdi niém vé Table va gia dinh 12 da tao ra céc 16p thong tin
ban dé cén quan ly, luu trit vao mdy tinh theo c4c Table, bay git dé hién thi cdc thong
tin cia Table di cé cin thao tdc nhu sau:

- Vao thuc don File va chon Open Table. Man hinh hién ra mot hop hdi thoai tuong
tu nhu hop hoi thoai md File trong Windows.

- Trong hop hoi thoai d6 chon tén thu muc chita Table ching ta muén ma.

- Trong danh sch cic Table chita trong thu muc di chon ¢ trén ching ta chon tén
ctia Table can mo.

- Bdm chon niit Open.

- s -

~ File N j ies e o |
;.;Z.'-Iamad-tab - c:\mapinfo :
. [Pbandod tab ke 3| LE_“".EEL_
"o bauhoc.tab ..... | P mapinfo -
| bauhoc2.tab = | £ data

bauhoc3.tab e b cod

bauthu.tab (3 mb_code
| docao.tab
| dsong.tab
| duongbo.tab

FleFomst Dives

[nglnio lgl N . E :

R Dispytabloinwindow
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Sau vai giay trén clra s6 man hinh s& hién thi ban d6 thé hién noi dung cac théng tin
irong Table di chon. Ching ta c6 thé thuc hién céc thao tdc nhu trén dé md thém céc
Table khac va khi d6 Maplnfo s& tu dong hién thi thém cic thong tin ctia Table chon
vao clra s6 ban d6 ddu tién néu cic thong tin trong céc Table chiing ta chon cé cung
mot hé toa do khi tao lap, nguoc lai Maplnfo s& tu tao ra mot cira sé ban dé khéc cho
céc Table c6 hé toa do khac nhau.

2. Tao ciia 56 bdn do tong hop tix cdc Table

Khi chiing ta chon va mé it nhdt mot Table thi trén thanh thuc don ctia Maplnfo s& tu
dong thém thuc don Map. D6 1a mot thue don dang Popup, vé chi tiét cia thuc don nay
s€ xem xét k§ sau nay. D€ tao ra ban dé méi tir cdc Table da md ta thuc hién nhu sau:

- Vao thyc don Windows, sau d6 chon New Map Wmdows Man hinh s€ hién ra mot
hop hoi thoai tao ctra s6 ban dé.

- Chon ciéc tén clia Table ma chiing ta muén hién thi tao thanh ban dé téng hop trong
ctra s6 man hinh, sau d6 chon OK.

Trong hop hoi thoai nay t6i da ta chi c6 thé chon dugc 4 16p thong tin déng thoi
chong xép 1én nhau tao ra ban dé téng hop. Néu muén tao ra ban dé téng hop véi nhiéu
16p lhong tin hon thi hay ding mot cdch phd cap nhit 1a: trude hét hdy md va tao ra ban
d6 téng hop ban dau gém 4 16p théng tin dau tién, ghi né lai thanh mot trang lam viéc,
sau d6 vao thuc don File va chon chitc nang Close All dé déng lai toan bo céc 16p thong
tin da mg, man hinh trd lai trang thdi ban ddu. Vao thuc don File va chon chitc nang
Open Workspace va mo tén clia trang 1am viéc vira ghi vao, sau d6 mo ti€p cac Table
khéc cdn dua thém vao ban d6 téng hop, phdn mém Maplnfo s& tu dong gan céc thong
tin trong Table vira m& va trang 1am viéc (lic nay chinh 1a cira s6 ban dé téng hop).

New Map Window

3. Tao cdc biéu dé ciia Table

Céc biéu d6 trong Maplnfo thé hién mat dé hoa ctia cic dir liéu s6 trong céc Table.
Chiing c6 thé 1a dang d6 thi, biéu d6 thanh, biéu dé manh va biéu dé ving. Dé tao ra
mot cilra s6 bi€u d6 ta thuc hién cdc bude sau:
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- Vao thuc don Windows, sau d6 chon New Graph Windows. Man hinh hién ra hop
hoi thoai tao biéu dé. :

- Chon tén cua Table, tén cdc trudng dit liéu (t6i da 4 trudng) va trudng ghi cdc nhan
cho biéu d6 ma chiing ta muén hién thi tao thanh biéu dé trong cira s6 man hinh, sau dé
chon OK.

Thuc hién chitc nang ndy trén man hinh may tinh s& hién ra mot cira sé biéu d6 clng
v6i dang bi€u d6 di chon va trén thanh thyuc don s&€ tu dong thém mot thuc don Popup
Graph. Vao céc chirc nang clia thuc don ndy c6 thé thay d6i ki€u dang bicu do, tiéu de,
ghi chti .v.v... trong clra s6 biéu do.

4. Duyét qua (Browsing) moét Table

Khi cin xem hodc nhép truc tiép theo dang bang biéu ndi dung cac thong tin thudc
tinh cia mot Table, c6 thé dung chiic nang Browse dé hién thi cdc thong tin d6 nhu sau:

- Vao thuc don Windows, sau dé chon New Browser Windows. Khi d6 man hinh
hién ra hop hoi thoai sau:

- Chon tén clia Table ma chiing ta muén hién thi noi dung thuoc tinh tao thanh bang
biéu trong cira sé man hinh, sau dé chon OK. Khi d6 man hinh s& hién ra mot bang dir
liéu cta 16p da chon.
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5. Dong cac Table

Dong cdc 16p thong tin hay Table, & day c6 thé hiéu 1a loai bd né ra khoi trang 1am
viéc hodc cira s6 ban d6 hién thoi. DEé déng mot 16p thong tin lai chiing ta vao thuc don
File va chon Close khi d6 man hinh hién ra hop thoai sau:

Close Table . ¢

 Close table: 3%

Chon tén ctia Table cin déng lai sau d6 bam chon OK dé thuc hién. Trong cira s6
ban d6 hi¢n thoi lap titc s& mat di cdc thong tin trong 16p da déng lai.

6. Ghi lai Table vao dia tir

Khi da thuc hién mot s6 thao tdc bién tap (thém hoac x6a) thong tin clia mét Table
nao d6 va céan luwu gitt lai su thay déi d6 cho muc dich sau nay ching ta phai ghi lai
nhing thay d6i d6 bing cich vao thuc don File vi chon chiic ning Save khi d6 man
hinh hién ra hop hoi thoai sau:

Savntose 0o . oo B

Chon tén clia Table can ghi lai sau d6 bam chon OK dé thuc hién.
7. Trang lam viéc (Workspace)

Trang lam viéc trong Maplnfo c6 th¢ coi 12 mot cira s ban d6 téng hop, né bao gébm
mot hay nhiéu Table hoac cic cira s6 thong tin khic nhu thong tin thuéc tinh, thong tin
bi€u d6 v.v... Sau khi tao xong mot trang lam viéc va ghi lai, nhitng 1an sau khi thuc
hién md trang 1am viéc ra thi trang 1am viéc s& hién thi nguyén trang cac thong tin cla
trang lam viéc lic ching ta ghi né vao dia. D€ ghi lai c4c thong tin trong trang 1am viéc
vao thuc don File va chon chifc nang Save Workspace khi d6 man hinh hién ra hop hoi
thoai twong tu nhu hop hoi thoai ghi File trong Windows, chiing ta chen tén trang 1am
viéc hodc nhap méi (phan mé réng cha tap tin ndy 1a *.wor) cling véi thu muc dé Iuu
thong tin sau dé bdm chon OK:
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Save Workspace

File Name: Directories: oK
|mmm c:\mapinfo\data
docao.wor - o o ik
hachinh. woi ] mapinfo
4 data

List Files of Type: Drives: -
!Workspace [*.wor) ;,.I I 25 I o Ll

II. LAM VIEC VOI CO SO DU LIEU TRONG BANG

1. Tao mot Table moi (New Table)

Khi muén tao ra mot Table méi truc ti€p tir thuc don cia Maplnfo ching ta vio
thuc don File va chon chitc nang New Table khi d6 man hinh hién ra hop hoi thoai
nhu sau: .

%i'éi New Table
% |

Create new table and:

' 8 PR AR e ki e o e WO e A i

[X Open new Mapper
I Add to cumrent Mappe:

....Ereatﬁ:.".....?f 1 C'E"_“:EI_ :

Trong hop hoi thoai nay ching ta thiy c6 3 lua chon chinh:

- Open new Browser (md ctra s6 Browser méi). Cira s6 nay gidp chiing ta c6 thé truc
ti€p nhap cdc thong tin thudc tinh cho cac déi tugng dé hoa.

- Open new Mapper (md cira s6 ban dé méi). Clra s6 nay cho phép ching ta truc tiép
tao ra cdc d6i tuong ban do. ‘
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- Add to current Mapper (thém vao cira s6 ban d6 hién tai). C4c thong tin trong Table
mdi nay s€ tu dong thém vao ban dé hién thoi.

Ching ta chon mét trong 3 chitc nang trén va sau dé badm vao niit Create man hinh
hién ra hop hoi thoai sau:

= New Table Structure

Fields Type Indexed

| Up g ‘ D own
d

b
|  Add Fiel ]
1. Hemowe Field E
Field Information fasei i tlh
Name: | | X Tabile is Mappable

Type: |Ch§ractel B‘j l

Width: | 10

Projection... a

I Uieate 1‘ Cancel E‘ Help ;

Trong hop hoi thoai nay cho phép chiing ta xdc dinh cédu tric dit liéu thuoc tinh cho
16p doi tuong bang cédch dinh nghia tén trudng, loai dit liéu, do rong cta truong, dong
thoi xdc dinh loai lu6i chi€u ban d6 cho 16p thong tin s& tao ra thong qua niit Projection.
Néu bam vao niit Projection man hinh hién ra hop hoi thoai:

e
B —"
¥

Choose Projection

Category
Longilude / Latitude |!;-

_ Category Members

Longitude 7 Latitude
Longitude / Latitude (AGD 66) El
Longitude / Latitude (Belgium) Er
Longitude 7 Latitude (ED 50)

Longitude / Latitude (Ireland 65)

. |Longitude / Latitude (NAD 27 for US) bl
g Longitude / Latitude ([NAD 27 for Canada) hd

OK A Cancel
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Chiing ta hay chon loai toa do cho 16p ban dé tao ra theo hop Category va sau dé
chon tén cua hé toa do theo hop Category number, sau dé chon OK.

Ching ta phai xdc dinh it nhat mot tén trudng dit liéu khi d6 miit Create s& bat lén va
sau khi xdc dinh xong cédc tham s6 can thiét ching ta bam niit Create dé tao méi khi dé
man hinh hién ra hop héi thoai ghi tap tin va chiing ta nhap tén ctia Table méi vao sau
d6 chon OK. Thuc hién lénh nay trén man hinh s& hién ra mét cira s6 ban dé va cho
phép dung hop cong cu vé dé phat sinh ra cdc déi tugng ban dé méi phuc vu cho nhu
cdu cta ching ta.

2. Co 50 dit liéu trong MaplInfo

Céu tric Table la mot céu triic co ban trong co s dif lieu cha Maplnfo. Méi mot
Table dugc xdc dinh boi ban ghi, trudng va chi s6 (Record, Field, Index). Mi ban ghi
la mot dong trong co s& dif liéu va né bao gébm nhiéu trudng khic nhau. Céc truong
trong ban ghi dugc sap x&p theo thit tu thit nhat, thi hai .v.v... Sy sap x€p d6 dugc goi la
chi s6 héa. V€ ban chét chi s6 ciia cdc trudng di liéu 12 mot méang con trd (Pointer) gidp
cho hé¢ théng truy cap cic thong tin ban ghi nhanh va hiéu qua hon.

Trong co s¢ dit liéu ctia Maplnfo chiing ta c6 thé sir dung hai loai Table 1a: Table c6
chira thong tin ban dé va Table khong chita thong tin ban dé nhu céc 16p thong tin dit
liéu trong dang DBF, Raster, Lotus 1-2-3, XL.S, ASCII.

3. Bién tdp cdu tric cua Table

Chiing ta c6 thé thay déi truc ti€p cau triic ctia céc Table dit liéu trong Maplnfo nhu
thém, loai bo, thay déi loai di lieu clia cic trudng, thay déi vi tri thit tu chia cdc truong
trong cdu tric hodc tao ra chi s6 héa. Chiing ta vao thuc don Table > Maintenance >
Table Structure, man hinh hién ra hop hei thoai x4c dinh tén ctia Table cin thay déi cau
tric dir liéu va sau d6 bAm OK.

E
1§
I
I
E
?

Man hinh hién ti€p hop hoi thoai twong tu nhur tao méi Table. Chiing ta thay déi cac
thong tin can thiét trong hop hoi thoai ndy nhu thém bét, thay ddi thi tu cac trudng,
thay déi loai dit lieu ctia trudng sau dé chon nit OK.
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4. Tao ban sao va ghi lai cdc Table thanh mét tén khdc

Dé ghi lai c4c thay déi da thuc hién, ching ta vao thuc don File > Save Table. Néu
hién tai dang mo nhiéu 16p thong tin thi man hinh s€ hién ra danh sich cac 16p dang mo
va chon tén 16p da thuc hién thay d6i dé ghi lai. Néu muén ghi lai Table véi mot tén
khdc nghia la tao ra mot ban sao méi cho Table, vao thuc don File > Save Copy As.
Chitc ndng nay con dugc sir dung khi chiing ta mu6n:

- Luu lai ban sao ctia Table géc .

- Ghi lai cac thong tin trong 16p Query.

- Ghi lai su thay déi céu triic ctia Table.

- Thay déi hé toa d6 ctia mot Table.

Vao chirc nang man hinh hién ra hop hoi thoai sau:

Savo I_gnblre

L

TEN

Chon tén 16p trong danh sdch 16p réi sau d6 bam chon Save As, man hinh hién ra hop
hoi thoai ghi File nhu sau:

_ File ﬂ_ame.

] HLIYEH TAB 4 = c\
KHUNG.TAB b -
TEN.TAB = nithuan
UBAM.TAB
XA TAB

|

_E'

Save Filo as Iype: N
! ‘Maplnfo

Nhap tén File méi hoac chon tén File ghi d& da cé réi sau d6 bam OK. Néu muén
chuyén déi hé toa do thi bam vao niit Projection, khi d6 man hinh hién ra hop hoi thoai
xédc dinh hé toa do va c6 thé chon hé toa do cin chuyén déi va bdm OK.
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5. Doi tén cuia Table

Nhu chiing ta da rd trong Maplnfo cdc Table duoc quan 1y khong chi mot File déc
lap duy nhat ma n6 la mot tap hop t6i thiéu it nhat 4 File (*.tab, *.dat, *.map, *.id). Do
vay néu dung lénh clia DOS thi c6 thé chiing ta dé dang bé qua mot s6 File can thiét, do
vay trong Maplnfo cé chiic nang cho phép c6 thé sao chép, d6i tén toan bo cic File lién
quan dén Table dé dang. Vao thuc don Table > Maintenance > Rename Table. Chon tén
Table can d6i tén réi bam nit Rename, sau d6 nhap tén méi cho File luu trir Table tai
hép hoéi thoai ghi File r6i chon OK.

B Repame Table e

":_lé[en_ama ]'_ébl::es:

Rename... |

6. Thém bdn ghi vao Table

Chung ta chon mét Table va dat né vao ché do bién tap duoc (Editable). Néu chiing
ta mu6n thém mot ban ghi vao Table, chiing ta vao thuc don Edit > New row hodc 4n
phim Ctrl + E. Chiing ta nhap céc thong tin cho ban ghi méi theo céu triic da x4c dinh
cho Table.

7. Ghép ndéi cdc Table

Céc Table mu6n ghép néi véi nhau phéi c6 cling mét ciu tric. Néu chiing khac nhau
thi chiing ta c6 thé thay déi cdu tric clia mot 16p theo céu tric cha 16p kia. Vao thuc
don Table > Append Rows to Table. Hop hoi thoai hién ra:

Tai hop thoai nay chiing ta xdc dinh cdc Table g6c (to Table) va Table s& ghép vao
n6 (Append Table) sau d6 chon nit OK.

8. Xoa mét Table
Néu muén xéa khoi hé théng co s& dif liéu ctia Maplnfo mot Table, vao thue don

Table > Maintenance > Delete Table. Chon tén 16p cin xéa trong danh séch céc Table
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dang m& va sau d6 chon miit Delete. Man hinh hién ra thong bdo cénh béo cho chiing ta
rang céc thong tin clia Table ma chon x6a di s& khong thé citu lai dugc. Chiing ta khéng
dinh chon OK dé x6a Table.

I et Delete Tﬂhlc
| s

D alelﬂ ]'_ablns

Cnncel

9. Déng géi mot Table

bong géi (Packing) Table cho phép chiing ta nén céc théng tin lai va t6i wu héa cac
thong tin trong Table. Vao thuc don Table > Maintenance > Pack Table. Chon tén 16p
trong danh sach cac Table dang md. Man hinh hién ra hop hoi thoai sau:

Pack Tabte _

O Pack labufél Data
'Dipack ﬁ;aﬁﬁi&};bata i v

Cancel !

Tai1 hop hoi thoai nay cé cac Iua chon:

- Pack Tabular Data. Péng géi dit liéu thudc tinh .

- Pack Graphics Data. P6ng géi dit liéu ban dé.

- Pack Both Types of Data. Péng g6i ca hai loai dit liéu.

Ching ta chon mot trong cédc lua chon trong danh sdch ctia hop hoi thoai, sau d6
chon niit OK. Chon Save khi man hinh thong béo ghi lai théng tin truéc khi déng géi.
Néu muén hién lai clra s6 ban dé thi ching ta vao Window > New Map Window. Nén

ding chitc nang nay khi da thuc hién bién tap xong hoan chinh 16p thong tin theo lua
chon ngdm dinh clia hé théng.

III. CAP NHAT VA CHIET XUAT THONG TIN

1. Cdp nhdt thong tin cho Table

Céc gid tri cia mot truong dit liéu trong Table cé thé dugc cap nhat thay déi theo gid
tri clia cdc truong khéc trong Table hodc nhan gid tri cia mot trudng dir liéu trong mot
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Table khdc. D€ thuc hién dugc chitc nang niy vao Table > Update Column, man hinh
hién ra hop hoi thoai sau:

[.Z. Update Column :

: J;.mg lo.l.lpdaln: IXA =]
. _Eolm«to Update: Idanso . ‘EI

Get Valwe Flnm ’{:ié.hlg; IXA L!J | Jain__. i

X Browse He;ulls

) e ] |

Tai hop hoi thoai nay ching ta phai chon tén 16p can thay déi thong tin tai hop Table
to Update, xéc dinh tén truong sé cap nhap dit liéu tai hop Column to Update, tén 16p
chita thong tin s& 14y d€ cap nhap. Xéc dinh gié tri hoac biéu thitc x4c dinh gi4 tri cho
truong dir liéu da chon. Chiing ta c6 thé bdm vao nit Assist dé hién ra hop xé4c dinh
biéu thitc, sau d6 chon OK. Vi du: x4c dinh truong mat do dan s6 la ty s6 cua truong
dén s6 chia cho truong dién tich trong cing 16p xa (MDS = DS/DT).

Bdm vao nit Assist d€ xdc dinh biéu thic tinh gid tri cho trudng dir liéu ching ta
chon. Khi d6 man hinh hién ra hop xac dinh biéu thitc va ching ta thanh lap cic biéu
thiic tir cac trudng dit liéu da c6 trong hé théng. Ching ta bam nit Join dé thuc hién lién
két dir liéu ctia hai 16p thong tin. Su lién két ndy c6 thé thuc hién theo hai phuong phép:
Lién két dia 1y va lién két theo thudc tinh. Su lién két nay s& duoc dé cap chi tiét tai cac
phan sau.

2. Triét xudt mot lop (Export)

Chiing ta muén tri€t xudt mot 16p thong tin (Table) ra mot dang dit liéu trao déi véi
cdc hé théng khac nhe DXF, DBF, MIF .v.v... chiing ta thuc hién céc buéc sau:

- M0 16p thong tin cin triét xuat thong qua File > Open Table.

- Vao Table > Export, man hinh hién ra hop hoi thoai xuit dit liéu.

- Chon loai dir liéu cin xuat ra (File Format) va thu muc. Trong hop File Format
chiing ta c6 thé chon mot trong 4 loai dit liéu sau:

+ MIF (dit liéu trao d6i cia Maplnfo).

+ DXF (dit liéu trao déi clia Autocad).

+ ASCII (dir liéu theo bo ma ASCII).

+ DBF (d liéu trao d6i ctia cdc hé quan tri co s& dit liéu).
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l[-_= : Export Table to File % ; .

I _c.:\mapin!ol_ . | e ;
S 5] [_Cencet ]
" | @ mapinfod4 . _':';. : .
1 1 custsymb -
S i |
£ sw_reg 3
£ tools
£ tutorial
Drives: _
File Format: . e b gho 3
|AutoCAD DXF e

- Xac dinh cac tham s6 can thiét trong cdc hop hoi thoai xudt thong tin va chon niit
Export. Néu chiing ta chon loai dit liéu 1a DXF thi man hinh hién tiép:

DXF Expoﬂ Iniurmatmn

P *Pleset\re Hultn-PoTygun ﬂe 'ons as DXF Bll:u:lwt

) Version 1 3

O Version 12

Tai day né€u chiing ta muén chuyén ca c4c dit liéu thuoc tinh di gin v6i d6 thi thi
dénh dau chon 6 Preserve Attribute Data. Ching ta c6 thé chon s6 chit s6 sau ddu phdy
dong tai 6 Number of Decimal Places ciing nhu hé dit liéu cia phdn mém Autocad 1a
Ver.12 hay Ver.13 (thong thudong ching ta nén chon Ver.12). Bim nit Set
Transformation man hinh s& hién ra hop chuyén déi toa d6 (co gian toa do). X4c dinh
xong cac tham s6 chon nit OK.

- Nhap tén File Iuu két qua, sau dé chon OK.
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Chuong 1V
BAN PO MAY TINH VA CAC LGP THONG TIN

Nhu phan trén di d€ cap so bo dén véan dé tao ban dé mdy tinh tir cc 16p thong trong
h¢ thong. Chiing ta c6 thé hiéu ban dé mdy tinh 1a mot tap hop clia céc 16p thong tin
chéng xép ién nhau. C4c 16p thong tin dé nhu 1a nhitng trang gidy trong va chia dung
cdc thong tin thé hién cdc khia canh khdc nhau ctia ban dé va ching dugc xé&p chong
I6p no trén 16p kia, dam béo sao cho chiing ta c6 thé nhin thdy toan bo cac thong tin thé
hi¢n moi khia canh ctia t& ban d6 & cing mét thdi diém quan sét.

L. CAC THU TUC CHUNG TAO RA BAN PO MAY TiNH
- M& it nhdt mét 16p thong tin (chon File > Open Table)
- Tao clra 56 ban d6 méi (chon Windows > New Map Windows)
- Thém cdc 16p thong tin da md vao ban dé hién thoi (chon Map > Layer Control > Add)

Hai thi tuc dau ching ta da 1am quen & phan trén, sau day ching t6i gidi thiéu ky vé
thu tuc thi ba

IL. HOP HOI THOAI PIEU KHIEN LOP THONG TIN

Chiing ta c6 thé truy nhap hop hoi thoai diéu khién 16p thong tin bang hai cach: Tir
thuc don Map ctia hé théng hoac tir biéu tuong cong cu diéu khién 16p trong hop cong
cu chinh. Trong hop hoi thoai nay s& hién ra toan bo céc 16p thong tin trong ban d6 hién
thoi va cdc tham s6 diéu khién 16p nhu sau:

L R
- |Cosmetic Layer = L. LB _
XA MM T I Cancel l
Label... |
Layers Reorder— ] E
Add. . Remove { ] Up  Down | Help
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Bé chon mot 16p thong tin nao dé chiing ta chi viec b&m chuét vio tén cha 16p d6
trong hop hoi thoai va khi d6 dong tén 16p dé s& bat sang (Highlight). Sau khi chon
xong tén I6p c¢6 thé chon cac tham s6 diéu khién 16p nhu sau:

- Tham s6 diéu khién 4n/hién (Visible). Tham s& nay gitp chiing ta diéu khién an di
hoéc hién lai cac thong tin cia mot 16p khi cdn. Chiing ta chon tén 16p théng tin va sau
d6 danh dau chon trong 6 bi€u tugng Visible trong hép héi thoai dé hién théng tin trén
man hinh ban d6 hoac khong chon dé 4n thong tin trong 16p d6 di.

- Tham s6 diéu khién bién tap (Editable). Chiing ta chi ¢ thé thay déi va bién tap
céc théng tin trong mot 16p néu 16p d6 di duge chon ddnh ddu 12 bién tap dugc. Gid tri
ngim dinh cia tham s6 nay la khong bién tap duge, do vay khi thuc hién bién tap lan
ddu cdc thong tin clla manh ban dé thi trudc hét phai chon tén 16p va dat n6 & ché do
bién tap duoc & 6 biéu tuong Editable trong hop hoi thoai trén.

- Tham 56 di€u khién chon (Selectable). Trong MaplInfo chi c6 thé thuc hién céc thao
tdc xur 1y, phan tich dir liu va bién tap d6i tuong dugc trong cira sé ban dé khi ma
ching ta da chon d6i tuong d6. Néu mot 16p thong tin d3 duge dat & ché do bién tap
duge thi n6 cling ty dong duge dit & ché d6 chon duge. DE dat mot 16p thong tin & ché
d6 chon dugce ching ta chi cdn chon tén clia 16p d6 va dénh d&u lva chon & 6 biéu
tuong Selectable trong hép héi thoai.

- Tham s8 diéu khién mic d¢ phéng dai clia 16p thong tin (Zoom Layer). Nhur chiing
ta da rd man hinh mdy tinh chi ¢6 mot kich thudc vat 1y nhat dinh do vay cac thong tin
ban d6 tao ra trén mdy tinh thudng bi thu nho lai trong khuén khé clia man hinh. Mudn
xem thong tin chi tiét hon thi chiing ta phai phéng dai mot phan clia man hinh tuong tw
nhu ding kinh Lip dé nhin vay. Khi chon tham s6 nay nghia la chiing ta da xdc dinh cho
h¢ thong chi hién thi chi tiét céc thong. tin trong 16p duge chon khi ma khoang cdch
phong dai cho phép sy hién thi chi tiét d6. Hay hi€u mot cach khdc, tham s6 nay diéu
khién h¢ théng hién thi thong tin chia mot 16p theo mot mitc d6 phéng dai nhat dinh. Dé&
dat mot 16p théng tin & ché do phéng dai tu dong chiing ta chi can chon tén cua 16p dé
va ddnh dau lya chon & 6 Zoom Layer trong hop héi thoai va nhap gid tri phong dai cuc
ti€u va cuc dai & hop Min Zoom va Max Zoom.

- Tham s6 diéu khién thugc tinh thé hién théng tin clia 16p (Display). Chiing ta c6 thé
ding tham s6 nay dé Iya chon cic thudc tinh thé hién khéc nhau cho timg 16p théng tin
khdc nhau trén trang ban d6. Vi du: trang ban d6é c6 4 16p thong tin 1a dudng giao
thong, mang ludi hé ao, ving lanh thd cha xa va dudng dia giéi hanh chinh. Thong
thuong c6 the thé hign ban d6 dé nhu sau: dudmg giao théng c6 do day 1a 0.5 mm trén
ban d6 mau dé; mang ludi hé aoc mau xanh lo nét lién; viing lanh thé clia x khong thé
hién dudng bao va dudng dia gidi hanh chinh thé hién nét dit mau den. Trong hop hoi
thoai nay chiing ta cé thé xde dinh cdc tham s6 cho thudc tinh thé hién timg loat d6i -
tuong trong 16p théng tin di chon. Khi bdm chen nit Display trong hép hoi thoai diéu
khién I6p thi trén man hinh m4y tinh s& hién ra nhu sau:
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 [Zoom Laypering—

r'Displa_'.l' within z_ﬁoﬁt"ranééz’.ﬂ. o

Trong hop hoi thoai ndy néu chiing ta ddnh dau chon kiéu thé hién chli dao & 6 Style
Override va badm vao niit c4c biéu tugng cho céc loai déi tuong thudc khung cira s6 ché
do hién thi (Display Mode) trong 16p dd chon, man hinh s& hién ra mét hop hoi thoai
xdc dinh tham s6 cho kiéu loai thé hién nhu sau:

a) D61 véi loai d6i tugng viing:

gin Style: 7%

Tai hop hoi thoai nay ching ta c6 thé xdc dinh kiéu loai thuéc tinh thé hién cho cic
déi trgng viing nhu mau sic, kiéu dudng, kiéu té6 mau .v.v... nhir sau:

+ Bam niit Parttern dé thay déi kiéu to6 vang.
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+ Bam niit Color dé thay déi mau t6 viing.

+ Bam nut Background dé thay déi kiéu t6 nén cia vang.

+ Bam nit Style trong khung Border dé thay déi kiéu dudng bao.

+ Bé&m nit Color trong khung Border dé thay déi mau dudng bao.

+ Bam nuit Width trong khung Border dé thay déi do day dudng bao.

Sau khi chon xong bam OK dé khang dinh va tr& vé man hinh truéc do6.

b) D6i vé6i doi tugng duong:

Tai hop hoi thoai nay chiing ta c6 thé x4c dinh kiéu loai thuoc tinh thé hién cho cic
daéi tuong dudng nhu mau sac, kleu ducmg, dO day cua ducng va sau dé chon OK.

F

+ Bam niit Style dé thay déi kiéu dudng bao.

+ Bam nit Color dé thay déi mau dudng bao.

+ Bam nit Width dé thay déi do day dudng bao. :

Sau khi chon xong bam niit OK dé khang dinh hodc niit Cancel dé loai bo tac dung.
c) béi v6i doi tugng diém:

Theo cdc tham s6 trong hop hoi thoai nay ching ta c6 thé x4c dinh kiéu loai thudc

tinh thé hién cho céc d6i tugng diém nhu mau sic, kiéu ky hiéu, loai ky hiéu, kich
thudce ky hléu va sau dé chon OK

__.ﬁymbol l
Color: ] ;

Hotation Am:;ie l ;dgg :
Backgmumﬂ : wssen Sl ol of
! C' &mmﬂ

O Halo
(" Bmém i

oL ﬁ..f)rnp Qhadow - . . |
T Bl : :
|

- OK ll -L"aﬂcel'_'_:-:g | ﬂBIP l
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Tai hop hoi thoai nay ching ta ¢6 thé chon cédc tham s6 sau:

+ Bam niit Font dé chon kiéu ky hiéu c6 trong hé théng.

+ Bam niit Symbol dé chon loai ky hiéu trong danh sich Font.

+ Bam niit Color dé thay di mau ctia ky hiéu.

+ Nhap géc quay cho d6i tuong diém trong hop Ratation Angle .

Ngoai ra chiing ta con c6 thé thay déi cdc tham s6 trong khung Background va
Effects dé lam tang thém su thé hién thim m§ clia cac ky hiéu.

Sau khi chon xong chiing ta bam mit OK dé thuc hién hoac nit Cancel dé loai bo tac
dung.

Trong hop hoi thoai nay chiing ta c6 thé chon:

+ Chitc nang hién thi huéng cua déi tugng dudng néu ching ta chon trong 6 Show
line Direction.

+ Hién thi cdc diém nit cia d6i tugng néu ching ta chon 6 Show Nodes.

+ Hién thi diém trong tam clia d6i tugng néu chiing ta chon 6 Show Centroids.

Sau khi xdc dinh va chon xong cdc tham s6 thugc tinh thé hién chon OK dé khang
dinh va thuc hién hoac bam niit Cancel dé loai bo.

- Tham s6 xdc dinh nhan cho cédc d6i tugng (Label). Khi muén hé théng s& tu dong
hién thi nhan céc d6i tuong trong mot 16p thong tin theo gid tri cia mot trudng trong co
so dir liéu thudc tinh chiing ta hdy chon tén 16p va sau d6 chon nit Label, khi d6 man

Label weith: ] THEM =1
‘Line Style - Label Positiorn-— b
[ =] [ =)

ki imple

1
(& MNone ‘ 1

-  Aa
..... T Custom :

< -ﬂotalnd with..'l'i._n'a segments

Tai hop hoi thoai nay chiing ta phai chon tén trudng cin gan nhian (thuc chit la céc
doi tuong chir thuyét minh) cho d6i tuong.

Chiing ta bam chuét vao hop Label With, khi d6 man hinh hién ra mot cira s6 con véi
danh sach tén cic trudng trong co so dit liéu, sau d6 chon trudng ma chiing ta muén gan
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nhan cho doi tuong (vi du truong THEM). Néu mudn gan cdc nhan déi tuong cho nhiéu
trudng trong co so dit liéu thi ching ta chon Expression (biéu thiic) trong cira sé khi
bam vao Label with va sau d6 nhap biéu thitc ctia céc truong tao thanh nhin cho d6i
tuong (vi du nhu Name + Chr(13) + Phone).

C6 thé chon vi tri can hién thi nhan cho déi tugng bing cich bam vio mét trong cic
biéu tugng trong khung cira s6 Label Position. Tuong tu nhu vay, chiing ta c6 thé chon
kiéu dudng trong khung cira s6 Line Style.

Néu chiing ta muén chon ki€u va co chit cho nhan thi bim vao biéu tuong Aa trong
khung ctra s6 Font khi d6 man hinh s& hién ra hop hoi thoai chon Font chit cla
Windows va chiing ta c6 thé chon kiéu chit, mau sic ciing nhu co chit cho nhan, sau khi
chon xong baim OK dé thuc hién.

Néu mu6n dong chir thé hién nhan d6i tuong tu dong xoay theo chiéu ctia d6i tuong
duong thi ching ta hdy chon bang céch danh dau trong 6 Rotated with line segments.

Sau khi xdc dinh xong toan bo cdc tham s6 cho nhdn d6i tuong chon OK dé thuc
hién. Néu muén céc nhan dé tu dong hién thi trong cira sé ban dé thi chiing ta chon tén
I6p r6i bam chon 6 biéu twgng Label.

- Tham s6 ban d6 chuyén dé (Thematic). Khi chiing ta da tao ra mot ban d6 chuyén
dé bang chitc nang Thematic Map thi hé thong sé tu dong tao ra moét I6p thong tin riéng
dé quan 1y 16p ban do chuyén dé. Niit Thematic trong hop hoi thoai diéu khién 16p nay
chi bat séng khi ma chiing ta ¢6 it nhat mot 16p quan 1y ban dé chuyén dé. Tham s6 nay
¢6 chitc nang tuwong tu nhu chic nang trong thuc don Map > Modify Thematic Map
dung dé bién tap lai phong cdch ban d6 chuyén dé da phat sinh.

- Thém vao hoac loai bo mot 16p théng tin trong trang ban dé. Néu ching ta chon nut
Add trong khung cira s6 Layer thi man hinh hién ra hop hoi thoai nhu sau:

Add layer: [TNL (2]

Lzigek 4 4l o ]

Chiing ta chon tén ctia 16p cdn thém vio trang ban dé hién thdi trong danh sich céc
16p dang m¢ sau d6 bam OK. Néu mu6n loai bé mot 16p thong tin ra khoi trang ban dé
hién thoi thi ching ta chon tén 16p cin loai bo réi sau dé bAm chon nit Remove khi d6
trong danh séch céc 16p thong tin sé khong con tén 16p dé nita.

- Sap x&p lai thit tr cdc 16p (Reorder). Céc 16p thong tin trong trang ban d6 s€ hién
thi trén man hinh theo ding thit ty ctia danh séch cac 16p trong hop hoi thoai diéu khién
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16p, 16p cubi cung hién thi truéc va 16p trén ciing hién thi sau ciing. D& sip xé&p lai thit
tu c4c 16p chiing ta chon tén 16p va sau dé bdm vao niit Up néu cho 16p d6 1én trén va
bam vao Down néu muén xé&p 16p d6 xudng dudi. Riéng doi véi 16p ¢6 tén 1a Cosmetic
layer chiing ta khong thé thay déi vi tri ctia n6 trong danh sach duoc.

- Céc dac diém cua 16p thong tin Cosmetic. Khi tao ra bat ky mot clra s6 ban dé nao
thi trong danh sach 16p ctia hop hoi thoai diéu khién 16p ciing c6 tén 16p Cosmetic layer.
Vé ban chat 16p thong tin nay c6 thé coi nhu 1a mét trang gidy trong con tring tinh chua
c6 thong tin nao trén d6 ca va dugc x€p O tdng trén clng trong trang ban dé ching ta
tao. C6 thé hiéu 16p thong tin nay nhu 1a mot trang gidy nhép ctia ching ta trong qua
trinh lam viéc. Thong thudng né tu dong chita céc thong tin nhu nhan déi tuong, tiéu dé
ban d6 va cic cic d6i tugng dia 1y kh4c phét sinh trong qué trinh 1am viéc. Néu muén
x6a céc thong tin trong 16p Cosmetic thi vao thuc don Map > Clear Cosmetic Layer va
néu mudn ghi lai cdc thong tin cia 16p d6 vao mot 16p thong tin khéc thi ching ta vao
Map > Save Cosmetic Objects khi d6 man hinh hién ra hop hoi thoai:

Chiing ta c6 thé chon tén 16p ma ching ta muén chuyén cic d6i twong trong 16p
Cosmetic sang mot 16p khac hoac chon New dé tao ra mot 16p théng tin méi ghi lai cac
déi tuogng trong 16p trung gian d6. Lép Cosmetic nay cé cic dic diém sau:

+ Lop Cosmetic ludn 1a 16p thong tin & vi tri trén cling trong danh sach 16p cia cira
s6 ban dé

+ Céc thong tin cha 16p Cosmetic khong tu dong ghi lai vao dia khi chiing ta déng
ctra s6 ban dé :

+ Chiing ta chi dugc phép dat 16p Cosmetic vao ché do bién tap duoc va chon duoc
(Editable va Selectable) ma théi. Trong 16p Cosmetic luén luén tur dong luu trit cdc nhin
d6i tugng khi chiing ta ding chitc nang v& nhan hodc hién thi nhin tu dong

+ Noi dung thong tin clia 16p Cosmetic luon két n6i twong tng ty 1& véi mitc do
phéng dai clia trang ban d6 hién thoi

III. NHAP DU LIEU VAO BAN PO

C4c dir liéu cua ching ta phai nhap vao ﬁf: thong c6 thé thong qua bon phuong phép
phd bién nhat sau day:

- Thuc hién dia ma héa.
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- Thuc hién tao d6i tugng diém.

- Thuc hién phdp sinh d6i tugng bing cong cu veé.
- Thyc hién trao d6i dir liéu véi cdc hé thong khéc.
a) Thuc hién dia ma héa (Geocoding):

Trong céc phén truéc da néu céc thong tin trong hé théng MaplInfo dugc quan 1y theo
cdc ban ghi (Record) do vay qué trinh gén toa d¢ dia 1y cho cic ban ghi hay néi céch
khéc 1a nhap dir liéu cuia chiing ta vao trong ban dé duoc goi 1 dia ma héa (Geocoding).
C6 ba phuong phap thuc hién Geocoding sau day:

- Thuc hién dia ma héa theo dia chi (Address). Phuong phap nay thuong dung trong
truong hop chiing ta muén ma héa cic dia chi trén dudng ph6 (vi du s6 nha trén phé).

- Thuc hién dia ma héa theo dudng bao (Boundary). Trong hé théng Maplnfo thuat
ngit dudng bao dugc hi€u nhu 12 mot viing khép kin. Khi ching ta ding phuong phap
nay dé thuc hién dia ma hod, he théng Maplnfo s& tim ki€m tén cha ving trong 16p ban

d6 theo tén ciia ving trong 16p tim ki€m (Search Table) va ‘gén toa do trong tam cua
ving d6 cho ban ghi s6 liéu viing clia chiing ta.

- Thuc hién dia ma héa theo tap tin thong tin diém (ZipInfo). Khi chiing ta c6 mot
tap tin chita cdc ma ZIP (ZIP code) cla cdc diém trong tam cic doi trong vung trong
I6p ban d6 thi nén chon phuong phap ndy dé nhap. Khi d6 cdc thong tin tir tap tin
Ziplnfo s& tw dong chuyén sang co s di liéu theo timg ban ghi mo‘ng ung.

Céc thu tuc chinh thuc hién Geocoding c6 thé tém tit nhu sau:

- Vao thyc don Table > Geocode khi d6 man hinh hién ra hop hoi thoai dia ma héa
va chiing ta phai xdc dinh c4c tham s6 cho né nhu sau:

Ceocude

.S_emchi 'i;:able '

4 fot leects in column: lnnne

*

g

Trong hop hoi thoai nay chiing ta phdi thuc hién lua chon cdc tham s6 sau:
+ Chon tén cla 16p ma chiing ta gan toa do dia ly trong hop Geocode Table.
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+ Chon tén cua trudng dit liéu ma né chita céc thong tin dia 1y ching ta s& ding dé
thuc hién tim ki€m theo hop using column.

+ Chon tén cua 16p chita cic thong tin dia 1y ma theo d6 s& thuc hién tim ki€ém thong
tin theo hop Search table.

+ Chon trudng trong Search table chita céc thong tin dia Iy tim kiém theo hop For
objects in column.

+ Chon ch& do tim kiém trong khung cira s6 Mode la ty dong (Automatic) hay bén tu
dong (Interactive). Ngam dinh lua chon nay 1a tu dong.

+ Chon ki€u ky hiéu thé hién (Symbol). Chiing ta bAm vao biéu tuong ky hiéu, khi dé
man hinh s€ hién ra mét bang danh sach cdc ky hiéu hién c6 trong hé théng va chiing ta
c6 thé chon chiing sau dé chon OK.

+ Chiing ta c6 thé x4c dinh lai thém (day 1a cdc tham s6 tiy chon c6 thé khong nhat
thi€t phai chon chiing) 16p thong tin trong hop Refine search with table va tén trudng sir

dung lam dudng bao theo hop using boundary name colum trong khung clra sé
Optional.

+ Néu chiing ta chon nit Options thi man hinh hién ra

Trong hop hoi thoai nay ching ta c6 thé xdc dinh thém c4c théng tin lién quan dén
qua trinh dia ma héa (Geocoding) nhu hién thi thém trudng theo hop Display additional
column, tén trudng ma ching ta mudn ghi két qua geocoding theo hop Put result code
in column, bo qua céc ban ghi ¢6 16i khi thuc hién Geocoding theo 6 Skip records that
already failed to geocode va cic lua chon theo khung cira s6 diéu khién khi thuc hién
tim ki€m khong thanh cong “When an exact match cannot be found”. Chiing ta chon
niit OK dé€ ra khoi hop hoi thoai nay va tré vé hop hoi thoai ctia Geocoding. Chiing ta
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chon mit OK dé thuc hién chiic nang theo c4c tham sé vira xdc dinh néu trén. Chiing ta

chon niit Cancel dé loai bo thao tac vira x4c dinh.

b) Tao d6i tuong diém trén trang ban do:

Néu chiing ta da c6 mot tap tin chira thong tin vé toa do cdc diém va muén hién thi
cdc diém d6 trong h¢ thong Maplnfo thi vao thuc don Table > Create Point khi d6 man

hinh s€ hién ra hop hoi thoai nhu sau:

Create F"cn"ints

ey

ints for table: [GEGDLLE T E R

Got X coordinat

from column: [DIENTICH

Get ¥ coordinates from column: [DANSO

 Multiply the ¥ coordinates by: '

~ Cancel

Trong hop hoi thoai nay chiing ta phai xdc dinh tén 16p cén tao d6i tuong diém theo
hop Create points for table, loai ky hiéu thé hién d6i tugng theo biéu twong using
symbol, chon trudng xédc dinh toa do cua diém theo hop Get X va Get Y coordinates
from column ciling nhu hé s6 xac dinh toa dé theo hop Multiply the X va Multiply the Y
coordinates by. Néu chiing ta mu6n thay déi hé quy chi€u toa do thi bdm vao niit
Projections khi d6 man hinh hién ra hop hoi thoai xdc dinh hé toa do va chiing ta c6 thé
chon hé toa do trong danh sich d6. Sau khi x4c dinh xong céc tham s6 trén chiing ta

chon niit OK dé thuc hién.

¢) Dung cong cu v& dé phat sinh déi tugng méi:

Trén hop cong cu vé (Drawing) chiing ta c6 thé chon cdc cong cu dé phat sinh ra céc

doi tugng nhu sau:
- D6i tugng diém.
- D61 tuong duong.
- D61 tugng vung.
- Déi tuong chit.

d) Trao d6i dir liéu v6i céc he théng khac thong qua Import :

Néu chiing ta da c6 céc dir liéu'trong cdc khuon dang trao d6i nhu MIF, DXF, .v.v...
ma hé théng c6 thé hiéu dugc thi ding chic nang Import dé nhap vao. Chon Table >

Import, khi d6 man hinh hién ra hop hoi thoai sau:
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File Name: L e Q_ueclbuo:
I'.mi‘ ‘ c: \.maplnlu-l-

+* = e:\

= mapinfo4
£ custsymb
£ data

£ sw_reg
£ tools

2 tutorial

Dlixei:
[+ I c:

lmpotl’ Fol'mga.l TR «;

Maplinfo lnlalchange

AuntnalCAN NYWF

Tai hop hoi thoai nay xdc dinh khuon dang dir liéu nhap vao thong qua danh sich
trong hop File Format. Thong dung nhat la khuoén dang DXF. Néu chiing ta chon khuon
dang DXF va bam chon niit Import man hinh hién ra hop hoi thoai sau:

DXF Impnrt Information :

DXF Layers ln lmpml

| .““u“‘i

X Preseive DXF Blocks as Multi-Pulygﬁri Regions
- FPreserve Attribute Data

[ Create Separate Tablez .

[~ Suppress Wamlng Messages

| : _P_m|eclton.-. 3 | Set l;ansfolmahon—g

I.- oK Hl Cancel j ] Options... g[ Help g

Tai hop hoi thoai nay chiing ta chon cdc 16p thong tin trong File DXF trong khung
DXF layer to Import sau d6 danh déu céc lua chon sau hop hoi thoai sau:

- Preserve DXF Blocks as Multi-polygon Region dé giir cdc kh6i trong DXF thanh
cédc doi tuong da vung.

- Preserve Attribute Data dé giit cdc thong tin thudc tinh trong DXF.

- Create Seperate Tables dé tao ra cdc Table khac nhau cho timg 16p thong tin c6
trong File DXF.

- Suppress Warning Messages dé dimg lai khi c6 canh béo.

- Chiing ta bdm miit Projection dé chon hé toa do cho 16p théng tin nhap vio (vi du
chon hé toa d6 Viét Nam va mii chi€u 18 véi duong kinh tuyén trung wong 1a 105°).
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= . Choose Projection :
Qa;legory ' . . .
IHe vietnam Lﬁ
Chtegory ﬁémbﬁ_is - - :

e T T mr— L ——
Mui 19 lo=111

- Chiing ta bam chon niit Set Tranformation néu muén thuc hién viéc chuyén déi hay
co gian h¢ toa do cua s6 liéu goc v6i hé toa do mdi bang cach xdc dinh lai cac gia tri toa
do X, Y ctia hai diém cuc dai va cuc tiéu trong khung bao vung dit liéu Point1 va Point2
cua hai hé thong dif liéu theo hop hdi thoai sau:

| Set Coordinate Transformation

DXF Comﬁinatef _ ~ Maplnfo

. Coordinates
. 2 Pointl | 1 ~_ Point1 '
bl [507.920 .. % |s07.920 | oK ! _
v: [2.323.400  v: [2.323.400 [ Cancel |
__ _Point 2 o s
% |508.010 i %: |508.010

v: [2.323540 ~ v: [2.323540 S

Sau khi xdc dinh xong cédc tham s6 trén chon OK va khi d6 man hinh hién ra hop hoi
thoai ghi File, chiing ta nhap tén File dé luu két qua trong hop hoi thoai d6 réi chon OK
dé thyc hi¢n. Man hinh s& hién ra mot cira s6 trang thdi thong béo qué trinh chuyén déi
dir lieu. Néu trong File DXF c6 céc thong tin khong theo chuén thi man hinh s& hién ra
hoi thoai canh bédo va khi d6 chiing ta nén bim chon No Warning dé tiép tuc thuc hién
chtic nang.

Néu chon dit liéu nhap vao theo chudn MIF thi sau khi chon tén File di liéu nhap
vao va bdm Import khi d6 man hinh hién ra hop héi thoai ghi File, chiing ta nhap tén
File d€ luu két qua trong hop hoi thoai d6 réi chon OK dé thuc hién. Man hinh s& hién
ra mot clra s6 trang thai thong bdo qué trinh chuyén ddi dit liéu. Néu dit liéu trong File
MIF khéng chudn thi s& c6 canh bdo hién thi trén man hinh vé su khong tuong thich dé.
Sau khi nhap xong dif liéu vao Windows > New Map Window dé hién thi cira s ban dé
chung ta vira nhap vao.
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IV. CHON CAC POI TUONG TREN BAN PO (SELECTION)

+ Muc dich cua Selection:

Kha ning phan tich khd manh ctia hé théng MaplInfo 12 mot trong cdc wu thé 16n ctua
né so v6i cédc phdn mém khéc vé Desktop GIS. Mu6n thuc hién dugc céc chitc nang
phén tich clia hé théng chiing ta phai chon cdc d6i tugng ban d6 cén thiét cho thao tc
dé. Trong hé théng Maplnfo chiing ta hi€u tap hgp chon (Selection) 1a mét tap hop dit
liéu duoc nhém lai véi nhau theo mét hoac nhiéu chi tiéu tham bién cho trude.

Trong hé théng Maplnfo cic Selection cé nhitng dac tinh sau day: Chiing 1a nhitng
I6p thong tin trung gian (Temporary table) khi chiing ta thuc hién chon cdc d6i tuong
thi h¢ théng Maplnfo tur dong phat sinh ra 16p trung gian nay dé luu trit cdc ban ghi ma
chuing ta chon vé6i tén mo rong l1a Query. Céc thong tin chon nay trong céc Query chiing
ta c6 thé thuc hién céc thao tic sau:

- Hién thi ching trong céc cita s8 thong tin Browser, Map va Graph Window, sao
chép thong tin vao bo dém va dan chiing vao céc Table khac hoac vao céc trinh ting
dung khac

- Bién tap va thuc hién lua ch(_m' ti€p cac thong tin trong cdc Query.

Néu chiing ta mu6n ghi lai cdc thong tin da chon thanh mot Table méi thi vao thuc
don File > Save Copy As va chon mot Query chita cdc théng tin cdn luu lai (vi du
Query2) sau d6 bam vao Save As, man hinh hién ra hop hi thoai ghi File va ching ta
nhap tén 16p méi hoac chdp nhan tén ngdm dinh réi chon OK.

Save Cbﬁy As

| Cancel |

- ——

+ Cac phuong phép thuc hién chon:

Maplnfo cho phép chiing ta thuc hién viéc chon (Selection) théng qua cong cu thuc
don hoéc cau I¢énh. Trén hop cong cu thuc don Main ching ta cé thé chon céc d6i tuong
trén ctra s6 ban d6 thong qua biéu tuong.

a) Chon trén man hinh ctra s6 ban d6 thong qua céng cu chon trén Main:

- Cong cu chon timg dai tuong.

- Chon theo bén kinh.

- Chon theo cita s6.

- Chon d6i tuong trong ving.
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b) Chon trén cira s6 Browser:

D¢ chon d6i tuong thong qua cira sé Browser chiing ta vao thuc don Window chon
New Browser Window va khi d6 man hinh hién ra hop hoi thoai Browser, chon tén 16p
can m& clra s6 Browser trong danh sdch céc 16p thong tin trén man hinh sau dé bam nit
OK. Man hinh hién ra cira s6 céc thong tin thudc tinh ctia 16p di chon nhu sau:

s
File Edit Ob

Mapinfo Professional
Query Table Options Browse Window Help

jects

mEEC A E RS
=] XA Map
- » Bro bt B
ten sohogd danso *
| Phuéc Binh 338 1.765
[J| Phuéc Hoa 153 912
| Phuée Tan 335 1.596
| Phuéc Tién 383 2120
[J| Phuéc Thang 428 24481 |
[ Phuéc Thanh 330 1.934)
[J| Hoa San 516 2580 |
]| Ma N&i 499 2E38|
[1| Phuérc Chinh 168 937 [+
=1 : S E
.
g e =1 o e PN BT (R TR EL BT T

Chiing ta c6 thé chon d6i tugng bang cich bdm vao biéu tuong cong cu chon trén
hop cong cu Main va sau d6 bdm vao diu dong ban ghi clia thong tin d6i twong cén
chon va khi d6 6 vuéng ddu dong s& dugc boi den va hinh anh ciia d6i tuong dé trén cira
56 ban d6 ciing duoc dénh ddu bat sang tuong ting.

¢) Loai bo su chon déi tuong:

Néu vi mét 1y do nao d6 ma chiing ta khéng mudn chon céc déi tuong da chon thi
gitt phim Shift va bam vao d6i tugng can loai bo su chon sau khi chic chén ring ching
ta da bam vao bi€u tugng coéng cu chon trén hop Main. D€ loai bo toan bo cic doi tuong
da chon ¢6 thé bdm chudt vao viing bét ky nao trén cita s6 ban d6 khong c6 d6i tuong
hoéc vao thuc don Query va chon Unselect All.

d) Chon d6i tuong thong qua Query:

Ngoai cic phuong phdp chon doi tugng trén man hinh chiing ta c¢6 thé thuc hién tim
ki€m va chon d6i tuong thong qua thuc don Query bing lénh Select va SQL Select. Dé
thuc hién dugc cédc chitc nang nay truée hét chiing ta phai xay dung hoac xac dinh chi
tieu tim ki€m, lua chon. Cic chi tiéu chon nay c6 thé 1a mot hing sd, ¢6 thé 12 mot biéu
thirc hodc todn hoc hoac légic, vi du chon toan bo cic xi c¢6 dan s6 16n hon 10000
nguoi chiing ta nhap biéu thitc vao hop chi tieu:

danso>10000
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+ Chitc nang Select:

Chirc nang Select cho phép chiing ta chon céc ban ghi dit liéu trong mot 16p thong tin
(Table) theo cac thong tin thudc tinh (Atribute) ctia né thoéa man céc chi tiéu cho trudce
ma chung ta da dat ra va tao ra 16p trung gian Query. Mu6n ghi lai cac thong tin dé6 thi
vao File > Save Copy As va chon muc Selection trong danh siach trén man hinh sau dé
bam nit Save va nhap tén File luu két qua ghi lai. Vao thuc don Query va chon chiic
nang Select, man hinh hién ra hop hoi thoai sau:

T S R P

_. Select ﬁecnlds from T able: [KA.

that S_alisfy: Al

Store Besults in Tab[e__;_ 5 .ISeIeclion

- Sort Results by Qolum_ii_;_ Inone : L%j

| IX Browse Results

[ ok §| Cancel || Hep |

Chon tén 16p chita cac thong tin ma chiing ta s& tim ki€ém béang cédch bam vao hop
Select Records from Tables, khi d6 man hinh s& hién ra mot danh sdch céc 16p thong tin
ma ching ta dang m& hién thoi. Ching ta bdm chon tén 16p can tim kiém thong tin
trong danh sach néu trén.

Sau khi chon xong tén 16p thong tin, ching ta thiét lap biéu thiic xdc dinh chi tiéu
tim ki€m d6i tuong truc ti€p vao tai hop "that Satisfy" hoac bam vao nit Assist... khi dé
man hinh hién ra hop hoi thoai ti€p theo sau:

Type an expression:

Expression

-

|

] Operators

[

I Functions

5 ok §| cance | ] T BT

Chung ta bdm vao hop Columns man hinh hién ra danh séch céc trudng dit liéu theo
cdu tric dir liéu cua 16p thong tin da chon. Chon tén trudng chiing ta can trong danh
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sdch khi d6 truong duge chon s& tur dong chuyén sang hop "Type an expression” bén
canh. Ching ta chon cdc todn tir hoac ham s6 trong hé théng biing céch bim chon trong
danh sich khi ching ta bdm vio hop Operators va Functions (vi du: Rent >=
abs((Tol1+Tol2)/2). Tai nit Functions chiing ta c6 thé chon c4c ham chuidn ca hé
théng nhu sau:

- Abs() ham 14y gid tri tuyét d6i.

- Area() ham 14y dién tich cta d6i tugng.

- CentroidX() 14y toa d6 X trong tam cha déi tuong.

- CentroidY() ldy toa d6 Y trong tam cla d6i tuong.

- Chr$() 1ay ky tu cla biéu thifc.

- Cos() tinh c0 sin ctta goc.

- CurDate() 14y ngay hién thoi cia hé théng.

- Day() 14y ngay thdng ctia hé théng.

- Distance() tinh khoang céch ciia hai diém.

- Format$() dinh dang cho biéu thic.

- Int() 1ay phan nguyén clia mét sg.

- Lease$() chuyén xau ky tu vé chit thuong.

- Left$() 1ay cdc ky ty bén trdi clia x4u.

- Len() tinh d6 dai ctia xau.

- LTrim$() loai bo ky tr tring bén tréi ciia xau.

- Maximum() tinh gi4 tri cuc dai.

- Mid$() 1ay ky tr gifta mot xau.

- Minimum() tinh gi4 tri cuc tiéu.

- Month() ldy thang cta hé théng.

- Objectlen() tinh do6 dai cua d6i tuong.

- Perimeter() tinh chu vi ctia d6i tuong.

- Proper$() chuyén k¢ tu ddu tidn cda xau thanh chit hoa.

- Right$() 14y ky e bén phai clia xau.

- Round(} 1am tron mét sé.

- RTrim$() loai bo ky tu tring bén phai ciia x4u.

- Sin() tinh gid tri sin cha géc.

- 5tr$() chuyén thanh xau ky ty.

- Ucase$() chuyén xau thanh ky tr chit hoa.

- Val() tinh gi4 tri clia xau theo ASCII.

- Weekday() 14y ngay trong tudn.

- Year() 13y nam cfia hé théng.
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Chiing ta c¢6 thé ding Help dé tim hiéu chi ti€t cd phép clia cdc ham chuédn néi trén
truée khi sir dung. Cdc ham nay vé co ban ciing giéng nhu cdc ham chuén trong céc hé
quan tri dit liéu.

Sau khi thiét 1ap xong biéu thitc chiing ta chon nit OK. Néu mu6n chinh sira lai biéu
thitc chi tiéu bam chon nit Verify. Tai hop Store results in Table lu6n luén 1a 16p trung
gian Selection. Néu chiing ta mudn sap xép két qua theo mot trudng dir liéu nao dé thi
ching ta chon tén trudng d6 theo hop Sort results by Column. Néu ching ta khong
mu6n hién thi két qua tim kiém trong cira s6 xét duyét Browser thi bam chuot loai bo su
danh diu trong 6 Browse Results. D& thuc hién chic nang bam niit OK, ngugc lai chon
nit Cancel.

+ Chitc nang SQL Select

Chic niang SQL Select cho phép ching ta chon céc ban ghi dit li¢u trong mot 16p
thong tin (Table) theo céc thong tin thudc tinh (Atribute) clia n6 théa man céc chi tiéu
cho truéc da dat ra va luu céc thong tin chon dé vao 16p trung gian Query. Bén canh
viéc tim ki€ém nhu chitc nang Select néu trén chifc nang nay con cho phép chung ta tao
ra mot trudng méi, tdng hop dit liéu cha cdc thong tin duge chon, lién két hai hay nhiéu
16p théng tin vao mot 16p thong tin két qua va cho phép chiing ta chi hién thi cac
trudng dir liéu da chon va céc ban ghi quan tam. Ching ta muén ghi lai cdc thong tin da
chon dé thi vao File > Save Copy As sau d6 chon Selection hoac Query trong danh sach
va bidm chon niit Save, nhap tén File dé luu két qua chon. Vao thuc don Query, chon
chire nang SQL Select man hinh hién ra hop hdi thoai sau:

R T N T T SR R S BT
Select Columns:  [- [Tables =l
| Colume =
‘-'Dperatms ‘ﬁl
|Agoregates  |=2]
| Functions (=]
 Group by Columns: [
into Table Named: |Selection
X Browse Results : i i _
o ok 1| cancet | | 1] Help ]

Trong hop hoi thoai nay ching ta phai xac dinh:

- Tai hop Table bam chon tén cdc 16p thong tin dang m& chita cdc thong tin ma
ching ta quan tam tim ki€ém va khi d6 trong hop From Table s€ hién lén tén cac 16p
chiing ta vira chon.
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- Tai hop Column chiing ta chon tén céc trudng dif litu trong danh sdch cdc trudng
ctia cdc 16p da chon s& thyc hién tim ki€m khi d6 trong hop Select Columns s& hién lén
tén cac trudong da chon. Néu 1a ddu (*) thi c6 nghia I chon toan bé cic trudng.

- Tai hép where Condition chiing ta thiét 1ap biéu thiic x4c dinh chi tiéu tim kiém.
Chiing ta c6 thé diing céc hop Column, Operator, Function dé thigt lap biéu thitc twong
tu nhu trong chitc nang Select.

- Tai hop Group by Column chiing ta chon tén clia trudng dit liéu ma theo dé céc dir
ligu duge chon s& dugc nhém lai theo gia tri.

- Tai hop Order by Column chiing ta chon tén cta trudng dit liéu ma theo dé céc dir
li¢u duge chon s& duge sap xép lai theo gid tri.

- Tai hop Into Table Named chiing ta chon tén ciia 16p dit lieu ma theo d6 cic dir liéu
dugce chon s& dugce ghi lai.

- Néu chiing ta mudn hién thi hoac khong cita s Browser két qua dugc chon thi bim
vao 6 vuong Browse Result dé chon hoic loai bo su chon dé.

- Néu chiing ta muén thuc hi¢n téng hop di liéu cia cdc ban ghi duge chon thi bim
vao hdp Aggregates khi d6 man hinh hién ra'danh sdch cac phuong phép tdng hop dit
liéu. Trong MaplInfo ¢6 6 phuong phép téng hop dir liéu di duoc xay dung sin beén
trong hé thong (Built - in) nhr sau;

+ Count(*): Thuc hi¢n dém s& ban ghi trong cdc nhém déi tuong.

+ Sum(expression): Thyc hign tinh téng cia cdc gid tri trong biéu thic expression
cho toan b cc ban ghi trong nhém d6i tuong.

+ Average(expression): Thuc hién tinh gi4 tri trung binh cong cha cac gia tri trong
bi€u thitc expression cho toan bo cc bin ghi trong nhém d6i tugng.

+ Wiavg(expression): Thuc hién tinh gi4 tri trung binh céng theo trong sd ctia cac
gid tri trong biéu thitc expression cho toin bo céc ban ght trong nhém dai tuong.

+ Max(expression): Thyc hién tim gid tri 16n nhét cha cac gid tri trong biéu thirc
expression cho toan bd céc ban ghi trong nhém d6i tuong.

+ Min(expression): Thyc hién tim gid tri nhd nhét clia céc gi4 tri trong bidu thitc
expression cho toan b cdc ban ghi trong nhém ddi tuong.

- Mudn xdc dinh lai c4c tham s6 cho chitc nang SQL Select thi bim chon niit Verify,
mudn x6a di cic tham s6 trén chiing ta chi cdn b4m niit Clear.

- Sau khi da x4c dinh xong céc tham s6 cho chitc nang SQL Select néu trén chung ta
bam chon niit OK dé thure hién va khi d6 heé théng s& tu dong tao ra 16p trung gian
Query dé Iuu céc théng tin théa man theo cdc diéu kién trén.

+ Chitc nang tim ki€ém (Find)

Chitc ndng nay chi bat sdng va sir dung duge khi ma trong Table chiing ta chon cé it
nhat mot truong dit lieu duge dénh Index. Vio thue don Query > Find man hinh hién ra
hop hoi thoai:
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. ‘i_u's.inn,ﬁ..l::iun_d%l.'ty Namu Coll.l'tﬁ'l_'_i;’ zlnone _ L%I

Mark with Symbot: |

Tai hop hoéi thoai nay chiing ta chon:
- Tén 16p tim ki€m trong hop Search Table (vi du 16p THU).

- Tén trudng dit liéu tim kiém trong hop for Objects in Column’(vi du TT).

- X4c dinh thém cac tham s6 tuy chon bam vao nit Option.

- Ky hiéu danh d4u déi tuong tim thay theo biéu tugng chiing ta chon tai Mark with Symbol.
Ngoai ra con c6 thé x4c dinh thém c4c tham s6 khdc nhu tén 16p tim lai & hop Refine

Search with Table va tén truong giéi han tai hop Using Boundary Name Column trong
khung Optional.

Sau khi xdc dinh xong va chon OK man hinh hién ti€p hop héi thoai

R T < T R S R

-

ke

Tai day gb cac chi tiéu tim ki€m theo tén trudng ching ta da chon & trén, sau dé
chon OK dé thuc hién khi dé céc d6i tuong théa man chi tiéu tim ki€m sé duoc danh
ddu bang ky hiéu ma ching ta da chon. Néu xé4c dinh lai chi tiéu bdm nit Respecify,
Loai bo chitc nang bdm nit Cancel.

Dé hién thi cdc d6i tuong da chon vé clra s6 ban d6 hién thoi vao thuc don
Query > Find Selection.
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Vi céc chitc nang chon trén chiing ta ¢6 thé tim ki€m va chon loc c4c thong tin trong
GIS can thiét cho mot muc dich ndo d6 va ghi lai vao thanh céc File doc lap ca thong tin
bin d6 va thong tin thudc tinh (File > Save Copy As). Trén céc thong tin dé chiing ta c6
thé thyc hién céc thao tic nhu cdc I6p thong tin doc 1ap khdc trong hé théng.

V. PANG KY HINH ANH VAO BAN PO

Cac hinh anh ma chiing ta c6 thé ding ky vao ban dé trong hé théng Maplnfo phai &
mot trong cdc khudn dang sau day: JPEG, GIF, TIFF, PCX, BMP, TGA va BIL. Trudc
hét ching ta phai thuc hién m& File anh va thuc hién dang ky né vao cilra s6 ban dé
thong qua toa d6 cia cdc diém trén ban d6 va trén hinh anh.

a) Bang ky hinh anh vao ban d6 theo toa do cic diém khéng ché da biét:
- Vao File > Open Table va chon & hop File Format 1a Raster Image, sau d6 chon tén
File hinh anh cian m& va bam niit Open, man hinh hién ra hop héi thoai nhu sau:

Ma plfu

Do you 'wéﬁ:ﬁih simply di:tﬁlay the image. or
. register it so that it will have geographic

!age Rglslralmn
i "ﬁgii':fdord

Labal . 3 X Coo;i:l-:' : Errur [pi:ﬁ;ﬁls]

0K 1 | Cancel gl !,I_nits i IE;t_liéctiun;.-él Help g
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- Xéc dinh hé toa do triing véi hé toa do céc diém da biét clia ban d6 thong qua niit Projection .

- Chon don vi toa do cho hinh anh nhap vao théng qua niit Units.

- Chon t6i thi€u ba diém trén hinh anh da biét toa d6 trén ban d6 va nhap cic gi4 tri
toa do ban d6 da biét vao hop hoi thoai diém khéng ché nhu sau:

Ad l:l Co ntrDI Pn |nt

- Chiing ta c6 thé bam niit New dé thém diém khéng ché€ méi vao ban do.
- Chon céc di€m khong ché€ da c6 trong khung Image Reglstratlon va bam nut Edit

dé bién tap lai, bAm nit Remove dé xéa di va bam niit Goto dé chuyén dén diém khong
ché€ ti€p theo.

- Bam niit (+) hoac (-) dé phéng to hodc thu lai hinh 4nh lai.

X4ac dinh xong chiing ta chon OK dé thuc hién hoac niit Cancel dé thoat ra. Thuc
hién xong chon File > Save Table dé ghi lai két qua dang ky va c6 thé coi Table nay
cing giéng nhu Table véc to khic trong viéc chéng x€p cac 16p thong tin.

b) Dang ky hinh anh vao ban dé khi khong biét toa do cdc diém khong ché’:

- Vao File > Open Table va chon ¢ hop File format la Raster Image, sau d6 chon tén
File hinh anh cdn m& va bam mit Open, mén hinh hién ra hop hoi thoai nhu & muc trén
va chon nit Display, man hinh hién ra cita s6 hinh anh ma chiing ta da chon. Néu chon
Table > Raster > Adjust Image Stylc man hmh hién ra hop h01 thoai:

ok ][ Gencet } (=) (] (iise ]
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Tai hop hoi thoai may c6 thé thay d6i do twong phan ciia hinh 4nh theo thudc

Contract va do sang t6i theo thuée Brighness sau d6 chon OK.

1.00 0.00 0
0.00 1.00 0
Click on imago: to mc.p..tli:'f'y_.point'.a ';:.ootdinalus.' - .ﬁ
amoct aGl o boahe Lnbls 001y 3003 oL
; .
XX QUANG SON XA PHUSC
; . TRUNG v
| E::::"::\"
-_;l-.a.q:'a‘ : Loty
. XA pHUSNG
=
| L]
|
' | OK Help
| o

- Xac dinh hé¢ toa d6 trung véi hé toa do ctia ban dé thoéng qua niit Projection.

- Chon don vi toa d6 cho hinh anh nhap vao thong qua nit Units. .

- Chon 16i thi€u ba di€m trén hinh 4nh ma ching ta coi chiing 12 diém khong ché s&

g4n v6i toa do ban dé.

- M& 16p thong tin ban d6 ma chiing ta s& dang ky hinh anh thong qua File > Open

Table va chon tén File can mé& réi chon Open.

- Chon tén diém khéng ché trong danh sich & khung Image Registration va vao thuc
don Table > Raster > Select Control Point From Map, sau d6 diing chu6t dé xac dinh Vi
tri clia diém khong ch€ tuong ving trén clra sé ban dé, khi d6 trén hop hoi thoai diém
khong ché s& hién ra gid tri toa do ban d6 cia diém khong ché ching ta chon. Lap lai

thao téc trén d6i véi cdc diém khéng ché di chon theo hop hoi thoai sau:

=B _Edit Control Point

Ty

~ Edit the information for thi

Label: 1

Map X: [1256.36 Tt
 MapY: [59863.68 o

: ':'\:5::'[maﬁé.f = l IJ

Image Y': ID

O Bt ]
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- Ching ta c6 thé baAm nit New dé thém diém kh6ng ché méi vao ban dé.

- Chon cac diém khong ch€ da c6 trong khung Image Registration va bam nit Edit
dé bién tap lai, bAm nit Remove dé x6a di va bam niit Goto dé chuyén dén diém khong
ché ti€p theo. :

- Bam niit (+) hodc (-) dé phéng to hoic thu lai hinh anh lai.

Xéc dinh xong ching ta chon OK dé thuc hién hodc mit Cancel dé thoat ra. Thuc
hién xong chon File > Save Table dé ghi lai két qua diang ky va cé thé coi Table nay
cling giong nhu Table véc to khac trong viéc chéng x€p céc 16p thong tin.

VL. MOT SO CONG CU BIEN TAP BAN PO

1. Tao luéi toa do

Chung ta chay chuong trinh ttng dung GridMaker.mbx hoac chon biéu tugng ctia né
161 dung chuét xdc dinh cira s6 bao 16p ban dé ching ta cin tao 6 lué6i, khi d6 man hinh
hién ra hop hoi thoai nhu sau:

E{ xtents

£

u,mth |_1'1"'_‘|§1 81
- _\_]1_ 1.2754

i

Tai hop hoi thoai nay chiing ta chon:

- Kiéu d6i tugng tao ra 6 luéi, néu chon 6 Region tao 6 luéi kiéu ving va néu chon 6
Polyline tao 6 luéi kiéu dudng.

- Chon kiéu thé hién ctia 6 lu6i theo niit Style tuwong tng, khi d6 man hinh hién ra
hop hoi thoai xdc dinh phong céch thé hién cha céc d6i tugng da chon kiéu & trén va

128



chiing ta c6 thé thay déi thugc tinh thé hién clia né nhu dudng nét, mau sic, kiéu 1o,
duong bién, .v.v... r6i sau dé chon OK dé khang dinh .

- Xdc dinh khodng céch giita cdc dudng trong 6 luéi theo hop Spacing between line
(vi du 15"=0.4 do).

- Khang dinh gi4 tri toa do cla khung 6 lu6i toa do tai cac hop North, South, East va
West. :

- Chon OK dé€ thuc hién va khi d6 man hinh hién ra hop hdi thoai ghi File, ching ta
nhap tén File luu két qua cta 16p 6 luéi sau dé badm OK.

2. Tao thang ti Ié cua bdn do

Chiing ta chay chuong trinh ting dung Scalebar.mbx hodc chon biéu tuon g cua no roi
dung chuét xdc dinh vi tri ctia thang ti 1¢ trong cira s6 ban d6 chiing ta can tao thang ti
1¢, khi d6 man hinh hién ra:

: Length of st:aié:_bar:

I @ Miles

' Kilometers
:ant“for scale bar labels: Az
Fill color for scale bar: o - -

Tai hop hoi thoai nay chiing ta xac dinh :

- D¢ dai cha thang ti 1¢ tai hop Lenght of Scale bar.

- Chon don vi cho thang ti ¢ 12 Mile hoac Kilometers.

- Chon Font chif cho nhan cla thang ti 1¢ tai biéu twong Font for scale bar.
- Chon mau t6 cta thang ti 1¢ tai biéu tuong Fill color for scale bar.

Thuc hién xong chiing ta chon File > Save Table dé ghi lai két qua.
3. Lam tron cdc doi tuong bdn do

Lam tron cdc doi tugng ban do chi thuc hién khi ching ta muén thé hién cic doi
tuong dudng cin udn lugn, tron tru nhu dudng binh do, géc pho .v.v... Chon 16p chita
thong tin va dat n6 vao ché€ do bién tap duoc. Chiing ta chon cic doi tugng can lam tron
(&n phim Shift d€ chon nhiéu déi twong) sau dé vao Edit > Smooth. Céc d6i tuong chon
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s€ duge lam tron theo dudng Spline. Muén loai b6 su lam tron chiing ta vao Edit >
Unsmooth khi dé cac doi tuong bi lam tron s& dugc tra lai nguyén trang ban dau.

4. Chuyén cac doi tuong duong vé ving
- Chen va dat tén 16p chita doi tuong & ché d6 bién tap dugc.

- Chon d6i tugng duong cdn chuyén thanh doi tuong ving, d6i tugng dudng nay
bat budc phai 12 mot doi tugng, né€u nhiéu dudng ching ta ding chic niang Combine
dé néi lai .

- Vao thuc don Object > Convert to regions.
5. Chuyén doi tuong vitng vé duomg
- Chon va dit tén 16p chira doi tuong & ché do bién tap dugc.

- Chon d6i tugng ving can chuyén thanh d6i twong dudng.
- Vao thuc don Object > Convert to Polylines.
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Chuong V
BIEN TAP CAC POI TUONG BAN PO

Viéc bién tap cdc d6i tuong ban d6 12 mot cong viée rdt cong phu va doi hoi phai tinh
kién nhdn. Trudc khi thuc hién céc thao tdc bién tap ching ta phai viio hop hoi thoai
Layer Control va chon dat tén 16p chita cdc déi tuong ban dé bién tap thanh ché do bién
tap duge (Editable). Céc thao tdc bién tap chinh cé thé thuc hién nhu sau:

1. CAC THAO TAC BIEN TAP CHINH

1. Vé déi tuong moi

Chon biéu tuong thuc don vé d6i tugng ma ching (a cdn tao ra trén hop thuc don
Drawing nhu v& doan thing, v& dudng cong, vé& hinh hop .v.v. sau d6 di chuot dén vi tri
cdn tao ra d6i tugng méi va xdc dinh vi trf cho c4c dinh ctia d6i tirong tao ra.

2. Xod doi tuong dd co

Chon d6i tugng cdn xo4 rdi sau d6 an phim Delete hoac vao thuc don Edit > Clear.
Néu mudn xod nhiéu doi tuong thi bim chon céc d6i tuong déng thoi véi an phim Shift
hoac chon theo cira 56 sau d6 g& phim Delete. Muén citu lai céc d6i tuong vira xod di
vao Edit > Undo.

3. Sao chép va dan cdc doi tuong

Chon céc d6i twong cdn sao chép sau d6 bdm vao biéu tuong sao chép hoac vao
Edit > Copy hay &n déng thdi (Ctrl + C) san dé chon Edit > Paste hay 4n dong thoi
(Ctrl + V). Cac d6i trgng trong Mapinfo duge sao chép theo dia 1y cho nén cac doi
turgng sao chép s&€ ¢6 vi trf dia 1y tring véi cdc d6i tugng g6e.

4. Dich chuyén vi tri doi tuong

Chon céc déi tugng cin dich chuyén vi tri bing chudt sau d6 giir chuot va di chuyén
dén vi tri m&i va bam chuot dé khang dinh vi tri méi.

5. Bién tdp cdc dinh cia doi tuong

Chon d6i tugng can bién tap dinh sau dé6 baim biéu tugng bat diém dinh trong hop
Main hodc vao Edit > Reshape, khi dé cdc dinh clia dGi tugng s& bat 1&n va ching ta cé
thé thuc hién:
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- Xo4 diém dinh: Chon diém dinh cin xo04 sau dé6 bam phim Del.

- Dich chuyén vi tri diém dinh: Chon diém dinh cin di chuyén sau dé giir chuot va di
chuyén dén vi tri méi va bim chuét dé khing dinh vi tri méi.

- Thém di€ém dinh: Bdm vao biéu tugng thém dinh trong hop Drawing dé chon ché do
sau d6 xdc dinh vi tri cia dinh mdi ctia d6i tugng va bam chudt.

- Sao chép mot doan d6i tuong: Chon d6i tugng goc sau dé bat diém dinh va ding
chudt dé chon dinh ddu ctia doan va an phim Shift hodc phim Ctrl déng thoi véi viec
bam chon dinh cu6i cla doan, khi d6 cdc dinh ctia doan s& duoc dénh dau chon va
chiing ta chon biéu tugng sao chép sau dé6 bam biéu twong gan. Chitc ning nay rat hiru
ich khi chiing ta mu6n nhéan ban cdc dudng chung nhau ctia cic d6i tugng khi déng cac
Polygon trong h¢ théng tao d6i tugng quan ly.

Sau day la man hinh vi du:

1

==l T ap 0
=|Eile Edit Objects Query TIable

Options Map Tools Window Help

*
IZuoH&B_ernv 555 T ?E&m]'i‘lu G one s ‘_ _..w AT I = Ngm

IL. BIEN TAP TRUC TIEP VI TRI DIA LY CUA CAC POI TUGNG

1. Doi tuong diém
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Tai day ching ta nhap gid tri toa do chinh x4c ctia diém can tao ra vao hop Location
X va Y. Thay déi ki€u thé hién chon niit Style va chon kiéu ky hiéu trong danh séch cua
hé théng, chon xong cédc tham s6 trén bam niit OK.

2. Doi tuong duong

Bim dip chuét vao do6i twong dudng cdn bién tap hodc chon déi twong sau d6 vao
Edit > Get Info khi d6 man hinh hién ra hop hoi thoai bién tap duong nhu sau:

= ¥ v I I R )

Bounds X1: [570.225 =6 ™ w1: [Z713709 20 m
Bounds xz.-' [591 -820.03 m w2 |[2134 703 96

j::ont-r 2  [se1. 137 " Jzaz1. 77402 m

Total Longlh 2363 mi
Line §¢t_gmenlsﬂ_ 3
Set:t'i:i:p:if:__s: 1 -

i—_ imo_ﬁ th

st

I DK gi l:.‘.ancolr-.:'-'-'—gl Help g

Tai hop hoi thoai nay chiing ta c6 thé nhap toa do chinh xéc clia cdc diém cuc tiéu va
cuc dai thugc doi tuong duong theo hop Bound X1, Y1 va Bound X2, Y2. Néu muén
lam tron d6i twong dudng chon 6 Smooth va thay déi thuoc tinh thé hién ching ta bam

nit Style sau d6 xac dinh cdc tham s6 clia né. Chon xong bam OK dé thuc hién hoac
Cancel dé loai bo.

3. Doi twong vang

Dung chudt bam dip vao déi tugng viing cdn bién tap hoac chon d6i tuong sau dé
vao Edit > Get Info khi d6 man hinh hién ra hop hoi thoai bién ldp vung nhu sau:

Flcglon Object

Bounds X1: [EIWIEEDR ey [2 107.032.28 m
Bounds X2: [587_479.39 m. ‘s'z, [2734a26991 m
Center %X: [570.876 38 m : [2720651.09 m

Total Area: 270.0 sq mi
Total Poﬂmetdt; 62.99 mi
Line Segmuntm 25 '

Pol_vgon '.:___.1

Tai hop hoi thoai nay c6 thé nhap toa d6 chinh x4c clia céc diém cuc tiéu va cuc dai
thudc déi tuong ving theo hop Bound X1, Y1 va Bound X2, Y2. Néu muén thay déi
thuoc tinh thé hién cla déi tugng bam niit Style sau d6é xdc dinh cdc tham s6 clia né.
Chon xong bdim OK dé thuc hién hoac Cancel dé loai bo.
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4. Déi tuong chix

Dung chudt bdm diip vao d6i tugng chir cén bién tap hodc chon d6i tuong sau dé vao
Edit > Get Info khi d6 man hinh hién ra hop hdi thoai bién tﬁp chit nhu sau:

Line Spacing

() &ncﬁ_i_}: Line

@ Single O H_o Line - Swle:
- Ogs C Simple Line [ ]|
-

i

. I £ Qnuhle

Tai hop hoi thoai nay chiing ta c6 thé nhap chinh xdc dong van ban ctia d6i tuong
chir. Néu muén thay déi ki€u chir bAm nut biéu twong Style sau dé x4c dinh cac tham s6
cua chit. Chiing ta c¢6 thé x4c dinh chinh xdc vi tri diém dau ctia dong chir tai hop Start
X va Y. Thay déi géc xoay clia dong chit trong hop Rotation Angle ciing nhu cdc tham
s6 vé khoang cich cédc dong chit trong khung Line Spacing, cdc tham s6 vé can 1é dong
chir trong khung Justification va cc tham s6 vé nhan duodng trong khung Label Line.
Chon xong bam OK dé thuc hién hoac Cancel dé loai bo.

ML THIET LAP CAC THAM SO CUA SO BAN PO

1. Thay déi ti l¢ tdm nhin ciia cita s6 bdn dé

D¢ thay d6i tim nhin ciia clra s6 ban dé hién thoi ngoai viec dung biéu tuong cong
cu phéng to thu nhé trén hép Main chiing tacé thé dt ty 1é ¢6 dinh cho tdm nhin bang
céch vao Map > Change View khi d6 man hinh hién ra hop hoi thoai sau:

i__ . : Change Vlew i

Znom [\Aﬁndow W‘dlh] I
Map Scale: 1 cm = |2 548 mi . '
- Cenlel of Window: X: }5?5 000 m Y |z 120,000 m

5 [ o _ll Cmel H Help ..l
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Tai hop héi thoai nay chiing ta nhap ti 1é cho tim nhin vio hop Map Scale theo ti 1¢
ban d6 chiing ta muon hién thi va sau d6 chon OK. Dung biéu tuong cong cu di chuyén
man hinh d€ xem timg phan cta ban d6. Néu muén in cic doi tugng chit theo ding co
chir da chon trong mot ti 1& ban d6 nhét dinh thi chung ta phdi dung chitc nang nay dé
dat ti 1¢ tdm nhin ctia ban dé theo ti 1¢ da chon va sau dé chon co chir ching ta in trudce
khi phét sinh ra cdc d6i tuong chit trén ban dé. '

2. Xac dinh cdc tham s6 cho cita s6 bdn dé hién thoi

Céc tham s6 nay chi ¢6 tdc dung trong cira sé ban dé hién thoi. Ching ta vao thuc
don Map > Options khi d6 man hinh hién ra hop hoi thoai sau:

— : Map Optons ;
Inits : i 0yl i
Map qnl E . | | I oK _I
{oordinate Units: [EEEEN. o ancer
Distance Units: Imiles L!_g
. : - | Projection... i
 Area Units: : Isquare miles Lﬁ _ -
HES ol s G0 800 BT gagenme xosia s Toollo [ g on)
Display in Status Bar:———  \When Resizing Window:
| (O Z_Qom (Window Widﬂi] 1 @ Fit ."%&p to New W'i.'it\dow' '
. (C Map Scale : | " Preserve Current Scale
~ O Cursor Location ‘ 1 -

Tai hop hoi thoai nay c6 thé chon céc tham s& sau:

- Pon vi toa d6 trong hop Coordinate Units.

- Pon vi khodng céch trong hop Distance Units.

- Pon vi dién tich trong hop Area Units.

- Chon hé toa d¢ thé hién ciia ban d6 chiing ta bam nit Projection.

- Hién/tat thanh cuén néu chiin g ta chon hoic loai bé d4anh dau 6 Scrool Bars.

- Hién thi thong tin trén thanh trang thdi la gid tri do rong cta cira sé ban d6 néu
chon 6 Zoom, ti 1¢ hién thdi ctia ban dé néu chon 6 Map Scale va toa do vi tri hién thoi
cua con tro néu chon 6 Cursor Location.

- Diéu khién su hién thi ctia ban d6 trong cira sé hién thdi luon luén kin theo kich
thu6c clra s6 néu chon 6 Fit Map to New Windows va gilt nguyén ti ¢ hién thi néu
chiing ta chon 6 Preserve Current Scale.

Sau khi chon xong céc tham s6 trén bam niit OK dé thuc hién hoac Cancel dé
thodt ra.
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3. Vé doi tuong duong bang chuong trinh itng dung Cogoline
Chiing ta chay chuong trinh ttng dung Cogoline.mbx (File > Run Mapbasic Program)
hodc chon biéu tuong ctia né trén hop Tools va ding chuot dé xac dinh vi tri ddu cla
déi twong duong, man hinh hién ra hop hoi thoai sau:
i e . wremse
1 st“."tiﬂg_-_x\i l_; 337926 —

Stnrlinq X ]11_191166

Angle I o degr_ea'a

Tai hop hoi thoai nay ching ta khang dinh gid tri toa do clia diém dau tai hop
Starting X va Starting Y. Nhap gia tri géc cua d6i tuong dudng tai hop Angle va do dai
ctia n6 tai hop Lenght theo don vi chon 1a Feet hay dam (Mile). Sau d6 bam niit Create
Line dé thuc hién chiic nang.

Lap lai thao tic trén dé tao ra cdc d6i tugng dudng ching ta cin va ghi lai két qua
thue hién thong qua File > Save Table.

Luu y: Trong bién tdap dé cé thé bdt diém vao cdc vi tri dd ¢é chiing ta phdi bdt ché
do bat diém bdng cdach bam phim S trén ban phim, khi dé trén thanh trang thdi cudi
man hinh sé hién ra chit SNAP va khi chiing ta di chuyén con chudt dén vi tri cac diém
da c6 thi con tré hé thong sé trd thanh hinh chit thdp. Muén tdt ché do bdt diém thi
chiing ta dn thém phim S mét lan nita.
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Chuong VI

HE TOA PO VA THIET KE TRANG BAN PO
TRONG MAPINFO

I. PHEP CHIKU VA LUGI CHIEU BAN PO

1. Phép chiéu bdn do

Phép chi€u ban d6 trong GIS 1a mét d4nh xa cia céc doi twong dia 1y tir mat cdu, duge
coi la thé hién hinh dang ctia Trdi dat thuc sang mat phiang. Khi ching ta chuyén cic
d6i tuong dia 1y tir the gisi thuc sang mét phing clia t ban d6 hay clha man hinh méy
tinh ching luén luén bi bién dang. Phép chigu ban d6 1a mot phuong phdp nhim lam
giam bdt su bien dang cla cdc d6i trong ban d6é khi chuyén chiing tir mat cdu sang mat
phing ban dé. C6 nhiéu phép chiéu khac nhau va chiing c6 cdc tinh chét khéc nhau, phit
hop cho timg viing lanh thé khédc nhau trén Trai dat. Néu cing mét vung lanh thé ma
ching ta thé hién né trén ban dé véi cic luéi chi€u khéc nhau thi hinh anh thu duoc ciia
no ciing khac nhau.

Ludi chi€u ban d6 duge gin lién v6i hinh dang va kich thuée cu thé cua Trai dat.
Hién nay hau hét cdc nuée va cic chau luc déu c6 mot hé toa do rieng chia minh. Tai
Viét Nam ta cdc ban d6 UTM trudc day dugce xuit ban dua trén co sd ludi chigu UTM
va kich thude qua dat theo Ellipsoid Everest, cdc bin dé Gauss sau ndy dugc xuit
ban dua trén co s& 1udi chi€u Gauss v kich thudc qua dat theo Ellipsoid Krasovsky.

Ludi chi€u ban d6 can duge xac dinh khi:

- Tao mdi mét 1dp thong tin;

- Nhap dit liéu da c6 tir khuén dang DXF (Import);

- Chay cic iing dung ctia GIS doi hoi d6 chinh x4c dia Iy theo ui chiéu ban dé cho mréce.

2. Ludi chiéu bdn dé va hé toa do trong Mapinfo

Trong GIS ching ta hi€u thuat ngir hé toa do bao gdm mot tap hop céc tham s6 cho
phép ta xdc dinh dugc chinh xdc vi trf cla cc d6i tugng trén mat dat. Mot trong cdc
tham s6 d6 trong GIS la phép chiéu ban dé. Khi xdc dinh hé toa d6 trong Maplinfo
chiing ta phai x4c dinh r5 loai toa d9, kich thudc qua dat va Iudi chigu ban dé.
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He toa do gén véi trai dat thyc duge sir dung trong GIS thong dung nhat bao gom céc
loai co ban sau:

- He toa do dia ly: Kinh tuyén va vi tuyén. Trong hé toa do niy moi diém trén tréi
dat dugc déu duge xdc dinh bang gid tri giao diém clia cdc dudng kinh tuyén va vi
tuyén di qua di€m dé. Kinh tuyén géc cé gia tri Lo=0 duoc quy uéc la duong kinh
tuy€n di qua Dai thién van Greenwich clia Thit d6 London nuéc Anh. Pudng vi tuyén
goc ¢6 gid tri Bo=0 12 dudng xich dao. Pudng kinh tuyén cé gia tri tir 0° dén 360° va
dudmng vi tuyén ¢ gid tri tir 0° dén 90° néu céc diém & phia Bic dudng xich dao va tir (°
dén -90° cac diém & phia Nam dudng xich dao.

- Hé toa d6 dia tam khéng gian: X, Y, Z. Trong hé toa do nay diém géc toa do 1a
diém trong tam chia Tréi dat, truc Z trung vdi truc xoay cha Trdi dat, truc X di qua giao
diém ciia dudng kinh tuyén goc v6i dudmg xich dao va truc Y ndm trong mat phing xich

dao va xoay 90° vé phia Dong so véi truc X. Moi diém trong khong gian déu duoge xac
dinhboi3 gidm X, Y, Z.

- He toa do mat phing ban d6: x, y. Trong hé toa dé ndy truc x 13 hinh chigu cla
dudng kinh tuyén trung uong va truc y 13 hinh chi€u cha dudng xich dao trén mét
phéng. Moi diém trén mat phéng duge xéc dinh boi 2 gid tri x, y.

Quy u6e phan manh ban d6 1/1.000.000 cia th€ gi6i bao phit viing 1anh thé véi kich
thudc 6° x 4° dugc x4c dinh nhu sau:
n=(L,+3)/6 ; N=n+30
Trong dé:
n - S8 thit tu cia mai ban dé;
N - S& thi ty clia mé’mh ban d6.
Chiing ta cé thé bién tap hoac thém méi mot he toa do vao hé théng Maplnfo bing

' céch dung céc trinh soan thao van ban dang ASCII d€ bién tap hay xdc dinh céc tham s6
cta hé toa d¢ trong File Mapinfow Prj.

Hé toa do ¢6 thé 1a h¢ toa do cuc bo khong gin véi Tréi dat (Non-Earth) hoac hé toa
do gan véi Trdi dat (Earth System).

Trong cong nghe GIS doi hoi cic déi tugng quéan 1y phai gén vt he toa do thuc, cé
nghia 12 moi d6i tugng phéi gin véi vi trf thuc clla ching trén mat déat. Chi cé cic 16p
thong tin trong hé Earth Coordinates chiing ta méi ¢é thé thuc hién:

- Chéng x&p cic 1p thong tin cha thé giéi thuc;

- Chuyén déi cc hé toa do tu dong;

- Xac dinh vi tri thue clha cdc d6i trgng.
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Cdc ban d6 trong hé Non-Earth Coordinates chi thé hién cic dgi tuong theo hinh
dang cla chiing va khong dugc gan véi vi tri thue té. Ching ta khong thé thuc hién viéc
chuyén déi giita cdc hé toa do.

3. Cdc tham 50 xdc dinh hé toa do

He toa do trong Mapinfo (trir hé toa do dia 1y) thong thudng duge xédc dinh bdi cdc
tham s& sau day:

- Tén ctia hé toa.do:;

- Tén luéi chiéu ban dé;

- Tén Ellipsoid qua dat;

- Bon vi toa do;

- Kinh tuyén trung vong;
- Vi tuyén g6c;

- He s6 ti 1g;

- Dich chuyén ctia truc X;
- Dich chuyén clia truc Y.

Vi du trong Maplnfo 4.0 hé toa d6 Gauss, mii 18 (hé toa 46 HANOI-72) duoc dinh
nghia trong tap tin quan'ly cdc heé toa d ciia phan mém nhur sau:

"He toa do Gauss", 8, 1001, 7, 105, 0, 1, 500000, 0

Trong dé:
"He toa do Gaus"  Tén hé toa do;
8 S6 hiéu phép chigu Gauss;
1001 56 hiéu qua cau Krasovsky (Datum);
7 Mai don vi toa d6 1A mét;
105 Gid tri kinh tuyén trung vong (L0O):
0 Gia tri v1 tuyén g6c (BO);
! Hg 56 til¢ dudng kinh tuyén trung wong (m);
500000 Dich chuyén ciia truc Y (YO);
0 Dich chuyén ctia truc X (X0).

Khi muén tao ra mot hé toa do méi thi chiing ta phai bién tap lai File Maplnfo.prj
cla hé théng theo cdc tham s6 néu trén bang c4c trinh bién tap ASCII. Bién tap xong
chiing ta ghi lai va goi chuong trinh Maplnfo.
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II. THIET KE TRANG BAN PO

1. Tao ra trang trinh bay bdan dé méi (Layout)

Trang trinh bay 1a mot cong cu cia Maplnfo cho phép téng hop céc cira s6 thong tin
nhu ctra s6 ban dé, cira s6 xét duyét, clra sé biéu do, cilra sé ghi chi .v.v... trén mot trang
ban d6 va c6 thé in 4n ra thiét bi ddu ra. Ching ta c¢6 thé thém bét bat ky mot cira s6
thong tin hién thoi dang md nao vao trang trinh bay hoac thém céc tiéu dé, ghi chi vao
trang trinh bay. Trang trinh bay 1a cong cu giip ching ta thiét k€& céc trang in 4n dau ra
theo nhu cau va déi tugng phuc vu mot caich mém déo va tham my.

Chiing ta vao thuc don Window > New Layout Window. Khi cira s Layout dugc m&

thi trén thanh thuc don chinh cia Maplnfo s& tu dong thém thuc don Layout. Man hinh
hién ra hop héi thoai nhu sau:

New Layo ut Win dow

"':'_Cleale a new Layuut wmdow containing: __ R s
f"i iOne Frame for Wmdow' i THU Map | . ng
(-“1 _Erames for All Cunently Open Windows '

- uo Frames

I oK gl . Cancel l | Help g

Tai hop hoi thoai nay c6 thé chon mét trong ba lwa chon:

- One Frame for Window: Lua chon nay la gid tri ngdm dinh ctia hé théng. Khi chon
chitc nang nay hé théng s€ tu dong tao ra mot khung (Frame) tai trung tam ciia trang
trinh bay va chiing ta c¢6 thé chon tén cua s6 thong tin hién thoi dang m& dé gén cho
khung d6 trong danh sich trén man hinh. Néu ching ta chon cira s6 ban d6 hay cira s
biéu d6 ma né c6 cira sé ghi chii (Legend) thi hé¢ théng ciing tw dong dwa céc ghi chu
vao trang trinh bay. Ching ta c6 thé bién tap, thay déi kich thudc, vi tri ciing nhu cic
thudc tinh thé hién clia khung giéng nhu 1a mot d6i tuong viing.

- Frames for All Currently Open Windows: Khi chon chitc nang nay hé théng sé tu
dong tao ra mot khung (Frame) va gén toan bo céc ctra s thong tin dang mé vao trang
trinh bay. Su sap x€p cla cac cilra s6 thong tin hién thoi dang md duge gan vao khung
van dam bao giéng nhu trén man hinh.

- No Frames: Su lua chon nay chiing ta s& thu dugc moét trang trinh bay tring. Két
qua cla chitc nang nay ciing twong tu nhu khi chon chiic nang tao ra cira sé Layout méi
néu chiing ta chua c6 mot cira s6 thong tin ndo duge md.
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Céac Frame trong Layout c6 cdc tinh chat sau day:
- Frame 12 mot déi tugng d6 thi va chiing ta c6 thé chon, bién tap do6i tuong.

- Chiing ta c6 thé sao chép, xo0d va dan doi tuong vao céc clra sé Layout khac.
2. Tao ra cdac khung (Frame) trén Layout

Khi da mo it nhat mot trang Layout thi trén hop cong cu thuc don Drawing biéu
tuong cong cu Frame sé bat séng lén va chiing ta c6 thé dung biéu tuong nay dé xac
dinh cic Frame trén trang Layout tuong tu nhu khi chiing ta tao ra mot doi tuong hinh
chir nhat. Khi tao xong Frame néu chiing ta dang md céc cira s8 thong tin thi man hinh s&
hién ra hop héi thoai khung (Frame Object Dialog) va khi dé chon tén cira sé théong tin
dang ma trong danh sich dé gan cho khung tai hop Window clia hop hoi thoai.

= — . — : o s
\H'.'indl.)\.n: : !THU Ha.[; : [_tg
ﬂound_s =1 cm Y1i: lé.é22 | : cm
Bounds X2: [24.105 em w2 [13.799 cm

.C.e:r;:tenx: { 16.185 t:m Y: |B..3.1l] ok
width:  [15.84 l::m : ﬂ;igm: [10 s cm
X Fill Frame with Map _S_cali.'s:'"on Pap;;:_: 1 cm = W mi

L acseer d [ mane o

Chiing ta c6 thé xdc dinh chinh xdc kich thuéc ciia khung bang cédch nhap céc gi4 tri
toa do trang gidy theo hop Bound X1, Y1 va Bound X2, Y2. Dt ti 1é cho trang ban dé
in ra trén gidy theo hop Scale on Paper 1 cm = xxxx va gan ban dé cho kich thudc cha
khung da tao ra néu chiing ta chon dénh d4u 6 Fill Frame with Map. Sau khi chon xong
bam niit OK d¢€ thuc hién hoac nit Cancel dé thoit ra. '

3. Chuyén dich va dinh vi lai cdc Frame

Muén thay déi céc vi tri hay kich thuéc ciia cic Frame trong Layout chlf{ng ta dung
bi€u tugng chon doi twgng va bam chudt dé chon Frame, khi dé Frame s& bat siang va
ching ta vao thyc don Option > Region Style dé thay déi cdc thuoc tinh thé hién clia
Frame nhu ki€u t6, mau sic, dudng bao v.v... Néu muén di chuyén Frame thi chiing ta
bam chon Frame va giit chuét khi d6 trén man hinh sé hién ra con tr6 hinh chit thap va
ching ta c6 thé di chuyén Frame dén vi tri méi, sau dé tha chuét. Néu thay déi kich
thudc cua Frame thi chon Frame réi di chu6t dén cic dinh ctia d6i tuong khi d6 man
hinh hi¢n ra con tré hinh miii tén hai d4u, chiing ta b4m chuot va giit nd, di chyén dén
vi tri méi sau d6 tha chuot.
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4. Can cdc doi tuong trén trang Layout

Chiing ta chon cac d6i tugng trén trang trinh bay cin can 1€ va sau d6 vao thuc don
Layout > Align Object, khi d6 hop hoi thoai Align Object Dialog hién ra nhu sau:

Fwn Align bjec:ls |

: -Hoiiz‘ohtql;f_:“"'

Don't change
Don't change
Align left edges of
Align center of
~____|Align right edges of

-' "V Dlslnhute

Ifet*.t'e_i':l{ _El:'bie'dfz '

1z

i

I Don't change

[_.E Selected Objects

 with Hespect to Ieach ulher

Ly

1L

Cancal E | E

.H.eln

~ OK

Trong hop hoi thoai nay céac lua chon

can theo phuong ngang va phuong doc trong

hop Horizontal va hop Vertical bao gém céc lua chon sau:

+ Tai khung Horizontal:

- Don't change Alignment
- Align left edges of

- Align center of

- Align right edges of

- Distribute

+ Tai khung Vertical:

- Don't change alignment
- Align top edges of

- Align center of

- Align bottom edges of
- Distribute

Khong thay déi

Can theo bién tréi clia d6i tugng
Can theo tam cta ddi tugng

Can theo bién phai cua déi tugng
Can theo su phén b6 cua doéi tugng

Khong thay déi

Can theo bién trén cua d6i tuong
Cin theo tam cta d6i tuong

Cén theo bién duéi ctia d6i tuong
Can theo su phan bo cua déi tugng

Ching ta chon mot trong cac chirc nang trén va sau dé vao hop with Respect to dé
chon chudn cin 1€ theo cdc d6i tugng di chon véi nhau (each other) hodc cin theo 1é

cua trang trinh bay (entire layout). Khi

da chon xong cdc lua chon theo yéu cau dat

ra trong hop hoi thoai trén, bAm niit OK dé khéng dinh hoic bam niit Cancel dé hiy

thao thac.
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5. Tao hinh béng (Shadow) cho cdc Frame

Ching ta chon céc Frame cin tao hinh béng va vao thuc don Layout > Create Drop
Shadow, khi d6 man hinh hién ra hOp héi thoai sau:

Dutance to ulfsel lhu dmp :hadow
Horizontal: [[EIES ey . .
Vertical: [oz17s cm

Ching ta xdc dinh gia tri cho hinh béng d6i tuong theo phuong ngang (Horizontal)
va phuong doc (Vertical), sau d6 chon niit OK dé khing dinh.

6. Thao tdc véi cdc doi tuong giao nhau trén Layout

Khi ching ta tao ra cdc d6i tugng trén trang Layout c6 thé céc d6i tuong do6 sé bi
giao nhau mot phén hodc déi twong nay nim trong d6i tuong khéc. Khi d6 c6 thé céc
thong tin clia d6i tugng ndm dudi cé thé bi che khuat khong nhin thay, do vay ching ta
phai chon cédc d6i tuong giao nhau d6 va vao thuc don Layout > Send to Back hoac
Layout > Bring to Front dé chuyén céc khung d6i tugng ra phia sau hodc ra phia trudc.

-

7. Thay déi tam nhin ciia trang Layout

Chiing ta ding biéu tugng phéng to, thu nhé trén hop cong cu dé phéng to hay thu
nhé trang Layout hay mot cilra sé trén trang Layout. Ching ta c¢6 thé vao thuc don
Layout > Change Zoom va nhap gié tri phan tram (%) phéng dai vao hop hoi thoai.
Khoang phéng dai cho phép trong MaplInfo 12 tir 6.3% dé&n 800%. Chiing ta ciling c6
thé an céc phim tir 1 dén 8 trén phan ban phim mé réng chia mdy tinh dé thuc hién
phoéng dai trang Layout 1én tr 1 dén 8 l4n gi4 tri hién thoi clia tim nhin. Vi du tim

nhin hién thoi la 20% thi khi &n chon s6 S thi he thong s& phéng dai tim nhin 1én 1a
5 x 20%=100%.

' Lavo ut Z'nrn

';Zt;l:u; rﬁ&— = MERES T

[ ._ ]' Ca"‘“” ]&

D¢ hién thi tim nhin thuc t€ cia trang Layout ching ta vao Layout > View Actual
Size khi d6 man hinh s& hién thi cdc d6i tugng & ty 1¢ ding nhu khi in ra trén gidy. Néu
chon Layout > View Entire Layout hé théng s& hién thi toan b6 cdc ndi dung cua trang
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trinh bay vao mét man hinh Layout. Néu chon Layout > Previous View hé théng dua lai
cho chiing ta tdm nhin truéc dé.

8. Tao ra cdc doi tuong chit trén trang Layout

Khi mu6n tao ra cdc ghi chi, tieu dé .v.v... trén trang Layout, chiing ta dung biéu
tuong thuc don trén hop cong cu Drawing dé tao ra déi tuong chit. Trude khi tao chiing,
vao Option > Text Style va chon phong chit va kiéu chit ciing nhu co chit sau dé chon
nuit OK.

Dé bién tap lai cdc d6i tugng chit ching ta chon biéu twong cong cu chon trén Main
réi bam ddp chuot vao déi tugng chit, khi d6 man hinh hién ra hop hoi thoai chir va
chiing ta c6 thé thay d6i cdc tham s6 x4c dinh dong ghi chi theo ¥ muén.

| R T T T
Text: [B3n D3 Hanh Chinh ' e
Start X: [21.126 em Y [13642 ém

:.:._;: rrLina Sﬁﬁci’lg:_w] ‘Justification - (Label Line— o

[ (:’é\ Single ’ A GI Left « [ = No Line S;_vle: %
BOE - f e ) Canter O Simple Line |: l
E C! Double ‘ E C Right l . Arrow Line '
Bﬁtatii:n Angle: ]O.D deg i

Lo R Eancet L[ e ]

Céc tham s6 trong hop héi thoai nay da dugc gidi thiéu k§ trong phan bién tap doi
tuong chir 6 trén. Ching ta ¢6 thé thao tdc cdc d6i tugng chir & day giéng nhu céc d6i
tuong chit trén trang ban d6 ma ching ta da kh4 thanh thao.

Céc d6i tugng chif trén trang trinh bay s& dugc gilt nguyén kich ¢& nhu khi chiing ta
nhap vao, n6 khéc véi cac d6i tugng chit trong trang ban dé 1a khong bi co gian theo ti
1¢ ban d6. Do vay c6 thé tao ra céc ghi chi miu trén trang trinh bay dé sir dung nhiéu
lan, chi ti€t vé trang trinh bay miu s& dugc gidi thiéu sau day.

IIL. IN TRANG BAN PO

1. Cdc tham s6 cua trang Layout

Khi muén thay déi cdc tham s6 ngdm dinh cia trang Layout thi vao thuc don
Layout > Display Option, khi d6 man hinh hién ra hop hoi thoai nhu sau:
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i

f“_' Shnw Fluleur

r; Show ,ﬂag& Breaks :
. Show frame cnntenls.
O ,&lways ' .
(= _Q_nly when La_-.mul: Wmdow is ﬂctlvu

-La_v,-oul Stze

width: [ page
Height: |1. page

Tntal slze- 2 3 r.:. vndu 21 l:l .cm hugh

Trong hop héi thoai nay bao gédm cic lua chon sau:
- Show Rulers. Hién thi biéu tuong thudc ké trén trang trinh bay.
- Show Page Breaks. Hién thi su phan t4ch giita cdc trang trong Layout.

- Always. Chiic nang nay cho phép hé théng luén luon hién thi noi dung cta cic
Frame trong trang Layout. Chon lua chon nay khi ching ta thay déi trén cic cira sé
thong tin ban d6 hay cic cira s6 thong tin khic thi trong n6i dung cdc Frame tuong ng
trén trang Layout ciing thay d6i theo. Day la lya chon ngdm dinh ctia hé thong.

- Only when Layout Window is Active. Lua chon ndy chi cho phép hién thi cic
thong tin ndi dung clia céc Frame khi cira s6 Layout duoc kich hoat. Khi cic cira s6
khac dugc m6 thi trén trang Layout chi hién thi tén tiéu dé cia cira sé dé.

- Never. H¢ thong khong bao gid hién thi néi dung cta cdc Frame trén trang trinh
bay. N6 chi hién thi tén ctia cdc cira s8 thong tin trong ciac Frame tuwong ting. Néu chon
chiic nang nay thi chiing ta c¢6 thé thuc hién nhanh chéng cic thao tdc chuyén dich hoac
thay d6i kich thuéc ctia Frame vi khong phai cho doi v& cdc thong tin ra man hinh.

- Chiing ta c6 thé xédc dinh 1¢ cho trang trinh bay hoac xdc dinh kich ¢ cta trang
Layout theo khé gidy ma chiing ta di c6 theo thiét bi mdy in da cai dat vao moi trudng

mdy tinh. Nhap s6 trang gidy theo chiéu Width va Height cha hop hoéi thoai, sau dé
chon niit OK.

2. Tao ra cdc trang Layou:t mdu

Trang Layout mau thong thudng 1a trang trinh bay tring vé noi dung va chi c6 céc
ghi chu, tieu dé duge sir dung nhiéu 14n cho mot yéu cdu dit ra. Chiing ta vao File >
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Close All dé déng lai toan b cic cira s6 thong tin hién thoi. Chon Window > New
Layout window, hé¢ théng s& tao ra mot trang trinh bay trang. Xdc dinh cic Frame cho
cdc tieu dé, ghi chi chiing ta cin, sau d6 phat sinh ra ching thong qua céc biéu tuong
cong cu. Két thic chon File > Save Workspace ghi lai trang Layout mau dé dé lan sau
mo trang lam viéc (Workspace) chita trang Layout mau nay va thiét k€ trang trinh bay
theo yéu cdu cua chiing ta.

3. In trang Layout

Sau khi da hoan thanh viéc trinh bay trang Layout, ¢6 thé in ra thiét bi in. Vio
File > Print, khi d6 man hinh hién ra hop hoi thoai diéu khién mdy in chiing ta da
cai dat. '

Printer:

Print Range
| @ @il
L Sg‘?éctit:iﬁ'

o
L
|

Chiing ta chon loai mdy in, s6 lugng ban in (Copy), s6 trang in theo toan bo (All)
hodc theo su chon lya (Selection) hoic theo trang (Page) tir trang (From) dén trang (To),
chat luong in (Print Quality) sau d6 bim nit OK. Man hinh hién ra cira sé thong béo
trang thai hoat dong ctia thiét bi in, n€u muén dirng lai viéc in 4n b4m vao nit Cancel.

Trude khi in phdi chic chan ring da n6i mdy in véi mdy tinh va bat sin m4y in.
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Chuong VII
CAC CHUC NANG PHAN TICH DIA LY CUA MAPINFO

I. TONG HOP PHAN TACH CAC POI TUGNG

1. Chon doi tugng muc tiéu trong phan tich dia ly

Muén thyc hién phan tich dia 1§ mot d6i tuong ndo dé trong hé thong Maplnfo trudc
hét ching ta chon d6i tuong dé va vao thuc don Object > Set Target, khi dé déi tuong
muc tiéu s& dugc ddnh d4u hién thi khdc v6i cdc d61 tugng khéc. Moi thao tdc phan tich
dia ly s& chi ¢6 tac dung d6i véi ddi wong muc tiéu. P&i tugng muc tidu phai & 16p
thong tin bién tap dugc.

2. Tdng hop/phan tich dit liéu thuée tinh trong phén tich dia ly

Khi cac dit li¢u thugc tinh di duge lién két vé6i cde thong tin khong gian thi trong khi
thue hign cdc chiic nang phan tich dia 1y h¢ théng c6 thé tr dong téng hop hoic phan
tdch cdc dif liéu di c6 dé va gan chiing cho cdc déi tugng méi tao ra.

a) Khi thuc hién téng hop cdc d6i tchmg thanh mot d6i tugng mdi hop hoi thoai téng
hop dit liéu hién ra bao gém:

- Sum: Cong céc gid tri s6 clia cdc trudng dir lidu va gén tong s6 dé cho truong dit
li¢u cta do6i tugng mdi.

- Average: Tinh gia tri trung binh ciia cdc dit liéu trong cdc d6i tugng goc va gén nd
cho trudng dir liéu cua d6i tugng mdi.

- Weighted Average: Tinh gid trj trung binh cé trong s6 cla céc dit liéu trong céc dai
tugng gde va gan né cho trudmg dir liéu cla déi tirong méi.

- Value: Luu va gin gid tri nhat dinh cla cdc d6i tugng géc cho d6i tugng méi.

- No change: Bao luu cic gid tri cha d6i tugng muc tiéu cho d6i tuong méi tao ra.

b) Khi thuc hién phan tach mét d6i tugng thanh céc d6i tugng méi hop hoi thoai
phan tach dit liéu hién ra bao gém:

- Blank: Céc trudng dir liéu cila déi tugng méi 1a céc trudng tring.

- Value: Luu va gén gid tn nhat dinh cha céc ddi tugng goéc cho doi tugng méi.

- Area proportion: Tao ra cdc gia tri méi trén co s cdc s6 liéu gdc theo gid tri hoac
kich thudc cia cdc doi twgng méi tao ra so véi déi tugng goce.
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3. Tong hop cdc doi tuong

Céc budc thuc hién chiic nang téng hop cdc déi tugng trong phdn mém Mapinfo ¢
thé tém tat nhu sau:

- M6 céc 16p thong tin cén thao téc;

- Dat 16p thong tin chita d6i tugng bién tap thanh ché do Editable;

- Chon d6i tugng va vao Object > Set Target;

- Chon céc d6i tuong khac cdn téng hop véi d6i tugng muc tiéu (an phim Shift déng

thoi v6i bam chon dé chon nhiéu déi tuong);

- Vao Object > Combine, hop hoi thoai téng hop dit liéu hién ra nhu sau:

S LY. . ek M
| |= Data Aggregatio

Destination ~ Method  Woeight Field
Field2 Yalue
Field3 Yalue

'«_-Aggtegatipn Mathod- e - - i : ,.,.W e LR

) Ho Ci]ange @z...iak;e.: ‘ B

O Average w%:;;%gh{ by I“D"E |“‘¥'! :

I Help il - Cancel E I - OK Mj

- Xéc dinh cdc tham s6 tong hop dif liéu clia hop hoi thoai trén cho timg trudng dit
liéu, sau d6 chon nit OK. Néu dénh déu 6 chon No Data s& thu dugc déi tuong két qua
chi ¢6 ban ghi dé thi con cédc bén ghi thudc tinh s& tring.

Chiing ta cling c¢6 thé téng hop céc d6i tuong tao ra mot déi tuong méi bang cach
chon cdc d6i tugng can tong hop (it nhit 2 d6i tugng), sau dé vao Object chon
Combine, man hinh hién ra cac hop hoi thoai nhu trén. Chon céc tham s6 cho cic bién
trong hop hoi thoai va bim chon nit OK dé thuc hién chiic nang da chon. Thuc hién
xong chiic nang ndy cic d6i tuong goc s& bi xod khoi co so dit liéu cha hé thong va
dudng bién chung giita céc d6i tugng ké nhau ciing s& bi mét di khi tao ra doi tuong mdi
két qua tong hop clia céc d6i tuong chon.

Ghi chii: Néu cdc déi tuong chiing ta chon dé tong hop ¢6 phdn giao nhau thi man
hinh sé hién ra thong bdo 16i va chite ndng sé khong thuc hién. Cdc déi tuong goc sé bi
Xod khoi co so dit liéu cua hé thong.

148



4. Phdn tdach doi tuong
- Dit 16p chita doi tuong bién tap thanh ché do Editable.
- Chon déi tugng va vao Object > Set Target.

- Chon hoac phat sinh r6i chon déi tuong khac 1am déi tugng cat (do6i tuong cat phai
la doi tuong ving).

- Vao ObJCCt > Split, hop hoi thoai phdn tach dir liéu hién ra:

E_la!d ﬂpme sk Mnlhod e
| Fielaz Yalue
Field3 Walue

‘Disaggregation Method e
7 Blank 5, Atea I*rnpnttlnn

(= “alue : i

§ g‘“" :‘.H_D D ata . : -
§ ! oK _! [ li’.‘ant:al ! I Help g

- Xéc dinh cédc tham s6 phan tich dir liéu cua hop hoi thoai trén cho timg trudong dit
liéu, sau d6 chon nit OK.

5. Xod mét phan cua doi tuong

- Dat 16p chira doi tuong bién tap thanh ché do Editable;

- Chon déi tugng va vao Object > Set Target;

- Chon hoac phat sinh r6i chon cdc d6i tuong khéc 1am d6i tuong cit (déi tuong cit
phai l1a déi tugng ving);

- Vao Object > Erase (hoac Erase Outside), hop hoi thoai phan tach dit liéu hlen ra
tuong tu nhu chifc nang phan tach déi tugng;

- Xéc dinh cdc tham s6 ctia hop hoi thoai trén cho timg truong dit liéu, sau dé chon
nit OK.

IL. TAO CAC POI TUONG MOI

1. Tao ra diém nit cua cdc doi tuong giao nhau
- Dit 16p chifa d6i tuong bién tap thanh ché do Editable:
- Chon déi twong va vao Object > Set Target;

- Chon hodc phat sinh réi chon cdc d6i tugng khdc 1am déi tuong cét (d6i tuong cit
phai la déi tuong viing);

- Vao Object > Overlay Nodes khi d6 man hinh hién ra hop thong bio trang thdi thuc
hién chifc nang cua hé théng.
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2. Tao ra vang vanh dai

- Dit 16p chira d6i tuong bién tap thanh ché do Editable;
- Chon déi tugng cén tao ra ving vanh dai;

® One buffer of all objects
5 o Dné'buﬂ'__'e‘i'«' for gach object

| s 4 cancar_}

Tai hop hoi thoai nay ching ta chon:

+ Xdc dinh bén kinh clia vanh dai béng cdch nhap gi4 tri vao hop Value trong khung
Radius hoac xdc dinh truong dir liéu ma gi4 tri clia né s& dugc coi 1a ban kinh vanh dai.

+ Xac dinh don vi ctia ban kinh vanh dai tai hop Units.

+ Xdc dinh d6 tron clia d6i twong vanh dai tao ra théng qua gid tri chiing ta nhép vao
hop Segment Per circle.

+ Chon chitc nang tao ra mot loai vanh dai cho toan bo cdc d6i tuong da chon néu
ching ta ddnh dau 6 One buffer of all Object.

+ Chon chifc nang tao ra cho méi déi twgng da chon mot kiéu loai vanh dai néu
ching ta danh dau 6 One Buffer for Each Object.

Sau khi xdc dinh xong cdc thong s6 trén bam niit OK dé thuc hién hoac nit Cancel
dé thoét ra.

IIL. TONG HOP VA LIEN KET THONG TIN

1. Tong hop doi twong thong qua cdc truong dit liéu thuéc tinh

Vé6i chitc nang nay hé théng khong doi hoi phai chon cdc déi tuong ban dé trén man
hinh, nhung doi héi phai c6 mot co s& dit liéu thuoc tinh. Thuc hién chic nang nay hé
théng s& tr dong tao ra cdc d6i twgng méi dya trén co s& cac dit liu trong co s& dir liéu
thudc tinh c6 cling gid tri. Céc d6i tuong goc vin dugc bao toan, vao thuc don Table >
Combine Objects Using Column man hinh hién ra hop hoi thoai:
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Group objects by column: ill: ltg
[E3

% Stote_ results in table: !THU

‘ j:l_uelp : t § | (ﬁancgl § ] MNext > a

Tai hop hoi thoai nay ching ta x4c dinh:

+ Chon tén I6p chita cdc déi tuong can téng hop vao hop Combine Objects From Table;

+ Chon tén trudng ma theo dé cac déi tugng s& dugc nhom lai néu cing mot gid tri
thudc tinh tai hop Group Objects by Column;

+ Chon tén 16p luu két qua tong hop tai hop Store Results in Table;

+ Bdm chon nit Next, man hinh hién ra hop hoi thoai téng hgp dit liéu thudc tinh va
chiing ta x4c dinh cdc tham s6 cho né réi chon niit OK.

l §=' Data Aggregation :
Destination Method Weight Field - .
Field2 Yalue
Field3 Yalue
rAggregation Method . oy v Fyey v
(' Blank = !alue:i _ |
C Sum ("} Average - Weight by: ]none Lij l
y ﬂ_o Data
| Help 5 I 'Cancal____'.g | < Back Il .. DK ,! -

Thuc hién xong chitc nang, cic doi tuong mdi tao ra s€ dugc danh ddu chon va ching
ta c6 thé ghi lai ching vao mot 16p khac thong qua File > Save Copy as. Vi du : quan 1y
cap xa la cap co s& va mbi xa ¢ trudng tén huyén thi ching ta cé thé tao ra 16p huyén
tu dong tir 16p xa@ bang cédch thuc hién chitc ning nay dé nhém cdc xa cé cuing tén huyén
v6i nhau.

2. Lién két lop thong tin ban do véi lop thong tin thuéc tinh

Doi khi chiing ta da c6 cdc thong tin thudc tinh tir truée va n€u mudn lién két
chiing v6i cdc thong tin ban dé dé€ tao ra co s (it liéu cho GIS, ching ta thuc hién
theo cic budc sau:
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- Mo 16p thong tin ban d6 da c6 File > Open Table.

- Thay doi céu tric ciia 16p ban dé sao cho né ¢6 it nhat mot truong dir liéu trung véi
I6p thong tin thudc tinh da c6 va chon né 1a Index.

- Nhap tha cong céc gid tri cho trudng dit liéu d6 trén ban dé (vi du tén xa).

- Mo 16p thong tin thudc tinh da c6 File > Open Table va chon File Type 1a DBF
hodc XLS. Chiing ta dam bao chic chéin 1a trong co s dif liéu c6 mot trudng da chon
la Index.

- Vao thuc don Table > Update Column khi dé6 man hinh hién ra hop hoi thoai:

Update Cnlumn

Table to Update: ITHU ! Lﬂ
Column to Upda;e: IAdd new temporary column L%j
Get Value From Table: [EE RN |
Calc_ul_a-te: . IValue _ L%j s
of: s : [u =]

= Bjowxe Flesljlfi

I OK i I Cancel _é | Help g

Tai hop héi thoai nay ching ta x4c dinh:
- Tén cta 16p ban d6 trong hop Table to Update;
- Tén cua 16p thong tin thudc tinh tai hop Get Value from Table:

- Bdm nut Join man hinh hién ra hop hoi thoai sau:

Join _
C where  [[THMEMNSG—_—_—_—_—]rom toble THU
matches lll L%ig from table Query1

@ where obiécl from table Query1

' contains I_%j object from table THU

] oK ] | Cancel i I - Help _é

Trong hop hai thoai nay ching ta x4c dinh tén cta hai truong dit lidu cé cung gid tri
dé lién két ban d6 véi thuoc tinh tai hop Where va Matches (Céc trudng nay phai chon
la Index). Chon xong bam nit OK dé tr& vé hop hoi thoai trude do.
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- Chon tén trudng dit liéu tir 16p thuée tinh s& gan cho ban dé tai hop Value va khi
dé tai hop Column to Update s& hién ra "Add new temporary Column" néu chip
nhén, h¢ théng s& tr dong thém vao I6p ban d6é mot trudng méi dé luu cdc thong tin
da chon;

- Néu khong mudn hién thi k&t qué lién két thanh cic cira sé xét duyét ching ta loai
bd su danh dau chon & 6 Browser Results.

Chon xong cdc tham s6 chiing ta bam nit OK dé thuc hién hodc niit Cancel dé thodt
ra khoi chifc nang.

Thue hién xong chife nang chiing ta ghi lai két qua theng qua File > Save Copy as.

Chiing ta ciing c6 thé diing chitc ning nay dé tdng hop cdc dit lieu ciia cdc d6i tuong
thude céc déi tugng khac vi du nhu cdc xa trong mét huyén théng qua chitc nang Join

va chon céc toan tir dia 1y nhu chita "Contain” hay nam trong "Within" tai hop Where
Object from Table ....
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Chuong VIII

TAO CUA SO PHAN NHOM THONG TIN
VA CUA SO BIEU PO

L. CUA SO PHAN NHOM THONG TIN

Redistrict 1a mét qud trinh phan nhém cdc déi tugng ban dé cé cung trudng gid tri
thudc tinh va déng thoi thuc hién téng hgp céc thong tin thude tinh ctia chiing nham
cung cdp cdc gid tri tuong ng cho nhém d6i tugng tao ra. Viéc phan nhém déi tugng
nay khong tao ra cic d6i tuong ban d6 mdéi hodc thuc hién thay déi phong céch thé hién
cua cdc d6i tugng ban dé. Redistrict 1a mot cong cu co dong phan nhém déi tuong va
hién thi ciing v6i cdc thong tin khic trong nhém.

Vao thuc don Window > New Redistrict Window, man hinh hién ra hop hoi thoai
va ching ta xdc dinh tén 16p ciing nhu tén trudng dit liéu dé thuc hién phan nhém
déi tuong. Hé thong tu dong hién ra cilra s6 thong tin District Browser theo hop hoi
thoai sau:

New Redistrict i'hdow

District Field: Ill

Available Fields: . Fields to Browse:
tt

S
ymbol l___:ﬁdd'l> RCLL
| << Remove .

Up I Down

oK g Cancel Help %
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Tai hop hoi thoai nay ching ta xéc dinh:
- Tén 16p can phan nhém tai hop Source Table;
- Tén trudng ma dua vao né sé€ phan 16p tai District Field;

- Trong khung cdc truong hién c6 clia 16p da chon tai Avaiable Field chon tén céc
truong s€ hién thi trong cira s6 Browser va chon niit Add, khi dé tén cla cic truong dé
s€ hién ra trong khung bén canh tai Field to Browse. Muén loai bo cac trudong trong cira
s6 Browse, chon né réi bim ndt Remove. Mu6hn thay déi vi trf clia cic trudng trong cua
s6 Browse thi chon tén trudng dé réi bdm nit Up hoac Down dé dua truong dit lieu
chon lén trén hodc xudng duéi. Sau khi x4c dinh xong cic tham s6 trén bam chon OK.

Thuc hién xong chiic nang man hinh hién ra mot cira sé thong tin ban dé ma cac doi
tuong trén d6 da dugc phén chia thanh cdc nhém theo céc chi tiéu ma ta da chon & trén,
duoc phan biét bang cdc mau khac nhau nhu sau:

Maplinfo Professional
Options Redistrict Tools Window Help

Bl | Phuéc Binh 1 |

| Lam San 1

| Phuée Hoa 1 i
| Phuée Tan 1|80

| Phuée Tién 1
| Phuérc Thang 1 1
| Phuée Thanh 1 | .

| TénSon 1|
1| Quidng Sen 1 | q.|
|l >

Ching ta vao thyc don Window va chon Tile Windows, khi d6 trén man hinh s& duoc
chia lam hai cira s6 mot bén 1a ban dé va mot bén 1a thong tin phan nhoém. Trong thuc
don Redistrict ching ta c6 thé thuc hién:

+ Gén do6i tugng da chon (Assign Selected object). Sau khi da chon xong cac doi
tugng muc tiéu trong cira s6 thong tin phan nhém va chiing ta ding chu6t dé chon cic
dGi tugng trén cilra s6 ban d6 sau d6 vao Redistrict > Assign Selected object hoac biéu
tuong cong cu trén hop Main;
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+ Dit nhém d6i twong muc tiéu tir ban d6 (Set Target District From Map). Chon mét
nhém d6i tuong va khing dinh né 12 nhém muc tiéu Redistrict > Set Target District
From Map hodc bi€u tuong cong cu trén hop Main;

+ Thém nhém déi tuong (Add District). Vao chitc nang nay trong cira s6 thong tin
phan nhém s€ c¢6 thém mot ban ghi cho nhém do6i tugng méi va ching ta cé thé xdc
dinh céc tham s6 cho nhém méi;

+ X6a nhém déi tugng muc tiéu (Delete Target District). Chon nhém d6i tugng cin
x6a va dat n6 thanh nhém muc tiéu sau dé vao Redistrict > Delete Target District dé x6a;

+ Chon cdc tham s6 cho Redistrict. Vao thuc don Redistrict > Options man hinh hién
ra hop hoi thoai nhur sau:

X Show Grid Lines
~ Save as Default

~ Tai hop hoi thoai nay c6 thé chon céc chitc nang sau:

- Most Recently Used. Thé hién trong cira s6 Browser phan nhém cic truong da sir
dung gin nhat;

- Alphabetical. Thé hién trong cita s6 Browser phan nhém cac trudng theo van chit cdi;

- Unordered. Thé hién trong cira s6 Browser phan nhém céc tridng khong c6 su sap xép;

- Show Grid Line. Hién thi cdc dudng ké 6 luéi trong cira s6 Browser phan nhém;

- Save As Default. Ghi lai cdc tham s6 trén thanh céc gi tri ngim dinh.

Chiing ta chon chitc nang can réi bim chon OK.

Vé bin chit c¢6 thé xem chiic nang nay nhu 12 mot cong cu tao ban dé chuyén dé bén
ty dong clia h¢ théng. Bén canh viéc phan nhém déi twgng chiing ta con thuc hién duoc
viéc tong hop céc dit lieu thudc tinh cha céc nhém.

IL. CUA SO BIEU PO
Khi da c6 it nhat mot 16p thong tin dwgec md va né da dugc gén thudc tinh, ching ta
c6 thé tao ra bi€u d6 thé hién céc dit liéu va lam tang thém tinh thim my clia trang ban

d6 mdy tinh. Cira s6 bi€u d6 12 mot cira s thong tin doc lap va chiing ta c6 thé in chiing
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trén trang trinh bay (Layout) ciing giéng nhu c4c cira s8 thong tin khac. Khi di md cira
s6 thong tin loai nay thi trén thanh thuc don clia hé théng sé tu dong thém mot thue don
con la Graph. Vao Window > New Graph window, man hinh hién ra hop hoi thoai:

New Graph Window .

Graph Toble 37 R ©

us.ing Qulunm:s.: | sohug'(;. {éj
-Inone L:.fj

i none \ |_!:_§
[nune L&] _

Label with Column: [ten 3

Trong hop hoi thoai nay chon tén 16p tao biéu d6 tai hop Graph Table va céc truong
dr ligu tao ra bi€u do tai Using Columns (t6i da chon dugc 4 truong tao bi€u dé cung
mot lic).

Chon tén trudng 1am nhan cho biéu dé tai hop Label with Column, sau d6 bim
nit OK dé thuc hién vi man hinh s& hién ra bi€u dé theo céc gia tri ngdm dinh cta
hé théng.

Mu6n thay d6i ki€u biéu dé vao thuc don Graph > Graph Type khi d6 man hinh hién
ti€p hop hoi thoai sau:

Graph Title: |EETLXTEEY

i..{;"aph Type - ;-Dptions ........ o : - .

| o '. .

| C Area | [T Stacked ;

| 1 0 1 =: I3U o
| @& Bar . [ Owverlapped _ ; ?p _
I ) Line [T Drop Lines Bar Gutter X: I1

| i & i :
| ) Pie B I¥X Botated l  Start Pie Angle: Io

| O XY '™ Show 3D |

.......................................... 5B R B R

Trong hop hoi thoai nay chiing ta chon:
- Tén tiéu dé cha biéu d6 tai hop Graph Title;

- Loai bi€u d6 théng qua ddnh dau chon trong khung Graph Type;
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+ Area (biéu do dién tich);
+ Bar (biéu d6 hinh c6t);
+ Line (biéu d6 dudng);
+ Pie (biéu dd tron);
+ X-Y (biéu dé toa do).
- Kiéu biéu d6 thong qua dénh dau chon trong khung Option
+ Stacked (biéu d6 chéng x€p);
+ Overlapped (biéu d6 giao nhau);
+ Drop Line (biéu d6 cé dudng phan cach);
+ Rotated (biéu dd xoay);
+ Show 3D (biéu dd ba chiéu).

Muén thay déi cdc nhin trén truc ctia biéu dé ching ta vao Graph > Label axis va
Graph > Value axis khi dé man hinh hién ra hép hoi thoai sau:

Axis Valuos . v R . - e

| omseMEvERE [ W AweMaisrumc [ |

1 Auto I-Iau.\faluu: I_._-—— X Aute Minor Unit: 1—.—‘ :
i‘i‘c"‘ g,ugo ;;,“;Ag, ) !— . .

Ia.ilaiut.\‘l'ick M_alkz ]l;ulsidu.: — L:E_I ™ Major ﬁ[idlirm_:”

Minor Tick Marks: |None L.:".J ™ Minor Gridline:
' Asis Labels: IAt.Axis ' | E3 |
Axnis ]‘_itle_:_. ite.n - = Aad.
..... ’ I .
!

Trong hop héi thoai nay chiing ta xac dinh:

- C4c gi4 tri clia truc biéu d6 tai khung Axis Value;

- Thay déi cdc nhin clia truc biéu ddé tai hop Axis Label;
- Thay déi cdc tiéu dé cha truc biéu d6 tai hop Axis Title.

Sau d6 chon nit OK va ghi lai clra s6 théng tin biéu dé thanh trang 1am viéc thong
qua File > Save Workspace.

158



Chuong IX
THANH LAP BAN PO CHUYEN bf

L. BAN PO CHUYEN PE VA Y NGHIA CUA NO TRONG GIS

Thanh 1ap ban do chuyén dé€ 1a mét cong cu hiéu qua nhit dé thé hién su phan tich va
hién thi cdc dit liéu trong GIS. Thanh lap ban dé chuyén dé 14 mot qud trinh thé hién
thong qua 16 v& cde d6i tugng ban d6 theo mot chuyén dé cu thé. Vi du ban dé thé hién
bang phwong phap t6 mau mat do dan s& theo don vi hanh chinh cép huyén 1a mot ban
d6 chuyen dé.

Trong Maplnfo ¢6 6 loai thé hién ban d6 chuyén dé khac nhau la:

- Thé hién theo khoang dir liéu;

- Thé hién theo biéu dé hinh chit nhat;

- Thé hién theo biéu dé hinh tron:

- Thé hién theo ky hiéu c6 trong s6;

- Thé hién theo mat 46 diém:

- Thé hién theo gi4 tri dit liéu doc lap.

Mbi mét loai ban dé chuyén dé trén ¢6 thé tng dung cho mét muc dich cu thé va
chiing ¢6 cdc tinh chét khéc nhau. Céc dif ligu sk dung d€ thanh 1ap cdc ban dé chuyén
dé c6 thé 1a gid tri s6 hoac khong nhat thiét phai 1a gi4 tri sé.

Théng qua ban d6 chuyén dé ching ta c6 thé tao ra mot xeri ban d6 dua trén
cung mot nén céc doi tugng ban dé chung, bidu thi cac van dé khéc nhau lien quan dén
cdc chii dé quan tam. Ban d6 chuyén dé 13 mot cong cu dé tao ra céc ban dé trén co s
cac dir lieu thugc tinh trong GIS thé hién not dung cla céc d6i turong ban dé.

II. KHAI QUAT VE THANH LAP BAN PO CHUYEN PE

+ Tham s6 thanh lap ban dé chuyén dé

Truée khi chiing ta thanh 1ap cdc ban d6 chuyén dé phai hiéu 15 vé cdc thanh phén
tao nén ban d6 chuyén dé va sy quan h¢ gifta chiing khi thanh lap ban d6. Cic dif lieu
hién thi trén ban d6é chuyen dé dugc goi la cdc tham s6 chuyén dé. Tuy theo két qua
phan tich chuyén dé ma chiing ta thuc hién va ¢ thé xac dinh mét hay nhiéu tham s&
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chuyén dé. Tham s6 chuyén dé c6 thé 1a gi4 tri cha mot trudng dit liéu hay 12 mot biéu
thitc todn hoc cua cac truong dit liéu.

+ Thong tin thanh lap ban d6 chuyén dé. Céc thong tin phuc vu dé thanh lap ban dé
chuyén dé c6 thé dugc truy cap tir mot 16p thong tin (Table) hay nhiéu 16p thong tin.

+ Lop thong tin chuyén dé (Thematic layer). Khi chiing ta tao ra ban dé chuyén dé
thi hé théng tur dong tao ra mot 16p thong tin chuyén dé doc lap dé quan 1y va luu trix
cdc thong tin d6. Trong hop diéu khién 16p ctia hé théng né ciing dugc tu dong thém
vao. Néu khong mu6n hién thi 16p thong tin chuyén dé ndy trén ban dé thi ching ta
phai vao hop diéu khién 16p (Layer Control) va chon tén ctia né réi bam niit Remove.

D¢ thuc hién tao ra ban dé chuyén dé vao Map > Create Thematic Map khi d6 man
hinh hién ra hop hoi thoai chuyén dé véi thuc don chinh sau:

il
.Bo'r Charts

: ® .__.‘-Z-;{- i e
® <@ |G

- Graduated - Dot Density Individual |

| Hetp ][ cancel .B [ Next> ]

Ranges ;

I11. CAC PHUOGNG PHAP TAO BAN PO CHUYEN PE

1. Tao bdn do chuyén dé theo phuong phdap Range

Chon biéu tugng Range trong hop hoi thoai chuyén dé va bam niit Next khi dé man
hinh hién ra hop hoi thoai sau:

[=

Create Themati Map - Step 2 of 3
Select a Table and a Field: e

Table:. m |

Eield: [sohogd =1

T~ lgnore Zeroes or Blanks

| l:l_alp I | Eah;:ﬁl. ._: - I : | < g_ac:lr..:_,_.:. gl Next > l

Tai hop hoi thoai nay chiing ta phai xdc dinh:
- Tén 16p thong tin tai hop Table;
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- Tén trudng dit liéu tai hop Field;

- Né€u chiing ta bé qua céc ban ghi tréng thi hily bim chon 6 vuéng Ignore Zerores or
Blanks ;

- Né€u muén thodt ra thi b4m nut Cancel, bam niit Back quay tr& lai man hinh truéc
d6, mudn ti€p tuc bam chon Next va man hinh hién ti€p hop hoi thoai sau:

: Create Thema

tic M.p Step 3 'l 3

 Preview:

<A by sohogd

7.920t0 7,930 (1)
1.910t0 7.920 (20)]

940t0 1,910 (15)
150to 940 (18)

Legend Label Order--
> Ascending

[0 gap—lvl !::Ml f 1[ ] E“l‘“ || DO li

Tai hop hoi thoai nay chiing ta s& dugc cung cdp mot tdm nhin téng quan vé cic
nhém chuyén dé s& tao ra trong khung Preview. Céc doi tuong trong 16p chuyén dé sé
dugc nhém theo gia tri ngdm dinh ctia hé théng trén co s& cic thong tin thudc tinh da
gan véi ching. Céc nhém d6i tuong dugc thé hién & céc phong cach khéc nhau clung vai
théng béo vé s6 lugng clia céc d6i tuong trong nhém dé.

Chiing ta c6 thé chon phong céch thé hién clia céc dif liéu trong bang ghi chu bang
cach chon 6 Ascending cho su hién thi gia tri tir nhd dén 16n hodc Descending cho su
hién thi gid tri t I6n dén nho.

Néu chdp nhén céc gid tri ngdm dinh cta hé théng khi tao ban dé chuyén dé thi
chiing ta c6 thé thuc hién: :

- Bam niit Cancel dé thoit ra.

- Bdm nit Help d€ goi trinh trg gitip clia hé théng.

- Bdm niit Back dé quay tré lai man hinh trude.

- Bdm nit OK dé thuc hién.

Trude khi chon it OK ching ta c6 thé thay déi céc tham s6 clia ban d6 chuyén dé
tao ra nhu dinh nghia lai cdc khoang gid tri, thay déi thuoc tinh thé hién va bang ghi
chi chuyén dé theo céc nt trén hop hoi thoai nhu sau:
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a) Néu chon nit Range man hinh hién ra hop hoi thoai nhu sau:

I.E ...... T Custumizﬂ e

Tai hop hoi thoai nay ching ta xac dinh:

- Phuong phdp tao ban dé chuyén dé tai hop Method. Trong danh sich cic phuong
phép hién c6 trong hé théng chiing ta c¢6 thé chon mot trong cic phuong phap sau:

+ Equal count. Tao ra nhém cac d6i tugng c6 s6 ban ghi nhu nhau.

+ Equal range. Tao ra nhém céc déi tugng c6 khoang dit liéu nhu nhau.

+ Natural Break. Su phan tdach cdc khoang dir liéu chuyén dé dua trén co so t6i
thiéu hod (Minimun) c4c hiéu s6 (Difference) ctia cdc dit liéu véi gié tri trung binh
cua ching.

+ Standard Deviation. Khoang giira dugc phan tich tai gid tri trung binh cta cac dir
liéu, khoang trén va khoang dudi né dugc xac dinh bang khoang giita cong trir di mot
gi4 tri sai léch chuan.

+ Quantile. Xac dinh su phan b6 cua moét bién dit liéu doc theo khoang dir liéu. Khi
chon phuong phdp nay man hinh hién ra hop Quantile va ching ta chon biéu thic dé
thuc hién thao tac xac dinh phén b6.

+ Custom. Chon chitc nang nay ching ta phai tu xac dinh cac khoang dir liéu chuyén
dé. Khi chon Custom, man hinh hién ra mot hop Custom Range va ching ta nhap
khoang dir liéu vao d6 thong qua gid tri min va max.

- Chiing ta c6 thé nhap s6 lugng cdc khoang dif liéu chuyén dé vio hop # of Range.
Theo gid tri nay hé thong s& tu dong tinh gid tri cho cac khoang dir liéu dua trén gia tri
Min va Max cua dir liéu.

- Chiing ta chon s6 chi s6 lam tron cho hé thong théng qua hop Round by.

Sau khi x4c dinh xong cdc tham s6 trén, ching ta bam vao Save Setting dé ghi lai va
sau d6 chon OK. Man hinh trd lai hoi thoai truée dé.
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b) Néu chon niit Style man hinh hién ra hop héi thoai nhu sau

7.920 to 7.930 ik it

Click on Style B ﬁ_llon:
at left to change .

s!;_v_le:

Range:

Style for Al Others™

150 to 940 |

leivory of

Cancel | [ Heww ]

Tai hop hoi thoai nay c6 thé thay déi phong cich thé hién cua cac d6i tuong chuyén
dé bang cdch bam diip vao céc biéu tuong cia né trong khung Style, khi d6 man hinh
hién ra hop hoi thoai phong cach viing (Region Style). Chiing ta c6 thé bién tap kiéu to,
mau t0, mau nén, ki€u dudng bién ciing nhu mau vi do diy ciia dudng bién tuong tu
nhu bién tap phong céch thé hién cia d6i tuong viing.

Chiing ta c6 thé bdm chon 6 Color dé tao ra 16p chuyén dé dua trén co s& t6 mau cc
nhém déi tuong hoic chon 6 None dé loai bo t6 mau.

Sau khi thyc hién xong cic thay déi vé phong céch thé hién cta cic nhém doi tuong

chuyén dé, chon OK dé thuc hién va
¢) Néu chon nit Legend m

an hinh hién ra hop hoi thoai nhu sau

man hinh tré lai hoi thoai truée dé.

Customize Legen' :

Title:

IXA by sohogd

Title Font: El

| Subtitle:

iR 7.920 to 7.930
1.910 to 7.920
1 {940 to 1910
150 to 940

all others

I

[ (S ubtitle Font: | Aa

|| X Show Legend for this Layer

Edit selected range here:

[7.920 to 7.930)

"‘if?”'(:';'biec!s '
X Show this Range

g | Carical | [savesettings | [ Help |
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Tai hop hoi thoai nay chiing ta x4c dinh:

- Chon kié€u chit cho tiéu dé chinh. Bdm chon biéu tuong tai Title font, khi d6 man
hinh hién ra hop héi thoai chon phéng chit va chiing ta chon kiéu, mau va co chit cho
tieu dé, sau d6 chon OK.

- Bién tap lai tiéu d€ ghi chu bang cdch gd vao tit ban phim tai hop Title.

- Chon kiéu chit cho tiéu dé phu. Bam chon biéu twong tai Subtitle font, khi d6 man
hinh hién ra hop héi thoai chon phong chit va ching ta chon kiéu, mau va co chir cho
tiéu dé, sau d6 chon OK.

- Bién tép lai tiéu dé phu cho ghi chid bang cdch g6 vao tir ban phim tai hop Subtitle.

- Chon hién thi ghi chi trong 16p thong tin, chiing ta bdm chon tai 6 Show legend for
this layer.

- Chon hién thi s6 lugng ban ghi, chiing ta b4m chon tai 6 Show Count.

- Chon kiéu chit cho cdc nhan. Bam chon biéu twong tai Font, khi d6 man hinh hién
ra hop hoi thoai chon phéng chir va chiing ta chon kiéu, mau va co chit cho tiéu dé, sau
d6 chon OK.

- Trong danh séch céc khoang dif liéu chuyén dé chiing ta chon né va cé thé bién tap
lai tai hop Edit select range hoac chon khong hién thi né thong qua chon 6 Show this
range.

- Xac dinh xong, bam niit Save Setting dé ghi lai, bdim vao Cancel dé loai bd va bdm
chon OK dé thuc hién va man hinh tr& lai hoi thoai trude va ching ta ti€p tuc chon OK
dé tao ban d6 chuyén dé.

2. Tao bdn do chuyén dé theo phuong phdp Bar Chart

Chiing ta chon biéu tugng Bar Chart trong hop hoi thoai chuyén dé va chon nit Next,
khi d6 man hinh hién ra nhu sau:

: Fields for Pie/Bar Chart:
 |sohogd

dientich
dantoc
Expression.__
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Tai hop hoi thoai nay chiing ta phai xac dinh:
- Tén 16p thong tin tao ban do chuyén dé tai hop Table (vi du chon XA)
- Chon tén céac truong dit liéu chuyén dé tai hop Fields from Table réi bam vao nuit

ADD, khi d6 tén trudong di chon s& hién thi trong khung Fields for Pie/Bar chart (vi du
chon truong sohogd va danso)

- Néu chiing ta mu6n loai bo cdc trudng da chon dé tao biéu dé chuyén dé thi chon
chiing trong danh sach Fields for Pie/Bar chart réi bAm niit Remove

- Néu chiing ta muén thay déi thit tu céc trudng da chon tao biéu dé chuyén dé thi
chon tén trudng do6 trong danh sach cua Fields for Pie/Bar chart réi bdm nit Up hoac
Down dé chuyén vi trf 1én trén hodc xuéng dudi

- Néu muén thodt ra thi bAm vao nit Cancel, muén quay trd lai man hinh truéc thi
badm nit Back, muén ti€p tuc thuc hién bdm chon Next. Man hinh hién ti€p hop hoi
thoai sau:

Bar Chart of XA
1.400.000

sohogd
danso

Legend Label Dldw ................. . __,.—.wm
@® Ascending Descending '

Tai hop hoi thoai nay sé dugce cung cdp mot tdm nhin tdng quan vé cdc nhém biéu do
chuyén dé s€ tao ra trong khung Preview va mau sic thé hién chiing cling nhu loai biéu
d6 thé hién.

C6 thé chon phong céch thé hién clia céc dit liéu trong bang ghi chi bing cach chon
6 Ascending cho su hién thi gid tri tir nhd dén 16n hoic 6 Descending cho sur hién thi
gié tri tir 16n dén nho.

Nuit Setting trong hop hoi thoai nay md& va khong c6 tdc dung.

Néu chiing ta chdp nhan cdc gié tri ngdm dinh cta hé théng khi tao ra 16p chuyén dé
biéu dé thi chiing ta thuc hién:

- Bdm nuit Cancel dé thodt ra.

- Bam nit Help dé goi trinh trg gitip ctia hé thong.
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- Bdm nit Back dé€ quay tr& lai man hinh trude.
- Bam nit OK dé thuc hién va man hinh tré lai hop hoi thoai trudc dé.

Trude khi chon niit OK ¢6 thé thay déi cdc tham s6 clia ban d6 chuyén dé tao ra nhu
dinh nghia va thay d6i thugc tinh thé hién ctia cdc biéu dé, bién tap thong tin trong bang
ghi chi chuyén dé theo céc nit trén hop hoi thoai nhu sau:

a) Néu chon nut Style man hinh hién ra hop hoi thoai nhu sau .

f“ Custnmlze Bar Styles

|:,de= ................................................................

dansu

. "'fivalun |1 -400.000 ‘_
u.dth |n 635 i ipbteiws>d

I;..Eéncel Tg | Help g

Tai hop hoi thoai nay c6 thé:

- Thay déi phong céch thé hién clia cic d6i tugng biéu dé chuyén dé bang céch chon
tén truong trong danh sich réi bAm vao biéu tugng Brush, khi d6 man hinh sé hién ra
hop hoi thoai phong cach viing (Region Style). Chiing ta c6 thé bién tap ki€u t6, mau to,
kiéu dudng bién ciing nhu mau va d6 day cua dudng bién tuong tu nhu bién tap phong
cdch thé hién clia d6i tuong viing. Sau d6 chon OK dé thuc hién.

- Chon ki€u biéu dé bing cich bam ddnh dau chon cic loai d6 trong khung Chart
type nhu sau:

+ Stacked (Biéu d6 chéng 1én nhau).

+ Multiple bars (Biéu dé da cot).

+ Graduated Stack (Biéu do chong xép tang dan).
+ Independence Scale (Khong phu thudc va ty 1¢).

+ Chi€u cao, do rong va gid tri ban ddu cta biéu dé theo cac hop Height, Width va
At value.

- Bim mit OK dé thuc hién, bam nit Cancel dé loai bo.

166



 b) Néu chon nit Legend man hinh hién ra hop héi thoai nhu sau:

I —

%i'_= Customize Legend : : i

;“-Légend- .................................................................. ] Rl ) R ange Labe{; .
| Xitle:

I_ ' |Bar Chart of XA

Title Font: Aa

| Subtitle:

i Subtiﬁe Font: Aa ' Edit selected range here:

1 [sohogd

-; x Shoﬁi L:e;i;end.!or this Layer

|
|
|
|
|
%f
i

‘ o R {S'c'wShoﬂ st Targe.

[ OK . §| ‘Cancel i I Save SellingsJ | Help a

Tai hop hoi thoai nay chiing ta xac dinh:

- Chon kiéu chit cho tiéu dé chinh. Bim chon biéu tuong tai Title font, khi d6 man
hinh hién ra hop hoi thoai chon phong chit va chiing ta chon kiéu, mau va co chit cho
tiéu dé, sau dé chon OK.

- Bién tap lai tiéu dé ghi chi bang cach gd vao tir ban phim tai hop Title.

- Chon kiéu chit cho tiéu dé phu. Bdm chon biéu tuong tai Subtitle font, khi d6 man
hinh hién ra hop hoéi thoai chon phong chir va ching ta chon kiéu, mau va co chit cho
tiéu dé, sau dé chon OK.

- Bién tap lai tiéu dé phu cho ghi chi bing céch g vao tir ban phim tai hop Subtitle.

- Chon hién thi ghi chi trong 16p thong tin, chiing ta bam chon tai 6 Show legend for
this layer.

- Chon kié€u chir cho cdc nhan. Bam chon biéu tugng tai Font, khi d6 man hinh hién
ra hop hoi thoai chon phong chir va chiing ta chon kiéu, mau va co chif cho tiéu dé, sau
dé6 chon OK.

- Trong danh séch cic truong dir liéu chuyén dé chon tén truong cén bién tap va c6
thé bién tap nd lai tai hop Edit select range hoac chon khong hién thi n6 théng qua chon
6 Show this range.

- Xéc dinh xong, chiing ta bam nut Save Setting dé ghi lai, b4m vao Cancel dé loai bo
va badm chon OK dé thuc hién.

3. Tao ban do chuyén dé tneo phuong phdp Pie Chart

Chon biéu tugng Pie chart trong hop hoi thoai chuyén dé, chon niit Next va khi dé
man hinh hién ra hop hoi thoai sau:
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© Table: [xA
“Fields :
| Fields from TABLE: _ Fields for Pie/Bar Chart:
i sohogd

so_nu

| ldientich

{ | |dantoc

; | |Expression... :
! << Remove |

[ up 1| péwn 1

| Help _ Il'.-il:'ancel I{ < Back ll :..gext:r I

Tai hop hoi thoai nay ching ta phai x4c dinh:

- Tén 16p thong tin tao ban d6 chuyén dé tai hop Table.

- Chon tén céc truong dir lieu chuyén dé tai hop Field from Table réi bdm vao nit
ADD, khi d6 tén truong da chon s& hién thi trong khung Field for Pie/Bar chart.

- Néu ching ta muén loai bo cic trudng da chon dé tao biéu dé chuyén dé thi chon
ching trong danh sach Field for Pie/Bar chart r6i bdm nit Remove.

- Néu muén thodt ra thi bAm vao nit CAncel, mudn quay tré lai man hinh truée thi
bam nit Back, muén ti€p tuc thi bdm chon Next. Man hinh hién ti€p hop hoi thoai
tuong tu nhu & muc 4 trén day.

Tai hop hoi thoai nay s& dugce cung cdp mot tdim nhin tdng quan vé cdc nhém biéu d6
chuyén dé s¢ tao ra trong khung Preview.

C6 thé chon phong céch thé hién clia cic dit liéu trong bang ghi chi bing céch chon
6 Ascending cho sy hién thi gid tri tir nhé dén 16n hoac 6 Descending cho sy hién thi
gid tri tir 1I6n dén nho. Nt Setting trong hop nay m& va khong c6 tic dung.

- Bam nit Cancel d€ thoat ra .

- Bdm niit Help d€ goi trinh trg gitp ctia hé thong.

- Bam niit Back dé€ quay trd lai man hinh trudc.

- Bam niit OK dé thuc hién.

Tai hop hoi thoai nay chiing ta x4c dinh:

a) Néu chon niit Style man hinh hién ra hop héi thoai nhu sau;
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Chart Type -
X Graduated

f" Half Pies

T L T P

Diameter: I 0.635 cm

for sum: l 45_000

| Dptions 2> I

Ok _! I Cancel

]:T[,elp ' E

[

Tai hop hoi thoai nay ching ta c6 thé:

- Thay d6i phong céch thé hién ciia cdc d6i tuong biéu d6 chuyén dé bang céch chon
tén trudng trong danh sich va bim vao biéu tuong Brush, khi d6 man hinh hién ra hop
hoi thoai phong cdch viing (Region Style). Chiing ta c¢6 thé bién tap kiéu t6, mau to,
ki€u dudng bién ciing nhu mau va d6 day clia dudng bién tuong ty nhu bién tap phong
cdch the hién clia d6i tuong ving. Sau d6 chon OK dé thuc hién.

- Chon ki€u biéu d6 bang cach bam chon céc loai d6 trong khung Chart type nhu sau:

+ Graduated (Biéu dé tang dan).

+ Half pie (Biéu d6 mot nira vong tron).
+ Duong kinh clia biéu d6 tron cho gi4 tri ban ddu theo céc hop Diameter va For sum.
- Bdm niit OK dé thuc hién, bam nit Cancel dé loai bo.

Title:

Cuslmize Legend

hoi thoai nhu sau:

|Bar Chart of XA

Title Font: I Aa

Subtitle:

E

| Subtitle Funl:._| Aa !

X Show Legend for this Layer

L e e e e

El:lii selected range here:

[sohoad
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Tai hop hoi thoai nay ching ta xéc dinh:

- Chon kiéu chit cho tiéu dé chinh. Bdim chon biéu tugng tai Title font, khi d6 man
hinh hién ra hop hoi thoai chon phong chif v chiing ta chon kiéu, mau va co chit cho
tieu dé, sau d6 chon OK.

- Bién tap lai tiéu dé ghi chi bang céch gd vao tir ban phim tai hop Title.

- Chon kiéu chi cho tiéu dé phu. Bim chon biéu tugng tai Subtitle font, khi d6 man
hinh hién ra hop hoi thoai chon phéng chit va chiing ta chon ki€u, mau va co chit cho
tiéu dé, sau d6 chon OK.

- Bién tap lai tiéu dé phu cho ghi chud bang cich go vao tir ban phim tai hop Subtitle.

- Chon hién thi ghi chd trong 16p thong tin, ching ta bAm chon tai 6 Show legend for
this layer.

- Chon kiéu chit cho cdc nhan. Bim chon biéu tugng tai Font, khi d6 man hinh hién
ra hop hoi thoai chon phong chit va chiing ta chon kiéu, mau va co chir cho tiéu dé, sau
d6 chon OK.

¢) Trong danh sich céc truong dit liéu chuyén dé ching ta chon tén trudng va c6 thé
bién tap lai tai hop Edit select range hodc chon khong hién thi n6é thong qua chon 6
Show this range.

- X4c dinh xong, bam niit Save Setting d€ ghi lai, bdm vao Cancel d€ loai bé va bam
chon OK dé thuc hién.

4. Tao bdn do chuyén dé theo phuong phdp Graduated

Chiing ta chon biéu tugng Graduated trong hop hoi thoai chuyén dé, chon niit Next
va khi dé man hinh hién ra:

Create Thematic Map - Slep
Field: "ISohogd - . e L?g

= mfibte Zeroes or

| II Cancel I I < Back ﬂ_ox! T

Tai hop hoi thoai nay chiing ta phai xac dinh:
- Tén 16p thong tin tai hop Table.
- Tén trudng dir li¢u tai hop Field.
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- Néu chiing ta bé qua c4c ban ghi tréng thi hay bdm chon 6 vuéng Ignore Zerores or
Blanks.

- Néu muon thodt ra thi bAm vio nuit Cancel, muén quay tr& lai man hinh trudc thi
ching ta bdm nit BACK, muén ti€p tuc chiing ta bdim chon Next. Man hinh hién tiép
hop hai thoai sau day:

: :'jl.egeni:l_ L abul u'deﬁ;;ﬂ:: ........ Sil e . _M_M
| © Ascending @& Qéscending J "

|2 meis ] [ cancer | [ <Back [ ok 1

Tai hop hoi thoai nay sé duogc cung cap mét tim nhin téng quan vé cdc nhém chuyén
dé s€ tao ra trong khung Preview. Cdc diém thé hién trong 16p chuyén dé s& dugc bidu
thi theo trong s6 nghia 12 gid tri cang 16n thi diém thé hién cang to va nguoc lai.

C6 thé chon phong c4ch thé hi¢n clia céc dit liéu trong bang ghi chu béng cdch chon
0 Ascending cho su hién thi gid tri tir nho dén 16n hoic 6 Descending cho sy hién thi
gid tri tlr 16n dén nhé.

Nt Style trong hoi thoai nay bi m& di, khéng c6 tac dun g.

- Bdm niit Cancel dé thoit ra.

- Bdm niit Help d€ goi trinh trg gitip ciia hé thong .

- Bdm nuit Back dé quay tr& lai man hinh trude,

- Bdm niit OK dé thuc hién.

Tai hop hoéi thoai nay chuing ta xdc dinh:

a) Néu chon nit Setting man hinh hién ra hop hoi thoai nhu sau:
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= Custnmlze Graduated Symhuls

e ..

at‘__\{alu&:' 8.000

Options >>

Cancel | Help l

Tai hop hoi thoai nay ching ta c6 thé:

- Thay déi phong céch thé hién cua cdc. d6i tuong di€ém chuyén dé bing céch bam
vao biéu tugng Symbol, khi d6 man hinh hién ra hop hoi thoai phong cich diém
(Symbol Style). Chiing ta c6 thé chon Font va kiéu ky hiéu diém trong danh sach cua hé
théng. Sau d6 chon OK dé thuc hién.

- Chon gia tri ban dau cho ky hiéu chuyén dé tai hop at Value.
- Bdm nit OK dé thuc hién, bdm nit Cancel d€ loai bo.
- B&m niit Option dé x4c dinh thém cac tham s6 phu cho 16p chuyén dé.

b) Néu chon niit Legend man hinh hién ra hop hoi thoai nhu sau:

Cuiamize Legend

N E e T i rHanga Labels : e
”I"llw { Font: | ‘Aa
1?0\- by sohogd g ' )

Tzlle Fonl: . An

Subtitle:

Subtitle Font: | Ae | | Edit selected range here:

X Show Legend for this Layer | :
- e | !“' Sho,u this Range ;

=yl '.;.m. |&as,m..g.g| Help |
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Tai hop hoi thoai nay chiing ta x4c dinh:

- Chon ki€u chir cho tiéu dé chinh. B4&m chon biéu tuong tai Title font, khi d6 man
hinh hién ra hop héi thoai chon phong chir va chiing ta chon kiéu, mau va co chit cho
tiéu dé, sau d6 chon OK.

- Bién tap lai tieu dé€ ghi chii bang c4ch gd vao tir ban phim tai hop Title.

- Chon ki€u chit cho tiéu dé phy. Bam chon biéu twong tai Subtitle font, khi d6 man
hinh hién ra hop hoi thoai chon phéng chir va chiing ta chon kiéu, mau va co chit cho
tiéu dé, sau dé chon OK.

- Bién tap lai tiéu dé phu cho ghi chi béng céch g6 vao tir ban phim tai hop Subtitle.

- Chon hién thi ghi chi trong 16p thong tin, ching ta bAm chon tai 6 Show legend for
this layer.

- Chon ki€u chit cho c4c nhan. Bdm chon biéu tuong tai Font, khi d6 man hinh hién
ra hop hoi thoai chon phong chir va ching ta chon kiéu, mau va co chit cho tiéu dé, sau
dé chon OK.

- Trong danh séch céc khoang dif liéu chuyén dé chiing ta chon né va c6 thé bién tap
lai tai hop Edit select range hodc chon khong hién thi né thong qua chon 6 Show this
range.

- Xéc dinh xong, chiing ta bdm niit Save Setting d€ ghi lai, bAm vao Cancel dé loai bo
va bam chon OK dé thuc hién.

5. Tao bdn do chuyén dé theo phwong phdp Dot Density

Chon biéu tugng Dot Density trong hop hoi thoai chuyén dé, chon niit Next va khi d6
man hinh hién ra:

Create Thematic Map - Step

Select a Table -&m:l.é Field: SIS IR B @t

Tai hop hoi thoai nay chiing ta phai x4c dinh:
- Tén 16p thong tin tai hop Table.
- Tén truong dit liéu tai hop Field.

- Néu b6 qua cdc bin ghi tréng thi hily bdm chon 6 vuéng Ignore Zerores or Blanks,
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- Néu mu6n thodt ra thi bdm vao niit Cancel, muén quay trd lai man hinh trudc thi
bdm nit BACK, mudn ti€p tuc chiing ta bAm chon Next. Man hinh hién ti€p hop hoi
thoai sau:

Create Thematic Map - Sle'i:l 3 of 3 '

Preview:

L

>A by danso
1 Dot = 30,000

Tai hop hoi thoai nay sé dugc cung cdp mot cdi nhin téng quan vé cdc nhém chuyén
dé sé tao ra trong khung Preview. Chiing ta c6 thé chon phong cach thé hién cta céc dit
liéu trong bang ghi chii bang cach chon 6 Ascending cho su hién thi gid tri tir nhé dén
I6n hodc 6 Descending cho su hién thi gid tri tir [6n dén nho. Niit Style m& di, khong c6
tac dung.

Bam niit Cancel dé tho4t ra;

Béam niit Help dé goi trinh trg gidp ctia hé thong;

Bam niit Back d€ quay tr& lai man hinh trudc;

Bam nit OK dé thuc hién;

Tai hoi thoai nay chiing ta x4c dinh:

a) Néu ching ta chon nit Setting man hinh hién ra hop hoi thoai nhu sau:

tv Settings'

ot Represents: [ENIN ~  units

Customize Dot Densi

- Smal l’i‘} __La}gq

(S st ot v 1

[0k 3 [ cencar 2P o
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Tai hop hoi thoai nay chiing ta c6 thé:

- Thay déi trong s6 cho méi diém chuyén dé thé hién tai hop Each Dot Represent.

- Chon ki€u thé hién diém nhé (Small) hay 16n (Large) tai hop Dot size.

- Bam chon niit Save setting dé ghi lai.

- Bdm nit OK d€ thuc hién, bam nit Cancel d€ loai bo.

b) Néu chiing ta chon niit Legend man hinh hién ra hop hoi thoai tuong tu nhu muc 6
va tai hoi thoai nay chiing ta x4c dinh:

- Chon ki€u chit cho tiéu dé chinh. B&m chon biéu tuong tai Title font, khi d6 man
hinh hién ra hop hoi thoai chon phéng chit va chiing ta chon kiéu, mau va co chit cho
tiu dé, sau dé chon OK.

- Bién tap lai tiéu dé ghi chi bang cach gd vao tir ban phim tai hop Title.

- Chon ki€u chit cho tiéu dé phu. B&m chon biéu tuong tai Subtitle font, khi d6 man
hinh hién ra hop héi thoai chon phéng chit va chiing ta chon kiéu, mau va co chit cho
tiéu dé, sau d6 chon OK. _

- Bién t4p lai tiéu dé phu cho ghi chi béng cdch g& vao tir ban phim tai hop Subtitle.

- Chon hién thi ghl chi trong 16p thong tin, chiing ta bAm chon tai 6 Show legend for
this layer.

- Chon kiéu chir cho cdc nhan. Bam chon biéu tuong tai Font, khi d6 man hinh hién

ra hop hoi thoai chon phong chit va ching ta chon kiéu, mau va co chir cho tiéu dé, sau
d6 chon OK. '

- Trong danh sdch cac khoang di liéu chuyén dé ching ta chon cdc khoang cén bién

tap va c6 thé bién tap lai tai hop Edit select range hodc chon khong hién thi né thong
qua chon 6 Show this range.

- Xac dinh xong, bdm niit Save Setting dé ghi lai, bdm vao Cancel dé loai bo va bam
chon OK dé€ thuc hién.

6. Tao ban do chuyén dé theo phuong phdp Individual

Chiing ta chon biéu tuong Individual trong hop hoi thoai chuyén dé, chon niit Next
va khi d6 man hinh hién ra:

_';EEield-’ ] ten

I lgnore Zeroﬂs or Blankt

; | ]j_elp : II Cancel
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Tai hop hoi thoai nay chiing ta phai xéc dinh:

- Tén 16p thong tin tai hop Table.

- Tén trudng dit liéu tai hop Field.

- Néu bo qua cac ban ghi tréng thi hdy bam chon 6 vuong Ignore Zerores or Blanks.

- Néu muoén thodt ra thi bAm vao nit Cancel, muén quay trd lai man hinh trude thi
bdm nit Back, bam nit Help dé goi trg gitip hé théng va muén tiép tuc ching ta bam
chon Next. Man hinh hién ti€p hop hoi thoai sau: '

“Create Thematic Map - Step 3 of 3

_Customize

-

Kinh Dinh
Loi Hai 1]
Lam Sen

Tai hop hoi thoai nay s& dugc cung cap mot tdm nhin téng quan vé cdc nhém chuyén
dé sé tao ra treng khung Preview. Hé théng tao ra d6i tugng chuyén dé bing cach to
mau timg déi tuong. Cho phép chiing ta c6 thé tao ra 100 d6i twong chuyén dé déc lap
v6i nhau, trong truong hop s6 d6i tuong nhiéu hon thi mau thé hién clia cdc déi tuong
chuyén de s& c6 thé tring nhau.

C6 thé chon phong cdch thé hién clia céc dir liéu trong bang ghi chii bing cich chon
6 Ascending cho sy hién thi gid tri tir nho dén 16n hoac 6 Descending cho su hién thi
gié tri tir 16n dén nho.

Nut Setting mo di, khong c6 tac dung.

Néu chdp nhan céc gid tri ngdm dinh ctia hé théng chiing ta theo hoi thoai trén ching
ta c6 thé thao tac:

- Bam niit Cancel dé€ thodt ra.
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- Bdm niit Help dé goi trinh trg gitp ctia hé théng.

- Bdm nit Back dé quay tré lai man hinh truéc

- Bdm nit OK dé thuc hién

Trudce khi chon OK chiing ta ¢6 thé thay déi cdc tham s6 ciia 16p chuyén dé tai hop
hoi thoai nay thong qua viéc chiing ta x4c dinh:

a) Néu chon niit Styles man hinh hién ra hop hoi thoai nhu sau:

Customize

Individual Styles
Individual ¥alue: . Style: _

Bao An
Céng Hai
Ho Hai

Hoa Son
Kinh Dinh
Loi Hai

Lam Son
Ma MNOi

M Hai

My Son

Nhi H3
Nhon Son
P.My Huong
P.Phd Ha
P_Phuéc M§ +]

LI»

X Use Color Styles

0 K‘_ l Cancel Help

Tai hop hoi thoai nay chiing ta c6 thé:

- Chon tén cla d6i tugng chuyén dé trong danh séch Individual Value va bam vio
hop Style dé thay déi, khi d6 man hinh hién ra hop hoi thoai phong céch thé hién viing
(Region Style) va chiing ta chon céc tham s6 cin thay déi nhu kiéu t6, mau t6, mau nén,
kiéu dudng bién v.v... sau d6 chon OK dé khéng dinh.

- Bdm chon hodc loai bé chon 6 Use Color Style dé sir dung mau thé hién hoac
khong cdc d6i tuong chuyén dé.

- Bdm nuit OK dé thuc hién, bam nit Cancel dé loai bo.

b) Néu chon nit Legend man hinh hién ra hop hdi thoai xdc dinh ghi chui twong tu
nhu trén sau day:
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ik Eiq:i:i'lg-'.sblecled. range here:

| X Show _L.B..g.éljld. for this Layer ool armmiseRs
F Show ﬁgtfon:l Count ' | ¥ Show thix:ﬂange

S UBGS Fontes] sia

rLegend | ‘Range Labels - 5
|| Yitle:  Font: | A3} |
| IXA by ten :
: r Sy .
. Title Font: ‘ A i Ct‘mg7H5i |
[ 4 Ho Hai i
! . . 4 - |Hoa Son |
=l Subtle; | |Kinh Dinh
|t - | |Loi H&i ;
3 _ i - La‘n_n_Sdn %
| ]

| OK af . ‘Canc.e_[. | | Save Settings | | Help ]

Tai hop hoi thoai nay ching ta xac dinh:

- Chon kiéu chir cho tiéu dé chinh. Bdm chon biéu tugng tai Title font, khi d6 man
hinh hién ra hop hoi thoai chon phéng chit va chiing ta chon kiéu, mau va co chit cho
tiéu dé, sau dé chon OK.

- Bién tap lai tiéu dé ghi chid bang céch gd vao tir ban phim tai hop Title.

- Chon kiéu chit cho tiéu dé phu. Bim chon biéu tuong tai Subtitle font, khi d6 man
hinh hién ra hop hoi thoai chon phéng chit va chiing ta chon kiéu, mau va co chir cho
tiéu dé, sau dé chon OK.

- Bién tap lai tiéu dé phu cho ghi chii bang céch gé vao tir ban phim tai hop Subtitle.

- Chon hién thi ghi chi trong 16p thong tin, chiing ta bAm chon tai 6 Show legend for
this layer.

- Chon hién thi s6 luong ban ghi, ching ta bdm chon tai 6 Show count.

- Chon kiéu chif cho cic nhian. Bim chon biéu tuong tai Font, khi d6 man hinh hién
ra hop hoi thoai chon phong chit va chiing ta chon kiéu, mau va co chir cho tiéu dé, sau
d6 chon OK.

- Trong danh séch céc trudng dit liéu chuyén dé ching ta chon tén cén thay déi va c6
thé bién tap lai tai hop Edit select range hodc chon khong hién thi né thong qua chon 6
Show this range.

- X4c dinh xong, bdm niit Save Setting dé ghi lai, bAm vao Cancel dé loai bo va bdm
chon OK dé thuc hién.
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Chuong X
NGON NGU MAPBASIC

I. CAC CHUC NANG CU BAN CUA NGON NGU MAPBASIC

1. Khd ndng thitong mai hod MapInfo

MapBasic 1a ngon ngir 1ap trinh trong moi trudng Maplnfo. N6 13 mot phan mém hé
thong tin ban dé cho phép ching ta thuong mai hod va ty dong hod Maplnfo.

Mot dng dung cua MapBasic cho phép thay déi hoac thay th€ céc menu chuén cia
Maplnfo, thém mdi hoan toan thanh menu Maplnfo va tao cho ngudi dung nhitng hop
thoai diéu khién theo y. Nhu vay, MapBasic cho phép ban tao ra cic hé théng giao dién
giip cho ngudi diing thuén lgi va nhanh chéng.

2. Khd ndng tu dong hod MapInfo

Nhitng tng dung cia MapBasic 1 thudng duge diang dé gitip cho ngudi ding tiét
kiém thoi gian, tién 19i cho viéc sir dung. Vi dy, mot ngudi ding Mapinfo dé xay dung
mét h¢ théng ludi toa do (theo kinh d6 va vi d6) khi tao ra bin dé. Néu vé& bing tay sé
mat nhiéu théi gian, cong sitc va khéng chinh xac, vi mdi dudmg trong ludi can duge vé
v6i d6 chinh xdc vé kinh d6 va vi dé. Tuy nhién mot tng dung ca MapBasic ¢é thé lam
viéc d6 rat d€ ma nhanh chéng, chinh x4c.

3. Cong cu ddnh gid dir liéu

Ching ta c6 thé hién thi nhiing yéu cau vé co s& dir liéu véi mot cdu tric MapBasic
don gian. Vi dy, bang cdch ding lénh Select (dwoc mo phong trong ngoédn ngit chuin
SQL ), ta c¢6 thé hoi vé dit lieu, ¥ing dung mot phép loc d€ dwa ra man hinh bat ky nhimg
ban ghi ndo mong muén, sdp x€p va téng hop céc két qua theo yéu cau. Chiing ta cé thé
thuc hi¢n tat ca nhimg cong viéc d6 véi ciu tric lénh cha MapBasic.

St dung céu triic cla MapBasic ta c6 thé chon va cap nhat (Select & Update) sd lieu
thong qua code { ma ) cdc ngdn ngi lap trinh khic.
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4. Tinh gon nhe ctia MapBasic

Cic dmg dung MapBasic gon nhe. Néu ban phdt trién mot img dung sir dung
MapBasic cho Windows ban ¢6 thé chay img dung dé trén Maplnfo cho Macintosh.

Tinh gon nhe cua MapBasic con ¢6 nghia 13 giam cong viéc cho chiing ta, nguoi lap
trinh. Ban c6 thé phdt trién ngay cdc tng dung cla minh va sau d6, dp dung né cho tit
ca cac khach hang sir dung Windows hoac Macintosh. Tinh gon nhe clia MapBasic cho
phép ban phan phéi chuong trinh clia minh cho nhiing st dung mot céch rong rii.

N&i chung, ban khéng cén thay déi chuong trinh dé 1am cho né tuong thich khi chay
trén cdc phan citng khac. Mot s6 phan mém khéc khong cd kha ning nay.

5. Khd ndng lién két voi cdc ting dung khdc

Ching ta khong bi giéi han boi cdc cdu triic va cdc chitc nang duge xay dung doi véi
ngon ngilt 1ap trinh. Vi MapBasic cho phép c4u tric mé, céc truong trinh ciia ban ¢6 thé
goi céc thu tuc trong cdc thu vién. Vi, n€u ban cin cdc chitic ning ma khéng cé trong
cdc lénh ciia MapBasic, cau tric md clia MapBasic cho phép ban thyc hién duoc.

Céc chuong trinh MapBasic ¢6 thé sir dung dif liéu chuyén déi déng DDE (Dynamic
Data Exchange) d€ lién két v6i cdc phdn mém khdc, bao gém cac ing dung cua
VisualBasic. Cdc chuong trinh MapBasic ciing ¢6 thé goi céc thil tuc trong thu vién céc
File lién két dong clia Windows DLL (Windows Dynamic Link Labary). Ban c6 thé cé
céc File DLL tir cdc ngudn throng mai, hodc ban ¢6 thé viét cac File DLL riéng sir dung
cdc ngén ngit 1ap trinh nhur C hoic Pascal.

MaBasic 4.0 cung cdp nhimg kha nang mdéi, 1ap ban dé lién két, cho phép ching ta
lién két céc chiic nang ctia Maplnfo véi cdc tng dung duge viét trong cidc méi truong
phét trién khac nhu Visual Basic.

II. CAU TRUC NGON NGU MAPBASIC

Muc ndy mo ta co sd clia chuong trinh MapBasic ma ban c6 thé sir dung trong ting
dung cua ban, bao gém céc bi€n, biéu thite, hing, ham, cau tric chuong trinh.v.v...

1. File va kiéu File

Chuang trinh cai MapBasic tao ra cdc File sau day trong dia cimg.

Tén Y nghia
1 2
Errors. Doc File Text liét ké cac ma 13i
MapBasic. Exe File chuong trinh chay méi trudng cao MapBasic
MapBasic. Def File chia cdc ma dinh nghia
Menu. Def Include File chita cdc ma menu tuong dng
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1 2

Icons. Def Include File chifa cdc ma biéu tugng ButtonPad vi con trd tiong tmg
Map Basic.hlp File trg gitp

MapBasic.h File tén cho nguoi tap trinh C/C++ tuong tu nhu

MapBasic. Bas |  MapBasic.def nhung sir dung c&u tric C/C++

File tén cho lap trinh bang Visuabasic, ndi dung tuong tu nhu
mapbasic. def nhung sit dung cdu tric VisualBasic

* Mb Céc chuong trinh méu, khi chiing ta ding méi trudng MapBasic, tao
ra File v4i cdc phdn md rong sau:

* mbp File chuong trinh nguén

* mbx File thuc hién (da dich)

File d&i twong Object (liét ké cdc Modul trong mot File d6i tugng)
*. Mbo Cac File d6i twong (duge tao sau khi dich cic modul
Trong doi tugng)

*err Liét ké céc 181, duge tao néu ching ta dich

3. Cdc bién va hang

Cac bién phai duoc sir dung trude khi sit dung chiing trong chuong trinh MapBasic.
C4c bién duoc khai bdo bang dong 1énh Dim.

Cu phdp nhur sau:

Dim <tén bién> As (kiéu bién) (Integer......)

Ban c6 thé khai bdo cting mét lic nhiéu bién trong dong lénh Dim,

Vi du: Dim Count, Items As Float

Item _name, Customer As String -

Tén bién:

-Tén bi¢n phdi bat ddu bang chil, chit gach chan ( _ ), ddu séng (~), nhung khong

chép nhan moét ky tu tring trong tén bién. Tén bign dai nhét 31 ky tu va trong d6 c6 thé
chita cdc kiéu sau:

Chit, so, ky hiéu ( # ), chir ghach chan ( _)

Mot tén bién c6 the két thiic vé6i $, %, &,!,@. Tir khod ciia MapBasic nhur if, Note, va
Print, déu khong dugc sir dung lam tén bién.

Cdc kiéu dit liéu:

MapBasic c6 céc ki€u dit lieu cho cdc bién sau:
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Tén kiéu M@ ta (pham vi cia kiéu) (2)
Smalllnt S& nguyén { gid tri trong khodng
-32767 dén 32767
Integer S6 nguyén ( gid i trong khodng
~2tydén2ty)
Float S6 thue ( ddu phdy dong )
String Sau ky tr ( nhiéu nhat 1a
32000 ky tu )
String * n Co dinh do6 dai ky
(dai n ky tir)
Logical True hay False ( diing hay sai )
(1) {(2)
Date Kiéu ngay
Object Dai tugng d6 hea
Alias Tham chiéu ¢t ciia bang
Pen Kiéu v& nét (line)
Brush Kiéu t6 mau
Font Kiéu phéng chit (font)
Symbol Ky tu la
Mang:

Dé dinh nghia méng ta diing 1énh Dim, vi dy:

Dim Uscrs (10} As String

Vi du trén dinh nghia mét méng gém 10 phdn tir, cac phan tir thude kidu xau ky tu.

Mbi mot phin tit cila mang cé dia chi theo tén chia mang va s& thit ty cia phéin tr dé.
Users(6) 1a phan tlr thit 6 clia mang. MapBasic cho phép ban dinh nghia mang véi s6
phén tir I6n nhat 1 7000, nhd nhat 13 1, phdn t ddu tién trong mang thi cé dia chi 1a

phan tir 1.

Ban c6 thé tao mot mang ma trong dé ¢6 chia mot s6 kidu bién do ngudi dimg dinh

nghia. Kich ¢& cia mang phai dugc khai bdo 1a mot hing s& nguyén,

Dinh nghia kiéu dit liéu ngreoi dimg:

- MapBasic cho phép ban dinh nghia kiéu dit lieu thong qua cym tir Type...End Type.
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Day Ia cdu tric todn cyc nén phai duge dung trong cic cdp toan cuc, khong duoc
ding trong bat ké mot ham nao. Mac dit cde kidu dit lieu phai dugc khai béo cap toan
cuc, ban vin ¢6 thé dinh nghia cdc bién dia phuong clia céc kidu dé khong céan tha tuc
va ham nhu sau:

Type Person

Fullname As String

Age As Smallint

Dateofbirth As Date

End Type

Global sales_mgr, sale_people (10 ) as person

Méi mét 1énh Type dinh nghia 1 kiéu dir lieu. Ban c6 thé sit dung lénh Dim vi
Global dé dinh nghia c4c bi¢n clia Type. Vi du duéi day dinh nghia bién sir dung cho
nhiéu ki€u Person tir vi du trén va an dinh dit liéu cho ching.

Dim contact As Person

Contact. Fullname = “Mr. Smith*

Contact.age = 42

Contact.dateofbirth = “06/1 1/50 *

D¢ tham nhap vao céc phén tir chia kiéu ta 1am nhur sau:

<tén bién>.<tén phdn ur>Trong vi du trén contact la mét bién kiéu Person. Contact.
Fullname {a mét phdn tir ndm trong Person.

Biéu thire:
Biéu thic trong MapBasic 1a sy lién hé giffa cdc hing s6, bién, ham, todn ti

(Operator). Céc toan tir trong biéu thitc phai ciing kidu bién ma di dugc dinh nghia. Vi
du: Ban khong thé c6 biéu thite ma ¢ kiéu String va kiéu Date.

C4u tric clia biéu thic

<tén bién>=<biéu thirc>

Vi du:

Records=45

Out_Filename= “ report

Ming va cdc bién c6 nhitmg kiéu khac nhau thi phai dugc 4n dinh mot gi4 tri cho
timg phén tir trong mot lan.

Vi du:

Units$(3)=. “Ed Smith “
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BDinh nghia bién toan cuc:

Tat ca cdc bién duge khai bdo véi tir khod Dim 12 bién dia phuong. Ching ton tai chi
trong cac thu tuc (Procedure) mdi duge dinh nghia. Con bién toan cuc thi sir dung trong
ca chuong trinh. Vi du bién dia phuong dinh nghia trong thii tuc chinh thi khong thé
diing trong thu tue bén trong dugc nhu 1a bién toan cuc.

Bién toan cuc phai duge dinh nghia trong cdp toan cuc d6, phai nam ngoai moi thi
tuc (Procedure) va phai ding trude moi thu tuc sir dung né.

Declare sub Other

Include “ MapBasic. DEF “

Declare sub Main

Global gx,gy as Float

Global status as String, start date as Date

Sub Main
gx=0
gy=0
Call Other
End sub
Sub Other
Dim X,y as Float
X=gx
End sub
Bang cic ham chuyén déi ciia MapBasic
Asr( ) Chuyén ddi ky tu ra ma ANSI
Chr$( ) Chuyén déi ma ANSI ra ky tu
Fix{ ) Cho phéan nguyén
Int( ) Cho 50 nguyén gan nhait
Make Brush( ) Cho gid tri Brush
Make Font( } Cho giﬁ tri Font
Make Symbol{ ) Cho gia tri Symbol
Make Pen( ) Cho gid tri Pen
Ser$( ) Cho gi4 tri kiéu String
String to Date( ) Bién déi kiéu String thanh bién Date

Bién gx va gy duoc dinh nghia ngoai cdc thi tuc nén chiing 1a-bién toan cuc.
Dong 1énh Global dinh nghia 14 bién toan cuc
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Ham chuyén doi:

MapBasic cung cap cho ban cdc hdm c6 thé chuyén dai giita cac dit liu vdi nhau. Vi
du, Ban chuyén déi 1 bién dudi dang s6 (Numerical) sang dang sau ky tu (String) sit
dung ham Str$( )

Héng s6-

Mot hang s6 thi gia tri cia né khéng thay déi trong céc chuong trinh.

M6t hang la siu ky tur (String) thi bat ddu va két thiic bdi ddu nhay kép () .
Vidu:

Name = “Sloan*

Title = “Downtown Redevelopment Plan*

Ban ¢4 thé phan cdc phdn trong xau ky tur bing céc cap dan ().

C6 thé ¢6 ddu nhady don trong xau ky tr dé, chuong trinh coi d6 1a ky tu.
Vidu:

Prompt = “The Table" “World" “is open

Hing s6 logic chi ¢6 thé 13 1 (True) hodc 0 (False). Bdi MapBasic di dinh nghia File
MapBasic.def nén ban c6 thé sir dung tir True va False nhu I gi4 tri hing logic.

Vi duy:

Include “MapBasic.def *
Dim allset As logical
Allset = true

Ban c6 thé an dinh biéu thitc (String) ki tu cho 1 bign ki€u Alias.’
Vi du:

Dim colname as Alias

Colname = “Address*

Trudng ngay (date) sir dung trong cic dang sau:

m - d -y, m/d/y, m/d, m-d.

Cdc phép todn

Cdc phép todn so sdnh:

So sanh 2 gid tri trong ciing 1 ki€u d€ nhan duge gid tri kiéu logic, gid tri (True hodc
False).

Phép todn so sdnh thudmg duoc ding trong biéu thic diéu kién.
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Bang cdc phép toan so sanh

Phép todn Y nghia Vidu
= So sanh bing nhau a=
<> So sénh khic a<>b
< So sdnh nhd hon a<b
> S0 sanh 1dn hon a>b
<= Nho hon hodc bang a<=b
>= Ldén hon hoic bing a>=b

Ngoai ra con c¢6 kiéu so sdnh khéc nita:

Between...End

Gia tri True néu s6 do 16n hon hodc bang gid tri va nho hon hoic bang gid tri trén.
VD: Between a and b thi biéu thitc 1a.

x>=a and x<=b. '

Bang cac phép toan logic

Phép toin Y nghia Vi du
And Ca hai cing nhan gia tri True .aAndb
Or Mot trong hai nhan gia tri True aOrb
Not Gid tri pht dinh Not a
Cdc phép todn s6 hoc

Bang cic phép toan sé hoc

Phép todn Y nghia Vidy
+ Phép cong a+b
- Phép trix a-b
* Phép nhin a*b
/ Phép chia a/b
Lay s6 nguyén cta phép chia a\b
Mod L&y s6 1€ cla phép chia amod b
A Phép tinh juy thira a’b
Vidu:
3/4=0.75
3\N4=0
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18 Mod 16 =2
47r3=64

Phép todn (+) va (-) ¢6 thé dung trong cdc phép todn khic nhu cong (n6i) cdc sau ky
t (String).

Ban c6 thé cong, trir duge ngay, thang, nam, két qua ra 6 ngay, thang, nam. Vi du,
cong 1 vao April 1. 1992 két qua Ia April 2.1992.
Cau tric diéu khién
Chi thi ré nhdnh don gidn:
MapBasic c6 3 loal 1& nhanh don gian. If...then, Do...Case. va Goto.
If.Then.. Else If. .Else If..Endlf
Vidu;
If Pvolts < Vspec Then
Call Vcomp(Pvolts)
Elself Pvolts = Vspec
Call V]imit(Pvolts)
Else
Call Vhigh (Pvolts, Vpec)
EndIf
Giai thich:
Cau dieu kién dau If (Pvolts < Vspec) nhan gid tri True, thi tat ca dong lénh giita
Then va Elself dugc thuc hién. Néu cau diéu kién ddu nhan Falsc thi bo qua va t6i dong
lenh Elself d€ kiém tra diéu kién ti&p theo (Pvolts = Vspec). Thu tuc nay tiép tuc cho t6i

khi 1 di¢u kién ding xdy ra. Néu khong diéu kién nao ding truée khi t6i 1énh Else thi
nhimg dong sau Else thuc hién.

Vi du:
If distance2 >1 And distance2 < 25 Then
Update customers
Set potetial =1
Where rowid = currow
Commit Table costomers
Elself distance? <=1 Then

Note * Specified distance is too small *
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Else
Note * Specified distance is too large *
EndIf
Do Case...Case....CaseElse.. EndCase:
Dong lénh Do....Case giong nhu dong 1énh if... elseif nhung khdc nhau & ché 1a dong

Iénh Do...Chi dugc sit dung véi cdc s6 nguyén. Vi du sau diy dua ra cdc théng bdo vé
thiang (1) d&n thang (12).

Néu bién this_month nhan gia tri one,two, hay 1a three thi thang (January, Februay,
March), dong 1&nh Do...Case s€ 4n dinh cdch dua ra thong bao:

Do Case This_Month

Case 1,2,3
Title = * First Quarter Results ©
Quarter = 1
Case 4.5.6
Title = ** Second Quarter Results
Quarter = 2
Case 7.8.9
Title = ** Thirtd Quarter Results *
Quater = 3
Case Else

Title = ** Fourth Quarter Results “
Quater = 4
End Case
Goto

Dong lénh Goto (Label) dinh huéng dé cho chuong trinh doc theo nhéin da duoc dinh
vi trong chuong trinh

Vidu:
Goto Get_out

Get_out:End Program _
Dong lénh Goto rat it khi duge ding trong ngon ngit MapBasic
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- Vong lap (Loops)

Dong lénh Loops cho phép thay th€ mét nhém 1énh. Cdu tric cia énh Loops 1a cho
phép thay thé€ moét phép todn hay moét tap hap céc phép todn cho t6i khi gap mét diéu
kién dic biét thi thoat ra khoi vong Loops.

For....To....Step....Next:
Lénh For Next tao ra vong ldp theo timg budce tinh bang s6.

S6 d&€m phai 1a bién s6 (hang hodc la bién).

Khi MapBasic thuc hién For... Next, né da 4n dinh gid tri bat dau cho bién dém. Sau
mdi vong lap MapBasic cong thém 1 gia tri bude nhay Step vao bién. Néu bién dé€m nhd
hon gia tri cudi thi MapBasic quay lai vong lap. Vong For.... Next dimg khi gia tri bién
dém Ién hon gid tri cudi.

Vi du sau day cho phép thuc hién 10 lan.
Dim How_many as Integer
For How_ many = 10 to 100 Step 10

Note ““ the next number i: ** How_many
Next

Do.... Until/While... Loop -
Dong lénh Do...Loop sk dung diéu kién dé xéac dinh khi nao vong loop dugc thue thi.
Vi du. Sau vong loop (quay lai ddu vong lap) st dung it nhat mot 14n.
Do
Call Find_Routc_lLeg
Call Update_Route_Dist
Loop Until Dist_traveled = Route_dist
Vong While thi chuong trinh thuc hién vong lap khi diéu kién bi sai (False). Con
vong Do...Loop Until thi thuc hign vong lap cho dén khi diéu kién ding. (True)
Vi du: |
Do while Dist_traveled < Route_dist

Call Find_Route led
Call Update_ Route_Dist
Loop

Dong lénh Exit Do thodt khoi vong lip Do...Loop va MapBasic thuc thi lénh ngay
sau 1énh Loop.
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Vong lap While... Wend.:

Cau tric lap While... Wend gidng nhu Do While...Loop.

Khong c6 1énh 1lam thoat khoi vong While... Wend, trir dong 1énh Goto
Vi du:

While Dist_traveled < Route Dist

Wend

Cdu triic chuong trinh

Du6i day la cau tric cua chuong trinh MapBasic (hinh 6-1):

Pinh nghia bi€n toan cuc
khai bdo cac kiéu dir liéu
Khai bdo cic thi tuc

l

Thi tuc 1

l

Thi tuc 2...

|

Thi tuc n

Hinh 6-1

Chuong trinh MapBasic co ban xay dung trén cdc khai (block) 1a diing céc thi tuc:
Vidu:

Declare Sub Main( )

Declare Sub NoteThis (r as float)

Define P1=3.14 |

Sub Main ()

Dim circle_area, radius as float

Radius =3

Circle_area = P*Radius*Radius

Call NoteThis (circle_area)
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End Program
End Sub
Sub NoteThis (r as floar)
Note ““ The result is ““ +str$(r)
End Sub

Cdu triic doan

Dong 1énh ¢6 thé ¢6 tuy chon (Goto nhin) theo gid tri clia dong lénh MapBasic.
Vi du:

Jumptowhere: x=x+1

Chiéu dai chia dong lénh ¢6 thé chia thanh nhiéu dong va khéng cin dua ky tu dac
biét dé nai ti€p. (Khong duge chia (cat) cdc hing , tén bién, it khod.... bdi 2 dong).

Vidu:
Selec * From 500 where sic_code > 540 and sic_code < 5600
Group by sic_order by 1

Ban ¢6 thé phan chia dong 1énh trong cira s6 MapBasic bing cach bam (Ctrl - Enter)
sau dong ddu ctia néu cau Iénh va két thiic dong.

Cdu triic cdp toan cuc
MapBasic sir dung 3 cdp cu tric cap toan cuc:

+ Cdu triic khai bdo. Moi tht tuc va ham dinh nghia do ngudi dung phai dugce khai
bdo triede khi né ¢6 thé duoc dinh nghia, goi ra. nhitng chuong trinh 16n thudng bit dau
1 loat liét ke, khai bdo ham.

+ Cdu triic kiéu dong lénh. Kiéu 1énh dugc tao ra kiéu dit lieu do ngudn sir dung dinh
nghia va phai dugc dinh nghia ngoai cdc thu tuc va trude khi ching duge sir dyng.

+ Cdu triic toan cuc. Dong lénh todn cyuc dinh nghia bién cuc va phii bén ngoai
moi thu tuc va xay ra truéc moi thi tuc. Thudng ching duge liét ké truée chuong
trinh cua ban.

+ Cau tric dich: Dinh nghia dong 1énh tao ra do ngudi st dung dang tir khod, phai
xudt hién trong chuong trinh trude khi tr khod duge sir dung.

BDinh nghia tiv khod cho nguoi ding

MapBasic cho phép ban dinh nghia tir khod do chinh ban tao ra bing dong lénh
Define.
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Vi du:
Define PI 3. 141493

Sau dong 1énh Define ban ¢6 thé sir dung tir khod mdi (vi du p!) nhu 1a mot hing so
trong chuong trinh cia ban. Vidu:

Marketarea = PI*radius*radius
Dong lénh Define phai nam trén mot dong va tén bién phai 1a chir hoa.
Ban c6 thé dé dong lénh Define 6 batky noi nao trong chuong trinh cta ban,

Trong tép MapBasic.def ¢6 chira cac hiing s6 di dugc dinh nghia, va ban cé thé st
dung ching.

Gop cdc tép
Ban c6 thé gop céc tep Text trong chuong trinh clia ban

Cac dong lénh duge gop thong qua lenh Include thi dugc dung nhu nhau thong qua
su xuat hién trong chuong trinh cha ban theo dong Include.

N6 duoc viét dau chuong trinh MapBasic.

Include *“ MAPBASIC. DEF ©
- Truyén cac tham s
Truyén tham s6 thong qua tham bién

Déng lénh Sub dinh nghia kiéu truyén tham s§ nay coa thi tuc va khai bao cac bién
duge truyén.

Vi du:

Sub cubefloat (Numpar as Float)
Numpar = numpar * 31

End Sub

Tham s6 1a numpar khong can lénh Dim dé khai bao. Pé goi mot thu tuc ma sl dung
tham s& thi phai dua cdc bign vao ding vi tri.

Vi du:
Call cubefloat(side_len)

Trong trudng hop nay side_len phai la mot bién kiéu Float dugc dinh nghia v6i iénh Dim
trong lic goi thit tuc. Sau khi I¢nh Call thye hién thi gid tri cua bién side_len thay déi.

Thu tuc khai bdo cho vi du trén

Declare Sub cubefloat (Numpar as Float)

Mot thil tuc ¢6 thé c6 nhiéu tham sé.

Sub cube(orig as Float, Result as Float)
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Truyén tham sé thong qua gid tri (tham tri}

Ban c6 thé truyén tham s& gid tri (tham tri), sit dung lénh ByVal. Mét thii tyc c6 thé
¢6 ca tham bi€n va tham tri. Cdc tham tri ¢6 tit khod ByVal di k&m.

Vi du

Subcubefloat(ByVal orig as Float, Result as Float)

Tir khoda ByVal dinh nghia Orig la tham tri

Pham vi cdc ham )

Mot chuong trinh ¢6 thé dinh nghia nhiéu ham ¢ dang gi6ng nhu dang chudn ciia
MapBasic. Khi chuong trinh goi ham ra, thi ham tdc dong va thay thé ham chuén cua chiing.

Khai bdo va goi cdc thit tue DLL :

Lién két dong cic thu vién (Dynamic Link Libraries) DLL, 14 céc tép cé chita thi tuc
¢6 thé thuc hién duge, ban ¢6 thé sir dung nhu 1 thi tuc trong chuong trinh MapBasic.
Diing 1&nh Call dé goi thi tuc DLL sir dung trong chuong trinh.

Cé nhi¢u bién DLL. Nhung dac biét DLL s& miéu ta thh tuc chita trong d6, tén, tham
s6. D¢ goi thii tuc DLL tir trong chuong trinh MapBasic, ban phai khai bdo né nhu
nhimg thu tuc khac. Ban ciing phai gop céc tén (File) tép va dinh vi chia tép DLL va tén
tép DLL. C6 thé str dung ménh dé Alias thay tén tha tuc DLL dé sir dung ma khong can
chuong trinh cua ban.

Ban chi cin goi thi tuc DLL khi ban muén goi ham cita MapBasic, bao gém céc
dong lénh khai bdo ham (Declare Function) & trén d4u chuong trinh clia ban réi goi
chuong trinh d6 ra bang lénh Call.

Vi du: Declare Sub my- routine Lib “C\Lib\ my lib.dII*
(ByVal x Asinteger, ByVal y As Integer)

ITI. LAM VIEC VOI BANG

M cac bang (Tables)

Ban c6 thé sir dung bang clia cdc tép nhir Dbase, Lotus, hay Excel thong qua céc dinh
dang cla chiing trong chirong trinh Maplnfo.

Mo bdng Maplinfo (Mapinfo table)

Dé lam viéc trén bang, trudc hét ban phi mé né ra. Sir dung lénh Open Table dé mé |
bang Maplnfo dinh dang la du6i (.tab) théng qua MapBasic.

Vi du:

Open Table “C\ MapInfo \ counties \ nycnty.tab *“ as county

Browse * from county
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Né&u nhu ban mo moét bang ¢é tén triing véi tén ciia mét bang di ¢é thi MapBasic tu
tao thém s6 ¢ cudi tén cua bang. Vi du, Ban d& mé mét bang c6 tén 1A WORLD.TAB thi
Maplnfo s&€ an dinh bang dugc md sau 1a WORLD_2.

Mo bang ngoai MapInfo (Non-Maplnfo Table)

Dé m& 1 t¢p bang & Dbase, Foxbase, Lotus hay Excel, trudc hét ban sir dung Register
Table dé ghi vao. Sau khi bdng duge ghi vao. Ban c6 thé sit dung ddng 1énh Open Table.

Register Table * C: \ MapInfo\ DATANUSSTINC.DBF

Type DBF

Open Table ** C: \ Maplnfo\DATA\ USSTINC.TAB “
Interactive

Poc bdng

Dé doc cdc gid tri tir bang ban cdn cé tham chi€u t6i bang, dinh vi hang, cot dir liéu
ma ban mudn doc, Trong vi du duéi day dong lénh Fetch dinh vi con trd, con tr6 chi téi
14n luot vi tri chia dT liéu, tir hang dau tién clia bang. Dong cudi cling 4n dinh gid tri
bién cot Pop_1990 clia bang t6i bién State_pop.

Dim State_Pop As Float

Fetch First From states

State_Pop = States.pop_1990

Tao va thay déi cdu tric ciia bdng

Ban c6 thé tao bang Maplnfo st dung dit liéu tir cdc bi€n da cé va sira chita cdc doan
cdu triic cha bang thong qua MapBasic.

S dung dong 1énh Create Table d€ tao bang. Dong 1énh ndy dinh nghia 1 ciu (ric
bang ma ban c6 (hé chén thém dif liéu bang Insert. Dong Create Index va Create Map
tao ra mot bang. Vi du tao bang dudi day vdi 1 tén dia chi, thanh phs, ngay:

Create Table Cust (Name Char (20), Address Char(30), City Char(30), Amount
Decimal (3,2) Date order Date, CustID Integer)

File * C:\ customer \Cust. Tab

Create MapInfo Cust Coordsys earth

Create Index On Cust (CustID)

Create Index On Cust (Namc)

Chon bang méi sir dung dong 1énh Commit hay nhap vao bang dang sir dung véi cau
1&nh ImPort.

Bién doi sita chita cdu trite cia bdng

Dong déu tién trong vi du dugi d6i tén cot dia chi, dong thit hai 13 do dai ctia cot tén 1 - 25
ky tu.
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Dong thit 3, dong dia chi, di chuyén va bo cot.
Alter table Cust (Rename Address Ship Address,
Modify Name Char (25),

Drop Amount

Add Zipcode Char (10),

Discount Decimal (4,2)

Order Name, Address, City, Zip-code,Order Date.
CustID. Discount)

Nhdp thém dit liéu vao bdng
MapBasic chita cdc 1énh dé dua dit liéu vao bang. Dong lénh Inset Into cho ban chén
vao hang mdi va ¢t méi vao bang

Khi thém di liéu vio bing c6 thé tao c6t méi, hiaing méi, hay 1a nhiing théng tin
trong c¢Ot va hang. Dé tao 1 c6t mai, sit dung 1énh Alter Table. Lénh Insert nhap thém
hang méi vao cudi bang. D€ cho thoéng tin vao mot hang, sir dung Iénh Update.

Lam viéc theo luu chon: ‘

Lua chon tén bang bao gém cdc hang di duge lwa chon. Trong chuong trinh
MapBasic viéc sir dung lua chon bang dugc thyc hién binh thudng nhu trong Mapinfo.

Vi du, ban c6 thé hién thi nhitng hang da duge hién thi bang cau lénh sau:

Browse From Selection

Upduate the Selection

Ban c¢6 thé thay déi lua chon bing cdch ding dong lénh Update va nhitng thay déi sé
dugc hién thi trong bang goc.

Vidu:

Seclect * From employees Where department = Marketing ** and salay < 20000
Update Selection

Set Salary = salary*1.15.
Su thay déi gid tri clia Salary s& dugc két qua trong bang géc Employees.

IV. SUDUNG CAC FILE
Ma 1 File

Céc lénh d&€ md mot File thay doi theo kiéu cua File va phuong phép cin st dung.
- File tudn twr. .
Vi du: Open File “ dataFile.dat ** For Output As # 1 (ghi vao File)
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Open File * dataFile.dat “ For Append As # 1 (thém vao File)

Open File ““ dataFile.dat ** For Input As # 1 {doc ti File)

File truy xuat ngiu nhién

Vi du: Open File “ dataFile.dat *“ For Random As # 1 Len = (80 m& File)
Len 80 la s6 chinh x4c cdc ky tu trong mot ban ghi

-File nhi phan (Binary)

Vi du: Open File  dataFile. Dat ** For Binary As # | { Ma File nhi phan)
Ban ciing ¢6 thé thém phdn thudc tinh cia dia chi

Vi du: Open File “ dataFile. Dat “ For Binary As # 1 Byte Order Lowhigh
Tham s6 Byte Order chi ¢6 thé 1a mot trong ba tit khoa sau:
*LOWHIGH

*HIGHLOW

*NATIVE

Boc va ghi cac ban ghi cua File. MapBasic cung cdp hai dang File:

Doi vai File tuan ty:

Input # num, string_var

Writenum # num, expressionl...

Prin # num, expressionl...

D61 véi File nhi phan va File truy xuat ngiu nhién:

Put # num, [position| , var

Put # num [position], var

Béng File

Ciu triic cau lénh déng File hién dang md

Close Fiic # 1

V.SUDUNG CAC BIEN DOI TUGNG (OBJECT)
- Khai niém

Kiéu bi¢n d6i twgng MapBasic cho phép ban 1am viéc véi cac déi tugng don, nhue
Lme hay doi twong phitc nhu Regions. Bi¢n d6i tugng duge st dung nhu cdc bién

khdc, ban ¢6 the thay déi kich thudc, qui dinh gid tri méi, sit dung chung so sanh vé
hinh thtc.

Pinh nghia
Sir dung dong 1énh Dim dé dinh nghia mét bién déi tugng.
Dim Myobj office as Object
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Mot 14n dinh nghia mot bién d6i tugng c6 thé diing cho moi d6i tugng khéc.

Office = Create Point (73.45.42.1)

Myobj = Office

Ban ¢6 thé an dinh cdc d6i tuong tir cc d6i bign déi twong khdc. Ham tra lai d6i
tugng. Céc dong lénh khac ciia MapBasic cho phép ban tao cdc dai tugng va chén ching
vao céc bién ddi tugng.

Bién déi tugng giit tat ca cdc thong tin cha d6i tugng dé. Vi du bién d6i tuong 6 thé
liru gift duwoc gia tri kiéu ban vé dé. MapBasic cung cdp cho ban tap hop cdc ham ma
ban c6 thé sir dung dé miéu ta chi tiét d6i tuong.

St dung cac ham Object.

Mot vai ham MapBasic dua déi tuong dé xit 1y nhur tinh todn khoang cich, do rong,
dién tich.

Vi du:

Open Table “ floodmap.tab

Dim floodarea as float

Fetch first from floodmap

Floodarea = area (floodmap.obj, ““ sq. Km *“)

Mot s6 ham khdc lai tao cic ddi tugng nhu diém, dudng thang, vong trdn, dudng bao
hinh chit nhat.

Dim TargetArea as Object
TargetArea = CreateCircle (103,44, 35.5,100)

Str dung todn tir so sanh

Mic du Mapbasic khong cho phép ban tac dang so sdnh déi twong ( if object_a =
object_b, ban c6 thé so sénh d6i tugng dé bi€t the nao vé quan hé khong gian (Relate
Spatially). Toan tir so sdnh ctia MapBasic 12 Contains, Within, Intersects va cc tuy chon
dugc dinh nghia cho phép ban so sdnh nhiing d6i twong dudi dang s6.

Vi du duéi day 1a so sdnh khong gian véi 1&nh If... Then.
If Parcel_Object Within Residential_Zone_Obj Then

Note ** Your Property is zoned residential “

End If

Vi du duéi so sanh v3i dong 1énh Select.

Select * From wellands Where obj Contains Part myproject

ft nhat mot doi tugng duoc siv dung trong diéu kién Within va Contains s& dugc mot
ddi tuong 1a viing kin: Regions, Ellipses, Rectangles.
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Hoac ban sit dung Within hoéc Contains trong lénh vé déi twong trong biéu thic.
Cau tric l1énh

Sir dung Within d€ kiém tra ¢6 hay khong déi tuong ddu tién nim trong déi tuong thit
hai.

Sit dung Contains dé kiém tra c6 hay khong d6i twong déu tién cé déi tuong thit hai &
trong do.

Bang ¥ nghia cac todn tur so sianh

Toan ti Céich dung Két qua 1a True néu
Contains A Contains B P61 twong A chita déi tuong B
Contains Part A Contains Part B Poi tuong A chita mét phan déi tuong B
Contains Entire A Contains Entire B Pai tugng A chira t4t cd d6i tuong B
Within A Within B A thuoc B
Partly Within A Partly Within B A mét phan thudc B
Entirely Within A Entire Within B A hoan toan thuoc B
Intersects A Intersects B A giao B
Vi du: .

Khi so sdnh Points véi | Regions
Points are Within Regions

Regions Contain Points

VL SUDUNG COT BOI TUGNG (OBJECT COLUMN)
- Cot déi tugng
Cot do1 tugng Object Colum chia trong bang (Table).
Thue t€ méi ban d6 trong Maplnfo 1a 1 bang chita 1 cot d6i tuong.

Cot d6i tugng c6 thé duge 1am tham chiéu trong 1énh MapBasic vdi tén d6i tuong,
hay Object.

Vidu

Open Table ** States. Tab “
Dim Mystate As Object
Fetch First From State
Fetch Next From State
Mystate = state.obj

Ban c6 thé thyc hi¢n gidng nhu kiéu ciia cdc todn tir v6i d6i tuong cot binh thudng.
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Vi du:

Tao mot hang ghi téng chiéu dai “mi” clia dudng cao téc trong Califolia.

Select .Sum ( Object Len (obj, “ mi “)) From highways Where Obj Within (Select
Obj From States Where State = “ CA *)

- Tao ¢4t doi tuong

Sit dung 1énh Creat Map dé tao mét ddi tugng cot trong moét bang. D& bd né di sir
dung Drop Map. Drop Map xod bo hoan toan céc déi tugng cét. Sir dung Delete Object
dé xod noi dung trong d6i tugng cot tir mot hang hay tit ca cdc hang. Dé ki€m tra d6i
tuong cdt con trong bang, s dung Tableinfo ( ) v6i thudc tinh Tab_info_Maptable.

- Hoi doi tuong trong bang

Ban ¢6 thé sir dung ham trong MapBasic hay céc todn tir so sanh dia 1y dé xay dung
cdc néu cau hoi ding trong bang ciia ban.

Tao cau hoi sir dung cdc ham.

Nhimg dong lénh dusi day sir dung ham ObjectLen ( ) dé tim t4t ca cdc phan tir ciia
no chiéu dai Ién hon 300 meters.

Select * From cable Where ObjectLen (obj, “ m ) > 300

- Tao, sita chira va doc cac doi tuong

MapBasic c¢é chita nhiéu Iénh va cdc ham ma ban tao d6i tugng thong qua Maplnfo.
Vi du, dong iénh Create Menu cho ban tao mot dong sir dung diém bét dau va diém cudi
ciia dudng thang, kiéu dudng, tén bién d6i tuong, tén déi tuong.

Ban c6 thé thay d6i thuoc tinh cha céc d6i twong voi dong lenh Alter Object. Khong
nhu dong 1€nh dinh nghia Create, Alter Object cung cho tit ca cac dai tuong, st dung
céc tén bién cna d6i twgng nhue 1a tham s6.

- Doc thong tin cua déi tugng

Cac ham d6i tugng ctia MapBasic cho ra cdc gié tri vé loai clia d6i twong véi tén bién
clia d6i tugng, hoac 12 him nim trong d6i tuong cot. DE sir dung nhimg ham nay, ban
can c6 MapBasic.def trong chuong trinh cta ban.

ObjectGeography ( ) cho ra thong tin vé toa do va géc do vé doi tuong dia 1y, vi du,
ban c6 the sir dung ObjectGeography( ) d€ tim va dinh vi d6i tuong diém, diém dau va
ket thiic cia déi tugng dudng thing.

- Tao déi tugng

Create Ellipse, Create Frame, Va Create Plin cho ban tao cic déi tuong trong ban vé.

Céc ham CreateCircle( ), CreateLine( ) va Create Point( ) clia MapBasic tra lai gi4 tri
cua déi tugng.
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Khi ban khong bi€t ¢6 bao nhiéu di€ém cé trong mot déi wgng, sit dung dong lénh
Create dé tao mot déi twong khong cé cac diém réi sau dé ding lénh Alter Obiject dé
thém cédc diém vao.

Diéu nay chi ¢6 thé dugc khi tao mot d6i tuong nhu Pline vh Region. Vi du duéi day
tao mot Polyline véi cdch nhir trén,

‘Include “ mapbasic. def “

Type Point

X As Float

Y As Float

End Type

Dim objcoord(5) As Point

Dim numnodes, i As Integer, Myobj As Object

Numnodes = 3

Set Coordsys earth

Objcoord(1).x =-89.213 objcoord(1).y=32.017

Objcoord(2).x = -89.204 objcoord(2).y=32.112

Objcoord(3).x = -89.132 objcoord(3).y =32.096

Create Pline Into Variable myobj ()

For 1= 1 to Numnodes

Alter Object Myobj Node Add (objcoord(i).x objcoord(i).y)
Next

Insert Into cables (obj) Values (myobj)
End Program

- Nhap déi tugng vao bang

Ban ¢6 thé cho thém d6i tuong vao d6i tugng cot. Trude tién ban phai xay dung d6i
tugng trong mot bign déi twong va sau dé cho vao trong bang bang c4ch sir dung lénh
Update.

Deé thém mot hang méi vao bang, ban sir dung 1énh {nset. Insert cho phép ban thém
mot hang. D€ chén mot vai hang (ir bang khéc vio, ban diing 1énh Sclect.

Xem kiéu ciia déi twong

Maplnfo dua ra cdc mo ta kiéu vé dai tuong thong qua lénh Browse. Bang su dinh

nghid moét bién d6i tugng trong dong lénh Note hay thong qua ham Str$( ), Maplnfo cho
ra kiéu cha doi tuong.
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Vi du:

Note county.obj

Puwra ra mot thong bao 12 Region. DE chon tét ca cdc d6i tuong dang Text thi ddu tién
ban phai b6 tri trang clra so.

Select * From Layout | where Str$ (obj) = “ Text

Dinh nghia kiéu doi niong

Ban ¢6 thé dinh nghia mot kiéu thuoc tinh chia déi twong nhu 13 ban tao ra né, sir
dung 1énh Create hodc Alter dé thay déi kiéu cia né.

Kiéu nét va kiéu Font

Ban c6 thé dinh nghia kiéu dé v& d6i trong. Cic dudng thing thi xac dinh do day,
loal duong (duong gach gach, dudng cham cham...) va mau.

MapBasic cho phép ban xdc dinh Font duge sit dung. Kiéu Text thi duge xac dinh
boi ki€u chit (dam, nghiéng, gach chan kich ¢& clia chit, mau chit, mau nén, Font chit
(vi du: Time New Roman trong méi truong Mucrosoft Windows) '

Bang cac kiéu coa doi tuung

Style b¢ day, loai dudng, va mau

Brush Loai, mau v&, mau nén

Font Tén font, kiéu, mau chir, mau nén, kich ¢
Symbol Pdnh bong mau, va c&

Ban c6 thé dinh nghia mét kiu khi ban tao ra mét d6i tuong khéc, MapBasic s& su
dung ki€u mac dinh sén.
Kiéu biit vé va mau

Mau thi duge x4c dinh theo s6 nguyeén. Vi du, mau den (Black) 12 s6 0. Mau xanh
(Blue) 1a 255. Ham RGB ( ) cho ra mdu nhu do, xanh... Theo 56 da dinh sin cta
MapBasic. Vi du, RGB {0,255,0) cho ra mau xanh (Blue).

Str dyng ham RGB () thi mau s& ¢6 gid tri méi ma mau di duoc goi ra.

Vi du:

Highway_style = MakePen(2,2,RGB(0,0,255))

Kiéu bién:

Ban c6 thé dinh nghia bién nhu kiéu Pen. Brush, Font, Symbol va sit dung ching véi
lénh Create Line va ham Stye Attr( ).

Ham nay cho phép ban thay déi kiéu cna bién.

201



Vi du:

Dim mypen As Pen

Mypen = makePen (1,10,RGB(128,128,128))

Vidu nay dinh nghia mot bién Mypen la méng, cham chdm, mau x4m.

Ham Styleattr( ) tra lai gid tri cia kiéu. Vi du, dé doc mau nét vé& tir bo mau chuan.

Include *“ MapBasic. def «

Dim fill_fore_color As Integer

Fill_fore_color = Styleattr(CurrenBrush( ), Brush_forecolor)

Sita chira mot kiéu déi tugng

Dong lénh Alter Object cho ban sira chita mét kiéu d6i nrong.

Vi du dudi day st dung lénh Alter Object dé thay déi d6i tuong dugc chon
trong bang.

Include “ MapBasic *

Dim myobj as Object, mysymbol as Symbol ( )

Mysymbol = CurrentSymbol( )

Fetch Fist From selection

Myobj = selection. Obj

If ObjectInfo (myobj.Obj_Info_Type) = Obj_Point Then

Alter Object Myobj

Info Obj_Info_Symbol, mysymbol

Update selection Set obj = myobj Where RowlID = 1
Else

Note “ The selected object should be a point “
EndIf
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